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Cross-referencing the documentation

When reading this manual, you will find references to other Stata manuals, for example,
[U] 27 Overview of Stata estimation commands; [R] regress; and [D] reshape. The first ex-
ample is a reference to chapter 27, Overview of Stata estimation commands, in the User’s Guide;
the second is a reference to the regress entry in the Base Reference Manual; and the third is a
reference to the reshape entry in the Data Management Reference Manual.

All the manuals in the Stata Documentation have a shorthand notation:

[GSM] Getting Started with Stata for Mac
[GSU] Getting Started with Stata for Unix
[GSW] Getting Started with Stata for Windows
[U] Stata User’s Guide
[R] Stata Base Reference Manual
[BAYES] Stata Bayesian Analysis Reference Manual
[CM] Stata Choice Models Reference Manual
[D] Stata Data Management Reference Manual
[DSGE] Stata Dynamic Stochastic General Equilibrium Models Reference Manual
[ERM] Stata Extended Regression Models Reference Manual
[FMM] Stata Finite Mixture Models Reference Manual
[FN] Stata Functions Reference Manual
[G] Stata Graphics Reference Manual
[IRT] Stata Item Response Theory Reference Manual
[LASSO] Stata Lasso Reference Manual
[XT] Stata Longitudinal-Data/Panel-Data Reference Manual
[META] Stata Meta-Analysis Reference Manual
[ME] Stata Multilevel Mixed-Effects Reference Manual
[MI] Stata Multiple-Imputation Reference Manual
[MV] Stata Multivariate Statistics Reference Manual
[PSS] Stata Power, Precision, and Sample-Size Reference Manual
[P] Stata Programming Reference Manual
[RPT] Stata Reporting Reference Manual
[SP] Stata Spatial Autoregressive Models Reference Manual
[SEM] Stata Structural Equation Modeling Reference Manual
[SVY] Stata Survey Data Reference Manual
[ST] Stata Survival Analysis Reference Manual
[TABLES] Stata Customizable Tables and Collected Results Reference Manual
[TS] Stata Time-Series Reference Manual
[TE] Stata Treatment-Effects Reference Manual:

Potential Outcomes/Counterfactual Outcomes
[ I ] Stata Index

[M] Mata Reference Manual
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About this manual

This manual discusses Stata for Windows R©. Stata for Mac R© users should see Getting Started
with Stata for Mac; Stata for Unix R© users should see Getting Started with Stata for Unix. This
manual is intended both for people who are completely new to Stata and for experienced Stata users
new to Stata for Windows. Previous Stata users will also find it helpful as a tutorial on some new
features in Stata for Windows.

Following the numbered chapters are three appendixes with information specific to Stata for
Windows.

We provide several types of technical support to registered Stata users. [GSW] 4 Getting help
describes the resources available to help you learn about Stata’s commands and features. One of these
resources is the Stata website (https://www.stata.com), where you will find answers to frequently asked
questions (FAQs) as well as other useful information. If you still have questions after looking at the
Stata website and the other resources described in [GSW] 19 Updating and extending Stata—Internet
functionality, you can contact us as described in [U] 3.8 Technical support.

Using this manual

The new user will get the most out of this book by treating it as an exercise book, working through
each example at the computer. The material builds, so material from earlier chapters will often be
used in later chapters. Bear in mind that Stata is a rich and deep statistical package—just as statistics
itself is rich and deep. The time spent working the examples will be repaid with dividends when
doing true statistical analyses.

The experienced user may still have something to learn from this manual despite its name. We
suggest looking through the chapters to see if there is anything new or forgotten.
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1 Introducing Stata—sample session

Introducing Stata
This chapter will run through a sample work session, introducing you to a few of the basic tasks

that can be done in Stata, such as opening a dataset, investigating the contents of the dataset, using
some descriptive statistics, making some graphs, and doing a simple regression analysis. As you
would expect, we will only brush the surface of many of these topics. This approach should give you
a sample of what Stata can do and how Stata works. There will be brief explanations along the way,
with references to chapters later in this book as well as to the system help and other Stata manuals.
We will run through the session by using both menus and dialogs and Stata’s commands so that you
can become familiar with them both. If you see that your menus and dialogs are not in English, we
recommend that you (temporarily) change the locale used by Stata to English, so that you can work
along with the examples. See [P] set locale ui for how to do this.

Take a seat at your computer, put on some good music, and work along with the book.

Sample session
The dataset that we will use for this session is a set of data about vintage 1978 automobiles sold

in the United States.

To follow along by pointing and clicking, note that the menu items are given by Menu > Menu
item > Submenu item > etc. To follow along by using the Command window, type the commands
that follow a dot (.) in the boxed listings below into the small window labeled Command. When
there is something to note about the structure of a command, it will be pointed out as a “Syntax
note”.

Start by loading the automobile dataset, which is included with Stata. Use the menus to do this:
1. Select File > Example datasets....
2. Click on Example datasets installed with Stata.
3. Click on use for auto.dta.

The result of this command is fourfold:
• The following output appears in the large Results window:� �

. sysuse auto
(1978 automobile data)� �

The output consists of a command and its result. The command, sysuse auto.dta, is bold
and follows the dot (.). The result, (1978 automobile data), is in the standard face here
and is a brief description of the dataset.
Note: If a command intrigues you, you can type help commandname in the Command window
to find help. If you want to explore at any time, Help > Search... can be informative.

• The same command, sysuse auto.dta, appears in the tall History window to the left. The
History window keeps track of all commands Stata has run, successful and unsuccessful. The
commands can then easily be rerun. See [GSW] 2 The Stata user interface for more information.

1



2 [ GSW ] 1 Introducing Stata—sample session

• A series of variables appears in the small Variables window to the upper right.
• Some information about make, the first variable in the dataset, appears in the small Properties

window to the lower right.

You could have opened the dataset by typing sysuse auto in the Command window and pressing
Enter . Try this now. sysuse is a command that loads (uses) example (system) datasets. As you will
see during this session, Stata commands are often simple enough that it is faster to use them directly.
This will be especially true once you become familiar with the commands you use the most in your
daily use of Stata.

Syntax note: In the above example, sysuse is the Stata command, whereas auto is the name of
a Stata data file.

Simple data management

We can get a quick glimpse at the data by browsing them in the Data Editor. This can be done

by clicking on the Data Editor (Browse) button, , or by selecting Data > Data Editor > Data
Editor (Browse) from the menus or by typing the command browse.

No command is issued when clicking on either Data Editor button because opening the Data Editor
has no effect on the dataset or any possible analysis.

When the Data Editor window opens, you can see that Stata regards the data as one rectangular
table. This is true for all Stata datasets. The columns represent variables, whereas the rows represent
observations. The variables have somewhat descriptive names, whereas the observations are numbered.
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The data are displayed in multiple colors—at first glance, it appears that the variables listed in black
are numeric, whereas those that are in colors are text. This is worth investigating. Click on a cell
under the make variable: the input box at the top displays the make of the car. Scroll to the right until
you see the foreign variable. Click on one of its cells. Although the cell may display “Domestic”,
the input box displays a 0. This shows that Stata can store categorical data as numbers but display
human-readable text. This is done by what Stata calls value labels. Finally, under the rep78 variable,
which looks to be numeric, there are some cells containing just a dot (.). The dots correspond to
missing values.

Looking at the data in this fashion, though comfortable, lends little information about the dataset.
It would be useful for us to get more details about what the data are and how the data are stored.
Close the Data Editor by clicking on its close button.

We can see the structure of the dataset by describing its contents. This can be done either by
going to Data > Describe data > Describe data in memory or in a file in the menus and clicking
on OK or by typing describe in the Command window and pressing Enter . Regardless of which
method you choose, you will get the same result:� �

. describe

Contains data from C:\Program Files\Stata17/ado/base/a/auto.dta
Observations: 74 1978 automobile data

Variables: 12 13 Apr 2020 17:45
(_dta has notes)

Variable Storage Display Value
name type format label Variable label

make str18 %-18s Make and model
price int %8.0gc Price
mpg int %8.0g Mileage (mpg)
rep78 int %8.0g Repair record 1978
headroom float %6.1f Headroom (in.)
trunk int %8.0g Trunk space (cu. ft.)
weight int %8.0gc Weight (lbs.)
length int %8.0g Length (in.)
turn int %8.0g Turn circle (ft.)
displacement int %8.0g Displacement (cu. in.)
gear_ratio float %6.2f Gear ratio
foreign byte %8.0g origin Car origin

Sorted by: foreign� �
At the top of the listing, some information is given about the dataset, such as where it is stored on

disk and when the dataset was last saved. The bold 1978 automobile data is the short description
that appeared when the dataset was opened and is referred to as a data label by Stata. The phrase
_dta has notes informs us that there are notes attached to the dataset. We can see what notes there
are by typing notes in the Command window:� �

. notes

_dta:
1. From Consumer Reports with permission� �

Here we see a short note about the source of the data.
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Looking back at the listing from describe, we can see that Stata keeps track of more than just
the raw data. Each variable has the following:

• A variable name, which is what you call the variable when communicating with Stata. Variable
names are one type of Stata name. See [U] 11.3 Naming conventions.

• A storage type, which is the way Stata stores its data. For our purposes, it is enough to know
that types like, say, str# are string , or text, variables, whereas all others in this dataset are
numeric. While there are none in this dataset, Stata also allows arbitrarily long strings, or
strLs. strLs can also contain binary information. See [U] 12.4 Strings.

• A display format, which controls how Stata displays the data in tables. See [U] 12.5 Formats:
Controlling how data are displayed.

• A value label (possibly). This is the mechanism that allows Stata to store numerical data while
displaying text. See [GSW] 9 Labeling data and [U] 12.6.3 Value labels.

• A variable label, which is what you call the variable when communicating with other people.
Stata uses the variable label when making tables, as we will see.

A dataset is far more than simply the data it contains. It is also information that makes the data
usable by someone other than the original creator.

Although describing the data tells us something about the structure of the data, it says little about
the data themselves. The data can be summarized by clicking on Statistics > Summaries, tables,
and tests > Summary and descriptive statistics > Summary statistics and clicking on the OK
button. You could also type summarize in the Command window and press Enter . The result is a
table containing summary statistics about all the variables in the dataset:� �

. summarize

Variable Obs Mean Std. dev. Min Max

make 0
price 74 6165.257 2949.496 3291 15906

mpg 74 21.2973 5.785503 12 41
rep78 69 3.405797 .9899323 1 5

headroom 74 2.993243 .8459948 1.5 5

trunk 74 13.75676 4.277404 5 23
weight 74 3019.459 777.1936 1760 4840
length 74 187.9324 22.26634 142 233

turn 74 39.64865 4.399354 31 51
displacement 74 197.2973 91.83722 79 425

gear_ratio 74 3.014865 .4562871 2.19 3.89
foreign 74 .2972973 .4601885 0 1� �

From this simple summary, we can learn a bit about the data. First of all, the prices are nothing like
today’s car prices—of course, these cars are now antiques. We can see that the gas mileages are not
particularly good. Automobile aficionados can get a feel for other esoteric characteristics.

There are two other important items here:

• The make variable is listed as having no observations. It really has no numerical observations
because it is a string (text) variable.

• The rep78 variable has five fewer observations than the other numerical variables. This implies
that rep78 has five missing values.

Although we could use the summarize and describe commands to get a bird’s eye view of the
dataset, Stata has a command that gives a good in-depth description of the structure, contents, and
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values of the variables: the codebook command. Either type codebook in the Command window
and press Enter or navigate the menus to Data > Describe data > Describe data contents (codebook)
and click on OK. Look over the output to see that much can be learned from this simple command.
You can scroll back in the Results window to see earlier results, if need be. We will focus on the
output for make, rep78, and foreign.

To start our investigation, we would like to run the codebook command on just one variable,
say, make. We can do this, as usual, with menus or the command line. To get the codebook output
for make with the menus, start by navigating to Data > Describe data > Describe data contents
(codebook). When the dialog appears, there are multiple ways to tell Stata to consider only the make
variable:

• We could type make into the Variables field.
• The Variables field is a combo-box control that accepts variable names. Clicking on the drop

triangle to the right of the Variables field displays a list of the variables from the current dataset.
Selecting a variable from the list will, in this case, enter the variable name into the edit field.

A much easier solution is to type codebook make in the Command window and then press Enter .
The result is informative:� �

. codebook make

make Make and model

Type: String (str18), but longest is str17

Unique values: 74 Missing "": 0/74

Examples: "Cad. Deville"
"Dodge Magnum"
"Merc. XR-7"
"Pont. Catalina"

Warning: Variable has embedded blanks.� �
The first line of the output tells us the variable name (make) and the variable label (Make and model).
The variable is stored as a string (which is another way of saying “text”) with a maximum length of
18 characters, though a size of only 17 characters would be enough. All the values are unique, so
if need be, make could be used as an identifier for the observations—something that is often useful
when putting together data from multiple sources or when trying to weed out errors from the dataset.
There are no missing values, but there are blanks within the makes. This latter fact could be useful
if we were expecting make to be a one-word string variable.

Syntax note: Telling the codebook command to run on the make variable is an example of using
a varlist in Stata’s syntax.

Looking at the foreign variable can teach us about value labels. We would like to look at the
codebook output for this variable, and on the basis of our latest experience, it would be easy to type
codebook foreign into the Command window (from here on, we will not explicitly say to press
the Enter key) to get the following output:
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� �
. codebook foreign

foreign Car origin

Type: Numeric (byte)
Label: origin

Range: [0,1] Units: 1
Unique values: 2 Missing .: 0/74

Tabulation: Freq. Numeric Label
52 0 Domestic
22 1 Foreign� �

We can glean that foreign is an indicator variable because its only values are 0 and 1. The variable
has a value label that displays Domestic instead of 0 and Foreign instead of 1. There are two
advantages of storing the data in this form:

• Storing the variable as a byte takes less memory because each observation uses 1 byte instead of the
8 bytes needed to store “Domestic”. This is important in large datasets. See [U] 12.2.2 Numeric
storage types.

• As an indicator variable, it is easy to incorporate into statistical models. See [U] 26 Working
with categorical data and factor variables.

Finally, we can learn a little about a poorly labeled variable with missing values by looking at the
rep78 variable. Typing codebook rep78 into the Command window yields� �

. codebook rep78

rep78 Repair record 1978

Type: Numeric (int)

Range: [1,5] Units: 1
Unique values: 5 Missing .: 5/74

Tabulation: Freq. Value
2 1
8 2
30 3
18 4
11 5
5 .� �

rep78 appears to be a categorical variable, but because of lack of documentation, we do not know
what the numbers mean. (To see how we would label the values, see Changing data in [GSW] 6 Using
the Data Editor and see [GSW] 9 Labeling data.) This variable has five missing values, meaning
that there are five observations for which the repair record is not recorded. We could use the Data
Editor to investigate these five observations, but we will do this by using the Command window only
because doing so is much simpler.
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The command equivalent to clicking on the Data Editor (Browse) button is browse. We would
like to browse only those observations for which rep78 is missing, so we could type� �

. browse if missing(rep78)� �

From this, we see that the . entries are indeed missing values. The . is the default numerical missing
value; Stata also allows .a, . . . , .z as user missing values, but we do not have any in our dataset.
See [U] 12.2.1 Missing values. Close the Data Editor after you are satisfied with this statement.

Syntax note: Using the if qualifier above is what allowed us to look at a subset of the observations.

Looking through the data lends no clues about why these particular data are missing. We decide
to check the source of the data to see if the missing values were originally missing or if they were
omitted in error. Listing the makes of the cars whose repair records are missing will be all we need
because we saw earlier that the values of make are unique. This can be done with the menus and a
dialog:

1. Select Data > Describe data > List data.
2. Click on the drop triangle to the right of the Variables field to show the variable names.
3. Click on make to enter it into the Variables field.
4. Click on the by/if/in tab in the dialog.
5. Type missing(rep78) into the If: (expression) box.
6. Click on Submit. Stata executes the proper command but the dialog remains open. Submit is

useful when experimenting, exploring, or building complex commands. We will primarily use
Submit in the examples. You may click on OK in its place if you like, and it will close the
dialog box.

The same ends could be achieved by typing list make if missing(rep78) in the Command
window. The latter is easier once you know that the command list is used for listing observations.
In any case, here is the output:
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� �
. list make if missing(rep78)

make

3. AMC Spirit
7. Buick Opel

45. Plym. Sapporo
51. Pont. Phoenix
64. Peugeot 604� �

At this point, we should find the original reference to see if the data were truly missing or if they
could be resurrected. See [GSW] 10 Listing data and basic command syntax for more information
about all that can be done with the list command.

Syntax note: This command uses two new concepts for Stata commands—the if qualifier and the
missing() function. The if qualifier restricts the observations on which the command runs to only
those observations for which the expression is true. See [U] 11.1.3 if exp. The missing() function
tests each observation to see if it contains a missing value. See [FN] Programming functions.

Now that we have a good idea about the underlying dataset, we can investigate the data themselves.

Descriptive statistics

We saw above that the summarize command gave brief summary statistics about all the variables.
Suppose now that we became interested in the prices while summarizing the data because they seemed
fantastically low (it was 1978, after all). To get an in-depth look at the price variable, we can use
the menus and a dialog:

1. Select Statistics > Summaries, tables, and tests > Summary and descriptive statistics >
Summary statistics.

2. Enter or select price in the Variables field.
3. Select Display additional statistics.
4. Click on Submit.

Syntax note: As can be seen from the Results window, typing summarize price, detail will get
the same result. The portion after the comma contains options for Stata commands; hence, detail
is an example of an option.
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� �
. summarize price, detail

Price

Percentiles Smallest
1% 3291 3291
5% 3748 3299

10% 3895 3667 Obs 74
25% 4195 3748 Sum of wgt. 74

50% 5006.5 Mean 6165.257
Largest Std. dev. 2949.496

75% 6342 13466
90% 11385 13594 Variance 8699526
95% 13466 14500 Skewness 1.653434
99% 15906 15906 Kurtosis 4.819188� �

From the output, we can see that the median price of the cars in the dataset is only $5,006.50! We can
also see that the four most expensive cars are all priced between $13,400 and $16,000. If we wished
to browse the most expensive cars (and gain some experience with features of the Data Editor), we

could start by clicking on the Data Editor (Browse) button, .

Once the Data Editor is open, we can click on the Filter observations button, , to bring up
the Filter observations dialog. We can look at the expensive cars by putting price > 13000 in the
Filter by expression field:

Pressing the Apply filter button filters the data, and we can see that the expensive cars are two
Cadillacs and two Lincolns, which were not designed for gas mileage:
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We now decide to turn our attention to foreign cars and repairs because as we glanced through the
data, it appeared that the foreign cars had better repair records. (We do not know exactly what the
categories 1, 2, 3, 4, and 5 mean, but we know the Chevy Monza was known for breaking down.)
Let’s start by looking at the proportion of foreign cars in the dataset along with the proportion of
cars with each type of repair record. We can do this with one-way tables. The table for foreign
cars can be done with menus and a dialog starting with Statistics > Summaries, tables, and tests
> Frequency tables > One-way table and then choosing the variable foreign in the Categorical
variable field. Clicking on Submit yields� �

. tabulate foreign

Car origin Freq. Percent Cum.

Domestic 52 70.27 70.27
Foreign 22 29.73 100.00

Total 74 100.00� �
We see that roughly 70% of the cars in the dataset are domestic, whereas 30% are foreign. The value
labels are used to make the table so that the output is nicely readable.

Syntax note: We also see that this one-way table could be made by using the tabulate command
together with one variable, foreign. Making a one-way table for the repair records is simple—it
will be simpler if done with the Command window. Typing tabulate rep78 yields� �

. tabulate rep78

Repair
record 1978 Freq. Percent Cum.

1 2 2.90 2.90
2 8 11.59 14.49
3 30 43.48 57.97
4 18 26.09 84.06
5 11 15.94 100.00

Total 69 100.00� �
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We can see that most cars have repair records of 3 and above, though the lack of value labels makes us
unsure what a “3” means. Take our word for it that 1 means a poor repair record and 5 means a good
repair record. The five missing values are indirectly evident because the total number of observations
listed is 69 rather than 74.

These two one-way tables do not help us compare the repair records of foreign and domestic cars.
A two-way table would help greatly, which we can get by using the menus and a dialog:

1. Select Statistics > Summaries, tables, and tests > Frequency tables > Two-way table with
measures of association.

2. Choose rep78 as the Row variable.
3. Choose foreign as the Column variable.
4. It would be nice to have the percentages within the foreign variable, so check the Within-row

relative frequencies checkbox.
5. Click on Submit.

Here is the resulting output:� �
. tabulate rep78 foreign, row

Key

frequency
row percentage

Repair
record Car origin

1978 Domestic Foreign Total

1 2 0 2
100.00 0.00 100.00

2 8 0 8
100.00 0.00 100.00

3 27 3 30
90.00 10.00 100.00

4 9 9 18
50.00 50.00 100.00

5 2 9 11
18.18 81.82 100.00

Total 48 21 69
69.57 30.43 100.00� �

The output indicates that foreign cars are generally much better than domestic cars when it comes
to repairs. If you like, you could repeat the previous dialog and try some of the hypothesis tests
available from the dialog. We will abstain.

Syntax note: We see that typing the command tabulate rep78 foreign, row would have given
us the same table. Thus using tabulate with two variables yields a two-way table. It makes sense
that row is an option—we went out of our way to check it in the dialog. Using the row option allows
us to change the behavior of the tabulate command from its default.

Continuing our exploratory tour of the data, we would like to compare gas mileages between
foreign and domestic cars, starting by looking at the summary statistics for each group by itself. A
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direct way to do this would be to use if qualifiers to summarize mpg for each of the two values of
foreign separately:� �

. summarize mpg if foreign==0

Variable Obs Mean Std. dev. Min Max

mpg 52 19.82692 4.743297 12 34

. summarize mpg if foreign==1

Variable Obs Mean Std. dev. Min Max

mpg 22 24.77273 6.611187 14 41� �
It appears that foreign cars get somewhat better gas mileage—we will test this soon.

Syntax note: We needed to use a double equal sign (==) for testing equality. The double equal
sign could be familiar to you if you have programmed before. If it is unfamiliar, be aware that it is a
common source of errors when initially using Stata. Thinking of equality as “exactly equal” can cut
down on typing errors.

There are two other methods that we could have used to produce these summary statistics. These
methods are worth knowing because they are less error-prone. The first method duplicates the concept
of what we just did by exploiting Stata’s ability to run a command on each of a series of nonoverlapping
subsets of the dataset. To use the menus and a dialog, do the following:

1. Select Statistics > Summaries, tables, and tests > Summary and descriptive statistics >
Summary statistics and click on the Reset button, .

2. Select mpg in the Variables field.
3. Select the Standard display option (if it is not already selected).
4. Click on the by/if/in tab.
5. Check the Repeat command by groups checkbox.
6. Select or type foreign in the Variables that define groups field.
7. Submit the command.

You can see that the results match those from above. They have a better appearance than the two
commands above because the value labels Domestic and Foreign are used rather than the numerical
values. The method is more appealing because the results were produced without needing to know
the possible values of the grouping variable ahead of time.� �

. by foreign, sort: summarize mpg

-> foreign = Domestic

Variable Obs Mean Std. dev. Min Max

mpg 52 19.82692 4.743297 12 34

-> foreign = Foreign

Variable Obs Mean Std. dev. Min Max

mpg 22 24.77273 6.611187 14 41� �
Syntax note: There is something different about the equivalent command that appears above: it contains
a prefix command called a by prefix. The by prefix has its own option, namely, sort, to ensure
that like members are adjacent to each other before being summarized. The by prefix command is
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important for understanding data manipulation and working with subpopulations within Stata. Make
good note of this example, and consult [U] 11.1.2 by varlist: and [U] 13.7 Explicit subscripting
for more information. Stata has other prefix commands for specialized treatment of commands, as
explained in [U] 11.1.10 Prefix commands.

The third method for tabulating the differences in gas mileage across the cars’ origins involves
thinking about the structure of desired output. We need a one-way table of automobile types (foreign
versus domestic) within which we see information about gas mileages. Looking through the menus
yields the menu item Statistics > Summaries, tables, and tests > Other tables > Table of means,
std. dev., and frequencies. Selecting this, entering foreign for Variable 1 and mpg for the Summarize
variable, and submitting the command yields a nice table:� �

. tabulate foreign, summarize(mpg)

Summary of Mileage (mpg)
Car origin Mean Std. dev. Freq.

Domestic 19.826923 4.7432972 52
Foreign 24.772727 6.6111869 22

Total 21.297297 5.7855032 74� �
The equivalent command is evidently tabulate foreign, summarize(mpg).

Syntax note: This is a one-way table, so tabulate uses one variable. The variable being summarized
is passed to the tabulate command with an option. Though we will not do it here, the summarize()
option can also be used with two-way tables.

A simple hypothesis test

We would like to run a hypothesis test for the difference in the mean gas mileages. Under the menus,
Statistics > Summaries, tables, and tests > Classical tests of hypotheses > t test (mean-comparison
test) leads to the proper dialog. Select the Two-sample using groups radio button, enter mpg for the
Variable name and foreign for the Group variable name, and Submit the dialog. The results are� �

. ttest mpg, by(foreign)

Two-sample t test with equal variances

Group Obs Mean Std. err. Std. dev. [95% conf. interval]

Domestic 52 19.82692 .657777 4.743297 18.50638 21.14747
Foreign 22 24.77273 1.40951 6.611187 21.84149 27.70396

Combined 74 21.2973 .6725511 5.785503 19.9569 22.63769

diff -4.945804 1.362162 -7.661225 -2.230384

diff = mean(Domestic) - mean(Foreign) t = -3.6308
Ho: diff = 0 Degrees of freedom = 72

Ha: diff < 0 Ha: diff != 0 Ha: diff > 0
Pr(T < t) = 0.0003 Pr(|T| > |t|) = 0.0005 Pr(T > t) = 0.9997� �

From this, we could conclude that the mean gas mileage for foreign cars is different from that of
domestic cars (though we really ought to have wanted to test this before snooping through the data).
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We can also conclude that the command, ttest mpg, by(foreign), is easy enough to remember.
Feel free to experiment with unequal variances, various approximations to the number of degrees of
freedom, and the like.

Syntax note: The by() option used here is not the same as the by prefix command used earlier.
Although it has a similar conceptual meaning, its usage is different because it is a particular option
for the ttest command.

Descriptive statistics—correlation matrices

We now change our focus from exploring categorical relationships to exploring numerical relation-
ships: we would like to know if there is a correlation between miles per gallon and weight. We select
Statistics > Summaries, tables, and tests > Summary and descriptive statistics > Correlations
and covariances in the menus. Entering mpg and weight, either by clicking or by typing, and then
submitting the command yields� �

. correlate mpg weight
(obs=74)

mpg weight

mpg 1.0000
weight -0.8072 1.0000� �

The equivalent command for this is natural: correlate mpg weight. There is a negative correlation,
which is not surprising because heavier cars should be harder to push about.

We could see how the correlation compares for foreign and domestic cars by using our knowledge
of the by prefix. We can reuse the correlate dialog or use the menus as before if the dialog is closed.
Click on the by/if/in tab, check the Repeat command by groups checkbox, and enter the foreign
variable to define the groups. As done on page 12, a simple by foreign, sort: prefix in front of
our previous command would work, too:� �

. by foreign, sort: correlate mpg weight

-> foreign = Domestic
(obs=52)

mpg weight

mpg 1.0000
weight -0.8759 1.0000

-> foreign = Foreign
(obs=22)

mpg weight

mpg 1.0000
weight -0.6829 1.0000� �

We see from this that the correlation is not as strong among the foreign cars.
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Syntax note: Although we used the correlate command to look at the correlation of two variables,
Stata can make correlation matrices for an arbitrary number of variables:� �

. correlate mpg weight length turn displacement
(obs=74)

mpg weight length turn displa~t

mpg 1.0000
weight -0.8072 1.0000
length -0.7958 0.9460 1.0000

turn -0.7192 0.8574 0.8643 1.0000
displacement -0.7056 0.8949 0.8351 0.7768 1.0000� �

This can be useful, for example, when investigating collinearity among predictor variables.

Graphing data
We have found several things in our investigations so far: We know that the average MPG of

domestic and foreign cars differs. We have learned that domestic and foreign cars differ in other
ways as well, such as in frequency-of-repair record. We found a negative correlation between MPG
and weight—as we would expect—but the correlation appears stronger for domestic cars.

We would now like to examine, with an eye toward modeling, the relationship between MPG and
weight, starting with a graph. We can start with a scatterplot of mpg against weight. The command
for this is simple: scatter mpg weight. Using the menus requires a few steps because the graphs
in Stata may be customized heavily.

1. Select Graphics > Twoway graph (scatter, line, etc.).
2. Click on the Create... button.
3. Select the Basic plots radio button (if it is not already selected).
4. Select Scatter as the basic plot type (if it is not already selected).
5. Select mpg as the Y variable and weight as the X variable.
6. Click on the Submit button.

The Results window shows the command that was issued from the menu:� �
. twoway (scatter mpg weight)� �

The command issued when the dialog was submitted is a bit more complex than the command
suggested above. There is good reason for this: the more complex structure allows combining and
overlaying graphs, as we will soon see. In any case, the graph that appears is
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We see the negative correlation in the graph, though the relationship appears to be nonlinear.

Note: When you draw a graph, the Graph window appears, probably covering up your Results
window. Click on the main Stata window to get the Results window back on top. Want to see the

graph again? Click on the Graph button, . See The Graph button in [GSW] 14 Graphing data
for more information about the Graph button.

We would now like to see how the different correlations for foreign and domestic cars are manifested
in scatterplots. It would be nice to see a scatterplot for each type of car, along with a scatterplot for
all the data.

Syntax note: Because we are looking at subgroups, this looks as if it is a job for the by prefix.
Let’s see if this is what we really should use.

Start as before:
1. Select Graphics > Twoway graph (scatter, line, etc.) from the menus.
2. If the Plot 1 dialog is still visible, click on the Accept button and skip to step 4.
3. Go through the process on the previous page to create the graph.
4. Click on the By tab of the twoway - Twoway graphs dialog.
5. Check the Draw subgraphs for unique values of variables checkbox.
6. Enter foreign in the Variables field.
7. Check the Add a graph with totals checkbox.
8. Click on the Submit button.
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The command and the associated graph are� �
. twoway (scatter mpg weight), by(foreign, total)� �
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The graphs show that the relationship is nonlinear for both origins of cars.

Syntax note: To make the graphs for the combined subgroups, we ended up using a by() option,
not a by prefix. If we had used a by prefix, separate graphs would have been generated instead of
the combined graph created by the by() option.

Model fitting: Linear regression
After looking at the graphs, we would like to fit a regression model that predicts MPG from the

weight and type of the car. From the graphs, we see that the relationship is nonlinear, so we will
try modeling MPG as a quadratic in weight. Also from the graphs, we judge the relationship to be
different for domestic and foreign cars. We will include an indicator (dummy) variable for foreign
and evaluate afterward whether this adequately describes the difference. Thus we will fit the model

mpg = β0 + β1 weight+ β2 weight
2 + β3 foreign+ ε

foreign is already an indicator (0/1) variable, but we need to create the weight-squared variable.
This can be done with the menus, but here using the command line is simpler. Type� �

. generate wtsq = weight^2� �
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Now that we have all the variables we need, we can run a linear regression. We will use the
menus and see that the command is also simple. To use the menus, select Statistics > Linear models
and related > Linear regression. In the resulting dialog, choose mpg as the Dependent variable
and weight, wtsq, and foreign as the Independent variables. Submit the command. Here is the
equivalent simple regress command and the resulting analysis-of-variance table.� �

. regress mpg weight wtsq foreign

Source SS df MS Number of obs = 74
F(3, 70) = 52.25

Model 1689.15372 3 563.05124 Prob > F = 0.0000
Residual 754.30574 70 10.7757963 R-squared = 0.6913

Adj R-squared = 0.6781
Total 2443.45946 73 33.4720474 Root MSE = 3.2827

mpg Coefficient Std. err. t P>|t| [95% conf. interval]

weight -.0165729 .0039692 -4.18 0.000 -.0244892 -.0086567
wtsq 1.59e-06 6.25e-07 2.55 0.013 3.45e-07 2.84e-06

foreign -2.2035 1.059246 -2.08 0.041 -4.3161 -.0909002
_cons 56.53884 6.197383 9.12 0.000 44.17855 68.89913� �

The results look encouraging, so we will plot the predicted values on top of the scatterplots for each
of the origins of cars. To do this, we need the predicted, or fitted, values. This can be done with
the menus, but doing it in the Command window is simple enough. We will create a new variable,
mpghat, to hold the predicted MPG for each car. Type� �

. predict mpghat
(option xb assumed; fitted values)� �

The output from this command is simply a notification. Go over to the Variables window and scroll
to the bottom to confirm that there is now an mpghat variable. If you were to try this command
when mpghat already existed, Stata would refuse to overwrite your data:� �

. predict mpghat
variable mpghat already defined
r(110);� �

The predict command, when used after a regression, is called a postestimation command. As
specified, it creates a new variable called mpghat equal to

−0.0165729 weight+ 1.59 × 10−6 wtsq− 2.2035 foreign+ 56.53884

For careful model fitting, there are several features available to you after estimation—one is
calculating predicted values. Be sure to read [U] 20 Estimation and postestimation commands.

We can now graph the data and the predicted curve to evaluate separately the fit on the foreign
and domestic data to determine if our shift parameter is adequate. We can draw both graphs together.
Using the menus and a dialog, do the following:

1. Select Graphics > Twoway graph (scatter, line, etc.) from the menus.

2. If there are any plots listed, click on the Reset button, , to clear the dialog box.
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3. Create the graph for mpg versus weight:
a. Click on the Create... button.
b. Be sure that Basic plots and Scatter are selected.
c. Select mpg as the Y variable and weight as the X variable.
d. Click on Accept.

4. Create the graph showing mpghat versus weight:
a. Click on the Create... button.
b. Select Basic plots and Line.
c. Select mpghat as the Y variable and weight as the X variable.
d. Check the Sort on x variable box. Doing so ensures that the lines connect from smallest

to largest weight values, instead of the order in which the data happen to be.
e. Click on Accept.

5. Show two plots, one each for domestic and foreign cars, on the same graph:
a. Click on the By tab.
b. Check the Draw subgraphs for unique values of variables checkbox.
c. Enter foreign in the Variables field.

6. Click on the Submit button.
Here are the resulting command and graph:� �

. twoway (scatter mpg weight) (line mpghat weight, sort), by(foreign)� �
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Here we can see the reason for enclosing the separate scatter and line commands in parentheses:
they can thereby be overlaid by submitting them together. The fit of the plots looks good and is cause
for initial excitement. So much excitement, in fact, that we decide to print the graph and show it to
an engineering friend. We print the graph, being careful to print the graph (and not all our results),
by choosing File > Print... from the Graph window menu bar.

When we show our graph to our engineering friend, she is concerned. “No,” she says. “It should
take twice as much energy to move 2,000 pounds 1 mile compared with moving 1,000 pounds the
same distance: therefore, it should consume twice as much gasoline. Miles per gallon is not quadratic
in weight; gallons per mile is a linear function of weight. Don’t you remember any physics?”

We try out what she says. We need to generate an energy-per-distance variable and make a
scatterplot. Here are the commands that we would need—note their similarity to commands issued
earlier in the session. There is one new command, the label variable command, which allows us
to give the gpm100m variable a variable label so that the graph is labeled nicely.� �

. generate gp100m = 100/mpg

. label variable gp100m "Gallons per 100 miles"

. twoway (scatter gp100m weight), by(foreign, total)� �
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Sadly satisfied that the engineer is indeed correct, we rerun the regression:� �
. regress gp100m weight foreign

Source SS df MS Number of obs = 74
F(2, 71) = 113.97

Model 91.1761694 2 45.5880847 Prob > F = 0.0000
Residual 28.4000913 71 .400001287 R-squared = 0.7625

Adj R-squared = 0.7558
Total 119.576261 73 1.63803097 Root MSE = .63246

gp100m Coefficient Std. err. t P>|t| [95% conf. interval]

weight .0016254 .0001183 13.74 0.000 .0013896 .0018612
foreign .6220535 .1997381 3.11 0.003 .2237871 1.02032

_cons -.0734839 .4019932 -0.18 0.855 -.8750354 .7280677� �
We find that foreign cars had better gas mileage than domestic cars in 1978 because they were so
light. According to our model, a foreign car with the same weight as a domestic car would use an
additional 5/8 gallon (or 5 pints) of gasoline per 100 miles driven. With this conclusion, we are
satisfied with our analysis.

Commands versus menus
In this chapter, you have seen that Stata can operate either with menu choices and dialogs or with

the Command window. As you become more familiar with Stata, you will find that the Command
window is typically much faster for oft-used commands, whereas the menus and dialogs are faster
when building up complex commands, such as those that create graphs.

One of Stata’s great strengths is the consistency of its command syntax. Most of Stata’s commands
share the following syntax, where square brackets mean that something is optional, and a varlist is a
list of variables. [

prefix:
]

command
[

varlist
] [

if
] [

in
] [

weight
] [

, options
]

Some general rules:
• Most commands accept prefix commands that modify their behavior; see [U] 11.1.10 Prefix

commands for details. One of the common prefix commands is by.
• If an optional varlist is not specified, all the variables are used.
• if and in restrict the observations on which the command is run.
• options modify what the command does.
• Each command’s syntax is found in the system help and the reference manuals.
• Stata’s command syntax includes more than we have shown you here, but this introduction

should get you started. For more information, see [U] 11 Language syntax and help language.

We saw examples using all the pieces of this except for the in qualifier and the weight clause. The
syntax for all commands can be found in the system help along with examples—see [GSW] 4 Getting
help for more information. The consistent syntax makes it straightforward to learn new commands
and to read others’ commands when examining an analysis.

Here is an example of reading the syntax diagram that uses the summarize command from earlier
in this chapter. The syntax diagram for summarize is typical:

summarize
[

varlist
] [

if
] [

in
] [

weight
] [

, options
]
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This means that

command by itself is valid: summarize

command followed by a varlist
(variable list) is valid: summarize mpg

summarize mpg weight

command with if (with or without
a varlist) is valid: summarize if mpg>20

summarize mpg weight if mpg>20

and so on.

You can learn about summarize in [R] summarize, or select Help > Stata command... and enter
summarize, or type help summarize in the Command window.

Keeping track of your work
It would have been useful if we had made a log of what we did so that we could conveniently

look back at interesting results or track any changes that were made. You will learn to do this in
[GSW] 16 Saving and printing results by using logs. Your logs will contain commands and their
output—another reason to learn command syntax is so that you can remember what you have done.

To make a log file that keeps track of everything appearing in the Results window, click on the

Log button, which looks like a lab notebook, . Choose a place to store your log file, and give it
a name, just as you would for any other document. The log file will save everything that appears in
the Results window from the time you start a log file to the time you close it.

Video example
What’s it like—Getting started in Stata

Conclusion
This chapter introduced you to Stata’s capabilities. You should now read and work through the

rest of this manual. Once you are done here, you can read the User’s Guide.

https://www.youtube.com/watch?v=YAVq99iUTTI


2 The Stata user interface

The windows
This chapter introduces the core of Stata’s interface: its main windows, its toolbar, its menus, and

its dialogs.

The five main windows are the History, Results, Command, Variables, and Properties windows.
Except for the Results window, each window has its name in its title bar. These five windows are
typically in use the whole time Stata is open. There are other, more specialized windows such as the
Viewer, Data Editor, Variables Manager, Do-file Editor, Graph, and Graph Editor windows—these
are discussed later in this manual.

To open any window or to reveal a window hidden by other windows, select the window from
the Window menu, or select the proper item from the toolbar. You can also use Ctrl+Tab to cycle
through all open windows inside the main Stata window or Alt+Tab to cycle through all open windows
(Stata and other) if you want to change windows from the keyboard. Many of Stata’s windows have
functionality that can be accessed by clicking on the right mouse button (right-clicking) within the
window. Right-clicking displays a contextual menu that, depending on the window, allows you to
copy text, set the preferences for the window, or print the contents of the window. When you copy
text or print, we recommend that you always right-click on the window rather than use the menu bar
or toolbar so that you can be sure of where and what you are copying or printing.

23
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The toolbar
This is the toolbar:

The toolbar contains buttons that provide quick access to Stata’s more commonly used features.
If you forget what a button does, hold the mouse pointer over the button for a moment, and a tooltip
will appear with a description of that button.

Buttons that include both an icon and an arrow display a menu if you click on the arrow. Here is
an overview of the toolbar buttons and their functions:

Open opens a Stata dataset. Click on the button to open a dataset with the Open
dialog.

Save saves the Stata dataset currently in memory to disk.

Print displays a list of windows. Select a window name to print its contents.

Log begins a new log or closes, suspends, or resumes the current log. See
[GSW] 16 Saving and printing results by using logs for an explanation of log
files.

Viewer opens the Viewer or brings a Viewer to the front of all other windows. Click
on the button to open a new Viewer. Click on the arrow to select a Viewer to bring
to the front. See [GSW] 3 Using the Viewer for more information.

Graph brings a Graph window to the front of all other windows. Click on the button
to bring the Graph window to the front. Click on the arrow to select a Graph window
to bring to the front. See The Graph button in [GSW] 14 Graphing data for more
information.

Do-file Editor opens the Do-file Editor or brings a Do-file Editor to the front of
all other windows. Click on the button to open a new Do-file Editor. Click on the
arrow to select a Do-file Editor to bring to the front. See [GSW] 13 Using the Do-file
Editor—automating Stata for more information.

Data Editor (Edit) opens the Data Editor or brings the Data Editor to the front of
the other Stata windows. See [GSW] 6 Using the Data Editor for more information.

Data Editor (Browse) opens the Data Editor in browse mode. See Browse mode in
[GSW] 6 Using the Data Editor for more information.

Variables Manager opens the Variables Manager. See [GSW] 7 Using the Variables
Manager for more information.

Show more results tells Stata to continue when it has paused in the middle of long
output. Click on the arrow to choose whether to run the command to completion.
See [GSW] B.8 More for more information.

Break stops the current task in Stata. See [GSW] 10 Listing data and basic command
syntax for more information.
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The Command window
Commands are submitted to Stata from the Command window. The Command window supports

basic text editing, copying and pasting, a command history, function-key mapping, filename completion,
and variable-name completion.

From the Command window, pressing

Page Up steps backward through the command history.
Page Down steps forward through the command history.

Tab autocompletes a partially typed variable name when possible or presents
a list of similar names if there could be more than one completion. Further
typing will narrow the list. As soon as the name is complete, the full name
will be inserted. If the name starts with a double quote, Tab attempts to
autocomplete a filename in the same manner.

See [U] 10 Keyboard use for more information about keyboard shortcuts for the Command window.

The command history allows you to recall a previously submitted command, edit it if you wish,
and then resubmit it. Commands submitted by Stata’s dialogs are also included in the command
history, so you can recall and submit a command without having to open the dialog again.

The Results window
The Results window contains all the commands and their textual results you have entered during

the Stata session.

You can scroll through the Results window to look at work you have done, it is much simpler to
search within the Results window by using the find bar. By default, the find bar is hidden. You can
expose it by selecting Edit > Find....

You can clear out the Results window at any time by right-clicking in the Results window and
selecting Clear results from the contextual menu. This action is not undoable.

The Variables window
The Variables window shows the list of variables in the dataset, along with the properties of

the variables. By default, it shows all the variables and their variable labels. You can change what
properties get displayed by right-clicking on the header of any column of the Variables window.

Click once on a variable in the Variables window to select it. Multiple variables can be selected
in the usual fashion, either by Ctrl -clicking on nonadjacent variables or by clicking on a variable and
Shift-clicking on a second variable to select all intervening variables.

Double-clicking on a variable in the Variables window puts the selected variable at the insertion
point in the Command window.

The leftmost column of the Variables window is called the one-click paste column. You can also
send variables to the Command window by hovering the mouse over the one-click paste column of
the Variables window and clicking on the arrow that appears. The one-click paste column can be
shown or hidden in the same fashion as the other columns in the Variables window.
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The Variables window supports filtering and changing the display order of the variables. Text
entered in the Filter variables here field will filter the variables appearing in the Variables window.
The filter is applied to all visible columns and shows all variables that match the criteria in at least
one column. By default, the filter will ignore case and show any variables for which at least one
column contains any of the words in the filter. Clicking on the wrench on the left will allow you to
change this behavior as well as add or remove additional columns containing information about the
variables.

You can change the display order of the variables in the Variables window by clicking on any
column header. The first click sorts in ascending order, the second click sorts in descending order,
and the third click puts the variables back in dataset order. Thus clicking on the Name column header
will make the Variables window display the variables in alphabetical order. Sorting in the Variables
window is live, so if you change a property of a variable when the Variables window is sorted by that
property, it will automatically move the variable to its proper location. Reordering the display order
of the variables in the Variables window does not affect the order of the variables in the dataset itself.

Right-clicking on a variable in the Variables window displays a menu from which you can select
• Keep only selected variables to keep just the selected variables in the dataset in memory. You

will be asked for confirmation. This affects only the dataset in memory, not the dataset as saved
on your disk. See [GSW] 12 Deleting variables and observations for more information.

• Drop selected variables to drop, or eliminate, the selected variables from the dataset in memory.
You will be asked for confirmation. Just as above, this affects only the dataset in memory, not
the dataset as saved on your disk. See [GSW] 12 Deleting variables and observations for more
information.

• Copy varlist to copy the selected variable names to the clipboard.
• Select all to select all variables in the dataset that satisfy the filter conditions. If no filter has

been specified, all variables will be selected.
• Send varlist to Command window to send all selected variables to the Command window.
• Font... to bring up a Font dialog, allowing you to change the font used to display the Variables

window contents.
Items from the contextual menu issue standard Stata commands, so working by right-clicking is just
like working directly in the Command window.

If you would like to hide the Variables window, click on its close button.

To reveal a hidden Variables window, select Window > Variables.

The Properties window

The Properties window displays variable and dataset properties. If a single variable is selected
in the Variables window, its properties are displayed. If there are multiple variables selected in the
Variables window, the Properties window will display properties that are common across all selected
variables.

Clicking the lock icon in the Properties window title bar toggles the ability to alter properties of
the selected variables. By default, changes are not allowed. Once the properties are unlocked, you
can make any changes to variable or dataset properties you like. Each change you make will create
a command that appears in the Results and Command windows, as well as in any command log, so
the changes are reproducible. Using the Properties window is one of the simplest ways of managing
notes, changing variable and value labels, and changing display formats. See [D] notes, [D] label,
and [D] format.
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Clicking the arrow buttons next to the lock icon will select the previous or next variable shown in
the Variables window, and that selection will be reflected in the Properties window. If you would like
to hide the Properties window, click on its close box. If you would like to reveal a hidden Properties
window, select Window > Properties.

You should also investigate the Variables Manager, explained in [GSW] 7 Using the Variables
Manager, because it extends these capabilities and provides a good interface for managing variables.

The History window
The History window shows the history of commands that have been entered, with unsuccessful

commands and their error codes in red, by default.

The toolbar has two tools for manipulating the contents of the History window. Clicking on the

Filter button, , in the History window title bar toggles the visibility of these tools. Text entered in
the Filter commands here field will filter the commands appearing in the History window. By default,
the filter ignores case and finds any commands containing any of the words in the filter. Clicking on
the wrench on the left allows you to change this behavior. You can hide the commands that produced

an error by clicking on the Filter errors button, .

To enter a command from the History window, you can
• Click once on a past command to copy it to the Command window, replacing the contents of

the Command window.
• Double-click on a past command to resubmit it. Executing the command adds the command to

the bottom of the History window.

Right-clicking on the History window displays a menu from which you can select various actions:
• Cut removes the selected commands from the History window and places them on the Clipboard.
• Copy copies the selected commands to the Clipboard.
• Delete removes the selected commands from the History window.
• Select all selects all the commands in the History window, including those before and after the

commands currently displayed.
• Clear all clears out all the commands from the History window, including those before and

after the commands currently displayed.
• Do selected submits all the selected commands and adds them to the bottom of the command

history. Stata will attempt to run all the selected commands, even those containing errors, and
will not stop even if a command causes an error.

• Send selected to Do-file Editor places all the selected commands into a new Do-file Editor
window.

• Save all... brings up a Save review contents dialog, which allows you to save all the commands
in the History window, including those before and after the commands currently displayed, in
a do-file. (See [GSW] 13 Using the Do-file Editor—automating Stata for more information
on do-files.)

• Save selected... brings up a Save review contents dialog, which allows you to save the selected
commands in the History window in a do-file.

• Font... brings up a Font dialog, allowing you to change the font used to display the History
window contents.
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Menus and dialogs

There are two ways by which you can tell Stata what you would like it to do: you can use menus
and dialogs, or you can use the Command window. When you worked through the sample session in
[GSW] 1 Introducing Stata—sample session, you saw that both ways have strengths. We will discuss
the menus and dialogs here.

Stata’s Data, Graphics, and Statistics menus provide point-and-click access to almost every
command in Stata. As you will learn, Stata is fully programmable, and Stata users can even create
their own dialogs and menus. The User menu provides a place for programmers to add their own
menu items. Initially, it contains only some empty submenus. As an example, suppose you wish
to perform a Poisson regression. You could type Stata’s poisson command, or you could select
Statistics > Count outcomes > Poisson regression, which would display this dialog:

This dialog provides access to all the functionality of Stata’s poisson command. Because the
dependent and independent variables must be numeric, you will find that the combo box will display
only numeric variables for choosing. The poisson command has many options that can be accessed
by clicking on the multiple tabs across the top of the dialog. The first time you use the dialog for a
command, it is a good idea to look at the contents of each tab so that you will know all the dialog’s
capabilities.
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The dialogs for many commands have the by/if/in and Weights tabs. These provide access to
Stata’s commands and qualifiers for controlling the estimation sample and dealing with weighted data.
See [U] 11 Language syntax for more information on these features of Stata’s language.

The dialogs for most estimation commands have the Maximization tab for setting the maximization
options (see [R] Maximize). For example, you can specify the maximum number of iterations for the
optimizer.

Most dialogs in Stata provide the same six buttons you see at the bottom of the poisson dialog
above.

OK issues a Stata command based on how you have filled out the fields in
the dialog and then closes the dialog.

Cancel closes the dialog without doing anything—just as clicking on the
dialog’s close button does.

Submit issues a command just like OK but leaves the dialog on the screen so
that you can make changes and issue another command. This feature is handy
when, for example, you are learning a new command or putting together a
complicated graph.

Help provides access to Stata’s help system. Clicking on this button will
typically take you to the help file for the Stata command associated with the
dialog. Clicking on it here would take you to the poisson help file. The help
file will have tabs above groups of options to show which dialog tab contains
which options.

Reset resets the dialog to its default state. Each time you open a dialog, it
will remember how you last filled it out. If you wish to reset its fields to their
default values at any time, simply click on this button.

Copy command to Clipboard behaves much like the Submit button, but
rather than issuing a command, it copies the command to the Clipboard. The
command can then be pasted elsewhere (such as in the Do-file Editor).

The command issued by a dialog is submitted just as if you had typed it by hand. You can see
the command in the Results window and in the History window after it executes. Looking carefully
at the full command will help you learn Stata’s command syntax.

In addition to being able to access the dialogs for Stata commands through Stata’s menus, you
can also invoke them by using two other methods. You may know the name of a Stata command for
which you want to see a dialog, but you might not remember how to navigate to that command in
the menu system. Simply type db commandname to launch the dialog for commandname:� �

. db poisson� �
You will also find access to the dialog for a command in that command’s help file; see [GSW] 4 Getting
help for more details.

As you read this manual, we will present examples of Stata commands. You may type those
examples as presented, but you should also experiment with submitting those commands by using
their dialogs. Use the db command described above to quickly launch the dialog for any command
that you see in this manual.



30 [ GSW ] 2 The Stata user interface

The working directory
If you look at the screenshot on page 23, you will notice the status bar at the base of the main

Stata window that contains the name of the current working directory you set when you installed
Stata. We will use the directory C:\Users\Stata\Documents\Stata in our examples; your exact
directory will differ. The current working directory is the folder where graphs and datasets will be
saved when typing commands such as save filename. It does not affect the behavior of menu-driven
file actions such as File > Save or File > Open.... Once you have started Stata, you can change the
current working directory with the cd command. See [D] cd for full details. Stata always displays
the name of the current working directory so that it is easy to tell where your graphs and datasets
will be saved.

Fine control of Stata’s windows
When Stata is first launched, the History, Results, Command, Variables, and Properties windows

appear within the main Stata window. The History, Variables, Properties, and Command windows are
initially linked to one another and attached to the edges of the Stata window. They can be resized by
dragging on their edges. They even have two more features: you can drag them by their title bars to
reposition them within the main window, and you can hide them as tabs when not in use. To hide
them as tabs, click on the pushpin icons in their title bars.

The Results window always occupies whatever space remains inside the main Stata window.

All other windows that open up can be moved freely and independently of the Stata window.

This default behavior is simple and familiar and needs little explanation. Try playing with the
windows inside the main Stata window now. If you find that the window behavior is good, you can
stop reading this section. If you find that you would like some extra customization or that you would
simply like some technical explanation of added window behaviors, keep reading.

Window types
The Stata for Windows interface has two types of windows: docking and nondocking. The History,

Command, Variables, and Properties windows are docking windows. All other windows are nondocking.

Docking windows have special characteristics that allow them to be used with other docking
windows: they can be linked (sharing a window with a splitter dividing the windows) or tabbed
(sharing a window with a tab for each docking window). They can be set to automatically hide when
not needed. Nondocking windows have none of these special characteristics.

Here is a brief comparison of the two types of windows:

Docking windows
• can be linked to other docking windows so that they share a window with a splitter dividing

them;
• can share one window with other docking windows with a tab for each; and
• can be made to hide automatically when not in use.

Nondocking windows
• are separate from the main Stata window (except for the Results window);
• cannot be linked to other windows;
• cannot be tabbed to another window; and
• cannot be made to hide automatically when not in use.
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When Stata is first launched, the History, Results, Command, Variables, and Properties windows
appear within the main Stata window. The History, Command, Variables, and Properties windows are
docking windows and are initially both docked and linked to one another. The Results window is a
nondocking window.

Docking windows
Docking windows may be moved within the main Stata window by dragging on their title bars.

When you drag a docking window over the main Stata window or another docking window, docking
guides appear (see figure 1). Dragging the title bar over a docking guide gives you a preview of how
and where the window will appear if you release the mouse button.

Dropping the box on one of the outer docking guides links the docking window to the window
under the guide. For example, figure 1 shows how you would drag the History window over the
Variables window, at which point the docking guides appear. When you move the mouse over the
bottom docking guide and release the mouse button, the History window becomes linked to the
Variables window and is displayed in the lower part of the window.

When docking windows are linked, a divider (splitter) is inserted between them. The splitter allows
the linked windows to be resized; increasing the size of one window decreases the size of the other.

Figure 1: Linking two windows

Dropping the box on the center docking guide (see figure 2) combines the docking window with
the window under the guide. One docking window is created with a tab for each docked window at
the bottom of the new window. Clicking on a tab displays its window. To undock a tabbed window,
click and drag the window’s tab out of the docking window to a docking guide. The docking window
containing the tabbed windows can also be linked to other docking windows.

Figure 2: Docking two windows

Auto Hide and pinning
Docking windows support the Auto Hide feature, which automatically hides the docking windows

when they are not in use. Pushpins appear in the title bar of all docked windows in the main Stata
window.
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To enable Auto Hide for a docking window, click on the pushpin in the title bar (see figure 3) so
that the pushpin is horizontal. Click on the pushpin again to disable Auto Hide; the pushpin will be
vertical.

After you enable Auto Hide for a docking window, the window is hidden when not in use and is
displayed as a tab along an edge of the main Stata window. To show the window, move the mouse
pointer over the tab. To hide the window again, move the mouse pointer outside the window. If the
window has the focus (its title bar is highlighted), it will be hidden if you click on another window.

Figure 3: Enabling Auto Hide

If you enable Auto Hide for the History window in its default docked location, it will obscure any
text at the beginning of the Command window when it is displayed. To avoid this problem, dock this
window at the right edge of the main Stata window before enabling Auto Hide.

Nondocking windows
Nondocking windows include the Graph window, Data Editor, Do-file Editor, Viewers, and dialogs.

These windows are always independent of the main Stata window. The Results window, because of
its status as the primary window of Stata, must remain inside the main Stata window.
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The Viewer’s purpose
The Viewer is a versatile tool in Stata. It will be the first place you can turn for help within Stata,

but it is far more than just a help system. You can also use the Viewer to add, delete, and manage
third-party extensions to Stata that are known as community-contributed features; to view and print
Stata logs from both your current and your previous Stata sessions; to view and print any other
Stata-formatted (SMCL) or plain-text file; and even to launch your web browser to follow hyperlinks.

This chapter focuses on the general use of the Viewer, its buttons, and a brief summary of the
commands that the Viewer understands. There is more information about using the Viewer to find help
in [GSW] 4 Getting help and for installing community-contributed features in [GSW] 19 Updating
and extending Stata—Internet functionality.

To open a new Viewer window (or open a new tab in an existing Viewer), you can either click

on the Viewer button, , or select Window > Viewer > New Viewer.

Viewer buttons
The toolbar of the Viewer has multiple buttons, a command box, and a search box.

Back goes back one step in your viewing trail.

Forward goes forward one step in your viewing trail, as-
suming you backtracked.

Reload page refreshes the Viewer, in case you are viewing
something that has changed since you opened the Viewer.

Print prints the contents of the Viewer.

Find text in page opens the find bar at the bottom of the
Viewer (see below).

Search chooses the scope of help searches in the Viewer.

33
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The Find bar is used to find text within the current Viewer. To reveal the Find bar at the bottom
of the window, click on the Find text in page button:

The Find bar has its own buttons, fields, and checkboxes.

Close closes the Find bar.

Find is the field for entering the search text you would like
to find. You can change the search options by using the
checkboxes.

Previous jumps to the previous instance of the search text;
it automatically wraps past the start of the Viewer document
if there are no previous instances of the search text.

Next jumps to the next instance of the search text; it au-
tomatically wraps past the end of the Viewer document if
there are no further instances of the search text.

Highlight all highlights other instances of the search text (in
yellow, by default) when this box is checked. If unchecked,
only the current instance of the search text is highlighted (in
black, by default). By default, this box is checked.

Match case, when checked, considers uppercase and low-
ercase letters to be different. When this box is checked,
searching for This would not find this. If unchecked, up-
percase and lowercase letters are considered the same, so
searching for This would find this. By default, this box
is unchecked.
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Viewer’s function
The Viewer is similar to a web browser. It has links (shown in blue text by default) that you can

click on to see related help topics and to install and manage third-party software. When you move the
mouse pointer over a link, the status bar at the bottom of the Viewer shows the action associated with
that link. If the action of a link is help logistic, clicking on that link will show the help file for
the logistic command in the Viewer. Middle-clicking on a link in a Viewer window (Ctrl+clicking
if you do not have a three-button mouse) will open the link in a new tab in the Viewer window.
Shift+clicking will open the link in a new Viewer window.

You can open a new Viewer by selecting Window > Viewer > New Viewer or by clicking on the
Viewer button on the toolbar of the main window. Entering a help command from the Command
window will also open a new Viewer.

To bring a Viewer to the front of all other Viewers, select Window > Viewer and choose a Viewer
from the list there. Selecting Close all Viewers closes all open Viewer window and tabs.

Viewing local text files, including SMCL files
In addition to viewing built-in Stata help files, you can use the Viewer to view Stata Markup

and Control Language (SMCL) files such as those typically produced when logging your work (see
[GSW] 16 Saving and printing results by using logs) as well as plain-text files. To open a file and
view its contents, simply select File > Open..., and you will be presented with a dialog:

You may either type in the name of the file that you wish to view and click on OK, or you may
click on the Browse... button to open a standard file dialog that allows you to navigate to the file.

If you currently have a log file open, you may view the log file in the Viewer. This method has
one advantage over scrolling back in the Results window: what you view stays fixed even as output
is added to the Results window. If you wish to view a current log file, select File > Log > View...,
and the usual dialog will appear but with the path and filename of the current log already in the
field. Simply click on OK, and the log will appear in the Viewer. See [GSW] 16 Saving and printing
results by using logs for more details.

Viewing remote files over the Internet
If you want to look at a remote file over the Internet, the process is similar to viewing a local file,

only instead of using the Browse... button, you type the URL of the file that you want to see, such as
https://www.stata.com/man/readme.smcl. You should use the Viewer only to view text or SMCL files.
If you enter the URL of, say, an arbitrary webpage, you will see the HTML source of the page instead
of the usual browser rendering.

https://www.stata.com/man/readme.smcl
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Navigating within the Viewer
In addition to using the scrollbar to navigate the Viewer window, you also can use the up and

down arrow keys and Page Up and Page Down keys to do the same. Pressing the up or down arrow
key scrolls the window a line at a time. Pressing the Page Up or Page Down key scrolls the window
a screen at a time.

Printing

To print the contents of the Viewer, right-click on the window and select Print.... You may also

select File > Print > Viewer name or click on the Print toolbar button, , to print.

Tabs in the Viewer
A Viewer window can have multiple tabs. You may view different files or different views of the

same file in different tabs. Clicking on the Open new tab button, , will open a new tab in the
current Viewer window. You can change the order of the tabs within a Viewer by dragging the tabs
along the tab bar within the window. If you drag a tab and drop it within the body of the same
Viewer window, a menu will appear. If you select New Horizontal Tab Group, the Viewer window
will be split horizontally. This is useful for having two views of the same file at different places in
the file. Similarly, if you select New Vertical Tab Group, the Viewer window will be split vertically.
This is useful for comparing two similar files side by side.

Once you have created a horizontal or vertical tab group, if you drop a tab inside a group, you
will get the choice of creating a similar new group or moving the tab to the selected group.

Right-clicking on the Viewer window
Right-clicking on the Viewer window displays a contextual menu that offers these options:
• Select all to select all text in the Viewer.
• Preferences... to edit the preferences for the Viewer window.
• Font... to change the font for the window.
• Print... to print the contents of the Viewer window.

In other contexts, there could be more items displayed in the contextual menu.

Searching for help in the Viewer
The search box in the Viewer can be used to search documentation. Click on the magnifying glass;

choose Search all, Search documentation and FAQs, or Search net resources; and then type a word
or phrase in the search box and press Enter . For more extensive information about using the Viewer
for help, see [GSW] 4 Getting help.
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Commands in the Viewer
Everything that can be done in the Viewer by clicking on links and buttons can also be done by

typing commands in the command box at the top of the window or on the Stata command line. Some
tasks that can be performed in the Viewer are

• obtaining help (see [GSW] 4 Getting help):
Type contents to view the contents of Stata’s help system.
Type commandname to view the help file for a Stata command.
Type keyword to search documentation, FAQs, and net resources for a topic.

• searching (see [GSW] 4 Getting help):
Type search keyword to search documentation, FAQs, and net resources for a topic.
Type search keyword, local to search only documentation and FAQs for a topic.
Type search keyword, net to search only net resources for a topic.

• finding and installing community-contributed commands (see [GSW] 4 Getting help and
[GSW] 19 Updating and extending Stata—Internet functionality):

Type net from https://www.stata.com/ to find and install Stata Journal, Stata
Technical Bulletin, and community-contributed commands from the Internet.
Type ado to review community-contributed packages you have installed.
Type ado uninstall to uninstall community-contributed packages you have installed on
your computer.

• viewing files in the Viewer:
Type view filename.smcl to view SMCL files.
Type view filename.txt to view text files.
Type view filename.log to view text log files.

• viewing files in the Results window:
Type type filename.smcl in the Command window to view SMCL files in the Results
window.
Type type filename.txt in the Command window to view text files in the Results
window.
Type type filename.log in the Command window to view text log files in the Results
window.

• launching your browser to view an HTML file:
Type browse URL to launch your browser.

Using the Viewer from the Command window
Typing help commandname in the Command window will bring up a new Viewer showing the

requested help.
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System help

Stata’s help system provides a wealth of information to help you learn and use Stata. To find out
which Stata command will perform the statistical or data management task you would like to do, you
should generally follow these steps:

1. Select Help > Search..., choose Search all, and enter the topic or keywords. This search
will open a new Viewer window containing information about Stata commands, references to
articles in the Stata Journal , links to Frequently Asked Questions (FAQs) on Stata’s website,
links to videos on Stata’s YouTube channel, links to selected external websites, and links to
community-contributed features.

2. Read through the results. If you find a useful command, click on the link to the appropriate
command name to open its help file.

3. Read the help file for the command you chose.
4. If you want more in-depth help, click on the link from the name of the command to the PDF

documentation, read it, then come back to Stata.
5. If the first help file you went to is not what you wanted, either click on the Also see menu

and choose a link to related help files or click on the Back button to go back to the previous
document and go from there to other help files.

6. With the help file open, click on the Command window and enter the command, or click on
the Dialog button and choose a link to open a dialog for the command.

7. If, at any time, you want to begin again with a new search, enter the new search terms in the
search box of the Viewer window.

8. If you select Search documentation and FAQs, Stata searches its keyword database for official
Stata commands, Stata Journal articles and software, FAQs, and videos. If you select Search net
resources, Stata searches for community-contributed commands, whether they are from the Stata
Journal or elsewhere; see [GSW] 19 Updating and extending Stata—Internet functionality
for more information.

Let’s illustrate the help system with an example. You will get the most benefit from the example
if you work along at your computer.

Suppose that we have been given a dataset about antique cars and that we need to know what
it contains. Though we still have a vague notion of having seen something like this while working
through the example session in [GSW] 1 Introducing Stata—sample session, we do not remember
the proper command.

Start by typing sysuse auto, clear in the Command window to bring the dataset into memory.
(See [GSW] 5 Opening and saving Stata datasets for information on the clear option.)

Follow the above approach:
1. Select Help > Search....
2. Check that the Search all radio button is selected.
3. Type dataset contents into the search box and click on OK or press Enter . Before we press

Enter , the window should look like

38
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4. Stata will now search for “dataset contents” among the Stata commands, the reference manuals,
the Stata Journal, the FAQs on Stata’s website, and community-contributed features. Here is the
result:
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5. Upon seeing the results of the search, we see two commands that look promising: codebook
and describe. Because we are interested in the contents of the dataset, we decide to check
out the codebook command. The [D] means that we could look up the codebook command
in the Data Management Reference Manual. The codebook link in (help codebook) means
that there is a system help file for the codebook command. This is what we are interested in
right now.

6. Click on the codebook link. Links can take you to a variety of resources, such as help for Stata
commands, dialogs, and even webpages. Here the link goes to the help file for the codebook
command.

7. What is displayed is typical for help for a Stata command. Help files for Stata commands
contain, from top to bottom, these features:

a. The quick access toolbar with three buttons:
i. The Dialog button shows links to any dialogs associated with the command.

ii. The Also see button shows links to related PDF documentation and help files.
iii. The Jump to button shows links to other sections within the current help file.

b. The second line of a help file shows a View complete PDF manual entry link.
Clicking on the link will open the complete documentation for the command—in this
case, codebook—in your PDF viewer.

c. The command’s syntax, that is, rules for constructing a command that Stata will correctly
interpret. The square brackets here indicate that all the arguments to codebook are optional
but that if we wanted to specify them, we could use a varlist, an if qualifier, or an in
qualifier, along with some options. (Options vary greatly from command to command.)
The options are listed directly under the command and are explained in some detail later
in the help file. You will learn more about command syntax in [GSW] 10 Listing data
and basic command syntax.
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d. A description of the command. Because “codebook” is the name for big binders containing
a hard copy describing each of the elements of a dataset, the description for the codebook
command is justifiably terse.

e. The options that can be used with this command. These are explained in much greater
detail than in the listing of the possible options after the syntax. Here, for example, we can
see that the mv option can look to see if there is a pattern in the missing values—something
important for data cleaning and imputation.

f. Examples of command usage. The codebook examples are real examples that step through
using the command on a dataset either shipped with Stata or loadable within Stata from
the Internet.

g. The information the command stores in the returned results. These results are used
primarily by programmers.

For now, either click on Jump to and choose Examples from the drop-down menu or scroll
down to the examples. It is worth going through the examples as given in the help file. Here is a
screenshot of the top of the examples:

Searching help

Search is designed to help you find information about statistics, graphics, data management, and
programming features in Stata, either as part of the official release or as community-contributed features.
When entering topics for the search, use appropriate terms from statistics, etc. For example, you could
enter Mann-Whitney. Multiple topic words are allowed, for example, regression residuals.
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When you are using Search, use proper English and proper statistical terminology. If you already
know the name of the Stata command and want to go directly to its help file, select Help > Stata
command... and type the command name. You can also type the command name in the Search field
at the top of the Viewer and press Enter .

Help distinguishes between topics and Stata commands because some names of Stata commands
are also general topic names. For example, logistic is a Stata command. If you choose Stata
command... and type logistic, you will go right to the help file for the command. But if you
choose Search... and type logistic, you will get search results listing the many Stata commands
that relate to logistic regression.

Remember that you can search for help from within a Viewer window by typing a command in
the command box of the Viewer or by clicking the magnifying glass button to the left of the search
box, selecting the scope of your search, typing the search criteria in the search box, and pressing
Enter .

Help and search commands

As you might expect, the help system is accessible from the Command window. This feature is
especially convenient when you need help on a particular Stata command. Here is a short listing of
the various commands you can use:

• Typing help commandname is equivalent to selecting Help > Stata command... and typing
commandname. The help file for the command appears in a new Viewer window.

• Typing search topic in the Command window produces the same output as selecting Help >
Search..., choosing Search all, and typing topic. The output appears in a new Viewer window.

• Typing search topic, local in the Command window produces the same output as selecting
Help > Search..., choosing Search documentation and FAQs, and typing topic. The output
appears in the Results window instead of a Viewer.

• Typing search topic, net in the Command window produces the same output as selecting
Help > Search..., choosing Search net resources, and typing topic. The output appears in the
Results window instead of a Viewer.

See [U] 4 Stata’s help and search facilities and [U] 4.8 search: All the details in the User’s
Guide for more information about these command-language versions of the help system. The search
command, in particular, has a few capabilities (such as author searches) that we have not demonstrated
here.

The Stata reference manuals and User’s Guide
All the Stata reference manuals come as PDF files and are included with the software. The manuals

themselves have many cross-references in the form of clickable links, so you can easily read the
documentation in a nonlinear way.

Many of the links in the help files point to the PDF manuals that came with Stata. It is worth
clicking on these links to read the extensive information found in the manuals. The Stata help system,
though extensive, contains only a fraction of the information found in the manuals.

Most Stata reference manuals are each arranged alphabetically. Each Getting Started with Stata
has its own index. A combined index for all other manuals can be found in the Stata Index. This
combined index is a good place to start when you are looking for information about a command.

Entries have names like collapse, egen, and summarize, which are generally themselves Stata
commands.
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Notations such as [R] ci, [R] regress, and [R] ttest in the Search results and help files are references
to the Base Reference Manual. You may also see things like [P] PyStata integration, which is a
reference to the Programming Reference Manual, and [U] 12 Data, which is a reference to the
User’s Guide. For a complete list of manuals and their shorthand notations, see Cross-referencing the
documentation, which immediately follows the table of contents in this manual.

For advice on how to use the reference manuals, see [GSW] 18 Learning more about Stata, or
see [U] 1.2 The User’s Guide and the Reference manuals.

Stata videos
The Stata YouTube channel is an excellent resource for learning about Stata. The brief videos

demonstrate many topics using Stata’s graphical user interface. They cover basic topics, such as
data management, graphics, summary statistics, and hypothesis testing, and advanced topics, such as
multilevel models and structural equation models.

There are also several playlists that provide a series of videos about a topic in sequence. For
example, the “Power and sample size calculations” playlist includes videos about how to calculate
power, sample size, and effect size for two independent proportions and for paired samples. The
“Survival analysis” playlist takes you through the process of setting your data up for survival analysis,
conducting basic descriptive analysis of survival data, graphing survival data, and calculating survivor
functions and life tables. The “Time series” playlist takes you through the process of setting your
data up for time-series analysis, creating time-series graphs, using time-series operators in estimation,
and fitting ARMA and ARIMA models. There is even a “Back-to-school video” playlist for students
who are using Stata for the first time or want a refresher after summer break.

See https://www.stata.com/links/video-tutorials/ for an up-to-date list of videos organized by topic.
The playlists can be accessed directly at https://www.youtube.com/user/statacorp/.

The Stata Journal
When searching in Stata, you will often see links to the Stata Journal.

The Stata Journal is a printed and electronic journal, published quarterly, containing articles about
statistics, data analysis, teaching methods, and effective use of Stata’s language. The Journal publishes
peer-reviewed papers together with shorter notes and comments, regular columns, tips, book reviews,
and other material of interest to researchers applying statistics in a variety of disciplines. The Journal
is a publication for all Stata users, both novice and experienced, with different levels of expertise in
statistics, research design, data management, graphics, reporting of results, and Stata, in particular.
See https://www.stata-journal.com for more information.

Associated with each issue of the Stata Journal are the programs and datasets described therein.
These programs and datasets are made available for download and installation over the Internet, not
only to subscribers but also to all Stata users. See [R] net and [R] sj for more information.

Because the Stata Journal has had several articles about measures of inequality, if you select Help
> Search..., choose Search documentation and FAQs, type inequality, and scroll down a bit, you
will see some of these references:

https://www.youtube.com/user/statacorp/
https://www.stata.com/links/video-tutorials/
https://www.youtube.com/user/statacorp/
https://www.stata-journal.com
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SJ-18-3 refers to volume 18, number 3 of the Stata Journal. st0539 refers to the package name;
st indicates that this package is in the “statistics” category of the Stata Journal. Listed next is the
title of the software package and the authors. The community-contributed commands found within
this package are listed next in parentheses, followed by the reference details of the article. Clicking
on an SJ link, such as SJ 18(3):692--715, will open a browser and take you to the Stata Journal
website, where you can view the abstract of the article and purchase the article. The search listing
concludes with a brief description of the community-contributed package.

The Stata Journal website allows all articles older than three years to be downloaded for free.
See Downloading community-contributed commands in [GSW] 19 Updating and extending Stata—
Internet functionality for more details on how to install community-contributed software. Also see
[R] ssc for information on a convenient interface to resources available from the Statistical Software
Components (SSC) Archive.
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We recommend that all users subscribe to the Stata Journal. See [U] 3.4 The Stata Journal for
more information.

Links to other sites where you can freely download programs and datasets for Stata can be found
on the Stata website; see https://www.stata.com/links/.

https://www.stata.com/links/


5 Opening and saving Stata datasets

How to load your dataset from disk and save it to disk
Opening and saving datasets in Stata works similarly to those tasks in other computer applications.

There are a few differences, however. First, it is possible to save and open files from within Stata’s
Command window. Second, Stata allows just one dataset to be active at any one time. That is, while it
is possible to have multiple datasets in memory at once (see [D] frames intro), only one dataset may
be active. Keeping this in mind will make Stata’s care in opening new datasets clear. This chapter
outlines all the possible ways to open and save datasets.

A Stata dataset can be opened in a variety of ways, most of which are probably familiar to you
from other applications:

• Double-click on a Stata data file, which is a file whose extension is .dta. Note: The file
extension may not be visible, depending on what options you have set in your operating system.

• Select File > Open... or click on the Open button and navigate to the file.
• Select File > Open data subset..., navigate to the file, specify the observation range, and select

variables from the dataset.
• Select File > Recent files > filename.
• Type use filename in the Command window. Stata will look for filename in the current working

directory. If the file is located elsewhere, you will need to give its path. Be aware that if there
is a space anywhere in the path or filename, you will need to put the filename inside quotation
marks. See [U] 11.6 Filenaming conventions.

• Type sysuse filename in the Command window. Stata will look for filename in a series of
directories called the adopath. Typically, this is for finding example datasets installed when
you installed Stata, but it can also be used for easy access to your own datasets. For more
information on the adopath, see [P] sysdir.

• Type webuse filename in the Command window. The webuse command is used to access
datasets used in the Stata manuals; for example, webuse lbw loads the lbw dataset used in the
documentation of the logistic command. For more information, see [D] webuse.

Opening a dataset in the current frame (see [D] frames intro) will replace the dataset, if any, that
is currently in memory for that frame. Datasets in other frames are unaffected. If there have been
changes to the data in the dataset in the current frame, Stata will refuse to discard the dataset unless
you force it to do so. If you open the file with any method other than the Command window, you
will be prompted. If you use the Command window and the current data have changed, you will get
the following error message:� �

. sysuse auto
no; dataset in memory has changed since last saved
r(4);� �

These behaviors protect you from mistakenly losing data.

To save an unnamed dataset (or an old dataset under a new name):
1. select File > Save as...; or
2. type save filename in the Command window.

46



[ GSW ] 5 Opening and saving Stata datasets 47

To save a dataset for use with Stata 13,
1. select File > Save as..., and select Stata 13 Data (*.dta) from the Save as type list; or
2. type saveold filename in the Command window.

To save a dataset that has been changed (overwriting the original data file),
1. select File > Save;
2. click on the Save button; or
3. type save, replace in the Command window.

Once you overwrite a dataset, there is no way to recover your original dataset. With important datasets,
you may want to either keep a backup copy of your original filename.dta or save your changes to
a dataset under a new name. This is no different from working with a word-processing document,
except that recovering from an inadvertent save of a dataset is nearly impossible.

Important note: Changes you have made to a dataset are not permanent until you save them. You
work with a copy of the dataset in memory, not with the data file itself. This should not be surprising,
because it is the way that you work with almost all applications on your computer.

If you do not want to save your dataset, you can clear the dataset in memory and open a new
dataset by typing use filename, clear.



6 Using the Data Editor

The Data Editor
The Data Editor gives a spreadsheet-like view of data that are currently in memory. You can use

it to enter new data, edit existing data, search through the dataset, and edit attributes of the data in
the dataset, such as variable names, labels, and display formats, as well as value labels.

In addition to the view of the data, there are two windows for manipulating variables and their
properties: the Variables window and the Properties window. These are similar to the same-named
windows in the main Stata window.

Any action you take in the Data Editor results in a command being issued to Stata as though
you had typed it into the Command window. This means that you can keep good records and learn
commands by using the Data Editor.

The Data Editor can be kept open while you work in Stata, giving you a live view of your dataset
as you work. To protect your data from inadvertent changes, the Data Editor has two modes: edit
mode for active editing and browse mode for viewing. In browse mode, editing within the Data Editor
window is disabled. We highly recommend that you use the Data Editor in browse mode and switch
to edit mode only when you want to make changes.

You can print your data from the Data Editor by selecting Print from the File menu.

We will be entering and editing data in this chapter, as well as manipulating the variables by using
the Variables and Properties windows, so start the Data Editor in edit mode by clicking on the Data
Editor (Edit) button, .

Buttons on the Data Editor
The toolbar for the Data Editor has some standard buttons and some buttons we have not yet seen:

Edit mode: Changes the Data Editor to edit mode.

Browse mode: Changes the Data Editor to browse mode for safely looking at data.

Open: Opens a Stata dataset. Stata will warn you if your current dataset has unsaved
changes.

Save: Saves the dataset visible in the Data Editor.

Print: Prints the dataset visible in the Data Editor.

Copy: Copies the current selection to the Clipboard.

Paste: Pastes the contents of the Clipboard. You may paste only if one cell is selected—this
cell will become the upper-left corner of the pasted contents. Warning: This action will
paste over existing data.
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Find: Opens the Find bar for searching in the Data Editor.

Filter observations: Filters the observations visible in the Data Editor. This button is useful
for looking at a subset of the current dataset.

You can move about in the Data Editor by using the typical methods:
• To move to the right, use the Tab key or the right arrow key.
• To move to the left, use Shift+Tab or the left arrow key.
• To move down, use Enter or the down arrow key.
• To move up, use Shift+Enter or the up arrow key.

You can also click within a cell to select it.

Right-clicking within the Data Editor brings up a contextual menu that allows you to manipulate
the data and what you are viewing. Right-clicking on the Data Editor window displays a menu from
which you can do many common tasks:

• Copy to copy data to the Clipboard.
• Paste to paste data from the Clipboard.
• Paste special... to paste data from the Clipboard with finer control of delimiters, giving a

preview of what will be pasted.
• Select all to select all the data displayed in the Data Editor. This could be different from the

data in the dataset if the data are filtered or some variables are hidden.
• Data to open a submenu containing

• Insert variable... to bring up a dialog for creating a new variable at the current cursor
position.

• Add variable... to bring up a dialog for creating a new variable at the beginning or end
of a dataset.

• Replace contents of variable... to bring up a dialog for replacing the values of the
selected variable.

• Insert observations... to bring up a dialog for inserting new empty observations at the
current cursor position.

• Add observations... to bring up a dialog for adding new empty observations to the end
of the dataset.

• Sort data... to sort the dataset by the selected variable.
• Value labels to access a submenu for managing and displaying value labels.
• Keep only selected data to keep only the selected data in the dataset. All remaining

data will be dropped (removed) from the dataset. As always, this affects only the data in
memory. It will not affect any data on disk.

• Drop selected data to drop the selected data. This is only possible if the selection consists
of either entire variables (columns) or observations (rows).

• Convert variables from string to numeric... for converting string variables to numeric
variables, which is useful when the string variables contain characters for formatting
numbers instead of just numbers.

• Convert variables from numeric to string... for converting numeric variables to strings.
• Encode string variable to labeled numeric... for encoding a string-valued categorical

variable to a numeric variable while still displaying the categories in tables and graphs.
• Decode labeled numeric variable to string... for turning an encoded variable back into

a string variable.
• Reset selected column widths to reset the selected columns to the default width.
• Hide selected variables to hide the selected variables.
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• Show only selected variables to hide all but the selected variables.
• Show entire dataset to turn off all filters and unhide all variables.
• Preferences... to set the preferences for the Data Editor.
• Font... to change the font of the Data Editor.

Data entry

Entering data into the Data Editor is similar to entering data into a spreadsheet. One major difference
is that the Data Editor has the concept of observations, which makes the data entry smart. We will
illustrate this with an example. It will be useful for you to follow the example at your computer. To
work along, you will need to start with an empty dataset, so save your dataset if necessary, and then
type clear in the Command window.

Note: As a check to see if your data have changed, type describe, short (or d,s for short).
Stata will tell you if your data have changed.

Suppose that we have the following data, and we want to enter them into Stata:

Make Price MPG Weight Gear ratio

VW Rabbit 4697 25 1930 3.78
Olds 98 8814 21 4060 2.41
Chev. Monza 3667 2750 2.73
AMC Concord 4099 22 2930 3.58
Datsun 510 5079 24 2280 3.54

5189 20 3280 2.93
Datsun 810 8129 21 2750 3.55

We do not know MPG for the third car or the make of the sixth.

Start by opening the Data Editor in edit mode. You can do this either by clicking on the Data
Editor (Edit) button, , or by typing edit in the Command window. You should be greeted by
a Data Editor with no data displayed. (If you see data, type clear in the Command window.) Stata
shows the active cell by highlighting it and displaying varname[obsnum] next to the input box in
the Cursor Location box. We will see below that we can navigate within a dataset by using this cell
reference. The Data Editor starts, by default, in the first row of the first column. Because there are
no data, there are no variable names, and so Stata shows var1[1] as the active cell.

We can enter these data either by working across the rows (observation by observation) or by
working down the columns (variable by variable). To enter the data observation by observation, press
Tab after entering each value until you have reached the end of the first row. In our case, we would
type VW Rabbit, press Tab, type 4697, press Tab, and continue entering data to complete the first
observation.
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After you are finished with the first observation, select the second cell in the first column, either
by clicking within it or by navigating to it. At this point, your screen should look like this:

We can now enter the data for the second observation in the same fashion as the first—with one
nice difference: after we enter the last value in the row, pressing the Tab key will bring us to the
first cell in the third row. This is possible because the number of variables is known after the first
observation has been entered, so Stata knows when it has all the data for an observation.

We can enter the rest of the data by pressing the Tab key between entries, simply skipping over
missing values by tabbing through them.

If we had wanted to enter the data variable by variable, we could have done that by pressing
Enter between each make of car until all seven observations were entered, skipping past the missing
entry by pressing Enter twice. Once the first variable was entered, we would select the first cell in
the second column and enter the price data. We would continue this until we were finished.

Notes on data entry

There are several things to note about data entry and the feedback you get from the Data Editor
as you enter data:

• Stata does not allow blank columns or rows in the middle of your dataset.
Whenever you enter new variables or observations, always begin in the first empty column
or row. If you skip columns or rows, Stata will fill in the intervening columns or rows with
missing values.

• Strings and value labels are color coded.
To help distinguish between the different types of variables in the Data Editor, string values,
value labels (see [GSW] 9 Labeling data), and all other values are displayed in different colors.
You can change the colors for strings and value labels by right-clicking on the Data Editor
window and selecting Preferences....

• A period (.) represents Stata’s system missing numeric value.
Stata has a system missing value, ‘.’, and extended missing values ‘.a’ through ‘.z’. By
default, Stata uses its system missing value.
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• The Tab key is smart.
As we saw above, after the first observation has been entered, Stata knows how many variables
you have. So at the end of the second observation (and all subsequent observations), Tab will
automatically take you back to the first column.

• The Cursor Location box both shows location and is used for navigation.
The Cursor Location box gives the location of the current cell. If you see, for example, var3[4],
this means that the current cell is the fourth observation of the variable named var3. You can
navigate to a particular cell by typing the variable name and the observation in the Cursor
Location box. If you wanted the second observation of var1 to be the active cell, typing var1 2
in the Cursor Location box and pressing Enter would take you there.

• Double quotes around text are unnecessary in string variables.
Once Stata knows that a variable is a string variable (it holds text), there is no need to put
quotes around the values, even if the values look like a number. Thus, if you wanted to enter
ZIP codes as text, you would enter the first ZIP code with quotes ("02173"), but the rest would
not need any quotes.

• The arrow keys are context sensitive.
If you select a cell and type new data, using an arrow key will accept the change and move to
a new active cell. If you double-click on a cell, you can edit within the cell contents. In this
case, the right- and left-arrow keys move within the cell’s data.

• You can throw away changes to a cell.
If, while you are entering data in a cell, you decide you would like to cancel the changes, press
the Esc key or click outside the cell.

Renaming and formatting variables

The data have now been entered into Stata, but the variable names leave something to be desired:
they have the default names var1, var2, . . . , var5. We would like to rename the variables so that
they match the column titles from our dataset. We would also like to give the variables descriptions
and change their formatting.

We will step through changing the name, label, and format of the price variable. We will then
add a note to the variable. Start by clicking on the var2 variable in the Variables window. The few
properties associated with var2 are now visible and editable in the Properties window. We may now
systematically change the properties of var2 to our choosing:

1. Double-click on var2 in the Name field to select the old variable name, and type price to
overwrite the name.

2. Click under the new price name in the Label field.
3. Enter a worthwhile label, such as Price in dollars.
4. Click on %9.0g in the Format field.
5. Click on the ellipsis (. . .) button that appears. The Create format dialog opens.
6. You can see here that there are many possible formats, most of which are related to time. We

want commas in our numbers, so check the Use commas in numeric output checkbox. When
you are done, click on the OK button.

7. Click in the Notes field.
8. Click on the ellipsis (. . .) button that appears. A dialog called Notes for price opens.
9. Click on the Add button and type a clever note.

10. When you are done typing, click on the Submit button, and then click on the Close button.
This note is now attached to the price variable.

11. Click on the disclosure control to see the note you just typed in the Properties window.
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To edit the properties of another variable, click on the variable in the Variables window. We can name
the first variable make; the third, mpg; the fourth, weight; and the fifth, gear ratio. Just before
you rename var5 to gear ratio, your screen should look like this:

You need to know some rules for variable names:
• Stata is case sensitive.
Make, make, and MAKE are all different names to Stata. If you had named your variables Make,
Price, MPG, etc., then you would have to type them correctly capitalized in the future. Using
all lowercase letters is easier.

• A variable name must be 1–32 characters long.
• The characters can be letters (A–Z, a–z), digits (0–9), underscores ( ), or Unicode characters

that are not symbols.
• Spaces or other characters are not allowed.
• The first character of a variable name must be a letter, an underscore, or a Unicode character.

Although you can use an underscore to begin a variable name, it is highly discouraged. Such
names are used for temporary variable names in Stata. You would like your data to be permanent,
so using a temporary name could lead to great frustration.

For more information about variable names and value labels, see [GSW] 9 Labeling data; for display
formats, see [U] 12.5 Formats: Controlling how data are displayed.

Copying and pasting data

You can copy and paste data by using the Data Editor. This is often a simple way to bring data
into Stata from any other applications such as spreadsheets or databases.

1. Select the data that you wish to copy by using one of these means:
• Click once on a variable name or column heading to select an entire column.
• Click once on an observation number or row heading to select the entire row.
• Click and drag the mouse to select a range of cells.

2. Copy the data to the Clipboard by right-clicking within the selected range, and select Copy.
3. Paste the data from the Clipboard by right-clicking on the top left cell of the area to which

you wish to paste, and select Paste.
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We will illustrate copying and pasting an observation by making a copy of the first observation
and pasting it at the end of the dataset.

Start by clicking on the observation number of the first observation. Doing so highlights all the
data in the row. Right-click on the same location (there is no need to move the mouse), and select
Copy:

Click on the first cell in the eighth row, right-click while you are still in that cell, and choose
Paste from the resulting menu. You can see that the observation was successfully duplicated.

Notes on copying and pasting
• The above example illustrated copying and pasting within the Data Editor. You can use roughly

the same technique to copy and paste between other applications and Stata and between Stata
and other applications. The easiest way to see if copying and pasting works properly with
another application is to try it. The one requirement for things to work well is that the external
application must copy tables in some delimited form, as do spreadsheet applications, many
database applications, and some word processors. Using Edit > Paste special... gives some
added flexibility to the formats you can paste into the Data Editor. If a simple paste does not
give you what you expected, you should try Edit > Paste special.... For more information on
file-based methods for importing data into Stata, see [GSW] 8 Importing data.

• If you are copying and pasting data with value labels, you have a choice. You can copy variables
with value labels as text, using the value labels as the actual values, or you can copy said
variables as their underlying encoded numbers. Copying with the value labels is the default. If
you would like the other choice, right-click in the Data Editor and select Data > Value labels
> Hide all value labels, or select Tools > Value labels > Hide all value labels.



[ GSW ] 6 Using the Data Editor 55

Changing data

As its name suggests, the Data Editor can be used to edit your dataset. As we have seen already, it
can be used to edit the data themselves as well as the description and display options for the variables.

Here is an example for making some changes to the automobile dataset, which illustrates both
methods for using the Data Editor and its documentation trail. We will also keep snapshots of the
dataset as we are working so that we can revert to previous versions of the dataset in case we make
a mistake.

We would like to investigate the dataset, work with value labels, delete the trunk variable, and
make a new variable showing gas consumption per 100 miles. These tasks will illustrate the basics
of working in the Data Editor.

Start by typing sysuse auto into the Command window. If you worked the previous example,
you will get an error and are told that the dataset in memory has changed since it was last saved.
This is good—Stata is keeping you from inadvertently throwing away the unsaved changes to your
current dataset as it loads auto.dta. If you would like to save the dataset you have been working
on, select File > Save and save the dataset in an appropriate location. Otherwise, type clear in the
Command window, and press Enter to clear out the data, and then load that auto.dta.

Once auto.dta is loaded, start the Data Editor.
1. We remember that our grandfather had a Toronado, which looked sleek but seemed to require

a lot of fill-ups. We would like to see if this car is in the dataset. To find it, we select Edit >
Find..., type Toronado, and press Enter . We see that this make of car got 16 miles per gallon.

2. We would like to see which cars have the lowest and highest gas mileages. To do this, right-click
on the column heading of the mpg column. Select Data > Sort data... from the contextual
menu. A dialog will pop up asking how you want to sort, defaulting to sorting in ascending
order. Click on OK. (Stata worries about sort order because sort order can affect reproducibility
when using resampling techniques. This is a good thing.) You will see that the data have now
been sorted by mpg in ascending order. The lowest-mileage cars are at the top of the screen;
by scrolling to the bottom of the dataset, you can find the highest-mileage cars. You also could
have sorted by selecting Tools > Sort data... once the mpg variable was selected.

3. We would like to investigate repair records and hence sort by the rep78 variable. (Do this
now.) We see that the Starfire and Firebird both had poor repair records, but we would like to
see the cars with good repair records. We could scroll to the bottom of the dataset, but it will
be faster to use the Cursor Location box: type rep78 74 and press Enter to make rep78[74]
the active cell. We notice that the last five entries for rep78 appear as dots. The dots mean
that these values are missing. A few items of note:

• As we can see from the result of the sort, Stata views missing values as being larger
than all numeric nonmissing values. In technical terms, this means that rep78 >= . is
equivalent to missing(rep78).

• What we do not see here is that Stata has multiple missing-value indicators: . is Stata’s
default or system missing-value indicator, and .a, .b, . . . , .z are Stata’s extended
missing values. Extended missing values are useful for indicating the reason why a value
is unknown.

• The different missing values sort among themselves: . < .a < .b < · · · < .z. See
[U] 12.2.1 Missing values for full details.

4. We would like to make the repair records readable. Click on rep78 in the Variables window.
5. Click on the Value label field in the Properties window, and then click on the ellipsis (. . . )

button that appears. This opens the Manage value labels dialog. We need to define a new value
label for the repair records.
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a. Click on the Create label button. You will see the Create label dialog.
b. Type a name for the label, say, repairs, in the Label name box.
c. Press the Tab key or click within the Value field.
d. Type 1 for the value, press the Tab key, and type atrocious for the label.
e. Press the Enter key to create the pairing.
f. Repeat steps d and e to make all the pairings: 2 with “bad”, 3 with “OK”, 4 with “good”,

and 5 with “stupendous”.
g. Click on the OK button to finish creating the value label.

h. Click on the disclosure control, , to show the label—you should see this:

If you have something else, you can edit the label by clicking on the Edit label button.
i. Click on the Close button to close the Manage value labels dialog.

Now that the label has been created, attach it to the rep78 variable by clicking on the down
arrow in the Value label field and selecting the repairs label. You can now see the labels
displayed in place of the values.

6. Suppose that we found the original source of the data in a time capsule, so we could replace
some of the missing values for rep78. We could type the values into cells. We can also assign
the values by right-clicking within a cell with a missing value and choosing a value from Data
> Value labels > Assign value from value label “repairs”. This strategy can be useful when a
value label has many possible values.

7. We would now like to delete the trunk variable. We can do this by right-clicking on the trunk
variable name at the top of the column and selecting the Data > Drop selected data menu
item. Because this can lead to data loss, the Data Editor asks whether we would like to drop
the selected variable. Click on the Yes button.

8. To finish up, we would like to create a variable containing the gallons of gasoline per 100
miles driven for each of the cars.

a. Right-click within any cell, and choose the Data > Add variable... menu item to bring
up the generate dialog.

b. Type gp100m in the Variable name field.
c. Being sure that the Specify a value or an expression radio button is selected, type 100/mpg

in its field. We could have clicked on the Create... button to open the Expression Builder
dialog, but this formula was simple enough to type. (You might want to explore the
Expression Builder right now to see what it can do.)
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d. Be sure that the Add at the end of dataset item is chosen from the Position of new
variable list.

e. Click on OK. You can scroll to the right to see the newly created variable.

Throughout this data-editing session, we have been using the Data Editor to manipulate the data.
If you look in the Results window, you will see the commands and their output. You can also see all
the commands generated by the Data Editor in the History window. If you wanted to save the editing
commands to use again later, you could do the following steps:

1. Click in the History window on the last command that came from the Data Editor.
2. Scroll up until you find the sort mpg command you ran immediately after opening the Data

Editor, and Shift-click on it.
3. Right-click on one of the highlighted commands.
4. Select Send selected to Do-file Editor.

This procedure will save all the commands you highlighted into the Do-file Editor. You could then
save them as a do-file, which you could run again later. We will talk more about the Do-file Editor
in [GSW] 13 Using the Do-file Editor—automating Stata. You can find help about do-files in
[U] 16 Do-files.

If you want to save this dataset, save it under a new name by using File > Save as... in the main
Stata window to prevent overwriting the original dataset.

Working with snapshots
The Data Editor allows you to save to disk snapshots of whatever dataset you are working on.

These are temporary copies of the dataset—they will be deleted when you exit Stata, so they need
to be treated as temporary. Still, there are many uses for snapshots, such as

• saving a temporary copy of the data in memory so that another dataset can be opened and
viewed;

• saving stages of work, which can be recovered in case you do something disastrous; and
• saving pieces of datasets while doing analyses.
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We will keep using auto.dta from above; if you are starting here, you can start fresh by typing
sysuse auto in the Command window to open the dataset. (If you get a warning about data in
memory being lost, either use clear or save your data. See [GSW] 5 Opening and saving Stata
datasets for more information.) If we open the Data Editor and click on the Snapshots tab beneath
the Variables window, we see the following window. If you are starting afresh, you will see numbers
rather than labels for rep78.

To begin with, only one button is active in the Snapshots toolbar. Click on the active button—the

Add button, . It brings up a dialog asking for a label, or name, for the snapshot. Give it an
inventive name, such as Start, and press Enter . You can see that a snapshot is now listed in the
Snapshots window, and all the buttons in the toolbar are now active. The following buttons appear
in the Snapshots window:

Add: Save a new snapshot with a timestamp and label.

Remove: Erase a snapshot. This action deletes the temporary snapshot file but does not
affect the data in memory.

Change label: Edit the label of the selected (highlighted) snapshot.

Restore: Replace the data in memory with the data from the selected snapshot. You
will get a dialog asking you to confirm your action.

You should now try manipulating the dataset by using the tools we have seen. Once you have
done that, create another snapshot, calling it Changed. Open the Snapshots window and restore the
Start snapshot by either double-clicking it or clicking first on it and then on the Restore button to
see where you started. You can then go back to where you were working by restoring your Changed
snapshot.

Snapshots continue to be available either until they are deleted or until you exit Stata. You can thus
use snapshots of one dataset while working on another. You will find your own uses for snapshots—just
take care to save the datasets you want for future use because the snapshots are temporary.
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Dates and the Data Editor
The Data Editor has two special tools for working with dates in Stata. To see these in action, we

will need to open another dataset. Either save your dataset or clear it out, and then type sysuse
sp500 in the Command window. Look in the Data Editor to see what you have.

You can see a date variable that has January 2, 2001, as its first day, though it is being displayed
in Stata’s default format for dates.

We will start with formatting:
1. Select the date variable in the Variables window to the right of the data table.
2. In the Properties window, select the Format row and click on the ellipsis button that appears.
3. The Create format dialog tells us three pieces of information about the date format:

• These are daily dates. As you can see, Stata understands other types of dates that are
often used in financial data.

• Looking at the bottom of the dialog, you can see that Stata’s default date format is %td.
This means that the variable contains time values that are to be interpreted as daily dates.

• This default format is displayed as, for example, 07apr2021.
4. There are many premade date formats in the Samples pane at the top right of the Create format

dialog. Click on April 7, 2021. You can see how the format would be specified at the bottom
of the dialog.

5. Click on OK to close the Create format dialog. You can see that the dates are now displayed
differently.

This is a very simple way to change date formats. For complete information on dates and date formats,
see [D] Datetime.

We will now change some of the dates to illustrate how this can be done simply, regardless of the
format in which the dates are displayed. If you look in the upper-right corner of the Data Editor, you
will see the Time/Date input mask field, which shows DMY. This field affects how dates are entered
when editing data.
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By default, the input mask is set to DMY. This means dates can be entered in many different
fashions, as long as the order of the date components is day, month, year. Try the following:

1. Click in the first observation of date so that the Cursor Location shows date[1].
2. Type 18jan2021 and press the Enter key. Stata understands the DMY input mask and knows

enough to enter the new date in the selected cell.
3. Enter 30042021 and press Enter . Stata still understands the input mask, even though there are

no separators.
4. Click within the Time/Date input mask field, and choose MDY from the drop-down menu.
5. Click on any observation in the date column.
6. Type March 15, 2021 and press Enter . Stata will still understand.

Working in this fashion is the fastest way to edit dates by hand. If you look in the Results window,
you will see why.

We are now finished with this dataset, so type clear and press Enter .

Data Editor advice
As you could see above, a small mistake in the Data Editor could cause large problems in your

dataset. You really must take care in how you edit your data.
• People who care about data integrity know that editors are dangerous—it is easy to accidentally

make changes. Never use the Data Editor in edit mode when you just want to look at your
data. Use the Data Editor in browse mode (or use the browse command).

• If you must edit your data, protect yourself by limiting the dataset’s exposure. For example, if
you need to change rep78 only if it is missing, find a way to look at just the missing values
for rep78 and any other variables needed to make the change. This will make it impossible for
you to change (damage) variables or observations other than those you view. We will explore
this aspect shortly.

• Even with these caveats, Stata’s Data Editor is safer than most because it records commands in
the Results window. Use this feature to log your output and make a permanent record of the
changes. Then you can verify that the changes you made are the changes you wanted to make.
See [GSW] 16 Saving and printing results by using logs for information on creating log files.

Filtering and hiding
We would now like to investigate restricting our view of the data we see in the editor. This feature

is useful for the reasons mentioned above, and as we will see, it helps if we would like to browse
through the data of a large dataset. In any case, we would like to focus on some data, not all the data,
whether we focus on some of the variables, some of the observations, or even just some observations
within some variables. We would also like to change the order of the variables. We will show you
how this is done by using both the graphical interface and commands.

Open the automobile dataset by typing sysuse auto. If you get an error message, type clear
and try again. Once you have done that, open the Data Editor.

Suppose that we would like to edit only those observations for which rep78 is missing. We will
need to look at the make of the car so that we know which observations we are working with, but
we do not need to see any other variables. We will work as though we had a very large dataset to
work with.
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1. Before we get started, try experimenting with the Variables window.
a. Drag variables up and down the list. Doing so changes the order of the variables’ columns

in the Data Editor. It does not change their order in the dataset itself.
b. Uncheck some of the checkboxes in the first column to hide some of the variables.
c. Type a search criterion in the Filter variables here field. Just like in the Variables window

in the main Stata window, the default is to ignore case and find any variables or variable
labels containing any of the words in the filter. Clicking on the wrench on the left
will allow you to change this behavior as well as to add or remove additional columns
containing information about the variables. The filtering of variables in the list affects
what is displayed in the Variables window; it does not affect what variables’ data are
displayed. When you are done, delete your filter text.

2. Right-click on any variable in the Variables window, and select Select all from the contextual
menu.

3. Click on any checkbox to deselect all the variables.
4. Click on the make variable to select it, and deselect all the other variables.
5. Click on the checkbox for make.
6. Click on the checkbox for rep78.

If you look in the Command window, you can see that no commands have been issued, because
hiding the variables does not affect the dataset—it affects only what shows in the Data Editor.

We now have protected ourselves by using only those variables that we need. We should now
reduce our view to only those observations for which rep78 is missing. This is simple.

1. Click on the Filter observations button, , in the Data Editor’s toolbar.
2. Enter missing(rep78) in the Filter by expression field.
3. Click on the Apply filter button.
4. If you are curious, click on the ellipsis button. It opens up an Expression Builder dialog. This

lists the wide variety of functions available in Stata. See the Stata Functions Reference Manual.
Now we are focused on the part of the dataset in which we would like to work, and we cannot
destroy or mistakenly alter other data by stray keystrokes in the Data Editor window.

It is worth learning how to hide variables and filter observations in the Data Editor from the
Command window. This can be quite convenient if you are going to restrict your view, as we did
above. To work from the Command window, we must use the edit command together with a varlist
(variable list) along with if and in qualifiers in the Command window. By using a varlist, we
restrict the variables we look at, whereas the if and in qualifiers restrict the observations we see.
([GSW] 10 Listing data and basic command syntax contains many examples of using a command
with a variable list and if and in.) Suppose we want to correct the missing values for rep78. The
minimum amount of data we need to expose are make and rep78. To see this minimal amount of
information and hence to minimize our exposure to making mistakes, we enter the commands� �

. sysuse auto
(1978 automobile data)

. edit make rep78 if missing(rep78)� �
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and we would see the following window:

Once again, we are safe and sound.

Keep this lesson in mind if you edit your data. It is a lesson well learned.

Browse mode
The purpose of using the Data Editor in browse mode is to look at data without altering them

by stray keystrokes. You can start the Data Editor in browse mode by clicking on the Data Editor
(Browse) button, , or by typing browse in the Command window. When you work in browse
mode, all contextual menu items that would let you alter the data, the labels, or any of the display
formats for the variables are disabled. You may view a variable’s properties with the Properties menu
item, but you may not make any changes. You still can filter observations and hide variables to get
a restricted view because these actions do not change the dataset.

Note: Because you can still use Stata menus not related to the Data Editor and because you can
still type commands in the Commands window, it is possible to change the data even if the Data
Editor is in browse mode. In fact, this means you can watch how your commands affect the dataset.
You are merely restricted from using the Data Editor itself to change the data.
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The Variables Manager
This chapter discusses Stata’s Variables Manager. To get started, open the automobile dataset by

typing sysuse auto, clear in the Command window. You open the Variables Manager by selecting

Data > Variables Manager or clicking on the Variables Manager button .

The Variables Manager is a tool for managing properties of variables both individually and in
groups. It can be used to create variable and value labels, rename variables, change display formats,
and manage notes. It has the ability to filter and group variables as well as to create variable lists.
Users will find these features useful for managing large datasets.

Any action you take in the Variables Manager results in a command being issued to Stata as
though you had typed it in the Command window. This means that you can keep good records and
learn commands by using the Variables Manager.

The Variable pane
The left pane of the Variables Manager is called the Variable pane, though it has no explicit title

on the screen. It shows the list of variables in the dataset. This list can be manipulated in a variety
of ways.

• The variables can be filtered by entering text into the filter box in the upper-left corner. This
can be a good way to zoom in on similarly named or labeled variables.

• The list can be sorted by clicking on the column title.
a. If you click on a column title, it will sort in ascending order.
b. A second click on the same column title will change to sorting in descending order.
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c. Clicking on the hash mark (#) restores the sort order to the original variable order.

The sort order affects only how the data appear in the Variable Managers window—the dataset
itself stays the same.

• The order of the columns can be changed by dragging the column titles. To restore the original
column headings, right-click on the column titles and select Restore column defaults.

• The variables can be grouped by values in one or more columns. This is done by dragging
the column titles into the grouping bar. The grouping can be canceled by dragging the column
titles back into the column titles row. Here is an example of auto.dta grouped by variable
type:

Grouping by variable label can be a good way to find unlabeled variables.

Right-clicking on the Variable pane

Right-clicking on the Variable pane displays a menu from which you can do many common tasks:
• Edit variable properties to change the focus to the Variable Properties pane. This will expose

the Variable Properties pane if it has been automatically hidden.
• Keep only selected variables to keep only the selected variables in the dataset and to drop all

the others.
• Drop selected variables to drop all the selected variables from the dataset.
• Manage notes for selected variable... to open a window that allows adding and deleting notes

for a single variable. This is disabled if multiple variables are selected.
• Manage notes for dataset... to open a window that allows adding and deleting notes for the

dataset as a whole.
• Copy varlist to copy the names of the selected variables to the Clipboard.
• Select all to select all visible variables. If a variable has become hidden because of the filter,

it will not be selected.
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• Send varlist to Command window to insert the names of the selected variables in the Command
window. Combined with grouping and sorting, this can be a useful way to create variable lists
in large datasets.

• Print... to print the Variable pane. You can change the widths of the printed columns by
changing the widths of the columns in the Variables Manager.

The Variable properties pane
The Variable Properties pane can be used to manipulate the properties of variables selected in the

Variable pane. With one variable selected, you can manipulate all properties of the variable. With
many variables selected, you can change their formats or types as well as assign value labels all at
once. These fields work in the same fashion as those shown in Renaming and formatting variables
in [GSW] 6 Using the Data Editor. We can also manage the notes Stata allows you to attach to
variables and the dataset—we will show an example below.

The Variable Properties pane is, in actuality, a docking window, like those discussed in Auto Hide
and pinning in [GSW] 2 The Stata user interface. You can see this because of the pushpin in its
upper-right corner. If you click on the pushpin, the window will automatically hide when not in use.
You can also dock the window in another part of the Variables Manager window by dragging it by
its title bar to one of the docking guides.

Managing notes
Stata allows you to attach notes to both variables and the dataset as a whole. These are simple

text notes that you can use to document whatever you like—the source of the dataset, data collection
quirks associated with a variable, what you need to investigate about a variable, or anything else.

Start by selecting a variable in the Variable pane. We will work with the price variable. Click
on the Manage... button next to the Notes field, and you will see the following dialog appear:
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We will add a few notes:
1. Click on the Add button to add a note.
2. Type TS - started working. TS with a trailing space inserts a timestamp in the note.
3. Add two more notes. We added two notes about prices:

It is worth experimenting with adding, deleting, and editing notes. Notes can be an invaluable
memory aid when working on projects that last a long time. Anytime you manipulate notes in the
Notes Manager, you create Stata commands.
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Copying and pasting
One of the easiest ways to get data into Stata is often overlooked: you can copy data from most

applications that understand the concept of a table and then paste the data into the Data Editor. This
approach works for all spreadsheet applications, many database applications, some word-processing
applications, and even some webpages. Just copy the full range of data, paste it into the Data Editor,
and everything will probably work well. You can even copy a text file that has the pieces of data
separated by commas and then paste it into the Data Editor.

Suppose that your friend has a small dataset about some very old cars.

VW Rabbit,4697,25,1930,3.78
Olds 98,8814,21,4060,2.41
Chev. Monza,3667,,2750,2.73
,4099,22,2930,3.58
Datsun 510,5079,24,2280,3.54
Buick Regal,5189,20,3280,2.93
Datsun 810,8129,,2750,3.55

You would like to put these data into Stata. Doing so is easier than you think:
1. Clear out your current dataset by typing clear.
2. Copy the above data.
3. Open the Data Editor in edit mode.
4. Select Edit > Paste special....
5. Stata sees that the column delimiters are commas and shows how the data would look.
6. Click on the OK button.

You can see that Stata has imported the data nicely.

Later in this chapter, we would like to bring these data into Stata without copying and pasting, so
we would like to save them as a text file. Go back to the main Stata window, and click on the Do-file
Editor button, , to open a new Do-file Editor window. Paste the data in the Do-file Editor, then
click on the Save button. Navigate to your working directory, and save the file as a few cars.csv.
If you do not know what your working directory is, look in the status bar at the bottom of the main
Stata window.

Be careful if you are copying data from a spreadsheet because spreadsheets can contain special
formatting that ruins its rectangular form. Be sure that your spreadsheet does not contain blank rows,
blank columns, repeated headers, or merged cells because these can cause trouble. As long as your
spreadsheet looks like a table, you will be fine.

Commands for importing data

Copying and pasting is a great way to bring data into Stata, but if you need a clear audit trail for
your data, you will need another way to bring data into Stata. The rest of this chapter will explain
how to do this. You will also learn methods that lend themselves better to repetitive tasks and methods
for importing data from a wide variety of sources.
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Stata has various commands for importing data. The three main commands for reading non–Stata
datasets in text are

• import delimited, which is made for reading text files created by spreadsheet or database
programs or, more generally, for reading text files with clearly defined column delimiters such
as commas, tabs, semicolons, or spaces;

• infile, which is made for reading simple data that are separated by spaces or rigidly formatted
data aligned in columns; and

• infix, which is made for data aligned in columns but possibly split across rows.

Stata has other commands that can read other types of files and can even get data from external
databases without the need for an interim file:

• The import excel command can read Microsoft Excel files directly, either as an .xls or as
an .xlsx file.

• The import sas command can read native SAS files, so data can be transferred from SAS to
Stata in this fashion.

• The import spss command can read IBM SPSS Statistics files.
• The import sasxport5 command can read version SAS V5 Transport files. The import
sasxport8 command can read version SAS V8 Transport files.

• The odbc command can be used to pull data directly from any data sources for which you
have ODBC (Open Database Connectivity) drivers.

• The jdbc command allows you to load data from a database, execute SQL statements on a
database, and insert data into a database using JDBC (Java Database Connectivity) drivers.

Stata can import more formats; see [D] import for the full list.

Each command expects the file that it is reading to be in a specific format. This chapter will
explain some of those formats and give some examples. For the full description, consult the Data
Management Reference Manual.

The import delimited command

The import delimited command was developed to read in text files that were created by
spreadsheet or database programs because these are common formats for sharing datasets on the
Internet. All spreadsheet programs and most database applications have an option to save the dataset
as a text file with the columns delimited with either tab characters or commas. Some of these programs
also save the column titles (variable names, in Stata) in the text file.

To read in such a file, you have only to type import delimited filename, where filename is the
name of the text file. The import delimited command will figure out what the delimiter character
is (tab or comma) and what type of data is in each column. As always, if filename contains spaces,
put double quotes around the filename, and include the path if filename is not in the current working
directory.

By default, the import delimited command understands files that use the tab or comma as the
column delimiter automatically. If you have a file that uses another character as the delimiter, use
import delimited’s delimiters() option.

Earlier in this chapter, you saved a file called a few cars.csv in Copying and pasting. These
data correspond to the make, price, MPG, weight, and gear ratio of a few very old cars. The variable
names are not in the file (so import delimited will assign its own names), and the fields are
separated by commas. Clear out any existing data, then use import delimited to read the data in
this file. Because there are spaces in the filename, it must be enclosed in double quotes.
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� �
. clear

. import delimited "a few cars.csv"
(5 vars, 7 obs)� �

You can look at the data in the Data Editor, and it will look just like the earlier result from copying
and pasting. We will now list the data so that we can see them in the manual. The separator(0)
option suppresses the horizontal separator line that is drawn after every fifth observation by default.� �

. list, separator(0)

v1 v2 v3 v4 v5

1. VW Rabbit 4697 25 1930 3.78
2. Olds 98 8814 21 4060 2.41
3. Chev. Monza 3667 . 2750 2.73
4. 4099 22 2930 3.58
5. Datsun 510 5079 24 2280 3.54
6. Buick Regal 5189 20 3280 2.93
7. Datsun 810 8129 . 2750 3.55� �

If you want to specify better variable names, you can include the desired names in the command.
When you specify variable names, you must also use the using keyword before the filename.� �

. import delimited make price mpg weight gear_ratio using "a few cars.csv"
(5 vars, 7 obs)

. list, separator(0)

make price mpg weight gear_r~o

1. VW Rabbit 4697 25 1930 3.78
2. Olds 98 8814 21 4060 2.41
3. Chev. Monza 3667 . 2750 2.73
4. 4099 22 2930 3.58
5. Datsun 510 5079 24 2280 3.54
6. Buick Regal 5189 20 3280 2.93
7. Datsun 810 8129 . 2750 3.55� �

As a side note about displaying data, Stata listed gear ratio as gear r~o in the output from
list. gear r~o is a unique abbreviation for the variable gear ratio. Stata displays the abbreviated
variable name when variable names are longer than eight characters.
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To prevent Stata from abbreviating gear ratio, you could specify the abbreviate(10) option:� �
. list, separator(0) abbreviate(10)

make price mpg weight gear_ratio

1. VW Rabbit 4697 25 1930 3.78
2. Olds 98 8814 21 4060 2.41
3. Chev. Monza 3667 . 2750 2.73
4. 4099 22 2930 3.58
5. Datsun 510 5079 24 2280 3.54
6. Buick Regal 5189 20 3280 2.93
7. Datsun 810 8129 . 2750 3.55� �

For more information on the ~ abbreviation and on list, see [GSW] 10 Listing data and basic
command syntax.

We will use this dataset again in the next chapter, so we would like to save it. Type save afewcars,
and press Enter in the Command window to save the dataset.

For this simple example, you could have copied the contents of the file and pasted it into the Data
Editor by using Paste special... and choosing comma as the delimiter.

For text files that have no nice delimiters or for which observations could be spread out across
many lines, Stata has two more commands: infile and infix. See [D] import for more information
about how to read in such files.

Importing files from other software

Stata has some more specialized methods for reading data that were created by other applications
and stored in their proprietary formats.

The import excel command is made for reading files created by Microsoft Excel. See [D] import
excel for full details.

The import spss command is made for reading files created by IBM SPSS Statistics. See [D] import
spss for full details.

The import sas command is made for reading files created by SAS. See [D] import sas for full
details.

The import sasxport5 and import sasxport8 commands can read SAS V5 and SAS V8 Transport
files. See [D] import sasxport5 and [D] import sasxport8 for full details.

If you have software that supports ODBC, you can read data by using the odbc command without
the need to create interim files. See [D] odbc for full details.

The jdbc command allows you to connect to, load data from, insert data into, and execute queries
on a database using JDBC. See [D] jdbc for full details.

Here is a brief summary of the choices:
• If you have a Microsoft Excel .xls or .xlsx file, use import excel.
• If you have an IBM SPSS Statistics .sav file, use import spss.
• If you have a SAS .sas7bdat file created on a Windows machine, use import sas.
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• If you have a file exported from a spreadsheet or database application to a tab-delimited or CSV
file, use import delimited.

• If you have a fixed-format file, either use infile with a dictionary or use infix.
• If you have a database accessible with ODBC, use odbc.
• If you have a database accessible with JDBC, use jdbc.
• If you have a SAS V5 Transport file, use import sasxport5.
• If you have a SAS V8 Transport file, use import sasxport8.
• If you have economic data from the Federal Reserve Data, use import fred.
• If you subscribe to any Haver Analytics databases, use import haver.
• If you have a dBASE file, use import dbase.
• If you have a table, you could try copying it and pasting it into the Data Editor.
• Finally, you can purchase a third-party transfer program that will convert the other software’s

data file format to Stata’s data file format.
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Making data readable
This chapter discusses, in brief, labeling of the dataset, variables, and values. Such labeling is critical

to careful use of data. Labeling variables with descriptive names clarifies their meanings. Labeling
values of numerical categorical variables ensures that the real-world meanings of the encodings are
not forgotten. These points are crucial when sharing data with others, including your future self.
Labels are also used in the output of most Stata commands, so proper labeling of the dataset will
produce much more readable results. We will work through an example of properly labeling a dataset,
its variables, and the values of one encoded variable.

The dataset structure: The describe command
At the end of The import delimited command in [GSW] 8 Importing data, we saved a dataset

called afewcars.dta. We will put this dataset into a shape that a colleague would understand. Let’s
see what it contains.� �

. use afewcars

. list, separator(0)

make price mpg weight gear_r~o

1. VW Rabbit 4697 25 1930 3.78
2. Olds 98 8814 21 4060 2.41
3. Chev. Monza 3667 . 2750 2.73
4. 4099 22 2930 3.58
5. Datsun 510 5079 24 2280 3.54
6. Buick Regal 5189 20 3280 2.93
7. Datsun 810 8129 . 2750 3.55� �

The data allow us to make some guesses at the values in the dataset, but, for example, we do not
know the units in which the price or weight is measured, and the term “mpg” could be confusing for
people outside the United States. Perhaps we can learn something from the description of the dataset.
Stata has the aptly named describe command for this purpose (as we saw in [GSW] 1 Introducing
Stata—sample session).
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� �
. describe

Contains data from afewcars.dta
Observations: 7

Variables: 5 21 Jan 2021 16:24

Variable Storage Display Value
name type format label Variable label

make str18 %18s
price float %9.0g
mpg float %9.0g
weight float %9.0g
gear_ratio float %9.0g

Sorted by:� �
Though there is precious little information that could help us as a researcher, we can glean some
information here about how Stata thinks of the data from the first three columns of the output.

1. The Variable name is the name we use to tell Stata about a variable.

2. The Storage type (otherwise known as the data type) is the way in which Stata stores the data in
a variable. There are six different storage types, each having its own memory requirement:
a. For integers:

byte for integers between −127 and 100 (using 1 byte of memory per observation)
int for integers between −32,767 and 32,740 (using 2 bytes of memory per observation)
long for integers between −2,147,483,647 and 2,147,483,620 (using 4 bytes of memory
per observation)

b. For real numbers:
float for real numbers with 8.5 digits of precision (using 4 bytes of memory per
observation)
double for real numbers with 16.5 digits of precision (using 8 bytes of memory per
observation)

c. For strings (text) between 1 and 2,045 bytes (using 1 byte of memory per observation per
character for ASCII and up to 4 bytes of memory per Unicode character):

str1 for 1-byte-long strings
str2 for 2-byte-long strings
str3 for 3-byte-long strings
. . .

str2045 for 2,045-byte-long strings
d. Stata also has a strL storage type for strings of arbitrary length up to 2,000,000,000 bytes.

strLs can also hold binary data, often referred to as BLOBs, or binary large objects, in databases.
We will not illustrate these here.

Storage types affect both the precision of computations and the size of datasets. A quick guide to
storage types is available at help data types or in [D] Data types.

3. The Display format controls how the variable is displayed; see [U] 12.5 Formats: Controlling
how data are displayed. By default, Stata sets it to something reasonable given the storage type.

We would like to make this dataset into something containing all the information we need.
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To see what a well-labeled dataset looks like, we can look at a dataset stored at the Stata Press
repository. We need not load the data (and disturb what we are doing); we do not even need a
copy of the dataset on our machine. (You will learn more about Stata’s Internet capabilities in
[GSW] 19 Updating and extending Stata—Internet functionality.) All we need to do is direct
describe to look at the proper file by using the command describe using filename.� �

. describe using https://www.stata-press.com/data/r17/auto

Contains data 1978 automobile data
Observations: 74 13 Apr 2020 17:45

Variables: 12

Variable Storage Display Value
name type format label Variable label

make str18 %-18s Make and model
price int %8.0gc Price
mpg int %8.0g Mileage (mpg)
rep78 int %8.0g Repair record 1978
headroom float %6.1f Headroom (in.)
trunk int %8.0g Trunk space (cu. ft.)
weight int %8.0gc Weight (lbs.)
length int %8.0g Length (in.)
turn int %8.0g Turn circle (ft.)
displacement int %8.0g Displacement (cu. in.)
gear_ratio float %6.2f Gear ratio
foreign byte %8.0g origin Car origin

Sorted by: foreign� �
This output is much more informative. There are three locations where labels are attached that help
explain what the dataset contains:

1. In the first line, 1978 automobile data is the data label. It gives information about the contents
of the dataset. Data can be labeled by selecting Data > Data utilities > Label utilities > Label
dataset, by using the label data command, or by editing the Label field in the Data portion of
the Properties window. When doing this in the main window, be sure that the Properties window
is unlocked.

2. There is a variable label attached to each variable. Variable labels are how we would refer to
the variable in normal, everyday conversation. Here they also contain information about the units
of the variables. Variables can be labeled by selecting the variable in the Variables window and
editing the Label field in the Properties window. You can also change a variable label by using
the Variables Manager or by using the label variable command.

3. The foreign variable has an attached value label. Value labels allow numeric variables such
as foreign to have words associated with numeric codes. The describe output tells you that
the numeric variable foreign has value label origin associated with it. Although not revealed
by describe, the variable foreign takes on the values 0 and 1, and the value label origin
associates 0 with Domestic and 1 with Foreign. If you browse the data (see [GSW] 6 Using the
Data Editor), foreign appears to contain the values “Domestic” and “Foreign”. The values in a
variable are labeled in two stages. The value label must first be defined. This can be done in the
Data Editor, or in the Variables Manager, or by selecting Data > Data utilities > Label utilities
> Manage value labels or by typing the label define command. After the labels have been
defined, they must be attached to the proper variables, either by selecting Data > Data utilities
> Label utilities > Assign value label to variables or by using the label values command.
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Note: It is not necessary for the value label to have a name different from that of the variable.
You could just as easily have used a value label named foreign.

Labeling datasets and variables
We will now load the afewcars.dta dataset and give it proper labels. We will do this with

the Command window to illustrate that it is simple to do in this fashion. Earlier in Renaming and
formatting variables in [GSW] 6 Using the Data Editor, we used the Data Editor to achieve a similar
purpose. If you use the Data Editor for the material here, you will end up with the same commands
in your log; we would like to illustrate a way to work directly with commands.� �

. use afewcars

. describe

Contains data from afewcars.dta
Observations: 7

Variables: 5 21 Jan 2021 16:47

Variable Storage Display Value
name type format label Variable label

make str18 %18s
price float %9.0g
mpg float %9.0g
weight float %9.0g
gear_ratio float %9.0g

Sorted by:

. label data "A few 1978 cars"

. label variable make "Make and model"

. label variable price "Price (USD)"

. label variable mpg "Mileage (miles per gallon)"

. label variable weight "Vehicle weight (lbs.)"

. label variable gear_ratio "Gear ratio"

. describe

Contains data from afewcars.dta
Observations: 7 A few 1978 cars

Variables: 5 21 Jan 2021 16:47

Variable Storage Display Value
name type format label Variable label

make str18 %18s Make and model
price float %9.0g Price (USD)
mpg float %9.0g Mileage (miles per gallon)
weight float %9.0g Vehicle weight (lbs.)
gear_ratio float %9.0g Gear ratio

Sorted by:
Note: Dataset has changed since last saved.

. save afewcars2
file afewcars2.dta saved� �
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Labeling values of variables

We will now add a new indicator variable to the dataset that is 0 if the car was made in the United
States and 1 if it was made in another country. Open the Data Editor and use your previously gained
knowledge to add a foreign variable whose values match what is shown in this listing:� �

. list, separator(0)

make price mpg weight gear_r~o foreign

1. VW Rabbit 4697 25 1930 3.78 1
2. Olds 98 8814 21 4060 2.41 0
3. Chev. Monza 3667 . 2750 2.73 0
4. 4099 22 2930 3.58 0
5. Datsun 510 5079 24 2280 3.54 1
6. Buick Regal 5189 20 3280 2.93 0
7. Datsun 810 8129 . 2750 3.55 1� �

You can create this new variable in the Data Editor if you would like to work along. (See [GSW] 6 Using
the Data Editor for help with the Data Editor.) Though the definitions of the categories “0” and “1”
are clear in this context, it still would be worthwhile to give the values explicit labels because it will
make output clear to people who are not so familiar with antique automobiles. This is done with a
value label.

We saw an example of creating and attaching a value label by using the point-and-click interface
available in the Data Editor in Changing data in [GSW] 6 Using the Data Editor. Here we will do
it directly from the Command window.� �

. label define origin 0 "Domestic" 1 "Foreign"

. label values foreign origin

. describe

Contains data from afewcars2.dta
Observations: 7 A few 1978 cars

Variables: 6 21 Jan 2021 16:47

Variable Storage Display Value
name type format label Variable label

make str18 %18s Make and model
price float %9.0g Price (USD)
mpg float %9.0g Mileage (miles per gallon)
weight float %9.0g Vehicle weight (lbs.)
gear_ratio float %9.0g Gear ratio
foreign byte %8.0g origin

Sorted by:
Note: Dataset has changed since last saved.

. save afewcarslab
file afewcarslab.dta saved� �
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From this example, we can see that a value label is defined via

label define labelname # "contents" # "contents" . . .

It can then be attached to a variable via

label values variablename labelname

Once again, we need to save the dataset to be sure that we do not mistakenly lose the labels later.
We saved this under a new filename because we have cleaned it up, and we would like to use it in
the next chapter.

If you had wanted to define the value labels by using a point-and-click interface, you could do this
with the Properties window in either the Main window or the Data Editor or by using the Variables
Manager. See [GSW] 7 Using the Variables Manager for more information.

There is more to value labels than what was covered here; see [U] 12.6.3 Value labels for a
complete treatment.

You may also add notes to your data and your variables. This feature was previously discussed
in Renaming and formatting variables in [GSW] 6 Using the Data Editor and Managing notes in
[GSW] 7 Using the Variables Manager. You can learn more about notes by typing help notes, or
you can get the full story in [D] notes.
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Command syntax
This chapter gives a basic lesson on Stata’s command syntax while showing how to control the

appearance of a data list.

As we have seen throughout this manual, you have a choice between using menus and dialogs
and using the Command window. Although many find the menus more natural and the Command
window baffling at first, some practice makes working with the Command window often much faster
than using menus and dialogs. The Command window can become a faster way of working because
of the clean and regular syntax of Stata commands. We will cover enough to get you started; help
language has more information and examples, and [U] 11 Language syntax has all the details.

The syntax for the list command can be seen by typing help list:

list
[

varlist
] [

if
] [

in
] [

, options
]

Here is how to read this syntax:
• Anything inside square brackets is optional. For the list command,

a. varlist is optional. A varlist is a list of variable names.
b. if is optional. The if qualifier restricts the command to run only on those observations for

which the qualifier is true. We saw examples of this in [GSW] 6 Using the Data Editor.
c. in is optional. The in qualifier restricts the command to run on particular observation

numbers.
d. , and options are optional. options are separated from the rest of the command by a

comma.
• Optional pieces do not preclude one another unless explicitly stated. For the list command,

it is possible to use a varlist with if and in.
• If a part of a word is underlined, the underlined part is the minimum abbreviation. Any

abbreviation at least this long is acceptable.
a. The l in list is underlined, so l, li, and lis are all equivalent to list.

• Anything not inside square brackets is required. For the list command, only the command
itself is required.

Keeping these rules in mind, let’s investigate how list behaves when called with different arguments.
We will be using the dataset afewcarslab.dta from the end of the previous chapter.

list with a variable list
Variable lists (or varlists) can be specified in a variety of ways, all designed to save typing and

encourage good variable names.
• The varlist is optional for list. This means that if no variables are specified, it is equivalent to

specifying all variables. Another way to think of it is that the default behavior of the command
is to run on all variables unless restricted by a varlist.

• You can list a subset of variables explicitly, as in list make mpg price.
• There are also many shorthand notations:

m* means all variables starting with m.
price-weight means all variables from price through weight in the dataset order.
ma?e means all variables starting with ma, followed by any character, and ending in e.

78



[ GSW ] 10 Listing data and basic command syntax 79

• You can list a variable by using an abbreviation unique to that variable, as in list gear r~o.
If the abbreviation is not unique, Stata returns an error message.

� �
. list

make price mpg weight gear_r~o foreign

1. VW Rabbit 4697 25 1930 3.78 Foreign
2. Olds 98 8814 21 4060 2.41 Domestic
3. Chev. Monza 3667 . 2750 2.73 Domestic
4. 4099 22 2930 3.58 Domestic
5. Datsun 510 5079 24 2280 3.54 Foreign

6. Buick Regal 5189 20 3280 2.93 Domestic
7. Datsun 810 8129 . 2750 3.55 Foreign

. l make mpg price

make mpg price

1. VW Rabbit 25 4697
2. Olds 98 21 8814
3. Chev. Monza . 3667
4. 22 4099
5. Datsun 510 24 5079

6. Buick Regal 20 5189
7. Datsun 810 . 8129

. list m*

make mpg

1. VW Rabbit 25
2. Olds 98 21
3. Chev. Monza .
4. 22
5. Datsun 510 24

6. Buick Regal 20
7. Datsun 810 .

. li price-weight

price mpg weight

1. 4697 25 1930
2. 8814 21 4060
3. 3667 . 2750
4. 4099 22 2930
5. 5079 24 2280

6. 5189 20 3280
7. 8129 . 2750� �
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� �
. list ma?e

make

1. VW Rabbit
2. Olds 98
3. Chev. Monza
4.
5. Datsun 510

6. Buick Regal
7. Datsun 810

. l gear_r~o

gear_r~o

1. 3.78
2. 2.41
3. 2.73
4. 3.58
5. 3.54

6. 2.93
7. 3.55� �

list with if
The if qualifier uses a logical expression to determine which observations to use. If the expression

is true, the observation is used in the command; otherwise, it is skipped. The operators whose results
are either true or false are

< less than
<= less than or equal
== equal
> greater than
>= greater than or equal
!= not equal
& and
| or
! not (logical negation)
() parentheses are for grouping to specify order of evaluation

In the logical expressions, & is evaluated before | (similar to multiplication before addition in
arithmetic). You can use this in your expressions, but it is often better to use parentheses to ensure
that the expressions are evaluated in the proper order. See [U] 13.2 Operators for complete details.
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� �
. list

make price mpg weight gear_r~o foreign

1. VW Rabbit 4697 25 1930 3.78 Foreign
2. Olds 98 8814 21 4060 2.41 Domestic
3. Chev. Monza 3667 . 2750 2.73 Domestic
4. 4099 22 2930 3.58 Domestic
5. Datsun 510 5079 24 2280 3.54 Foreign

6. Buick Regal 5189 20 3280 2.93 Domestic
7. Datsun 810 8129 . 2750 3.55 Foreign

. list if mpg > 22

make price mpg weight gear_r~o foreign

1. VW Rabbit 4697 25 1930 3.78 Foreign
3. Chev. Monza 3667 . 2750 2.73 Domestic
5. Datsun 510 5079 24 2280 3.54 Foreign
7. Datsun 810 8129 . 2750 3.55 Foreign

. list if (mpg > 22) & !missing(mpg)

make price mpg weight gear_r~o foreign

1. VW Rabbit 4697 25 1930 3.78 Foreign
5. Datsun 510 5079 24 2280 3.54 Foreign

. list make mpg price gear if (mpg > 22) | (price > 8000 & gear < 3.5)

make mpg price gear_r~o

1. VW Rabbit 25 4697 3.78
2. Olds 98 21 8814 2.41
3. Chev. Monza . 3667 2.73
5. Datsun 510 24 5079 3.54
7. Datsun 810 . 8129 3.55

. list make mpg if mpg <= 22 in 2/4

make mpg

2. Olds 98 21
4. 22� �

In the listings above, we see more examples of Stata treating missing numerical values as large values,
as well as the care that should be taken when the if qualifier is applied to a variable with missing
values. See [GSW] 6 Using the Data Editor.
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list with if, common mistakes
Here is a series of listings with common errors and their corrections. See if you can find the errors

before reading the correct entry.� �
. list

make price mpg weight gear_r~o foreign

1. VW Rabbit 4697 25 1930 3.78 Foreign
2. Olds 98 8814 21 4060 2.41 Domestic
3. Chev. Monza 3667 . 2750 2.73 Domestic
4. 4099 22 2930 3.58 Domestic
5. Datsun 510 5079 24 2280 3.54 Foreign

6. Buick Regal 5189 20 3280 2.93 Domestic
7. Datsun 810 8129 . 2750 3.55 Foreign

. list if mpg=21
=exp not allowed
r(101);� �

The error arises because “equal” is expressed by ==, not by =. Corrected, it becomes� �
. list if mpg==21

make price mpg weight gear_r~o foreign

2. Olds 98 8814 21 4060 2.41 Domestic� �
Other common errors with logic:� �

. list if mpg==21 if weight > 4000
invalid syntax
r(198);

. list if mpg==21 and weight > 4000
invalid ’and’
r(198);� �

Joint tests are specified with &, not with the word and or multiple ifs. The if qualifier should be
if mpg==21 & weight>4000, not if mpg==21 if weight>4000. Here is its correction:� �

. list if mpg==21 & weight > 4000

make price mpg weight gear_r~o foreign

2. Olds 98 8814 21 4060 2.41 Domestic� �
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A problem with string variables:� �
. list if make==Datsun 510
Datsun not found
r(111);� �

Strings must be in double quotes, as in make=="Datsun 510". Without the quotes, Stata thinks that
Datsun is a variable that it cannot find. Here is the correction:� �

. list if make=="Datsun 510"

make price mpg weight gear_r~o foreign

5. Datsun 510 5079 24 2280 3.54 Foreign� �
Confusing value labels with strings:� �

. list if foreign=="Domestic"
type mismatch
r(109);� �

Value labels look like strings, but the underlying variable is numeric. Variable foreign takes on values
0 and 1 but has the value label that attaches 0 to “Domestic” and 1 to “Foreign” (see [GSW] 9 Labeling
data). To see the underlying numeric values of variables with labeled values, use the label list
command (see [D] label), or investigate the variable with codebook varname. We can correct the
error here by looking for observations where foreign==0.

There is a second construction that also allows the use of the value label directly.� �
. list if foreign==0

make price mpg weight gear_r~o foreign

2. Olds 98 8814 21 4060 2.41 Domestic
3. Chev. Monza 3667 . 2750 2.73 Domestic
4. 4099 22 2930 3.58 Domestic
6. Buick Regal 5189 20 3280 2.93 Domestic

. list if foreign=="Domestic":origin

make price mpg weight gear_r~o foreign

2. Olds 98 8814 21 4060 2.41 Domestic
3. Chev. Monza 3667 . 2750 2.73 Domestic
4. 4099 22 2930 3.58 Domestic
6. Buick Regal 5189 20 3280 2.93 Domestic� �
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list with in
The in qualifier uses a numlist to give a range of observations that should be listed. numlists

have the form of one number or first/last. Positive numbers count from the beginning of the dataset.
Negative numbers count from the end of the dataset. Here are some examples:� �

. list

make price mpg weight gear_r~o foreign

1. VW Rabbit 4697 25 1930 3.78 Foreign
2. Olds 98 8814 21 4060 2.41 Domestic
3. Chev. Monza 3667 . 2750 2.73 Domestic
4. 4099 22 2930 3.58 Domestic
5. Datsun 510 5079 24 2280 3.54 Foreign

6. Buick Regal 5189 20 3280 2.93 Domestic
7. Datsun 810 8129 . 2750 3.55 Foreign

. list in 1

make price mpg weight gear_r~o foreign

1. VW Rabbit 4697 25 1930 3.78 Foreign

. list in -1

make price mpg weight gear_r~o foreign

7. Datsun 810 8129 . 2750 3.55 Foreign

. list in 2/4

make price mpg weight gear_r~o foreign

2. Olds 98 8814 21 4060 2.41 Domestic
3. Chev. Monza 3667 . 2750 2.73 Domestic
4. 4099 22 2930 3.58 Domestic

. list in -3/-2

make price mpg weight gear_r~o foreign

5. Datsun 510 5079 24 2280 3.54 Foreign
6. Buick Regal 5189 20 3280 2.93 Domestic� �

Controlling the list output

The fine control over list output is exercised by specifying one or more options. You can use
sepby() to separate observations by variable. abbreviate() specifies the minimum number of
characters to abbreviate a variable name in the output. divider draws a vertical line between the
variables in the list.
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� �
. sort foreign

. list ma p g f, sepby(foreign)

make price gear_r~o foreign

1. 4099 3.58 Domestic
2. Buick Regal 5189 2.93 Domestic
3. Chev. Monza 3667 2.73 Domestic
4. Olds 98 8814 2.41 Domestic

5. Datsun 510 5079 3.54 Foreign
6. VW Rabbit 4697 3.78 Foreign
7. Datsun 810 8129 3.55 Foreign

. list make weight gear, abbreviate(10)

make weight gear_ratio

1. 2930 3.58
2. Buick Regal 3280 2.93
3. Chev. Monza 2750 2.73
4. Olds 98 4060 2.41
5. Datsun 510 2280 3.54

6. VW Rabbit 1930 3.78
7. Datsun 810 2750 3.55

. list, divider

make price mpg weight gear_r~o foreign

1. 4099 22 2930 3.58 Domestic
2. Buick Regal 5189 20 3280 2.93 Domestic
3. Chev. Monza 3667 . 2750 2.73 Domestic
4. Olds 98 8814 21 4060 2.41 Domestic
5. Datsun 510 5079 24 2280 3.54 Foreign

6. VW Rabbit 4697 25 1930 3.78 Foreign
7. Datsun 810 8129 . 2750 3.55 Foreign� �

The separator() option draws a horizontal line at specified intervals. When not specified, it defaults
to a value of 5.
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� �
. list, separator(3)

make price mpg weight gear_r~o foreign

1. 4099 22 2930 3.58 Domestic
2. Buick Regal 5189 20 3280 2.93 Domestic
3. Chev. Monza 3667 . 2750 2.73 Domestic

4. Olds 98 8814 21 4060 2.41 Domestic
5. Datsun 510 5079 24 2280 3.54 Foreign
6. VW Rabbit 4697 25 1930 3.78 Foreign

7. Datsun 810 8129 . 2750 3.55 Foreign� �
Break

If you want to interrupt a Stata command, click on the Break button, .

It is always safe to click on the Break button. After you click on Break, the state of the system
is the same as if you had never issued the original command.
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generate and replace
This chapter shows the basics of creating and modifying variables in Stata. We saw how to work

with the Data Editor in [GSW] 6 Using the Data Editor—this chapter shows how we would do this
from the Command window. The two primary commands used for this are

• generate for creating new variables. It has a minimum abbreviation of g.
• replace for replacing the values of an existing variable. It may not be abbreviated because it

alters existing data and hence can be considered dangerous.
The most basic form for creating new variables is generate newvar = exp, where exp is any kind
of expression . Of course, both generate and replace can be used with if and in qualifiers. An
expression is a formula made up of constants, existing variables, operators, and functions. Some
examples of expressions (using variables from auto.dta) would be 2 + price, weight^2 or
sqrt(gear ratio).

The operators defined in Stata are given in the table below:

Relational
Arithmetic Logical (numeric and string)

+ addition ! not > greater than
- subtraction | or < less than
* multiplication & and >= > or equal
/ division <= < or equal
^ power == equal

!= not equal
+ string concatenation

Stata has many mathematical, statistical, string, date, time-series, and programming functions. See
help functions for the basics, and see the Stata Functions Reference Manual for a complete list
and full details of all the built-in functions.

You can use menus and dialogs to create new variables and modify existing variables by selecting
menu items from the Data > Create or change data menu. This feature can be handy for finding
functions quickly. However, we will use the Command window for the examples in this chapter
because we would like to illustrate simple usage and some pitfalls.

Stata has some utility commands for creating new variables:
• The egen command is useful for working across groups of variables or within groups of

observations. See [D] egen for more information.
• The encode command turns categorical string variables into encoded numeric variables, while

its counterpart decode reverses this operation. See [D] encode for more information.
• The destring command turns string variables that should be numeric, such as numbers with

currency symbols, into numbers. To go from numbers to strings, the tostring command is
useful. See [D] destring for more information.

We will focus our efforts on generate and replace.
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generate
There are some details you should know about the generate command:
• The basic form of the generate command is generate newvar = exp, where newvar is a

new variable name and exp is any valid expression. You will get an error message if you try
to generate a variable that already exists.

• An algebraic calculation using a missing value yields a missing value, as does division by zero,
the square root of a negative number, or any other computation which is impossible.

• If missing values are generated, the number of missing values in newvar is always reported. If
Stata says nothing about missing values, then no missing values were generated.

• You can use generate to set the storage type of the new variable as it is generated. You might
want to create an indicator (0/1) variable as a byte, for example, because it saves 3 bytes per
observation over using the default storage type of float.

Below are some examples of creating new variables from the afewcarslab dataset, which we
created in Labeling values of variables in [GSW] 9 Labeling data. (To work along, start by opening
the automobile dataset with sysuse auto. We are using a smaller dataset to make shorter listings.)
The last example shows a way to generate an indicator variable for cars weighing more than 3,000
pounds. Logical expressions in Stata result in 1 for “true” and 0 for “false”. The if qualifier is used
to ensure that the computations are done only for observations where weight is not missing.
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� �
. use afewcarslab
(A few 1978 cars)

. list make mpg weight

make mpg weight

1. VW Rabbit 25 1930
2. Olds 98 21 4060
3. Chev. Monza . 2750
4. 22 2930
5. Datsun 510 24 2280

6. Buick Regal 20 3280
7. Datsun 810 . 2750

. * changing MPG to liters per 100km

. generate lphk = 3.7854 * (100 / 1.6093) / mpg
(2 missing values generated)

. label var lphk "Liters per 100km"

. * getting logarithms of price

. g lnprice = ln(price)

. * making an indicator of hugeness

. gen byte huge = weight >= 3000 if !missing(weight)

. l make mpg weight lphk lnprice huge

make mpg weight lphk lnprice huge

1. VW Rabbit 25 1930 9.408812 8.454679 0
2. Olds 98 21 4060 11.20097 9.084097 1
3. Chev. Monza . 2750 . 8.207129 0
4. 22 2930 10.69183 8.318499 0
5. Datsun 510 24 2280 9.800845 8.532869 0

6. Buick Regal 20 3280 11.76101 8.554296 1
7. Datsun 810 . 2750 . 9.003193 0� �
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replace

Whereas generate is used to create new variables, replace is the command used for existing
variables. Stata uses two different commands to prevent you from accidentally modifying your data.
The replace command cannot be abbreviated. Stata generally requires you to spell out completely
any command that can alter your existing data.� �

. list make weight

make weight

1. VW Rabbit 1930
2. Olds 98 4060
3. Chev. Monza 2750
4. 2930
5. Datsun 510 2280

6. Buick Regal 3280
7. Datsun 810 2750

. * will give an error because weight already exists

. gen weight = weight/1000
variable weight already defined
r(110);

. * will replace weight in lbs by weight in 1000s of lbs

. replace weight = weight/1000
(7 real changes made)

. list make weight

make weight

1. VW Rabbit 1.93
2. Olds 98 4.06
3. Chev. Monza 2.75
4. 2.93
5. Datsun 510 2.28

6. Buick Regal 3.28
7. Datsun 810 2.75� �

Suppose that you want to create a new variable, predprice, which will be the predicted price of the
cars in the following year. You estimate that domestic cars will increase in price by 5% and foreign
cars, by 10%.

One way to create the variable would be to first use generate to compute the predicted domestic
car prices. Then use replace to change the missing values for the foreign cars to their proper values.
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� �
. gen predprice = 1.05*price if foreign==0
(3 missing values generated)

. replace predprice = 1.10*price if foreign==1
(3 real changes made)

. list make foreign price predprice, nolabel

make foreign price predpr~e

1. VW Rabbit 1 4697 5166.7
2. Olds 98 0 8814 9254.7
3. Chev. Monza 0 3667 3850.35
4. 0 4099 4303.95
5. Datsun 510 1 5079 5586.9

6. Buick Regal 0 5189 5448.45
7. Datsun 810 1 8129 8941.9� �

Of course, because foreign is an indicator variable, we could generate the predicted variable with
one command:� �

. gen predprice2 = (1.05 + 0.05*foreign)*price

. list make foreign price predprice predprice2, nolabel

make foreign price predpr~e predpr~2

1. VW Rabbit 1 4697 5166.7 5166.7
2. Olds 98 0 8814 9254.7 9254.7
3. Chev. Monza 0 3667 3850.35 3850.35
4. 0 4099 4303.95 4303.95
5. Datsun 510 1 5079 5586.9 5586.9

6. Buick Regal 0 5189 5448.45 5448.45
7. Datsun 810 1 8129 8941.9 8941.9� �
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generate with string variables

Stata is smart. When you generate a variable and the expression evaluates to a string, Stata creates
a string variable with a storage type as long as necessary, and no longer than that. where is a str1
in the following example:� �

. list make foreign

make foreign

1. VW Rabbit Foreign
2. Olds 98 Domestic
3. Chev. Monza Domestic
4. Domestic
5. Datsun 510 Foreign

6. Buick Regal Domestic
7. Datsun 810 Foreign

. gen where = "D" if foreign=="Domestic":origin
(3 missing values generated)

. replace where = "F" if foreign=="Foreign":origin
(3 real changes made)

. list make foreign where

make foreign where

1. VW Rabbit Foreign F
2. Olds 98 Domestic D
3. Chev. Monza Domestic D
4. Domestic D
5. Datsun 510 Foreign F

6. Buick Regal Domestic D
7. Datsun 810 Foreign F

. describe where

Variable Storage Display Value
name type format label Variable label

where str1 %9s� �
Stata has some useful tools for working with string variables. Here we split the make variable into

make and model and then create a variable that has the model together with where the model was
manufactured:
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� �
. gen model = usubstr(make, ustrpos(make," ")+1,.)
(1 missing value generated)

. gen modelwhere = model + " " + where

. list make where model modelwhere

make where model modelw~e

1. VW Rabbit F Rabbit Rabbit F
2. Olds 98 D 98 98 D
3. Chev. Monza D Monza Monza D
4. D D
5. Datsun 510 F 510 510 F

6. Buick Regal D Regal Regal D
7. Datsun 810 F 810 810 F� �

There are a few things to note about how these commands work:
1. ustrpos(s1,s2) produces an integer equal to the first character in the string s1 at which

the string s2 is found or 0 if it is not found. In this example, ustrpos(make," ") finds the
position of the first space in each observation of make.

2. usubstr(s,start,len) produces a string of length len characters, beginning at character start
of string s. If c1 = ., the result is the string from character start to the end of string s.

3. Putting 1 and 2 together: usubstr(s,ustrpos(s," ")+1,.) will always give the string s
with its first word removed. Because make contains both the make and the model of each car,
and make never contains a space in this dataset, we have found each car’s model.

4. The operator “+”, when applied to string variables, will concatenate the strings (that is, join
them together). The expression "this" + "that" results in the string "thisthat". When the
variable modelwhere was generated, a space (" ") was added between the two strings.

5. The missing value for a string is nothing special—it is simply the empty string "". Thus the
value of modelwhere for the car with no make or model is " D" (note the leading space).

6. If your strings might contain Unicode characters, use the Unicode versions of the string functions,
as shown above. See [U] 12.4.2 Handling Unicode strings.
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clear, drop, and keep
In this chapter, we will present the tools for paring observations and variables from a dataset. We

saw how to do this using the Data Editor in [GSW] 6 Using the Data Editor; this chapter presents
the methods for doing so from the Command window.

There are three main commands for removing data and other Stata objects, such as value labels,
from memory: clear, drop, and keep. Remember that they affect only what is in memory. None
of these commands alter anything that has been saved to disk.

clear and drop all
Suppose that you are working on an analysis or a simulation and that you need to clear out Stata’s

memory so that you can impute different values or simulate a new dataset. You are not interested in
saving any of the changes you have made to the dataset in memory—you would just like to have
an empty dataset. What you do depends on how much you want to clear out: at any time, you can
have not only data but also metadata such as value labels, stored results from previous commands,
and stored matrices. The clear command will let you carefully clear out data or other objects; we
are interested only in simple usage here. For more information, see help clear and [D] clear.

If you type the command clear into the Command window, it will remove all variables and value
labels. In basic usage, this is typically enough. It has the nice property that it does not remove any
stored results, so you can load a new dataset and predict values by using stored estimation results from
a model fit on a previous dataset. See help postest and [U] 20 Estimation and postestimation
commands for more information.

If you want to be sure that everything is cleared out, use the command clear all. This command
will clear Stata’s memory of data and all auxiliary objects so that you can start with a clean slate.
The first time you use clear all while you have a graph or dialog open, you may be surprised
when that graph or dialog closes; this is necessary so that Stata can free all memory being used.

If you want to get rid of just the data and nothing else, you can use the command drop all.

drop
The drop command is used to remove variables or observations from the dataset in memory.
• If you want to drop variables, use drop varlist.
• If you want to drop observations, use drop with an if or an in qualifier or both.

94
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We will use the afewcarslab dataset to illustrate drop:� �
. use afewcarslab
(A few 1978 cars)

. list

make price mpg weight gear_r~o foreign

1. VW Rabbit 4697 25 1930 3.78 Foreign
2. Olds 98 8814 21 4060 2.41 Domestic
3. Chev. Monza 3667 . 2750 2.73 Domestic
4. 4099 22 2930 3.58 Domestic
5. Datsun 510 5079 24 2280 3.54 Foreign

6. Buick Regal 5189 20 3280 2.93 Domestic
7. Datsun 810 8129 . 2750 3.55 Foreign

. drop in 1/3
(3 observations deleted)

. list

make price mpg weight gear_r~o foreign

1. 4099 22 2930 3.58 Domestic
2. Datsun 510 5079 24 2280 3.54 Foreign
3. Buick Regal 5189 20 3280 2.93 Domestic
4. Datsun 810 8129 . 2750 3.55 Foreign

. drop if mpg > 21
(3 observations deleted)

. list

make price mpg weight gear_r~o foreign

1. Buick Regal 5189 20 3280 2.93 Domestic

. drop gear_ratio

. list

make price mpg weight foreign

1. Buick Regal 5189 20 3280 Domestic

. drop m*

. list

price weight foreign

1. 5189 3280 Domestic� �
These changes are only to the data in memory. If you want to make the changes permanent, you
need to save the dataset.
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keep

keep tells Stata to drop all variables except those specified explicitly or through the use of an if
or in expression. Just like drop, keep can be used with varlist or with qualifiers but not with both at
once. We use a clear command at the start of this example so that we can reload the afewcarslab
dataset:� �

. clear

. use afewcarslab
(A few 1978 cars)

. list

make price mpg weight gear_r~o foreign

1. VW Rabbit 4697 25 1930 3.78 Foreign
2. Olds 98 8814 21 4060 2.41 Domestic
3. Chev. Monza 3667 . 2750 2.73 Domestic
4. 4099 22 2930 3.58 Domestic
5. Datsun 510 5079 24 2280 3.54 Foreign

6. Buick Regal 5189 20 3280 2.93 Domestic
7. Datsun 810 8129 . 2750 3.55 Foreign

. keep in 4/7
(3 observations deleted)

. list

make price mpg weight gear_r~o foreign

1. 4099 22 2930 3.58 Domestic
2. Datsun 510 5079 24 2280 3.54 Foreign
3. Buick Regal 5189 20 3280 2.93 Domestic
4. Datsun 810 8129 . 2750 3.55 Foreign

. keep if mpg <= 21
(3 observations deleted)

. list

make price mpg weight gear_r~o foreign

1. Buick Regal 5189 20 3280 2.93 Domestic

. keep m*

. list

make mpg

1. Buick Regal 20� �
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The Do-file Editor
Stata comes with an integrated text editor called the Do-file Editor, which can be used for many

tasks. It gets its name from the term do-file, which is a file containing a list of commands for Stata
to run (called a batch file or a script in other settings). See [U] 16 Do-files for more information.
Although the Do-file Editor has advanced features that can help in writing such files, it can also be
used to build up a series of commands that can then be submitted to Stata all at once. This feature
can be handy when writing a loop to process multiple variables in a similar fashion or when doing
complex, repetitive tasks interactively.

To get the most from this chapter, you should work through it at your computer. Start by opening

the Do-file Editor, either by clicking on the Do-file Editor button, , or by typing doedit in the
Command window and pressing Enter .

The Do-file Editor toolbar
The Do-file Editor has 15 buttons. Many of the buttons share a similar purpose with their look-alikes

in the main Stata toolbar.

If you ever forget what a button does, hover the mouse pointer over a button, and a tooltip will
appear.

New: Open a new do-file in a new tab in the Do-file Editor.

Open: Open a do-file from disk in a new tab in the Do-file Editor.

Save: Save the current file to disk.

Print: Print the contents of the Do-file Editor.

Find: Open the Find dialog for finding text.

Cut: Cut the selected text and put it in the Clipboard.

Copy: Copy the selected text to the Clipboard.

Paste: Paste the text from the Clipboard into the current document.

Undo: Undo the last change.
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Redo: Undo the last undo.

Toggle bookmark: Turn on or off the bookmark on the current line. Bookmarks are a
way to move quickly within the do-file. They are quite useful in long do-files or when
debugging.

Previous bookmark: Go to the previous bookmark (if any).

Next bookmark: Go to the next bookmark (if any).

Show file in Viewer: Show the contents of the do-file in a Viewer window. This is
worthwhile when editing files that contain SMCL tags, such as log files or help files.

Execute (do): Run the commands in the do-file, showing all commands and their output.
If text is highlighted, the button becomes the Execute selection (do) button and will run
only the selected lines, showing all output. We will refer to this as the Do button.

Using the Do-file Editor
Suppose that we would like to analyze fuel usage for 1978 automobiles in a manner similar to

what we did in [GSW] 1 Introducing Stata—sample session. We know that we will be issuing many
commands to Stata during our analysis and that we want to be able to reproduce our work later
without having to type each command again.

We can do this easily in Stata: simply save a text file containing the commands. When that is
done, we can tell Stata to run the file and execute each command in sequence. Such a file is known
as a Stata do-file; see [U] 16 Do-files.

To analyze fuel usage of 1978 automobiles, we would like to create a new variable containing
gallons per mile. We would like to see how that variable changes in relation to vehicle weight for
both domestic and imported cars. Performing a regression with our new variable would be a good
first step.

To get started, click on the Do-file Editor button to open the Do-file Editor. After the Do-file
Editor opens, type the commands below into the Do-file Editor. Purposely misspell the name of the
foreign variable on the fifth line. (We are intentionally making some common mistakes and then
pointing you to the solutions. This will save you time later.)

* an example do-file
sysuse auto
generate gp100m = 100/mpg
label var gp100m "Gallons per 100 miles"
regress gp100m weight foreing
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Here is what your Do-file Editor should look like now:

You will notice that the color of the text changes as you type. The different colors are examples
of the Do-file Editor’s syntax highlighting. The colors and text properties of the syntax elements can
be changed by selecting Edit > Preferences... from the Do-file Editor menu bar and then clicking
on the Colors tab in the resulting window.

Syntax highlighting extends beyond highlighting Stata commands. You can switch the syntax
highlighting from Stata by going to the Language menu and choosing the language you would like.
The Language menu includes a selection for Markdown because Stata can process Markdown to create
dynamic documents. See [RPT] dyndoc for more information. This menu also contains selections for
Python and Java because Stata has both Python integration and Java integration. See [P] PyStata
integration and [P] Java integration for more information. Stata will default to the proper language
based on the extension of the file you are editing, but if the file has not been saved yet, you will
need to tell it what language to choose.

Also note that if you pause briefly as you type, the Do-file Editor will allow autocompletion of
words that are already in the do-file. Once the suggestions appear, more typing will narrow down the
possibilities. You can navigate the suggestions using the up- and down-arrow keys or keep typing to
narrow them to a single word. Once you have the word you like, pressing Enter will place the word
in your do-file.

Click on the Do button, , to execute the commands. Stata executes the commands in sequence,
and the results appear in the Results window:� �

. do C:\Users\Stata\AppData\Local\Temp\STD08000000.tmp

. * an example do-file

. sysuse auto
(1978 automobile data)

. generate gp100m = 100/mpg

. label var gp100m "Gallons per 100 miles"

. regress gp100m weight foreing
variable foreing not found
r(111);

.
end of do-file� �
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The do "C:\ . . . " command is how Stata executes the commands in the Do-file Editor. Stata saves
the commands from a do-file with unsaved changes to a temporary file and issues the do command to
execute them. Everything worked as planned until Stata saw the misspelled variable. The first three
commands were executed, but an error was produced on the fourth. Stata does not know of a variable
named foreing. We need to go back to the Do-file Editor and change the misspelled variable name
to foreign in the last line:

Click on the Do button again. Alas, Stata now fails on the first line—it will not overwrite the
dataset in memory that we changed.� �

. do C:\Users\Stata\AppData\Local\Temp\STD08000000.tmp

. * an example do-file

. sysuse auto
no; dataset in memory has changed since last saved
r(4);

.
end of do-file� �

We now have a choice for what we should do:
• We can put a clear command in our do-file as the very first command. This automatically

clears out Stata’s memory before the do-file tries to load auto.dta. This is convenient but
dangerous because it defeats Stata’s protection against throwing away changes without warning.

• We can type a clear command in the Command window to manually clear the dataset and
then process the do-file again. This process can be aggravating when building a complicated
do-file.

Here is some advice: Automatically clear Stata’s memory while debugging the do-file. Once the
do-file is in its final form, decide the context in which it will be used. If it will be used in a highly
automated environment (such as when certifying), the do-file should still automatically clear Stata’s
memory. If it will be used rarely, do not clear Stata’s memory. This decision will save much heartache.
We will add a clear option to the sysuse command to automatically clear the dataset in Stata’s
memory before the do-file runs:
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The do-file now runs well, as clicking on the Do button shows:� �
. do C:\Users\Stata\AppData\Local\Temp\STD08000000.tmp

. * an example do-file

. sysuse auto, clear
(1978 automobile data)

. generate gp100m = 100/mpg

. label var gp100m "Gallons per 100 miles"

. regress gp100m weight foreign

Source SS df MS Number of obs = 74
F( 2, 71) = 113.97

Model 91.1761694 2 45.5880847 Prob > F = 0.0000
Residual 28.4000913 71 .400001287 R-squared = 0.7625

Adj R-squared = 0.7558
Total 119.576261 73 1.63803097 Root MSE = .63246

p100m Coefficient Std. err. t P>|t| [95% conf. interval]

weight .0016254 .0001183 13.74 0.000 .0013896 .0018612
foreign .6220535 .1997381 3.11 0.003 .2237871 1.02032

_cons -.0734839 .4019932 -0.18 0.855 -.8750354 .7280677

.
end of do-file� �

You might want to select File > Save as... to save this do-file from the Do-file Editor. Later, you
could select File > Open to open it and then add more commands as you move forward with your
analysis. By saving the commands of your analysis in a do-file as you go, you do not have to worry
about retyping them with each new Stata session. Think hard about removing the clear option from
the first command.

After you have saved your do-file, you can execute the commands it contains by typing do filename,
where the filename is the name of your do-file.
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The File menu

The File menu of the Do-file Editor includes standard features found in most text editors. You
may choose any of these menu items: create a New > Do-file, Open an existing file, Save the current
file, save the current file under a new name with Save as..., or Print the current file. There are also
buttons on the Do-file Editor’s toolbar that correspond to these features.

Finally, you can create a New > Project... to keep track of collections of files used in a project.
These can be do-files, data files, graph files, or any other files you like. For more information on the
Project Manager, see [P] Project Manager.

The Edit menu

The Edit menu of the Do-file Editor includes the standard Undo, Redo, Cut, Copy, Paste, Delete,
and Find capabilities. There are also buttons on the Do-file Editor’s toolbar for easy access to these
capabilities. There are several other Edit menu features that you might find useful:

• You can select Insert file... to insert the contents of another file at the current cursor position
in the Do-file Editor.

• You can select the current line with Select line.
• You can delete the current line with Delete line.
• Find > Go to line... will allow you to jump to a specific line number. The line numbers are

displayed at the left and the lower-right of the Do-file Editor window.
• Advanced leads to a submenu with some programmer’s friends:

– Shift right indents the selection by one tab.
– Shift left unindents the selection by one tab.
– Re-indent indents the selection according to its nesting within blocks and programs.
– Toggle comment toggles //-style comments at the start of the selected lines.
– Add block comment puts a /* before and a */ after the selected region, commenting it

out.
– Remove block comment undoes the above.
– Make selection uppercase converts the selection to all capital letters.
– Make selection lowercase converts the selection to all lowercase letters.
– Complete word attempts to complete the current word based on words that are already

in the do-file. If there are multiple possibilities, all will be shown. You can either pick
the completion you would like or keep typing to narrow the choices.

– Convert to UTF-8... converts the current file to UTF-8 encoding.
– Convert line endings to macOS/Unix format (\n) converts the line endings for the current

file to macOS/Unix format.
– Convert line endings to Windows format (\r\n) converts the line endings for the current

file to Windows format.
– Convert tabs to spaces replaces any tab characters with spaces, leaving the spacing as

it currently appears.
– Convert leading spaces to tabs converts any spaces at the start of lines to tab characters.

The number of spaces per tab is determined by a preference setting.
– Convert all spaces to tabs converts spaces to tab characters wherever possible. The

number of spaces per tab is determined by a preference setting.
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Matching and balancing of parentheses ( ), braces { }, and brackets [ ] are also available from
the Edit menu. When you select Edit > Find > Match brace, the Do-file Editor looks at the character
immediately to the left and right of the cursor. If either is one of the characters that the editor can
match, the editor will find the matching character and place the cursor immediately in front of it. If
there is no match, the cursor will not move.

When you select Edit > Find > Balance braces, the Do-file Editor looks to the left and right of the
current cursor position or selection and creates a selection that includes the narrowest level of matching
braces. If you select Balance braces again, the editor will expand the selection to include the next
level of matching braces. If there is no match, the cursor will not move. Balancing braces is useful
for working with blocks of code defined by loops or if commands. See [P] foreach, [P] forvalues,
[P] while, and [P] if for more information.

Balance braces is easier to explain with an example. Type {now {is the} time} in the Do-file
Editor. Place the cursor between the words is and the. Select Edit > Find > Balance braces. The
Do-file Editor will select {is the}. If you select Balance braces again, the Do-file Editor will select
{now {is the} time}.

Text in Stata strings can include Unicode characters and is encoded as UTF-8 (see [U] 12.4.2 Handling
Unicode strings). However, you may have do-files, ado-files, or other text files that you used with
Stata 13 or earlier, and those files contain characters other than plain ASCII such as accented characters,
Chinese, Japanese, or Korean (CJK) characters, Cyrillic characters, and the like. If you open a file
that is not encoded in UTF-8, Stata prompts you to specify the encoding for the file so that it can
convert the file to UTF-8. If you cancel the conversion or choose the wrong encoding, you can try the
conversion again later using Convert to UTF-8. The conversion to UTF-8 can be undone by using
Edit > Undo and is not permanent until you save the do-file. For Stata datasets with characters
not encoded in UTF-8 or for bulk conversion of multiple Stata files, you should use the unicode
translate command.

Editing tip: You can click on the left margin near a line number to select the entire line and the
end-of-line characters. Doing so makes it easy to delete lines or cut lines and paste them elsewhere.
You can click and drag within the line-number column to select a range of complete lines.

The View menu
The View menu of the Do-File Editor allows you to zoom in and out or display special characters

such as tabs and line endings.

The Tools menu
You have already learned about the Do button. Selecting Tools > Execute (do) is equivalent to

clicking on the Execute (do) button.

Selecting Tools > Execute (do) from top will send all the commands from the first line to the
current line to the Command window. This method is a quick way to run a part of a do-file.

Selecting Tools > Execute (do) to bottom will send all the commands from the current line through
the end of the contents of the Do-file Editor to the Command window. This method is a quick way
to run a part of a do-file.

Selecting Tools > Execute quietly (run) is equivalent to Tools > Execute (do) but the commands
will be executed quietly; that is, no output will be displayed in the Command window.
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Selecting Tools > Execute (include) is similar to clicking on the Execute (do) button with one
major difference: local macros defined in the current session can be expanded in the commands being
executed.

Do is equivalent to Stata’s do command, whereas Execute (include) is equivalent to Stata’s
include command. See [U] 16 Do-files for a complete discussion.

You can also preview files in the Viewer by selecting Tools > Show file in Viewer or by clicking

on the Show file in Viewer button, . This feature is useful when working with files that use
Stata’s SMCL tags, such as when writing help files or editing log files.

Saving interactive commands from Stata as a do-file
While working interactively with Stata, you might decide that you would like to rerun the last

several commands that you typed interactively. From the History window, you can send highlighted
commands or even the entire contents to the Do-file Editor. You can also save commands as a do-file
and open that file in the Do-file Editor. You can copy a command from a dialog (rather than submit
it) and paste it into the Do-file Editor. See [GSW] 6 Using the Data Editor for details. Also see
[R] log for information on the cmdlog command, which allows you to log all commands that you
type in Stata to a do-file.

Navigating your do-file
When working with long files, bookmarks allow you to easily navigate through your do-file. By

placing a bookmark before important sections in your do-file, you can return to those sections more
easily later. You can add a bookmark line by using Edit > Toggle bookmark, clicking the Toggle
bookmark button on the toolbar, or by manually typing a line beginning with a special comment,
**#. All other text on the rest of the line is treated as the title of the bookmark. You cannot have
ado code on the same line as the bookmark comment, or the bookmark comment will be ignored.

You can move between bookmarks using the options in the Edit menu, the equivalent buttons on
the Do-file Editor toolbar, or the Navigation Control. The Navigation Control of the Do-file Editor
allows you to move between bookmarks as well as programs that you have defined in your do-file.
When you select a program or a bookmark from the Navigation Control, you will jump directly to
the position of that program or bookmark in your do-file.
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Bookmarks can also be removed with the Toggle bookmark option in the Edit menu or toolbar
as well as simply deleting the line. You can also add and remove bookmarks by clicking in the
bookmark margin next to the line you want to add the bookmark before. When you add a bookmark
line, the bookmark icon will be added in the bookmark margin to make it more visibly obvious for
you while scrolling.

Projects
For advanced users managing many files as part of a project, Stata has a Project Manager that

uses the Do-file Editor. For more information on the Project Manager, see [P] Project Manager.
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Working with graphs
Stata has a rich system for graphical representation of data. The main command for creating graphs

is unsurprisingly named graph. Behind this plain name is a wealth of tools. In this chapter, we will
make one simple graph to point out the basics of the Graph window. See the [G] Stata Graphics
Reference Manual for more information about all aspects of working with graphs.

A simple graph example
In the sample session of [GSW] 1 Introducing Stata—sample session, we made a scatterplot,

added a fitted regression line, and made a grid of scatterplots to allow comparisons across groups.
Here, using the automobile dataset, we make a simple box plot that shows the displacements of the
cars’ engines and how they compare across repair records within the place of manufacture of the cars.
Start by loading the dataset by typing sysuse auto in the Command window and pressing Enter .

We select Graphics > Box plot, choose or type displacement in the Variables field on the Main
tab, click on the Categories tab, check the Group 1 checkbox and enter rep78 for the first grouping
variable, and check the Group 2 checkbox and enter foreign for the second grouping variable.
Finally, we click on the Submit button so that we could easily make changes to the graph if need
be. After we look at the graph, we realize that we forgot the title. We close the Graph window, click
on the Titles tab of the graph box dialog, type the title Displacement across repairs within
origin, and click on the Submit button again.

The Graph window comes up, showing us our nicely titled graph:
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Graph window

When the Graph window comes up, it shows our graph in a window with a toolbar. The first four
buttons are familiar to us from other Stata windows: Open, Save, Print, and Copy. The next two
buttons are new:

Rename graph: This button allows the graph to be renamed. Why would you do this?
If you would like to have multiple graphs open at once, the graphs need to be named.
So you can click on the Rename graph button to give a graph a name. This graph will
then remain open when you create your next graph.

Graph Editor: Stata has a Graph Editor that allows you to manipulate and edit your
graph. This feature will be introduced in the next chapter.

The inactive buttons to the right of the Graph Editor button are used by the Graph Editor, so
their meanings will become clear in the next chapter.

We decide that we like this graph and would like to save it. We can save it either by clicking on
the Save button and choosing a name and a location or by right-clicking on the Graph window itself
and selecting Save as....

Saving and printing graphs
You can save a graph once it is displayed by right-clicking on its window and selecting Save as....

You can print a graph by right-clicking on its window and selecting Print.... You can also use the
File menu to save or print a graph. We recommend that you always right-click on a graph to save
or print it to ensure that the correct graph is selected.

Right-clicking on the Graph window
Right-clicking on the Graph window displays a menu from which you can select the following:
• Save as... to save the graph to disk.
• Copy to copy the graph to the Clipboard.
• Start Graph Editor to start the Graph Editor.
• Preferences... to edit the preferences for graphs.
• Print... to print the graph.

The Graph button

The Graph button, , is located on the main window’s toolbar. The button has two parts, an
icon and an arrow. Clicking on the icon brings the topmost Graph window to the front of all other
windows. Clicking on the arrow displays a menu of open graphs. Selecting a graph from the menu
brings that graph to the front of all other windows. If you close the Graph window, you can reopen
it only by reissuing a Stata command that draws a new graph.
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The Graph Editor

With Stata’s Graph Editor, you can change almost anything on your graph; you can add text, lines,
arrows, and markers wherever you like.

We will first make a graph to edit and will then point out the tools in the Graph Editor. Start by
opening the automobile dataset: sysuse auto. Here is the command that we will use to make the
graph:� �

. scatter mpg weight, name(mygraph) title(Mileage vs. vehicle weight)� �
Start the Editor by right-clicking on your graph and selecting Start Graph Editor. Click once on
the title of the graph. Here is a picture of the Graph Editor with its elements labeled.

Select any of the tools along the left of the Graph Editor window to edit the graph. The Pointer

(Select tool), , is selected by default.

108



[ GSW ] 15 Editing graphs 109

You can change the properties of objects or drag them to new locations by using the Pointer. As
you select objects with the Pointer, a Contextual Toolbar will appear just above the graph. In the
above example, the title of the graph is selected, so the Contextual Toolbar has controls that are
relevant for editing titles. You can use any of the controls on the Contextual Toolbar to immediately
change the most important properties of the selected object. Right-click on an object to access more
properties and operations. Hold the Shift key when dragging objects to constrain the movement to
horizontal or vertical directions.

Add text, lines, or markers (with optional labels) to your graph by using the three Add... tools—

, , and . Lines can be changed to arrows by using the Contextual Toolbar. If you do
not like the default properties, simply change their settings in the Contextual Toolbar before adding
the text, line, or marker. The new settings will then be applied to all added objects, even in future
Stata sessions.

Do not be afraid to try things. If you do not like a result, change it back by using the same tool

or by clicking on the Undo button, , in the Standard Toolbar for the Graph Editor (below the
main menu). Edit > Undo in the main menu does the same thing.

Remember to reselect the Pointer tool when you want to drag objects or change their properties.

You can move objects on the graph and have the rest of the objects adjust their position to

accommodate the move with the Grid edit tool, . With this tool, you are repositioning objects in
the underlying grid that holds the objects in the graph. Some graphs, for example, by graphs, are
composed of nested grids. You can reposition objects only within the grid that contains them; they
cannot be moved to other grids.

You can also select objects in the Object Browser along the right of the graph. This window shows
a hierarchical listing of the objects in the graph. Clicking or right-clicking on an object in the Object
Browser is the same as clicking or right-clicking on the object in the graph.

The Graph Editor has the ability to record your actions and play them back on later graphs. When

you click on the Start recording button, , every editing action you take, including undos and
redos, is recorded. If you would like to do some editing that is not recorded, you can click on the

Pause recording button, . You can click on the Pause recording button again to resume recording.
When you are done with your recording, click on the Start recording button. You will be prompted

to save your recording. Any recording you save is available from the Play recording button, ,
and may be applied to future graphs. You can even play a recording in any Stata graph command
by using the play option. See Graph Recorder in [G-1] Graph Editor for more information.

Stop the editor by selecting File > Stop Graph Editor from the main menu or by clicking on the
Graph Editor button. When you stop the Graph Editor, you will be prompted to save your graph if
you have made any changes. If you do not save your graph, your changes will not be lost, but you
will risk losing them if you create a new graph in the same Graph window. You must stop the Editor
if you would like to work on other tasks in Stata.

Here are a few of the things that you can do with the Editor:
• Add annotations using lines, arrows, and text.
• Add or remove grid lines or reference lines.
• Add or modify titles, captions, and notes.
• Change scatterplots to line plots, connected plots, areas, bars, spikes, or drop lines—and, of

course, vice versa.
• Change the size, color, margin, and other properties of your graph’s titles (or any other text on

the graph).
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• Move your legend to another side of the graph, or even place it in the plot region.
• Change the aspect ratio of your graph.
• Stack the bars on a bar graph or turn them into percentages.
• Rotate or change the angle of axis labels.
• Add custom ticks and labels to the axes.
• Change the rule for the number and spacing of ticks and labels on an axis.
• Emphasize a point on the graph, whether marker, bar, spike, or other plot, by making it a

custom color, size, or symbol.
• Change the text or properties of a marker label.

Because you can edit every property of every object on the graph, you can change almost anything
about your graph. To learn more, see [G-1] Graph Editor or type help graph editor.



16 Saving and printing results by using logs

Using logs in Stata
When you work on an analysis, it is worthwhile to behave like a bench scientist and keep a

lab notebook of your actions so that your work can be easily replicated. Everyone has a feeling of
complete omniscience while working intensely—this feeling is wonderful but fleeting. The next day,
the exact small details needed for perfect duplication have become obscure. Stata has a lab notebook
at hand: the log file.

A log file is simply a record of your Results window. It records all commands and all textual
output as it happens. Thus it keeps your lab notebook for you as you work. Because it writes the
file to disk while it writes the Results window, it also protects you from disastrous failures, be they
power failures or computer crashes. We recommend that you start a log file whenever you begin any
serious work in Stata.

Logging output

All the output that appears in the Results window can be captured in a log file. Stata can save the
file in one of two different formats. By default, Stata will save the file in its Stata Markup and Control
Language (SMCL) format, which preserves all the formatting and links from the Results window.
You can open these results in the Viewer, and they will behave as though they were in the Results
window. If you would rather have plain-text files without any formatting, you can save the file as
a plain log file. We recommend using the SMCL format because SMCL files can be translated into a
variety of formats readable by applications other than Stata with the File > Log > Translate... menu
(see [R] translate).

To start a log file, click on the Log button, . This will open a standard file dialog that allows
you to specify a directory and filename for your log. If you do not specify a file extension, the
extension .smcl will be added to the filename. If you specify a file that already exists, you will be
asked whether you want to append the new log to the file or overwrite the file with the new log.
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Here is an example of a short session:� �
name: <unnamed>
log: C:\Users\Stata\Documents\Stata\base.smcl

log type: smcl
opened on: 25 Jan 2021, 16:47:40

. sysuse auto
(1978 automobile data)

. by foreign, sort: summarize price mpg

-> foreign = Domestic

Variable Obs Mean Std. dev. Min Max

price 52 6072.423 3097.104 3291 15906
mpg 52 19.82692 4.743297 12 34

-> foreign = Foreign

Variable Obs Mean Std. dev. Min Max

price 22 6384.682 2621.915 3748 12990
mpg 22 24.77273 6.611187 14 41

. * be sure to include the above stats in report!

. * now for something completely different

. corr price mpg
(obs=74)

price mpg

price 1.0000
mpg -0.4686 1.0000

. log close
name: <unnamed>
log: C:\Users\Stata\Documents\Stata\base.smcl

log type: smcl
closed on: 25 Jan 2021, 16:47:41� �

There are a few items of interest.
• The header showing the log file’s location, type, and starting timestamp is part of the log file.

This feature helps when working with multiple log files.
• The two lines starting with asterisks (*) are comments. Stata ignores the text following the

asterisk, so you may type any comment you would like, with any special characters you would
like. Commenting is a good way to document your thought process and to mark sections of
the log for later use.

• In this example, the log file was closed by using the log close command. Doing so is not
strictly necessary because log files are automatically closed when you exit Stata.

Stata allows multiple log files to be open at once only if the log files are named. For details on
this topic, see help log.
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Working with logs
Log files are best viewed using Stata’s Viewer. Select File > Log > View.... If there is a log file

open (as shown by the status bar), it will be the default log file to view; otherwise, you need to either
type the name of the log file into the dialog or click on the Browse... button to find the file with a
standard file dialog.

Once you are in the Viewer window, everything behaves as expected: you can copy text and paste
between the Viewer and anything else that uses text, such as word processors or text editors. You can
even paste into the Command window or the Do-file Editor, but you should take care to copy only
commands, not their output. It is okay to copy the prompt (“.”) at the start of the echoed command
because Stata is smart enough to ignore it in the Command window. When working with a word
processor, what you paste will be unformatted text; it will look best if you use a fixed-width font,
like Courier, to display it.

Viewing your current log file is a good way to keep a reminder of something you have already
done or a view of a previous result. The Viewer window takes a snapshot of your log file and hence
will not scroll as you keep working in Stata. If you need to see more recent results in the Viewer,
click on the Reload page button.

For more detailed information about logs, see [U] 15 Saving and printing output—log files and
[R] log. For more information about the Viewer, see [GSW] 3 Using the Viewer.

Printing logs
To print a standard SMCL log file, you need to have the log file open in a Viewer window. Once

the log file is in the Viewer, you can click on the Print button, right-click on the Viewer window,
and select Print..., or select File > Print.... A Print dialog will appear. After you click on Print, a
Print settings dialog will appear.

• You can fill in none of, any of, or all the items Header, Name, and Project. You can check or
uncheck options to Print line numbers, Print header, and Print logo. These items are saved and
will appear again in the print sheet Print settings (in this and in future Stata sessions).

• You can set the font, margins, and color scheme that the printer will use by clicking on Prefs... in
the Print settings dialog to open the Printer preferences dialog. Monochrome is for black-and-white
printing, Color is for default color printing, and Custom 1 and Custom 2 are for customized color
printing. You can set the font by clicking on the Font... button. The resulting Font dialog will list
only the fixed-width “typewriter” fonts (for example, Courier) available for your printer.

You could also use the translate command to generate a PostScript or PDF version of the log
file. See [R] translate for more information.

If your log file is a plain-text file (.log instead of .smcl), you can open it in a text editor, such as
Notepad, in the Do-file Editor or in your favorite word processor. You can then edit the log file—add
headings, comments, etc.—format it, and print it. If you bring the log file into a word processor,
it will be displayed and printed with its default font. The log file will not be easily readable when
printed in a proportionally spaced font (for example, Times New Roman or Georgia). It will look
much better printed in a fixed-width font (for example, Courier New).

You may wish to associate the .log extension with a text editor (such as Notepad or WordPad)
in Windows. You can then edit and print the logs from those Windows applications if you like.
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Rerunning commands as do-files
Stata also can log just the commands from a session without recording the output. This feature is

a convenient way to make a do-file interactively. Such a file is called a cmdlog file by Stata. You
can start a cmdlog file by typing

cmdlog using filename.do

and you can close the cmdlog file by typing

cmdlog close

Here, for example, is what a cmdlog of the previous session would look like. It contains only
commands and comments and hence could be used as a do-file.� �

sysuse auto
by foreign, sort: summarize price mpg
* be sure to include the above stats in report!
* now for something completely different
corr price mpg� �

If you start working and then wish you had started a cmdlog file, you can save yourself heartache
by saving the contents of the History window. The History window stores the last 5,000 commands
you have typed. Simply right-click on the History window and select Save all... from the menu. This
will work best if you first filter out all the commands that resulted in errors as was shown in The
History window in [GSW] 2 The Stata user interface. If you would like to move the commands
directly to the Do-file Editor, select Select all followed by Send selected to Do-file Editor. You may
find this method a more convenient way to create a text file containing only the commands that you
typed during your session.

See [GSW] 13 Using the Do-file Editor—automating Stata, [U] 16 Do-files, and [U] 15 Saving
and printing output—log files for more information.
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Changing and saving fonts and sizes and positions of your windows

You may find that you would like to change the fonts and display style of Stata’s windows,
depending on your monitor resolution and personal preferences. At the same time, there could be
requirements for font usage, say, when you submit graphs to journals. Stata accommodates both of
these by allowing sets of preferences for how windows are displayed.

We will first cover what can be changed in each window and then talk about what you can manage
with your preferences.

Graph window

The preferences for the Graph window can be changed by right-clicking on the Graph window
and choosing Preferences... from the contextual menu. The settings can then be set for how graphs
are displayed in Stata. The settings that should be used when printing can be set under the Printer
tab. The behavior of the Clipboard is controlled under the Clipboard tab.

The Graph preferences allow different schemes that control the look of graphs. These schemes
provide a quick way to optimize graphs for printing or to display on a screen. There are even schemes
defined for The Economist and the Stata Journal so that you can get the details for these publications
right without much fuss. Changing the scheme does not change the current graph—it applies the
settings to future graphs.

All other windows
You can change the display font and font size for most types of windows in Stata.

If fonts and font sizes for a window can be changed, they can be changed by right-clicking on the
window and selecting Font... from the contextual menu. Doing so will bring up the Font dialog, from
which you can pick the font and size of your choice. The font lists for each of the Results, Viewer,
Data Editor, and Do-file Editor windows are restricted to fixed-width fonts only. This restriction
ensures that output and numbers line up properly and are readable. The other windows can have any
font that you would like without any adverse consequences.

Changing color schemes

In addition to changing the fonts themselves, you can also change the background and foreground
colors of text being displayed. In the Do-file Editor, you can choose the colors for syntax highlighting,
allowing, say, Stata commands to be displayed in a different color from arbitrary text. You can control
the overall color scheme by selecting a scheme in the General tab of the General preferences.
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The Results and Viewer windows have color schemes that control the display of input, text,
results, errors, links, and highlighted text. Each has its color scheme set in the same fashion: you can
right-click on the window and select or design your own color scheme. The default setting for both
the Results window and the Viewer is the built-in Standard scheme, which uses a white background
and dark text. There are other built-in schemes as well as slots for custom schemes. The settings for
the Viewer affect all Viewer windows at once. Choosing an overall scheme from the General tab
will reset all custom settings to the settings determined by that scheme.

Managing multiple sets of preferences
Stata’s preferences are automatically saved when you exit Stata, and they are reloaded when Stata

is launched. However, sometimes you may wish to rearrange Stata’s windows and then revert to your
preferred arrangement of windows. You can do this by saving your preferences to a named preference
set and loading them later. Any changes you make to Stata’s preferences after loading a preferences
set do not affect the set; the set remains untouched unless you specifically overwrite it.

To manage preferences, open the Edit > Preferences menu, and do any of the following:
• Select a preference set from the Load preference set menu to load it. Several different

preference sets come installed with Stata, some meant for small screens, others meant for giving
presentations involving Stata. They are worth a look.

• Select Save preference set > New preference set... to save the current preferences to a set.
Enter a name for the set, and click on OK.

• Select an existing set from the Save preference set menu to overwrite it with the current
preferences.

• Select a preference set from the Delete preference set menu to delete it. Click on OK to verify
that you wish to delete the set.

Closing and opening windows

You can close all windows but the Results and Command windows. If you want to open a closed
window, open the Window menu and select the desired window.
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Where to go from here

You now know plenty enough to use Stata. There is still much, much more to learn because Stata
is a rich environment for doing statistical analysis and data management. What should you do to
learn more?

• Get an interesting dataset and play with Stata.
a. Use the menus and dialog system to experiment with commands. Notice what commands

show up in the Results window. You will find that Stata’s simple and consistent command
syntax will make the commands easy to read so that you will know what you have done
and easy to remember so that typing some commands will be faster than using menus.

b. Play with graphs and the Graph Editor.
• If you venture into the Command window, you will find that many things will go faster. You

will also find that it is possible to make mistakes where you cannot understand why Stata is
balking.

a. Try help commandname or Help > Stata command... and entering the command name.
b. Look at the command syntax and the examples in the help file, and compare them

with what you typed. Compare them closely: small typographical errors make commands
impossible for Stata to parse.

• Explore Stata by selecting Help > Search.... You will uncover many statistical routines that
could be of great use.

• Look through the Combined subject table of contents in the Stata Index.
• Read and work your way through the User’s Guide . It is designed to be read from cover to

cover, and it contains most of the information you need to become an expert Stata user. It is
well worth reading. If you are not this ambitious and instead prefer to sample the User’s Guide
and the references, there is some advice later in this chapter for you.

• Browse through the reference manuals to read about statistical methods you like to use, making
use of the links to jump to other topics. The reference manuals are not meant to be read from
cover to cover—they are meant to be referred to as you would an encyclopedia. You can find
the datasets used in the examples in the manuals by selecting File > Example datasets... and
then clicking on Stata 17 manual datasets. Doing so will enable you to work through the
examples quickly.

• Stata has much information, including answers to frequently asked questions (FAQs), at
https://www.stata.com/support/faqs/.

• There are many useful links to Stata resources at https://www.stata.com/links/. Be sure to look
at these materials because many outstanding resources about Stata are listed here.

• Join Statalist, a forum devoted to discussion of Stata and statistics.
• Read The Stata Blog: Not Elsewhere Classified at https://blog.stata.com to read articles written

by people at Stata about all things Stata.
• Visit Stata on Facebook at https://facebook.com/statacorp,

join Stata on Instagram at https://www.instagram.com/statacorp,
find Stata on LinkedIn at https://www.linkedin.com/company/statacorp,
and follow Stata on Twitter at https://twitter.com/stata to keep up with Stata.

• Subscribe to the Stata Journal, which contains reviewed papers, regular columns, book reviews,
and other material of interest to researchers applying statistics in a variety of disciplines. Visit
https://www.stata-journal.com.
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• Many supplementary books about Stata are available. Visit the Stata Bookstore at
https://www.stata.com/bookstore/.

• Take a Stata NetCourse R©. NetCourse 101 is an excellent choice for learning about Stata. See
https://www.stata.com/netcourse/ for course information and schedules.

• Attend a classroom or a web-based training course taught by StataCorp. Visit
https://www.stata.com/training/classroom-and-web/ for course information and schedules.

• View a webinar led by Stata developers. Visit https://www.stata.com/training/webinar/ for the
current list of topics and schedule.

• Watch Stata videos at https://www.youtube.com/user/statacorp.

Suggested reading from the User’s Guide and reference manuals
The User’s Guide is designed to be read from cover to cover. The reference manuals are designed

as references to be sampled when necessary.

Ideally, after reading this Getting Started manual, you should read the User’s Guide from cover
to cover, but you probably want to become at least somewhat proficient in Stata right away. Here is
a suggested reading list of sections from the User’s Guide and the reference manuals to help you on
your way to becoming a Stata expert.

This list covers fundamental features and points you to some less obvious features that you might
otherwise overlook.

Basic elements of Stata
[U] 11 Language syntax
[U] 12 Data
[U] 13 Functions and expressions

Data management
[U] 6 Managing memory
[U] 22 Entering and importing data
[D] import — Overview of importing data into Stata
[D] append — Append datasets
[D] merge — Merge datasets
[D] compress — Compress data in memory
[D] frames intro — Introduction to frames

Graphics
[G] Stata Graphics Reference Manual

Reproducible research
[U] 16 Do-files
[U] 17 Ado-files
[U] 13.5 Accessing coefficients and standard errors
[U] 13.6 Accessing results from Stata commands
[U] 21 Creating reports

[RPT] Dynamic documents intro — Introduction to dynamic documents
[RPT] putdocx intro — Introduction to generating Office Open XML (.docx) files
[RPT] putexcel — Export results to an Excel file
[RPT] putpdf intro — Introduction to generating PDF files
[R] log — Echo copy of session to file
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Useful features that you might overlook
[U] 29 Using the Internet to keep up to date
[U] 19 Immediate commands
[U] 24 Working with strings
[U] 25 Working with dates and times
[U] 26 Working with categorical data and factor variables
[U] 27 Overview of Stata estimation commands
[U] 20 Estimation and postestimation commands
[R] estimates — Save and manipulate estimation results

Basic statistics
[R] anova — Analysis of variance and covariance
[R] ci — Confidence intervals for means, proportions, and variances
[R] correlate — Correlations of variables
[D] egen — Extensions to generate
[R] regress — Linear regression
[R] predict — Obtain predictions, residuals, etc., after estimation
[R] regress postestimation — Postestimation tools for regress
[R] test — Test linear hypotheses after estimation
[R] summarize — Summary statistics
[R] table intro — Introduction to tables of frequencies, summaries, and command results
[R] tabulate oneway — One-way table of frequencies
[R] tabulate twoway — Two-way table of frequencies
[R] ttest — t tests (mean-comparison tests)

Matrices
[U] 14 Matrix expressions
[U] 18.5 Scalars and matrices
[M] Mata Reference Manual

Programming
[U] 16 Do-files
[U] 17 Ado-files
[U] 18 Programming Stata
[R] ml — Maximum likelihood estimation
[P] Stata Programming Reference Manual
[M] Mata Reference Manual

System values
[R] set — Overview of system parameters
[P] creturn — Return c-class values
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Internet resources
The Stata website (https://www.stata.com) is a good place to get more information about Stata.

You will find answers to FAQs, ways to interact with other users, official Stata updates, and other
useful information. You can also join Statalist, a forum devoted to discussion of Stata and statistics.

You will also find information on Stata NetCourses R©, which are interactive courses offered over
the Internet that vary in length from a few weeks to eight weeks. Stata also offers in-person and
web-based training sessions, as well as webinars on Stata features. Visit https://www.stata.com/learn/
for more information.

At the website is the Stata Bookstore, which contains books that we feel may be of interest to
Stata users. Each book has a brief description written by a member of our technical staff explaining
why we think this book may be of interest.

We suggest that you take a quick look at the Stata website now. You can register your copy of
Stata online and request a free subscription to the Stata News.

Visit https://www.stata-press.com for information on books, manuals, and journals published by
Stata Press. The datasets used in examples in the Stata manuals are available from the Stata Press
website.

Also visit https://www.stata-journal.com to read about the Stata Journal, a quarterly publication
containing articles about statistics, data analysis, teaching methods, and effective use of Stata’s
language.

Visit Stata’s official blog at https://blog.stata.com for news and advice related to the use of Stata.
The articles appearing in the blog are individually signed and are written by the same people who
develop, support, and sell Stata. The Stata Blog: Not Elsewhere Classified also has links to other
blogs about Stata, written by Stata users around the world.

Follow Stata on Facebook at https://facebook.com/statacorp, Twitter at https://twitter.com/stata,
Instagram at https://www.instagram.com/statacorp, and LinkedIn at
https://www.linkedin.com/company/statacorp. You may also follow Stata on Twitter at
https://twitter.com/stata fr or https://twitter.com/stata es. These are good ways to stay up-to-the-
minute with the latest Stata information. Watch short example videos of using Stata on YouTube at
https://www.youtube.com/user/statacorp.

See [GSW] 19 Updating and extending Stata—Internet functionality for details on accessing
official Stata updates and free additions to Stata on the Stata website.

https://www.stata.com
https://www.stata.com/learn
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https://www.linkedin.com/company/statacorp
https://twitter.com/stata_fr
https://twitter.com/stata_es
https://www.youtube.com/user/statacorp
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Internet functionality in Stata
Stata works well with the Internet. Stata can use datasets and view remote help files as though

they were on your computer. Stata also can keep itself up to date (with your permission, of course).
Finally, you can install community-contributed commands, which are commands that extend Stata’s
functionality. These are commands that have been presented in the Stata Journal (SJ) or the Stata
Technical Bulletin (STB) or have simply been written and shared by the greater Stata community.

This chapter will show you how you can expand Stata’s horizons.

Using files from the Internet
Stata understands URLs as though they were local file locations. If you know of a file on the web

that you would like to use, be it a dataset, a graph, or a do-file, you can easily open it in Stata. Here
is a small example.

There are many datasets at https://www.stata-press.com/data/. Suppose that you would like to
use the census12 dataset used in [U] 11 Language syntax and that you know that its location is
https://www.stata-press.com/data/r17/census12.dta. Because you know that the command for opening
a dataset is use, you could type the following:� �

. use https://www.stata-press.com/data/r17/census12.dta
(1980 Census data by state)

. describe

Contains data from https://www.stata-press.com/data/r17/census12.dta
Observations: 50 1980 Census data by state

Variables: 7 6 Apr 2020 15:43

Variable Storage Display Value
name type format label Variable label

state str14 %14s State
state2 str2 %-2s Two-letter state abbreviation
region str7 %9s Census region
pop long %10.0g Population
median_age float %9.2f Median age
marriage_rate float %9.0g
divorce_rate float %9.0g

Sorted by:� �
This functionality is everywhere in Stata. Any command that reads a file with a filename in its syntax
can use a web address as easily as a file that is stored on your computer.

This example used the HTTP protocol for retrieving the file. Stata also understands the HTTPS and
FTP protocols.
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Official Stata updates
By official Stata, we mean the pieces of Stata that are provided and supported by StataCorp.

The other and equally important pieces are the community-contributed additions published in the SJ,
distributed over Statalist, or distributed in other ways.

Stata can fetch both official updates and community-contributed commands from the Internet. Let’s
start with the official updates. StataCorp often releases updates to official Stata. These updates add
new features and, sometimes, fix bugs.

By default, Stata has automatic update checking turned on and set to check for updates every
seven days. To change or check your settings, select Edit > Preferences > General preferences...
and click on the General tab.

We recommend using automatic update checking because it is a simple, unobtrusive way to be
sure that your copy of Stata is always up to date. If you keep this default, you will be prompted with
a dialog when you start Stata if you have not recently checked for updates.

To manually check whether there are any official Stata updates, either click on Help > Check for
updates or type update query in the Command window. Regardless of which choice you make,
Stata goes to check for official updates. After it checks, it will show you your update status. If your
copy of Stata is already up to date, you will be told. If your copy of Stata needs updating, you will
be told, and a link, Install available updates, will show up in your Results window. You can
click on this link or type update all and press Enter . In either case, Stata will download what is
needed to bring your copy of Stata up to date. Stata will need to restart after being updated, so it
gives you a chance to postpone the update in case there was something (such as saving the command
history) you wanted to do in the current session.

Troubleshooting note: If you do not have write permission for C:\Program Files\Stata17, you
cannot install official updates in this way. You may still download the official updates, but you will
need to use the command-line version of update; see [U] 29 Using the Internet to keep up to date
for instructions.

Automatic update checking

Stata can periodically check for updates for you. By default, Stata will check once every seven
days for updates from the StataCorp website. The seven-day interval is from the last time an update
query was performed, regardless of whether it was by Stata or by you. You can change the interval
between checks.

Before Stata connects to the Internet to check for an update, it will ask you if you would like to
check now, check the next time Stata is launched, or check after the next interval. You can disable
the prompt and allow Stata to check without asking.

If an update is available, Stata will notify you. From there, you should follow the recommendations
for updating Stata.

You can change the settings for automatic update checking by selecting Edit > Preferences >
General preferences... and choosing General.
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Finding community-contributed commands by keyword
Stata has a built-in utility created specifically to search the Internet for community-contributed

Stata commands. You can access it by selecting Help > Search..., choosing Search net resources, and
entering a keyword in the field. Choosing Help > SJ and community-contributed features yields
more specific choices for searching. The utility searches all community-contributed commands on the
Internet, including the entire collection of SJ and STB commands. The results are displayed in the
Viewer, and you can click to go to any of the matches found.

For the syntax on how to use the equivalent search keywords, net command, see [R] search.

Downloading community-contributed commands
Downloading community-contributed commands is easy. Start by selecting Help > SJ and

community-contributed features:

As the Viewer says, try Search... first.

Suppose that you were interested in finding more information or some community-contributed
commands involving goodness of fit for logistic regression. You select Help > Search..., select Search
all, type logistic goodness of fit in the search box, and click on the OK button.
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The first entry points you to all the postestimation commands that are available after logistic
regression. The second entry points to Stata’s built-in estat gof command specifically for computing
goodness-of-fit statistics after logistic regression. You investigate this command and find it interesting.
You see that the next three links point to FAQs and examples on UCLA’s website. Then the next three
links are for articles in the SJ. You are interested in multinomial logistic regression, so you decide to
check the last of these links. It points to an article in the SJ, volume 12, number 3 (third quarter).
You should click on the st0269 link because it will go to the command associated with this article.

You will see that the package has one help file for the new commands. Click the
st0269/mlogitgof.sthlp link to see if the mlogitgof command looks interesting. If you decide
that you would like to install the command, click the Back button and click on the link click here
to install. If you decide that you would like to use some of the ancillary files—files that typically
help explain the workings of the command, you could download those, too. You do not need to
worry—doing so will not interfere in any way with your copy of Stata. We will show you how to
safely uninstall these commands shortly.
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You can keep the community-contributed commands you have installed up to date by using the ado
update command. Typing ado update will check for updates, while typing ado update, update
will check for updates and install any available updates.

Now suppose that you decide that you would like to uninstall the package. Doing so is simple
enough: select Help > SJ and community-contributed features, and click on the List link. You
should see the following:
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If you click on the one-line description of the package, you will see the full description of what
has been installed. Here is what you would see if you scroll to the bottom, with a different install
date, of course:

You can uninstall materials by clicking on click here to uninstall when you are looking at
the package description.

For information on downloading community-contributed commands by using the net command,
see [R] net.
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A.1 If Stata does not start
You tried to start Stata and it refused; Stata or your operating system presented a message explaining

that something is wrong. Here are the possibilities:

Cannot find license file
This message means just what it says; nothing is too seriously wrong. Stata simply could not find
the license file it was looking for. The most common reason for this is that you did not complete
the installation process.

Did you enter the codes on your license to unlock Stata? If not, go back and complete the
initialization procedure.

Error opening or reading the file
Something is distinctly wrong for purely technical reasons. Stata found the file that it was looking
for, but there was an I/O error.

About the only way this situation could arise would be a hard-disk error. Stata technical support
will be able to help you diagnose the problem; see [U] 3.8 Technical support.

License not applicable
Stata has determined that you have a valid Stata license, but the license does not apply to the
version of Stata that you are trying to run.

The most common reason for this message is that you have a license for Stata/BE but you are
trying to run Stata/SE or Stata/MP, or you have a license for Stata/SE but you are trying to run
Stata/MP. If any of these is the case, insert the installation DVD, run the installer again, choose
Modify, click on the Next button, and choose the appropriate edition.

Other messages
The other messages indicate that Stata thinks you are attempting to do something that you are
not licensed to do. Most commonly, you are attempting to run Stata over a network when you
do not have a network license, but there are many other alternatives. There are two possibilities:
either you really are attempting to do something that you are not licensed to do or Stata is wrong.
In either case, you are going to have to contact us. Your license can be upgraded, or if Stata is
wrong, we can provide codes to make Stata stop thinking that you are violating the license; see
[U] 3.8 Technical support.
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A.2 Troubleshooting tips
If you experience an unexpected problem, first make sure that you are running the most current

version of Stata (see [GSW] 19 Updating and extending Stata—Internet functionality for information
on updating). If the problem still exists, look at the frequently asked questions (FAQs) for Windows in
the user-support section of the Stata website, https://www.stata.com/support/faqs/windows/. You may
find the answer to the problem there. If not, we can help, but you must give us as much information
as possible.

Reboot your computer, restart Stata, and try to reproduce the problem, writing down everything
you do before the fault occurs. We will want that information.

If Stata used to work on your computer but suddenly stopped working, try to remember any
hardware or software that you have recently installed.

Also give us as much information about your computer as possible. What version of Windows are
you running? How much memory do you have? What processor do you have? What brand is your
computer? Finally, we need your Stata serial number and the revision date of your version of Stata.
Include them if you email, and know them if you call. You can obtain them by typing the about
command in Stata’s Command window. about lets you know everything about your copy of Stata,
including the version and the date it was produced.

https://www.stata.com/support/faqs/windows/
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B.1 The Windows Properties Sheet

When you double-click on a shortcut to start an application in Windows, you are actually executing
instructions defined in the shortcut’s Properties Sheet. To open the Properties Sheet for any shortcut,
right-click on the shortcut, and select Properties.

Open the Properties Sheet for Stata’s shortcut. Click on the Shortcut tab. You will see something
like the following:

StataSE
Target type: Application
Target location: Stata17
Target: C:\Program Files\Stata17\StataSE.exe /UseRegistryStartin

Start in:
Shortcut key: None
Run: Normal window

The field names may be slightly different, depending on the version of Windows that you are
running. The names and locations of files may vary from this. There are two things to pay attention
to: the Target and Start in fields. Target is the actual command that is executed to invoke Stata. Start
in is the directory to switch to before invoking the application. You can change these fields and then
click on OK to save the updated Properties Sheet.

You can have Stata start in any directory you desire. If necessary, delete the parameter /UseReg-
istryStartin from your Target field. Then change the Start in field of Stata’s Properties Sheet to
the location you would like Stata to have as its default working directory. Of course, once Stata is
running, you can change directories whenever you wish by using File > Change working directory...;
see also [D] cd.
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B.2 Making shortcuts

You can arrange to start Stata without going through the Start menu by creating a shortcut on the
Desktop. The easiest way to do this is to copy the existing Stata shortcut to the Desktop. You can
also create a shortcut directly from the Stata executable. Here are the details:

1. Open the C:\Program Files\Stata17 folder or the folder where you installed Stata.

2. In the folder, find the executable for which you want a new shortcut. The filenames for the 64-bit
versions of Stata are

Stata/MP: StataMP-64.exe
Stata/SE: StataSE-64.exe
Stata/BE: Stata-64.exe

Right-click on and drag the appropriate executable onto the Desktop.

3. Release the mouse button, and select Create Shortcut(s) Here from the menu that appears.

You have now created a shortcut. If you want the shortcut in a folder rather than on the Desktop,
you can drag it into whatever folder appeals to you.

You set the properties for this shortcut just as you would normally. Right-click on the shortcut,
and select Properties. Edit the Properties Sheet as explained above in [GSW] B.1 The Windows
Properties Sheet.

B.3 Executing commands every time Stata is started

Stata looks for the file profile.do when it is invoked and, if it finds it, executes the commands
in it. Stata looks for profile.do first in the directory where Stata is installed, then in the current
directory, then along your path, then in your home directory as defined by Windows’s USERPROFILE
environment variable (typically C:\Users\username), and finally along the ado-path (see [P] sysdir).
We recommend that you put profile.do in your home directory.

If you create a shortcut that starts in a different directory, it will run the profile.do from that
directory. This feature allows you to have different profile.do files for different projects.

Say that every time you start Stata, you would like to start a dated log for the session. In your
default working directory, say, C:\Users\Stata\Documents\Stata, create the file profile.do
containing this rather odd-looking command:

log using ‘: display %tCCCYY-NN-DD-HH-MM-SS ///
Clock("‘c(current_date)’ ‘c(current_time)’","DMYhms")’, ///
name(default_log_file)

When you invoke Stata, the usual opening appears but with the following additional command,
which will be executed:

running C:\Users\Stata\Documents\Stata\profile.do ...

How does the command work? Let’s work from the inside out:
• c(current date) and c(current time) are local system macros containing the current

date and current time. See [P] creturn for more information.
• The left (‘) and right (’) quotes around the local macros expand them. See [P] macro for a

full explanation.
• The Clock() function uses the resulting date string and the date mask "DMYhms" to create a

datetime number Stata understands. See [D] Datetime.
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• The format %tCCCYY-NN-DD-HH-MM-SS formats this number in year-month-day-hour-minute-
second form because this will make the files sort nicely. See [D] Datetime display formats for
the details.

• The odd-looking ‘: display ...’ allows the formatted date to be used directly in the command
as the file name. This is the advanced concept of an in-line expansion of a macro function.
You can see more in [P] macro.

• The log using command starts a log file, such as shown in [GSW] 16 Saving and printing
results by using logs.

• The name option gives the log file the internal name default log file so that it will not
likely conflict with other log files. See [R] log for details.

• Finally, the /// notations are continuation comments so that the three separate lines are
interpreted as a single command. See [P] comments for more about comments.

There are many advanced Stata programming concepts in this one single command!

profile.do is treated just as any other do-file once it is executed; results are just the same as if
you had started Stata and then typed run profile.do. The only special thing about profile.do
is that Stata looks for it and runs it automatically.

System administrators might also find sysprofile.do useful. This file is handled in the same
way as profile.do, except that Stata first looks for sysprofile.do. If that file is found, Stata
will execute any commands it contains. After that, Stata will look for profile.do and, if that file
is found, execute the commands in it.

One example of how sysprofile.do might be useful would be when system administrators want
to change the path to one of Stata’s system directories. Here sysprofile.do could be created to
contain the command

sysdir set SITE "\\Matador\StataFiles"

See [U] 16 Do-files for an explanation of do-files. They are nothing more than text files containing
sequences of commands for Stata to execute.

B.4 Other ways to launch Stata
The first time that you start Stata for Windows, Stata registers with Windows the actions to

perform when you double-click on certain types of files. You can then start a new instance of Stata by
double-clicking on a Stata .dta dataset, a Stata .do do-file, or a Stata .gph graph file. In all cases,
your current working directory will become the folder containing the file you have double-clicked.

Stata will behave as you would expect in each case. If you double-click on a dataset, Stata will
open the dataset after Stata starts. If you double-click on a graph, the graph will be opened by Stata.
If you double-click on a do-file, the do-file will be opened in the Do-file Editor.

If you would rather run a do-file directly, right-click on the do-file. You will see menu items for
Execute (do) and Execute quietly (run). These items will complete the requested action in a new
instance of Stata.

If you want to edit a do-file, look at a graph, or open a dataset without starting a new instance of
Stata, drag the file over Stata’s main window.
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B.5 Stata batch mode
You can run large jobs in Stata in batch mode. There are a few different ways to do this, depending

on what your goals are.

Method 1

If you have a particular location where your log file should be after the job is done, this is the
method you should use.

In Windows 10, type cmd in the search box in the taskbar, and press Enter .

In Windows 8, point your mouse at the hotspot in the right corner of the screen to access the
Charms Sidebar, select the search charm, and start typing command in the search field. Once the
list of possible applications shrinks down to just the Command Prompt app, press Enter . In older
versions of Windows, click on the Start menu and choose Run.... If you are working on Windows 7
and do not see the Run... menu item, then you need to click on Start > All Programs > Accessories
> Run. In the Open field, type

cmd

and press Enter .

You should now have a command prompt window open. Change the current directory to the
place you would like the log file to be by using the cd command. For example, suppose your
bigjob do-file is in C:\Users\someone\statastuff, and you would like to save your log in
C:\Users\someone\statalogs. You would type the following to suppress all screen output and
place the log file in the proper location:

cd C:\Users\someone\statalogs
"C:\Program Files\Stata17\StataSE.exe" /e do "C:\Users\someone\statastuff\bigjob"

You must specify the location of the Stata executable.

The /e parameter above tells Stata how to behave when running in batch mode. The available
parameters and their purposes are

Parameter Result
/b set background (batch) mode and log in plain text

/e set background (batch) mode and log in plain text without prompting
when Stata command has completed

/q suppress logo and initialization messages

/rngstream# set random-number generator to mt64s (see [R] set rng) and set
random-number stream to # (see [R] set rngstream)

/s set background (batch) mode and log in SMCL

Method 2

If you would like to have a batch job that you could run at a particular time or that you could
save for later use, you can use the Task Scheduler, which is part of most Windows installations.

This is a bit more advanced, and its implementation differs slightly for each kind of Windows,
but here is the general gist.
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In Windows 10, you can search for the Task Scheduler in the search box in the taskbar. In
Windows 8, you can search for the Task Scheduler by using the search charm. In earlier versions of
Windows, you can generally find the Task Scheduler by clicking Start > All Programs > Accessories
> System Tools > Task Scheduler. Once you have opened the Task Scheduler, click on Create Basic
Task, and follow the steps of the Basic Task Schedule Wizard to schedule a do-file to run in batch
mode. You must specify the /b or /e option. In the Start in field, type the path where you would
like the log file to be saved. When this file runs, all output will be suppressed and written to a log
file that will be saved in the path specified.

General notes
While your do-file is executing, the Stata icon will appear on the taskbar.

If you click on the icon on the taskbar, Stata will display a box asking if you want to cancel the
batch job.

Once the do-file is complete, Stata will flash the icon on the taskbar on and off. You can then
click on the icon to close Stata. If you wish for Stata to automatically exit after running the batch
do-file, use /e rather than /b.

You do not have to run large do-files in batch mode. Any do-file that you run in batch mode can
also be run interactively. Simply start Stata, type log using filename, and type do filename. You
can then watch the do-file run, or you can minimize Stata while the do-file is running.

B.6 Running simultaneous Stata sessions
Each time you double-click on the Stata icon or launch Stata in any other way, you invoke a new

instance of Stata, so if you want to run multiple Stata sessions simultaneously, you may. The title
bar of each new Stata that is invoked will reflect its instance number.

B.7 Changing Stata’s locale

To change the locale of Stata to English, type

set locale_ui en

To change it back to match the locale set for your operating system, type

set locale_ui default

For a complete explanation of locales and Stata, see [U] 12.4.2.4 Locales in Unicode.
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B.8 More
If you would like Stata to pause every time the screen fills with results, type set more on. This

will cause a more prompt to appear at the bottom of the Results window whenever there is more
information to be displayed than can fit on the screen. This happens, for example, when you are
listing many observations.� �

. list make mpg

make mpg

1. Linc. Continental 12
2. Linc. Mark V 12
3. Cad. Deville 14
4. Cad. Eldorado 14
5. Linc. Versailles 14

6. Merc. Cougar 14
7. Merc. XR-7 14
8. Peugeot 604 14
9. Buick Electra 15

10. Merc. Marquis 15

11. Buick Riviera 16
12. Chev. Impala 16
13. Dodge Magnum 16
14. Olds Toronado 16
15. AMC Pacer 17

16. Audi 5000 17
17. Dodge St. Regis 17
18. Volvo 260 17
19. Buick LeSabre 18
20. Dodge Diplomat 18

more� �
If you want to see the next screen of text, you have a few options: press any key, such as the Spacebar;

click on the More button, ; or click on the more link at the bottom of the Results window.
To see just the next line of text, press Enter . Pressing q will interrupt the command. If you click
on the arrow of the More button, you can also select the Run to completion menu item to let the
command completely finish.

B.9 Memory size considerations
Memory management in Stata is automatic. For details on efficiency tweaks needed by a very few

Stata users, look at [D] memory.
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C.1 Using Stata datasets and graphs created on other platforms

Stata will open any Stata .dta dataset or .gph graph file regardless of the platform on which
it was created, even if it was a Mac or Unix system. Also Stata for Mac and Stata for Unix users
can use any files that you create. If you transfer a Stata file by using file transfer protocol (FTP), just
remember to transfer by using binary mode rather than ASCII.

C.2 Exporting a Stata graph to another document
Suppose that you wish to export a Stata graph to a document created by your favorite word

processor or presentation application. You have two main choices for exporting graphs: you may copy
and paste the graph by using the Clipboard, or you may save the graph in one of several formats and
import the graph into the application.

C.2.1 Exporting the graph by using the Clipboard

The easiest way to export a Stata graph into another application is by copying and pasting.

Either create your graph or redisplay an existing graph. To copy it to the Clipboard, right-click
on the Graph window, and select Copy. Stata will copy the graph as an Enhanced Metafile (EMF);
this ensures that the receiving application obtains it in the highest resolution possible.

A metafile contains the commands necessary to redraw the graph. That is, a metafile is a collection
of lines, points, text, and color information. Metafiles, therefore, can be edited in a structured drawing
program.

After you have copied the graph to the Clipboard, switch to the application into which you wish
to import the graph and paste it. In most applications, this is accomplished by selecting Edit > Paste.
Consult the documentation for your particular application for more details.
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C.2.2 Exporting the graph to a file

Stata can export graphs to several different file formats. If you right-click on a graph, select Save
as..., and then click on the drop-down menu next to Save as type, you will see that Stata can save
in the following file types:

Enhanced Metafile (EMF, .emf), Enhanced PostScript (EPS, .eps) with or without a TIFF Preview,
Joint Photographic Experts Group (JPEG, .jpg) with High Quality or Maximum Quality, Portable
Document Format (PDF, .pdf), Portable Network Graphics (PNG, .png), PostScript (PS, .ps), Scalable
Vector Graphics (SVG, .svg), and Tag Image File Format (TIFF, .tif).

EMF, EPS, PDF, PS, and SVG are vector formats, whereas JPEG, PNG, and TIFF are bitmap formats.
If you wish to include a thumbnail of the graph with an EPS file, choose EPS with TIFF Preview
(*.eps). Choosing the preview option does not affect how the graph is printed. PNG and SVG are well
suited for placing graphs on a webpage. See [G-2] graph export for more information.

C.3 Installing Stata for Windows on a network drive
You will need a network license before you can install Stata on a network drive. You can install

Stata from the server; or if you have the appropriate privileges, you can install Stata directly to the
network drive.

Once Stata is installed, run it to initialize the license. Mount the network drive that Stata is installed
on from a workstation. Right-click on the Desktop or on the Windows Start menu, and select New
> Shortcut. Type the path for the Stata executable into the edit field, or click on Browse... to locate
it. Type Stata as the name of the shortcut.

Once a shortcut for Stata has been created, right-click on it, and select Properties. Set the default
working directory for Stata by changing the Start in field to a local drive that users have write access
to. This is where Stata will store datasets, graphs, and other Stata-related files. If the workstation
will be used by more than one user, consider changing the Start in field to the environment variable
%HOMEDRIVE%%HOMEPATH%. Doing so will set the default working directory to each user’s home
directory.

C.4 Calling Stata from Python
You can call Stata from Python using the pystata Python package. This includes a suite of API func-

tions and IPython magic commands that can be used to interact with Stata and Mata. To learn more about
the pystata Python package, view the online documentation at https://www.stata.com/python/pystata.
Or see [P] PyStata module for more information.

C.5 Changing a Stata for Windows license
If you have already installed Stata and your license needs to be changed, go to Help > About

Stata, then click on the Update license... button on the lower left. You can either browse renewal
options or enter a new License and Activation Key.

https://www.stata.com/python/pystata
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automatic update checking, see updates, automatic
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batch mode, 133–134
blog, see Stata Blog
Break button, see button, Break
browse command, 2, 7, 62
button,

Break, 24, 86
Clear more condition, 24, 135
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Data Editor (Edit), 24, 48, 50
Do, see button, Execute (do)
Do-file Editor, 24, 98
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Open, 24
Print, 24
Reset, 18
Run, see button, Execute (do)
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compared with menus, 21
downloading and installing, 123–125
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uninstalling, 126
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copying,

data, see data, copying
graphs, see graphs, copying
text, see text, copying
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D
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importing, see importing data
labeling, 72–77
listing, 78–86
pasting, 53, 67
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browse mode, 62
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cell navigation, 52
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cursor location box, 50–52, 55
date

editing, 59–60
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mask, 59–60

edit mode toolbar button, 24
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enter data by row, 50
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filtering, 9, 61
fonts, 115
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tips, 60, 70
toolbar, 48
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when to browse, 60
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opening, 46, 136
saving, 46
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dates, editing, see Data Editor, date editing
db command, 29
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Submit button, 29
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directory, working, see working directory
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Do,
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menu item, 103

do-file, 98–101, 104, 114, 131
editing, see Do-file Editor
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toggle bookmark, 98
toolbar button, 24
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Execute (do) to bottom, 103
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Show file in Viewer, 104

View menu, 103
docking guides, see windows, docking guides
docking windows, see windows, docking
drop command, 94–95
dropping variables, see variables, dropping
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dynamic documents, 118
dyndoc command, 99

E
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editing data, see Data Editor
editing dates, see Data Editor, date editing
editing do-file, see Do-file Editor
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EMF, 136
Encapsulated Postscript, see EPS
encode command, 87
Enhanced Metafile, see EMF
EPS, 137
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dialogs, 4, 5, 7, 8, 10–16, 18, 28, 106
graphs, 15–20, 106, 108
help, 38–41
if qualifier, 7, 12, 61–62, 80–83, 95–96
in qualifier, 84
menus, 1, 3–5, 7, 8, 10–16, 18, 28–29, 106
varlist, 61, 78–80

Excel, see import excel command
exp, see expressions
expressions, 80, 87

F
Facebook, 117, 120
Federal Reserve Economic Data, 71



140 Subject index

filenames, quotes, 46
files, double-clicking, 132
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changing in one graph, see Graph Editor
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preferences, see preferences, font

functions, 87

G

generate command, 17, 18, 20, 88–93
tips, 91
troubleshooting, 90

generating variables, see variables, creating
Google+, 117
Graph Editor, 108–110

abilities, 109
closing, see Graph Editor, stopping
contextual toolbar, 108–109
experimentation, 109
Grid edit tool, 109
Object Browser, 109
recording, 109
starting, 108
stopping, 109
tools, 109
Undo button, 109

graph setup, see graphs, schemes
Graph window, 16, 107

contextual menu, 107
right-clicking, 107–108
toolbar button, 24

Graphical User Interface, see GUI
graphs,

copy and paste, 136
copying, 107
editing, see Graph Editor
examples, see examples, graphs
export formats, 137
exporting, 136
overlaid, 18–20
printing, 20, 107
renaming, 107
right-clicking, 107
saving, 107
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GUI, 23–32

H

Haver Analytics databases, 71
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help for command, 37

help system, 38–45
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menu, 38
search dialog, 38
searching, 38–45, 123–125
tips, 41
videos, 38, 43
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filtering, 27
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reusing commands, 27, 57
right-click, 27, 114
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tip, 114
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I
identifier variable, 5
if qualifier, 7, 12, 21, 78, 80–83, 89, 94

troubleshooting, 82–83
import dbase command, 71
import delimited command, 68–71
import excel command, 68, 70
import fred command, 71
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import sas command, 68, 70
import sasxport command, 68
import sasxport5 command, 70, 71
import sasxport8 command, 70, 71
import spss command, 68, 70
importing data, 67–71

comma-delimited, see import delimited command
copying and pasting, 54, 67, 70, 71
ODBC, see ODBC
paste special, 54
tips, 70

in qualifier, 21, 78, 84, 94
indicator variable, 6, 17, 91

generating, 88
infile command, 68, 71
infix command, 68, 71
Internet, 121–127

installing programs, see commands, downloading
and installing

resources, 117–120
searching, 123–125
using remote files, 121

J
Java, 99
jdbc command, 68, 71
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keep command, 94, 96

L

label command, 74
label data command, 74
label define command, 75, 77
label values command, 74, 77
label variable command, 20, 74
labels,

data, 3, 74–75
value, 3–5, 10, 12, 74, 76–77

confusing with string variable, 83
why needed, 6

variable, 4, 5, 74
license, 137

changing, 137
line, twoway subcommand, 19
linear regression, see regression, linear
linking windows, see windows, linking
list command, 7, 69, 78–86
listing data, see data, listing
loading data, see dataset, opening
locale, 134
Log button, 24
log command, 111–113
log files, 22, 111–114

appending, 111
commenting, 112
contents, 112
file extension, 113
keeping just commands, 114
multiple open at once, 112
overwriting, 111
plain text, 111, 113
printing, 113
rerunning commands, 114
SMCL, 111, 113
starting, 111
tips, 113
translating formats, 111, 113
types, 113
viewing, 113

logical
expression, 80–82
operators, see operators, logical

M

Markdown, 99
median, 9
memory, 6, 46, 73, 135

allocation, 135

menus, 28
compared with commands, 21
examples, see examples, menus

missing() function, 7, 62, 81
missing values, 3, 4, 7, 11, 51, 55, 80–81, 88–89, 93

extended, 55
more condition, 24, 135
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net command, 37
NetCourses, see Stata NetCourses
network installation, 137
nondocking windows, see windows, nondocking
Not Elsewhere Classified, see Stata Blog
notes,

managing, 64–66
timestamps, 66

numlist, 84

O
observations, 2
ODBC, 71
odbc command, 68, 71
one-way table, see table, one-way
open, 48
Open toolbar button, 24
opening a dataset, see dataset, opening
operators,
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logical, 80, 82, 87
relational, 80, 87
string, 93

options, 8, 21, 41, 78, 84
output, printing and saving, see log files
Output settings dialog, 113

P
paste, 48
pasting,

data, see data, pasting
graphs, see graphs, copy and paste
text, see text, pasting

PDF, 113, 137
PDF documentation, 38, 40, 42
PNG, 137
poisson command, 28
Portable Network Graphics, see PNG
postestimation commands, 18
precision, 73
predict command, 18
preferences, 115–116

Clipboard, 115
font, 115–116
Graph window, 115
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output, 113
toolbar button, 24

profile.do, 131
Project Manager, 102, 105
projects, 105
Properties Sheet, 130, 131
Properties window, 2, 23, 30, 52
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revealing, 27

PyStata, 99, 137
Python, 99, 137

R
reading list, see Stata reading list
recording sessions, see log files
reference manuals, 42
regress command, 18, 21
regression,

linear, 17–21, 101
Poisson, 28

relational operators, see operators, relational
replace command, 87–91
reproducible research, 118
Results window, 1, 16, 23, 25

color scheme, 115
fonts, 115
searching, 25

Run button, see button, Execute (do)

S
sample session, 1–22
SAS, see import sas command
save, 48
save command, 30, 46–47
Save toolbar button, 24
saveold command, 47
saving

data, see dataset, saving
output, see log files

scatter, twoway subcommand, 15–17, 19
search command, 37, 42
searching help system, see help system, searching
set more command, 135
shortcuts, 130–131
Show file in Viewer button, see button, Show file in

Viewer

SMCL, 35, 98, 104, 111
splitters, see windows, splitters
SPSS, see import spss command
Stata

batch mode, 133–134
Blog, 117, 120
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datasets available, 117, 121
executing commands at startup, 131
FAQs, 117
Graph Editor, see Graph Editor
learning more, 117–120
Markup and Control Language, see SMCL
NetCourses, 118, 120
output, 1
Press, 120
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reading list, 118–119
simultaneous sessions, 134
starting, 130, 133
starts with an error, see troubleshooting
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training, 118, 120
troubleshooting, see troubleshooting
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user interface, see GUI
videos, 43, 118
webinars, 118
won’t start, see troubleshooting
working directory, see working directory

Stata Journal, 38–39, 43–45, 117, 120, 121
Stata News, 120
status bar, 30
storage type, see variables, data type
string variable, see variables, string
strings, 92–93

quoting, 83
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syntax, 40, 78–85
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diagram, 21
list command, 78

syntax note, 2, 5, 7–17, 21
sysprofile.do, 132
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tabbing windows, see windows, tabbing
table,

one-way, 10–11, 13
two-way, 11

tabs, 27
tabulate command, 10–13
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pasting, 97

text variables, see variables, string
TIFF, 137
toolbar, main, 24
tooltip, 24
tostring command, 87
training, see Stata training
troubleshooting, 128–129

unexpected problem, 129
updates, see updates, troubleshooting

ttest command, 14
Twitter, 117, 120
twoway line command, 19
twoway scatter command, 15–17, 19
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Unicode, 93
update command, 37
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automatic update checking, 122
troubleshooting, 122

use command, 46
User’s Guide, 117
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variables, 2
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creating, 56, 87–93
data type, 4–6, 73, 88
display format, 4, 73
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formatting, 52
generating, see variables, creating
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missing values, see missing values
name, 4, 73

abbreviating, 69, 78–80
autocompletion, 25

naming, 52
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storage type, see variables, data type
string, 4, 5, 92–93

confusing with value labels, 83
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Variables Manager, 63–66
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dropping variables, 64
filtering variables, 63
keeping variables, 64
notes, 64–66
printing, 65
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right-clicking, 64
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clicking, 25
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contextual menu, 26
filtering, 26
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commands, 37
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opening, 116
preferences, 31
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	Contents
	[IG] Installation Guide
	Simple installation
	Before you install
	Stata for Windows installation
	Stata for Mac installation
	Stata for Unix installation

	Installing Stata for Windows
	Upgrade or update?
	Upgrading to Stata/MP, Stata/SE, or Stata/IC
	Before you install
	Installation
	Initialize the license
	Update Stata if necessary
	Register your copy
	Creating network shortcuts
	Other ways to start Stata
	Exiting Stata
	Verifying installation

	Installing Stata for Mac
	Upgrade or update?
	Upgrading to Stata/MP, Stata/SE, or Stata/IC
	Warning against multiple Stata applications
	Before you install
	Installation
	Initialize the license
	Update Stata if necessary
	Register your copy
	Other ways to start Stata
	Exiting Stata

	Installing Stata for Unix
	Installation overview
	Find your installation DVD and paper license
	Obtain superuser access
	Create a directory for Stata
	Upgrading
	Install Stata
	Initialize the license
	Set the message of the day (optional)
	Verify that Stata is working
	Modify shell start-up script
	Update Stata if necessary
	Starting Stata
	Exiting Stata
	Troubleshooting Unix installation
	Troubleshooting Unix start-up
	Stata(console) starts but Stata(GUI) does not

	Platforms and flavors
	Available platforms
	Available flavors

	Documentation

	[GS] Getting Started
	[GSM] Mac
	Contents
	1 Introducing Stata---sample session
	Introducing Stata
	Sample session
	Simple data management
	Descriptive statistics
	A simple hypothesis test
	Descriptive statistics---correlation matrices
	Graphing data
	Model fitting: Linear regression
	Commands versus menus
	Keeping track of your work
	Video example
	Conclusion

	2 The Stata user interface
	The windows
	The toolbar
	The Command window
	The Results window
	The Sidebar
	The Variables window
	The Properties window
	The History window
	Tabs
	Menus and dialogs
	The working directory

	3 Using the Viewer
	The Viewer's purpose
	Viewer buttons
	Viewer's function
	Viewing local text files, including SMCL files
	Viewing remote files over the Internet
	Navigating within the Viewer
	Printing
	Right-clicking on the Viewer window
	Searching for help in the Viewer
	Commands in the Viewer
	Using the Viewer from the Command window

	4 Getting help
	System help
	Searching help
	Help and search commands
	The Stata reference manuals and User's Guide
	Stata videos
	The Stata Journal

	5 Opening and saving Stata datasets
	How to load your dataset from disk and save it to disk

	6 Using the Data Editor
	The Data Editor
	Buttons on the Data Editor
	Data entry
	Notes on data entry
	Renaming and formatting variables
	Copying and pasting data
	Notes on copying and pasting
	Changing data
	Working with snapshots
	Dates and the Data Editor
	Data Editor advice
	Filtering and hiding
	Browse mode

	7 Using the Variables Manager
	The Variables Manager
	The Variable pane
	Right-clicking on the Variable pane
	The Variable properties pane
	Managing notes

	8 Importing data
	Copying and pasting
	Commands for importing data
	The import delimited command
	Importing files from other software

	9 Labeling data
	Making data readable
	The dataset structure: The describe command
	Labeling datasets and variables
	Labeling values of variables

	10 Listing data and basic command syntax
	Command syntax
	list with a variable list
	list with if
	list with if, common mistakes
	list with in
	Controlling the list output
	Break

	11 Creating new variables
	generate and replace
	generate
	replace
	generate with string variables

	12 Deleting variables and observations
	clear, drop, and keep
	clear and drop _all
	drop
	keep

	13 Using the Do-file Editor---automating Stata
	The Do-file Editor
	The Do-file Editor toolbar
	Using the Do-file Editor
	The File menu
	The Edit menu
	The View > Do-file Editor menu
	Saving interactive commands from Stata as a do-file
	Navigating your do-file
	Projects

	14 Graphing data
	Working with graphs
	A simple graph example
	Graph window
	Saving and printing graphs
	Right-clicking on the Graph window
	The Graph button

	15 Editing graphs
	The Graph Editor

	16 Saving and printing results by using logs
	Using logs in Stata
	Logging output
	Working with logs
	Printing logs
	Rerunning commands as do-files

	17 Setting font and window preferences
	Changing and saving fonts and sizes and positions of your windows
	Graph window
	All other windows
	Changing color schemes
	Managing multiple sets of preferences
	Closing and opening windows

	18 Learning more about Stata
	Where to go from here
	Suggested reading from the User's Guide and reference manuals
	Internet resources

	19 Updating and extending Stata---Internet functionality
	Internet functionality in Stata
	Using files from the Internet
	Official Stata updates
	Automatic update checking
	Finding community-contributed commands by keyword
	Downloading community-contributed commands

	A Troubleshooting Stata
	A.1 If Stata does not start
	A.2 Troubleshooting tips

	B Advanced Stata usage
	B.1 Executing commands every time Stata is started
	B.2 Other ways to launch Stata
	B.3 Stata batch mode
	B.4 Changing Stata's locale
	B.5 More
	B.6 Memory size considerations

	C More on Stata for Mac
	C.1 Using Stata datasets and graphs created on other platforms
	C.2 Exporting a Stata graph to another document
	C.3 Stata and the Notification Manager
	C.4 Stata(console) for Mac
	C.5 Calling Stata from Python
	C.6 Changing a Stata for Mac license

	Subject index
	A
	B
	C
	D
	E
	F
	G
	H
	I
	J
	K
	L
	M
	N
	O
	P
	R
	S
	T
	U
	V
	W
	Y


	[GSU] Unix
	Contents
	1 Introducing Stata---sample session
	Introducing Stata
	Sample session
	Simple data management
	Descriptive statistics
	A simple hypothesis test
	Descriptive statistics---correlation matrices
	Graphing data
	Model fitting: Linear regression
	Commands versus menus
	Keeping track of your work
	Video example
	Conclusion

	2 The Stata user interface
	The windows
	The toolbar
	The Command window
	The Results window
	The Variables window
	The Properties window
	The History window
	Menus and dialogs
	The working directory

	3 Using the Viewer
	The Viewer in Stata(GUI)
	The Viewer's purpose
	Viewer buttons
	Viewer's function
	Viewing local text files, including SMCL files
	Viewing remote files over the Internet
	Navigating within the Viewer
	Printing
	Tabs in the Viewer
	Right-clicking on the Viewer window
	Searching for help in the Viewer
	Commands in the Viewer
	Using the Viewer from the Command window

	4 Getting help
	System help
	Searching help
	Help and search commands
	The Stata reference manuals and User's Guide
	Stata videos
	The Stata Journal

	5 Opening and saving Stata datasets
	How to load your dataset from disk and save it to disk

	6 Using the Data Editor
	The Data Editor in Stata(GUI)
	Buttons on the Data Editor
	Data entry
	Notes on data entry
	Renaming and formatting variables
	Copying and pasting data
	Notes on copying and pasting
	Changing data
	Working with snapshots
	Dates and the Data Editor
	Data Editor advice
	Filtering and hiding
	Browse mode

	7 Using the Variables Manager
	The Variables Manager in Stata(GUI)
	The Variable pane
	Right-clicking on the Variable pane
	The Variable properties pane
	Managing notes

	8 Importing data
	Copying and pasting in Stata(GUI)
	Commands for importing data
	The import delimited command
	Importing files from other software

	9 Labeling data
	Making data readable
	The dataset structure: The describe command
	Labeling datasets and variables
	Labeling values of variables

	10 Listing data and basic command syntax
	Command syntax
	list with a variable list
	list with if
	list with if, common mistakes
	list with in
	Controlling the list output
	Break

	11 Creating new variables
	generate and replace
	generate
	replace
	generate with string variables

	12 Deleting variables and observations
	clear, drop, and keep
	clear and drop _all
	drop
	keep

	13 Using the Do-file Editor---automating Stata
	The Do-file Editor in Stata(GUI)
	The Do-file Editor toolbar
	Using the Do-file Editor
	The File menu
	The Edit menu
	The View menu
	The Tools menu
	Saving interactive commands from Stata as a do-file
	Navigating your do-file
	Projects

	14 Graphing data
	Working with graphs
	A simple graph example
	Graph window
	Saving and printing graphs
	Right-clicking on the Graph window
	The Graph button

	15 Editing graphs
	The Graph Editor

	16 Saving and printing results by using logs
	Using logs in Stata
	Logging output
	Working with logs
	Printing logs
	Rerunning commands as do-files

	17 Setting font and window preferences
	Changing and saving fonts and sizes and positions of your windows
	Graph window
	All other windows
	Changing color schemes
	Managing multiple sets of preferences
	Closing and opening windows

	18 Learning more about Stata
	Where to go from here
	Suggested reading from the User's Guide and reference manuals
	Internet resources

	19 Updating and extending Stata---Internet functionality
	Internet functionality in Stata
	Using files from the Internet
	Official Stata updates
	Finding community-contributed commands by keyword
	Downloading community-contributed commands

	A Troubleshooting Stata
	A.1 If Stata(GUI) and Stata(console) do not start
	A.2 If Stata(console) starts but Stata(GUI) does not
	A.3 Troubleshooting tips

	B Advanced Stata usage
	B.1 Executing commands every time Stata is started
	B.2 Advanced starting of Stata for Unix
	B.3 Stata batch mode
	B.4 Using X Windows remotely
	B.5 Summary of environment variables
	B.6 Changing Stata's locale
	B.7 More
	B.8 Memory size considerations

	C Stata manual pages for Unix
	conren
	Syntax
	Description
	Finding a color scheme
	Can your terminal underline?
	If you had success
	If you did not have success
	Also see

	stata
	Syntax
	Description
	Remarks and examples

	pystata
	Subject index
	A
	B
	C
	D
	E
	F
	G
	H
	I
	J
	K
	L
	M
	N
	O
	P
	R
	S
	T
	U
	V
	W
	X
	Y


	[GSW] Windows
	Contents
	1 Introducing Stata---sample session
	Introducing Stata
	Sample session
	Simple data management
	Descriptive statistics
	A simple hypothesis test
	Descriptive statistics---correlation matrices
	Graphing data
	Model fitting: Linear regression
	Commands versus menus
	Keeping track of your work
	Video example
	Conclusion

	2 The Stata user interface
	The windows
	The toolbar
	The Command window
	The Results window
	The Variables window
	The Properties window
	The History window
	Menus and dialogs
	The working directory
	Fine control of Stata's windows
	Window types
	Docking windows
	Auto Hide and pinning
	Nondocking windows

	3 Using the Viewer
	The Viewer's purpose
	Viewer buttons
	Viewer's function
	Viewing local text files, including SMCL files
	Viewing remote files over the Internet
	Navigating within the Viewer
	Printing
	Tabs in the Viewer
	Right-clicking on the Viewer window
	Searching for help in the Viewer
	Commands in the Viewer
	Using the Viewer from the Command window

	4 Getting help
	System help
	Searching help
	Help and search commands
	The Stata reference manuals and User's Guide
	Stata videos
	The Stata Journal

	5 Opening and saving Stata datasets
	How to load your dataset from disk and save it to disk

	6 Using the Data Editor
	The Data Editor
	Buttons on the Data Editor
	Data entry
	Notes on data entry
	Renaming and formatting variables
	Copying and pasting data
	Notes on copying and pasting
	Changing data
	Working with snapshots
	Dates and the Data Editor
	Data Editor advice
	Filtering and hiding
	Browse mode

	7 Using the Variables Manager
	The Variables Manager
	The Variable pane
	Right-clicking on the Variable pane
	The Variable properties pane
	Managing notes

	8 Importing data
	Copying and pasting
	Commands for importing data
	The import delimited command
	Importing files from other software

	9 Labeling data
	Making data readable
	The dataset structure: The describe command
	Labeling datasets and variables
	Labeling values of variables

	10 Listing data and basic command syntax
	Command syntax
	list with a variable list
	list with if
	list with if, common mistakes
	list with in
	Controlling the list output
	Break

	11 Creating new variables
	generate and replace
	generate
	replace
	generate with string variables

	12 Deleting variables and observations
	clear, drop, and keep
	clear and drop _all
	drop
	keep

	13 Using the Do-file Editor---automating Stata
	The Do-file Editor
	The Do-file Editor toolbar
	Using the Do-file Editor
	The File menu
	The Edit menu
	The View menu
	The Tools menu
	Saving interactive commands from Stata as a do-file
	Navigating your do-file
	Projects

	14 Graphing data
	Working with graphs
	A simple graph example
	Graph window
	Saving and printing graphs
	Right-clicking on the Graph window
	The Graph button

	15 Editing graphs
	The Graph Editor

	16 Saving and printing results by using logs
	Using logs in Stata
	Logging output
	Working with logs
	Printing logs
	Rerunning commands as do-files

	17 Setting font and window preferences
	Changing and saving fonts and sizes and positions of your windows
	Graph window
	All other windows
	Changing color schemes
	Managing multiple sets of preferences
	Closing and opening windows

	18 Learning more about Stata
	Where to go from here
	Suggested reading from the User's Guide and reference manuals
	Internet resources

	19 Updating and extending Stata---Internet functionality
	Internet functionality in Stata
	Using files from the Internet
	Official Stata updates
	Automatic update checking
	Finding community-contributed commands by keyword
	Downloading community-contributed commands

	A Troubleshooting Stata
	A.1 If Stata does not start
	A.2 Troubleshooting tips

	B Advanced Stata usage
	B.1 The Windows Properties Sheet
	B.2 Making shortcuts
	B.3 Executing commands every time Stata is started
	B.4 Other ways to launch Stata
	B.5 Stata batch mode
	B.6 Running simultaneous Stata sessions
	B.7 Changing Stata's locale
	B.8 More
	B.9 Memory size considerations

	C More on Stata for Windows
	C.1 Using Stata datasets and graphs created on other platforms
	C.2 Exporting a Stata graph to another document
	C.3 Installing Stata for Windows on a network drive
	C.4 Calling Stata from Python
	C.5 Changing a Stata for Windows license

	Subject index
	A
	B
	C
	D
	E
	F
	G
	H
	I
	J
	K
	L
	M
	N
	O
	P
	R
	S
	T
	U
	V
	W
	Y



	[U] User's Guide
	Contents
	Stata basics
	1 Read this---it will help
	1.1 Getting Started with Stata
	1.2 The User's Guide and the Reference manuals
	1.3 What's new
	1.4 References

	2 A brief description of Stata
	3 Resources for learning and using Stata
	3.1 Overview
	3.2 Stata on the Internet (www.stata.com and other resources)
	3.3 Stata Press
	3.4 The Stata Journal
	3.5 Updating and adding features from the web
	3.6 Conferences and training
	3.7 Books and other support materials
	3.8 Technical support
	3.9 References

	4 Stata's help and search facilities
	4.1 Introduction
	4.2 Getting started
	4.3 help: Stata's help system
	4.4 Accessing PDF manuals from help entries
	4.5 Searching
	4.6 More on search
	4.7 More on help
	4.8 search: All the details
	4.9 net search: Searching net resources

	5 Editions of Stata
	5.1 Platforms
	5.2 Stata/MP, Stata/SE, or Stata/BE
	5.3 Size limits of Stata/MP, SE, and BE
	5.4 Speed comparison of Stata/MP, SE, and BE
	5.5 Feature comparison of Stata/MP, SE, and BE

	6 Managing memory
	6.1 Memory-size considerations
	6.2 Compressing data
	6.3 Setting maxvar
	6.4 The memory command
	6.5 Setting aside memory for temporary storage of preserved datasets

	7 --more-- conditions
	7.1 Description
	7.2 set more
	7.3 The more programming command

	8 Error messages and return codes
	8.1 Making mistakes
	8.2 The return message for obtaining command timings

	9 The Break key
	9.1 Making Stata stop what it is doing
	9.2 Side effects of clicking on Break
	9.3 Programming considerations

	10 Keyboard use
	10.1 Description
	10.2 F-keys
	10.3 Editing keys in Stata
	10.4 Editing keys in Stata for Unix(console)
	10.5 Editing previous lines in Stata
	10.6 Tab expansion of variable names


	Elements of Stata
	11 Language syntax
	11.1 Overview
	11.2 Abbreviation rules
	11.3 Naming conventions
	11.4 varname and varlists
	11.5 by varlist: construct
	11.6 Filenaming conventions
	11.7 References

	12 Data
	12.1 Data and datasets
	12.2 Numbers
	12.3 Dates and times
	12.4 Strings
	12.5 Formats: Controlling how data are displayed
	12.6 Dataset, variable, and value labels
	12.7 Notes attached to data
	12.8 Characteristics
	12.9 Data Editor and Variables Manager
	12.10 Data frames
	12.11 References

	13 Functions and expressions
	13.1 Overview
	13.2 Operators
	13.3 Functions
	13.4 System variables (_variables)
	13.5 Accessing coefficients and standard errors
	13.6 Accessing results from Stata commands
	13.7 Explicit subscripting
	13.8 Using the Expression Builder
	13.9 Indicator values for levels of factor variables
	13.10 Time-series operators
	13.11 Label values
	13.12 Precision and problems therein
	13.13 References

	14 Matrix expressions
	14.1 Overview
	14.2 Row and column names
	14.3 Vectors and scalars
	14.4 Inputting matrices by hand
	14.5 Accessing matrices created by Stata commands
	14.6 Creating matrices by accumulating data
	14.7 Matrix operators
	14.8 Matrix functions
	14.9 Subscripting
	14.10 Using matrices in scalar expressions
	14.11 Reference

	15 Saving and printing output---log files
	15.1 Overview
	15.2 Placing comments in logs
	15.3 Logging only what you type
	15.4 The log-button alternative
	15.5 Printing logs
	15.6 Creating multiple log files for simultaneous use

	16 Do-files
	16.1 Description
	16.2 Calling other do-files
	16.3 Creating and running do-files
	16.4 Programming with do-files
	16.5 References

	17 Ado-files
	17.1 Description
	17.2 What is an ado-file?
	17.3 How can I tell if a command is built in or an ado-file?
	17.4 How can I look at an ado-file?
	17.5 Where does Stata look for ado-files?
	17.6 How do I install an addition?
	17.7 How do I add my own ado-files?
	17.8 How do I install official updates?
	17.9 How do I install updates to community-contributed additions?
	17.10 References

	18 Programming Stata
	18.1 Description
	18.2 Relationship between a program and a do-file
	18.3 Macros
	18.4 Program arguments
	18.5 Scalars and matrices
	18.6 Temporarily destroying the data in memory
	18.7 Temporary objects
	18.8 Accessing results calculated by other programs
	18.9 Accessing results calculated by estimation commands
	18.10 Storing results
	18.11 Ado-files
	18.12 Tools for interacting with programs outside Stata and with other languages
	18.13 A compendium of useful commands for programmers
	18.14 References

	19 Immediate commands
	19.1 Overview
	19.2 The display command
	19.3 The power command

	20 Estimation and postestimation commands
	20.1 All estimation commands work the same way
	20.2 Standard syntax
	20.3 Replaying prior results
	20.4 Cataloging estimation results
	20.5 Saving estimation results
	20.6 Specification search tools
	20.7 Specifying the estimation subsample
	20.8 Specifying the width of confidence intervals
	20.9 Formatting the coefficient table
	20.10 Obtaining the variance--covariance matrix
	20.11 Obtaining predicted values
	20.12 Accessing estimated coefficients
	20.13 Performing hypothesis tests on the coefficients
	20.14 Obtaining linear combinations of coefficients
	20.15 Obtaining nonlinear combinations of coefficients
	20.16 Obtaining marginal means, adjusted predictions, and predictive margins
	20.17 Obtaining conditional and average marginal effects
	20.18 Obtaining pairwise comparisons
	20.19 Obtaining contrasts, tests of interactions, and main effects
	20.20 Graphing margins, marginal effects, and contrasts
	20.21 Dynamic forecasts and simulations
	20.22 Obtaining robust variance estimates
	20.23 Obtaining scores
	20.24 Weighted estimation
	20.25 A list of postestimation commands
	20.26 References

	21 Creating reports
	21.1 Overview
	21.2 The dynamic document commands
	21.3 The putdocx, putpdf, and putexcel commands


	Advice
	22 Entering and importing data
	22.1 Overview
	22.2 Determining which method to use
	22.3 If you run out of memory
	22.4 ODBC sources
	22.5 JDBC sources

	23 Combining datasets
	23.1 References

	24 Working with strings
	24.1 Description
	24.2 Categorical string variables
	24.3 Mistaken string variables
	24.4 Complex strings
	24.5 References

	25 Working with dates and times
	25.1 Overview
	25.2 Inputting dates and times
	25.3 Displaying dates and times
	25.4 Typing dates and times (datetime literals)
	25.5 Extracting components of dates and times
	25.6 Converting between date and time values
	25.7 Business dates and calendars
	25.8 References

	26 Working with categorical data and factor variables
	26.1 Continuous, categorical, and indicator variables
	26.2 Estimation with factor variables
	26.3 References

	27 Overview of Stata estimation commands
	27.1 Introduction
	27.2 Means, proportions, and related statistics
	27.3 Continuous outcomes
	27.4 Binary outcomes
	27.5 Fractional outcomes
	27.6 Ordinal outcomes
	27.7 Categorical outcomes
	27.8 Count outcomes
	27.9 Generalized linear models
	27.10 Choice models
	27.11 Exact estimators
	27.12 Models with endogenous covariates
	27.13 Models with endogenous sample selection
	27.14 Time-series models
	27.15 Panel-data models
	27.16 Multilevel mixed-effects models
	27.17 Survival analysis models
	27.18 Meta-analysis
	27.19 Spatial autoregressive models
	27.20 Treatment-effects models
	27.21 Pharmacokinetic data
	27.22 Multivariate analysis
	27.23 Generalized method of moments (GMM)
	27.24 Structural equation modeling (SEM)
	27.25 Latent class models
	27.26 Finite mixture models (FMMs)
	27.27 Item response theory (IRT)
	27.28 Dynamic stochastic general equilibrium (DSGE) models
	27.29 Lasso
	27.30 Survey data
	27.31 Multiple imputation
	27.32 Power, precision, and sample-size analysis
	27.33 Bayesian analysis
	27.34 Reference

	28 Commands everyone should know
	29 Using the Internet to keep up to date
	29.1 Overview
	29.2 Sharing datasets (and other files)
	29.3 Official updates
	29.4 Downloading and managing additions by users
	29.5 Making your own download site


	Glossary
	A
	B
	C
	D
	E
	F
	H
	I
	L
	N
	O
	P
	S
	T
	U
	V


	[BAYES] Bayesian Analysis
	Contents
	Intro
	Description
	Remarks and examples
	What is Bayesian analysis?
	Bayesian versus frequentist analysis, or why Bayesian analysis?
	How to do Bayesian analysis
	Advantages and disadvantages of Bayesian analysis
	Brief background and literature review
	Bayesian statistics
	Posterior distribution
	Selecting priors
	Point and interval estimation
	Comparing Bayesian models
	Posterior prediction

	Bayesian computation
	Markov chain Monte Carlo methods
	Metropolis--Hastings algorithm
	Adaptive random-walk Metropolis--Hastings
	Blocking of parameters
	Metropolis--Hastings with Gibbs updates
	Convergence diagnostics of MCMC

	Summary
	Video examples

	References
	Also see

	Bayesian commands
	Description
	Remarks and examples
	Overview example

	Acknowledgments
	References
	Also see

	Bayesian estimation
	Description
	Video examples
	Also see

	bayes
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Using the bayes prefix
	Likelihood model
	Default priors
	Initial values
	Command-specific options

	Introductory example
	Linear regression: A case of informative default priors
	Logistic regression with perfect predictors
	Multinomial logistic regression
	Generalized linear model
	Truncated Poisson regression
	Zero-inflated negative binomial model
	Parametric survival model
	Heckman selection model
	Multilevel models
	Two-level models
	Crossed-effects model
	Blocked-diagonal covariance structures

	Panel-data models
	Time-series and DSGE models
	Video examples

	Stored results
	Methods and formulas
	References
	Also see

	bayesmh
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Using bayesmh
	Setting up a posterior model
	Likelihood model
	Prior distributions
	Declaring model parameters
	Referring to model parameters
	Specifying arguments of likelihood models and prior distributions
	Substitutable expressions
	Constraints on coefficients in linear combinations
	Random effects
	Checking model specification

	Specifying MCMC sampling procedure
	Reproducing results
	Burn-in period and MCMC sample size
	Improving efficiency of the MH algorithm---blocking of parameters
	Gibbs and hybrid MH sampling
	Adaptation of the MH algorithm
	Specifying initial values

	Summarizing and reporting results
	Posterior summaries and credible intervals
	Saving MCMC results

	Convergence of MCMC
	Video examples
	Getting started examples
	Mean of a normal distribution with a known variance
	Mean of a normal distribution with an unknown variance
	Simple linear regression
	Multiple linear regression
	Improving efficiency of the MH sampling

	Convergence diagnostics using multiple chains
	Multiple chains using default initial values
	Multiple chains using overdispersed initial values

	Bayesian predictions
	Simulating replicated outcomes
	Posterior predictive checks

	Logistic regression model: A case of nonidentifiable parameters
	Ordered probit regression
	Beta-binomial model
	Multivariate regression
	Panel-data and multilevel models
	Two-level random-intercept model or panel-data model
	Linear growth curve model---a random-coefficient model
	Multilevel logistic regression
	Three-level nonlinear model

	Survival models
	Bayesian analysis of change-point problem
	Bioequivalence in a crossover trial
	Random-effects meta-analysis of clinical trials
	Item response theory
	Latent growth model

	Stored results
	Methods and formulas
	Adaptive MH algorithm
	Adaptive MH algorithm for random effects
	Gibbs sampling for some likelihood-prior and prior-hyperprior configurations
	Likelihood-prior configurations
	Prior-hyperprior configurations

	Marginal likelihood

	References
	Also see

	bayesmh evaluators
	Description
	Syntax
	Options
	Remarks and examples
	Program evaluators
	Simple linear regression model
	Logistic regression model
	Multivariate normal regression model
	Cox proportional hazards regression
	Global macros

	Stored results
	Reference
	Also see

	Bayesian postestimation
	Postestimation commands
	Remarks and examples
	Different ways of specifying model parameters
	Specifying functions of model parameters
	Storing estimation results after Bayesian estimation
	Different ways of specifying predictions and their functions

	Also see

	bayesgraph
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Using bayesgraph
	Examples
	Trace plots
	Autocorrelation plots
	Histogram plots
	Kernel density plots
	Cumulative sum plots
	Bivariate scatterplots
	Diagnostic plots
	Functions of model parameters


	Methods and formulas
	References
	Also see

	bayesstats
	Description
	Also see

	bayesstats ess
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Effective sample size and MCMC sampling efficiency
	Using bayesstats ess

	Stored results
	Methods and formulas
	Also see

	bayesstats grubin
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Gelman--Rubin convergence diagnostic
	Using bayesstats grubin

	Stored results
	Methods and formulas
	References
	Also see

	bayesstats ic
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Bayesian information criteria
	Bayes factors
	Using bayesstats ic

	Stored results
	Methods and formulas
	References
	Also see

	bayesstats ppvalues
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Posterior predictive checks
	PPPs
	Nonlinear effect of labor and capital on companies' output

	Stored results
	Methods and formulas
	References
	Also see

	bayesstats summary
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Bayesian summaries for an auto data example

	Stored results
	Methods and formulas
	Point estimates
	Credible intervals

	References
	Also see

	bayestest
	Description
	Remarks and examples
	Also see

	bayestest interval
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Interval tests for continuous parameters
	Interval tests for discrete parameters

	Stored results
	Methods and formulas
	Reference
	Also see

	bayestest model
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Testing nested hypotheses
	Comparing models with different priors

	Stored results
	Methods and formulas
	Also see

	bayespredict
	Description
	Quick start
	Menu
	Syntax
	Options
	Options for predictions
	Options for posterior summaries
	Options for bayesreps

	Remarks and examples
	Overview of Bayesian predictions
	Prior and posterior predictive distributions
	Simulated outcomes
	Posterior predictive checking and replicated outcomes

	Using bayespredict and bayesreps
	Generating and saving simulated outcomes
	Defining test statistics using Mata functions
	User-defined Stata programs
	Posterior summaries of simulated outcomes
	Prediction dataset

	Bayesian predictions
	Posterior predictive inference
	Out-of-sample prediction
	One-step-ahead Bayesian forecast after Bayesian VAR

	Stored results
	Methods and formulas
	Posterior predictive distribution
	MCMC sampling from posterior predictive distribution
	Residuals and expected values

	References
	Also see

	set clevel
	Description
	Syntax
	Option
	Remarks and examples
	Also see

	bayes: betareg
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	bayes: binreg
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	bayes: biprobit
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	bayes: clogit
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	bayes: cloglog
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	bayes: dsge
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	bayes: dsgenl
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	bayes: dsge postestimation
	Postestimation commands
	Remarks and examples
	Also see

	bayes: fracreg
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	bayes: glm
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	bayes: gnbreg
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	bayes: heckman
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	bayes: heckoprobit
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	bayes: heckprobit
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	bayes: hetoprobit
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	bayes: hetprobit
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	bayes: hetregress
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	bayes: intreg
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	bayes: logistic
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Methods and formulas
	Reference
	Also see

	bayes: logit
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Methods and formulas
	Reference
	Also see

	bayes: mecloglog
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	bayes: meglm
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Additional model parameters

	Stored results
	Methods and formulas
	Also see

	bayes: meintreg
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	bayes: melogit
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	bayes: menbreg
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	bayes: meologit
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	bayes: meoprobit
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	bayes: mepoisson
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	bayes: meprobit
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	bayes: mestreg
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Ancillary model parameters

	Stored results
	Methods and formulas
	Also see

	bayes: metobit
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	bayes: mixed
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	bayes: mlogit
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	bayes: mprobit
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	bayes: mvreg
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	bayes: nbreg
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	bayes: ologit
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	bayes: oprobit
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	bayes: poisson
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	bayes: probit
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	bayes: regress
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Video examples

	Stored results
	Methods and formulas
	Also see

	bayes: streg
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Ancillary model parameters

	Stored results
	Methods and formulas
	Also see

	bayes: tnbreg
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	bayes: tobit
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	bayes: tpoisson
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	bayes: truncreg
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	bayes: var
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Advantages of Bayesian VAR models
	Introductory examples
	US macroeconomic examples

	Stored results
	Methods and formulas
	VAR model specification
	Original Minnesota prior with known (fixed) error covariance
	Conjugate Minnesota prior for VAR model with unknown error covariance
	MVN-inverse Wishart prior
	MVN-diffuse (normal-Jeffreys) prior

	References
	Also see

	bayes: var postestimation
	Postestimation commands
	Also see

	bayesvarstable
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	bayesfcast
	Description
	Quick start
	Syntax
	Also see

	bayesfcast compute
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Methods and formulas
	Bayesian dynamic forecasts
	Dynamic forecasts after bayes: var

	Reference
	Also see

	bayesfcast graph
	Description
	Menu
	Syntax
	Options
	Remarks and examples
	Also see

	bayesirf
	Description
	Quick start
	Syntax
	Remarks and examples
	Also see

	bayesirf create
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	IRFs after Bayesian vector autoregression (VAR) models
	Technical aspects of IRF files

	Methods and formulas
	Also see

	bayesirf graph
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Also see

	bayesirf cgraph
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Also see

	bayesirf ograph
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Also see

	bayesirf table
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Also see

	bayesirf ctable
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Also see

	bayes: xtlogit
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	bayes: xtmlogit
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	bayes: xtnbreg
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Methods and formulas
	Reference
	Also see

	bayes: xtologit
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	bayes: xtoprobit
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	bayes: xtpoisson
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	bayes: xtprobit
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	bayes: xtreg
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	bayes: zinb
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	bayes: ziologit
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	bayes: zioprobit
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	bayes: zip
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	Glossary
	Reference


	[CM] Choice Models
	Contents
	Intro
	Description
	Remarks and examples
	Introductions
	Declaring and summarizing data
	Fitting choice models
	Postestimation
	Glossary


	Intro 1
	Description
	Remarks and examples
	Interpretation of coefficients
	Inferences from margins
	Expected choice probabilities
	Effects of a continuous covariate
	Effects of a categorical covariate
	Effects of an alternative-specific covariate

	More inferences using margins

	Also see

	Intro 2
	Description
	Remarks and examples
	Data layout for choice models
	cmset: Cross-sectional data
	cmset: Panel data

	Also see

	Intro 3
	Description
	Remarks and examples
	cmchoiceset: Tabulating choice sets
	cmsample: Looking at problem observations
	cmtab: Tabulating chosen alternatives versus other variables
	cmsummarize: Descriptive statistics for CM variables

	Also see

	Intro 4
	Description
	Remarks and examples
	Specialized choice model commands
	Other commands for choice models
	Models for cross-sectional data
	Models for panel data
	Multilevel models for clustered data



	Intro 5
	Description
	Remarks and examples
	Overview of CM commands for discrete choices
	cmclogit: McFadden's choice model
	Looking at cases with missing values using cmsample
	margins after CM estimation
	cmmixlogit: Mixed logit choice models
	cmmprobit: Multinomial probit choice models
	nlogit: Nested logit choice models
	Relationships with other estimation commands
	Duplicating cmclogit using clogit
	Multinomial logistic regression and McFadden's choice model

	Estimation considerations
	Setting the number of integration points
	Convergence
	More than one chosen alternative


	References
	Also see

	Intro 6
	Description
	Remarks and examples
	Overview of CM commands for rank-ordered alternatives
	cmroprobit: Probit regression for rank-ordered alternatives
	Expected choice probabilities (the margins command) after cmroprobit
	cmrologit: Logistic regression for rank-ordered alternatives

	References
	Also see

	Intro 7
	Description
	Remarks and examples
	Data layout for panel choice data
	A cmxtmixlogit model
	Time-series operators
	Using other cm estimation commands with panel data

	Also see

	Intro 8
	Description
	Remarks and examples
	Random utility models
	Alternative-specific variables and case-specific variables
	Independence of irrelevant alternatives
	Estimators that do not assume IIA
	Maximum simulated likelihood

	References
	Also see

	cmchoiceset
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Also see

	cmclogit
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	cmclogit postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Testing coefficient estimates
	Predicted probabilities
	Casewise versus alternativewise sample selection

	Obtaining estimation statistics for the alternatives

	Also see

	cmmixlogit
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	cmmixlogit postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Methods and formulas
	Also see

	cmmprobit
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	The multinomial probit model
	Covariance structures
	Applying constraints to correlation parameters

	Convergence problems

	Stored results
	Methods and formulas
	Overview
	Simulated likelihood

	References
	Also see

	cmmprobit postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	estat
	Description for estat
	Menu for estat
	Syntax for estat
	Options for estat covariance, estat correlation, and estat facweights

	Remarks and examples
	Predicted probabilities
	Obtaining estimation statistics

	Also see

	cmrologit
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Overview
	Examples
	Comparing respondents
	Incomplete rankings and ties
	Clustered choice data
	Comparison of cmrologit and clogit
	On reversals of rankings

	Stored results
	Methods and formulas
	Acknowledgment
	References
	Also see

	cmrologit postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Also see

	cmroprobit
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	Reference
	Also see

	cmroprobit postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	estat
	Description for estat
	Menu for estat
	Syntax for estat
	Options for estat covariance, estat correlation, and estat facweights

	Remarks and examples
	Also see

	cmsample
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Also see

	cmset
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Also see

	cmsummarize
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Also see

	cmtab
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Also see

	cmxtmixlogit
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	cmxtmixlogit postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Methods and formulas
	Also see

	margins
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Estimating margins for case-specific variables
	Estimating margins for alternative-specific variables
	The altsubpop suboption for unbalanced choice sets
	More on unbalanced choice sets
	The outcomecontrast() and alternativecontrast() suboptions

	Graphing margins results

	Stored results
	Also see

	nlogit
	Description
	Quick start
	Menu
	Syntax
	Options
	Specification and options for lev#_equation
	Options for nlogit
	Specification and options for nlogitgen
	Specification and options for nlogittree

	Remarks and examples
	Introduction
	Data setup and the tree structure
	Estimation
	Testing for the IIA
	Nonnormalized model

	Stored results
	Methods and formulas
	Two-level nested logit model
	Three-level nested logit model

	References
	Also see

	nlogit postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	estat
	Description for estat
	Menu for estat
	Syntax for estat

	Remarks and examples
	Also see

	Glossary

	[D] Data Management
	Contents
	Intro
	Description
	Also see

	Data management
	Description
	References
	Also see

	append
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Video example

	Reference
	Also see

	assert
	Description
	Quick start
	Syntax
	Options
	Remarks and examples
	Reference
	Also see

	assertnested
	Description
	Quick start
	Syntax
	Options
	Remarks and examples
	Also see

	bcal
	Description
	Quick start
	Menu
	Syntax
	Option for bcal check
	Options for bcal create
	Remarks and examples
	Stored results
	Reference
	Also see

	by
	Description
	Quick start
	Syntax
	Options
	Remarks and examples
	References
	Also see

	cd
	Description
	Quick start
	Syntax
	Remarks and examples
	Stata for Windows
	Stata for Mac
	Stata for Unix

	Also see

	cf
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Acknowledgment
	Also see

	changeeol
	Description
	Quick start
	Syntax
	Options
	Remarks and examples
	Also see

	checksum
	Description
	Quick start
	Syntax
	Options
	Remarks and examples
	Stored results
	Also see

	clear
	Description
	Quick start
	Syntax
	Remarks and examples
	Also see

	clonevar
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Acknowledgments
	Also see

	codebook
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	References
	Also see

	collapse
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introductory examples
	Variablewise or casewise deletion
	Weights
	A final example

	Acknowledgment
	Also see

	compare
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Also see

	compress
	Description
	Quick start
	Menu
	Syntax
	Option
	Remarks and examples
	Video example

	Also see

	contract
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Acknowledgments
	Reference
	Also see

	copy
	Description
	Quick start
	Syntax
	Options
	Remarks and examples
	Also see

	corr2data
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Methods and formulas
	Reference
	Also see

	count
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	References
	Also see

	cross
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	References
	Also see

	Data types
	Description
	Remarks and examples
	Precision of numeric storage types

	Also see

	datasignature
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Using datasignature interactively
	Using datasignature in do-files
	Interpreting data signatures
	The logic of data signatures

	Stored results
	Methods and formulas
	Reference
	Also see

	Datetime
	Description
	Quick start
	Syntax
	Types of dates and how they are displayed
	How Stata dates are stored
	Converting dates stored as strings to Stata dates
	Formatting Stata dates for display
	Creating dates from components
	Converting among units
	Extracting time-of-day components from datetimes
	Extracting date components from daily dates
	Typing dates into expressions

	Remarks and examples
	Introduction
	Example 1: Converting string datetimes to Stata datetimes
	Example 2: Extracting date components
	Example 3: Building dates from components
	Example 4: Converting among date types
	Example 5: Using dates in expressions

	References
	Also see

	Datetime business calendars
	Description
	Syntax
	Remarks and examples
	Step 1: Read the data, date as string
	Step 2: Convert date variable to %td date
	Step 3: Convert %td date to %tb date
	Key feature: Each business calendar has its own encoding
	Key feature: Omitted dates really are omitted
	Key feature: Extracting components from %tb dates
	Key feature: Merging on dates

	Also see

	Datetime business calendars creation
	Description
	Syntax
	Remarks and examples
	Introduction
	Concepts
	The preliminary commands
	The omit commands: from/to and if
	The omit commands: and
	The omit commands: omit date
	The omit commands: omit dayofweek
	The omit commands: omit dowinmonth
	Creating stbcal-files with bcal create
	Where to place stbcal-files
	How to debug stbcal-files
	Ideas for calendars that may not occur to you

	Also see

	Datetime conversion
	Description
	Quick start
	Syntax
	Remarks and examples
	Introduction
	Specifying the mask
	How the conversion functions interpret the mask
	Working with two-digit years
	Working with incomplete dates and times
	Converting run-together dates, such as 20060125
	Valid times
	The clock() and Clock() functions
	Why there are two datetime encodings
	Advice on using datetime/c and datetime/C
	Determining when leap seconds occurred
	The date() function
	The other conversion functions

	Reference
	Also see

	Datetime display formats
	Description
	Quick start
	Syntax
	Remarks and examples
	Specifying display formats
	Times are truncated, not rounded, when displayed

	Also see

	Datetime durations
	Description
	Quick start
	Syntax
	Functions for calculating durations
	Functions for converting units of a duration

	Remarks and examples
	Calculating ages and differences of dates
	Calculating differences of datetimes

	Reference
	Also see

	Datetime relative dates
	Description
	Quick start
	Syntax
	Remarks and examples
	Current date and time
	Birthdays and anniversaries
	Months: Number of days, first day, and last day
	Determining leap years
	Determining leap seconds

	Also see

	Datetime values from other software
	Description
	Remarks and examples
	Introduction
	Converting SAS dates
	Converting SPSS dates
	Converting R dates
	Converting Excel dates
	Example 1: Converting Excel dates to Stata dates

	Converting OpenOffice dates
	Converting Unix time

	Reference
	Also see

	describe
	Description
	Quick start
	Menu
	Syntax
	Options to describe data in memory
	Options to describe data in file
	Remarks and examples
	describe
	describe, replace

	Stored results
	References
	Also see

	destring
	Description
	Quick start
	Menu
	Syntax
	Options for destring
	Options for tostring
	Remarks and examples
	destring
	tostring
	Saved characteristics
	Video example

	Acknowledgment
	References
	Also see

	dir
	Description
	Quick start
	Syntax
	Option
	Remarks and examples
	Also see

	drawnorm
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Methods and formulas
	References
	Also see

	drop
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Also see

	ds
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Acknowledgments
	Also see

	duplicates
	Description
	Quick start
	Menu
	Syntax
	Options
	Options for duplicates examples and duplicates list
	Option for duplicates tag
	Option for duplicates drop

	Remarks and examples
	Video example

	Stored results
	Acknowledgments
	References
	Also see

	dyngen
	Description
	Menu
	Syntax
	Option
	Remarks and examples
	Also see

	edit
	Description
	Quick start
	Menu
	Syntax
	Option
	Remarks and examples
	Modes
	The current observation and current variable
	Assigning value labels to variables
	Changing values of existing cells
	Adding new variables
	Adding new observations
	Copying and pasting
	Logging changes
	Advice

	Also see

	egen
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Summary statistics
	Definitions of egen summary functions

	Missing values
	Generating patterns
	Marking differences among variables
	Ranks
	Standardized variables
	Row functions
	Categorical and integer variables
	String variables

	Acknowledgments
	References
	Also see

	encode
	Description
	Quick start
	Menu
	Syntax
	Options for encode
	Options for decode
	Remarks and examples
	encode
	decode
	Video example

	References
	Also see

	erase
	Description
	Quick start
	Syntax
	Remarks and examples
	Also see

	expand
	Description
	Quick start
	Menu
	Syntax
	Option
	Remarks and examples
	References
	Also see

	expandcl
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Also see

	export
	Description
	Remarks and examples
	Summary of the different methods
	export excel
	export delimited
	jdbc
	odbc
	outfile
	export sasxport5 and export sasxport8
	export dbase


	Also see

	filefilter
	Description
	Quick start
	Syntax
	Options
	Remarks and examples
	Stored results
	Reference
	Also see

	fillin
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	References
	Also see

	format
	Description
	Quick start
	Menu
	Syntax
	Option
	Remarks and examples
	Setting formats
	Setting European formats
	Details of formats
	Other effects of formats
	Displaying current formats
	Video example

	References
	Also see

	frames intro
	Description
	Remarks and examples
	What frames can do for you
	Use frames to multitask
	Use frames to perform tasks integral to your work
	Use frames to work with separate datasets simultaneously
	Use frames to record statistics gathered from simulations
	Frames make Stata (preserve/restore) faster
	Other uses will occur to you that we should have listed

	Learning frames
	The current frame
	Creating new frames
	Type frame or frames, it does not matter
	Switching frames
	Copying frames
	Dropping frames
	Resetting frames
	Frame prefix command
	Linking frames
	Ignore the _frval() function
	Posting new observations to frames

	Programming with frames
	Ado-programming with frames
	Mata programming with frames


	Reference
	Also see

	frames
	Description
	Menu
	Syntax
	Also see

	frame change
	Description
	Menu
	Syntax
	Remarks and examples
	Also see

	frame copy
	Description
	Quick start
	Menu
	Syntax
	Option
	Remarks and examples
	Also see

	frame create
	Description
	Menu
	Syntax
	Remarks and examples
	Also see

	frame drop
	Description
	Menu
	Syntax
	Remarks and examples
	Also see

	frame prefix
	Description
	Quick start
	Syntax
	Remarks and examples
	Example of interactive use
	Example of use in programs

	Also see

	frame put
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Also see

	frame pwf
	Description
	Menu
	Syntax
	Remarks and examples
	Stored results
	Also see

	frame rename
	Description
	Menu
	Syntax
	Remarks and examples
	Also see

	frames dir
	Description
	Menu
	Syntax
	Remarks and examples
	Stored results
	Also see

	frames reset
	Description
	Menu
	Syntax
	Remarks and examples
	Also see

	frget
	Description
	Quick start
	Syntax
	Options
	Remarks and examples
	Overview
	Everything you need to know about frget

	Stored results
	Also see

	frlink
	Description
	Quick start
	Syntax
	Options
	Options for frlink 1:1 and frlink m:1
	Options for frlink rebuild

	Remarks and examples
	Overview of the frlink command
	Everything you need to know about linkages
	Example 1: A typical m:1 linkage
	How link variables work
	Advanced examples
	Example 2: A complex m:1 linkage
	Example 3: A 1:1 linkage, a simple solution to a hard problem

	Stored results
	Also see

	generate
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	generate and replace
	set type
	Video examples

	References
	Also see

	gsort
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Also see

	hexdump
	Description
	Syntax
	Options
	Remarks and examples
	Stored results
	Also see

	icd
	Description
	Remarks and examples
	Introduction to ICD coding
	Terminology
	Diagnosis codes
	Procedure codes
	Working with multiple codes

	References
	Also see

	icd9
	Description
	Quick start
	Menu
	Syntax
	Options
	Options for icd9 check
	Options for icd9 clean
	Options for icd9 generate
	Option for icd9 search

	Remarks and examples
	Using icd9 and icd9p
	Verifying and cleaning variables
	Interactive utilities
	Creating new variables

	Stored results
	References
	Also see

	icd9p
	Description
	Quick start
	Menu
	Syntax
	Options
	Options for icd9p check
	Options for icd9p clean
	Options for icd9p generate
	Option for icd9p search

	Remarks and examples
	Verifying and cleaning variables
	Interactive utilities
	Creating new variables

	Stored results
	References
	Also see

	icd10
	Description
	Quick start
	Menu
	Syntax
	Options
	Options for icd10 check
	Options for icd10 clean
	Options for icd10 generate
	Option for icd10 lookup
	Options for icd10 search

	Remarks and examples
	Introduction
	Managing datasets with ICD-10 codes
	Creating new variables

	Stored results
	Acknowledgments
	References
	Also see

	icd10cm
	Description
	Quick start
	Menu
	Syntax
	Options
	Options for icd10cm check
	Options for icd10cm clean
	Options for icd10cm generate
	Option for icd10cm lookup
	Options for icd10cm search

	Remarks and examples
	Introduction
	Managing datasets with ICD-10-CM codes
	Interactive utilities

	Stored results
	Acknowledgments
	Reference
	Also see

	icd10pcs
	Description
	Quick start
	Menu
	Syntax
	Options
	Options for icd10pcs check
	Options for icd10pcs clean
	Options for icd10pcs generate
	Option for icd10pcs lookup
	Options for icd10pcs search

	Remarks and examples
	Introduction
	Managing datasets with ICD-10-PCS codes
	Interactive utilities

	Stored results
	Acknowledgments
	Also see

	import
	Description
	Remarks and examples
	Summary of the different methods
	import excel
	import delimited
	jdbc
	odbc
	infile (free format)---infile without a dictionary
	infix (fixed format)
	infile (fixed format)---infile with a dictionary
	import sas
	import sasxport5 and import sasxport8
	import spss
	import fred
	import haver (Windows only)
	import dbase
	spshape2dta

	Examples
	Video example

	References
	Also see

	import dbase
	Description
	Quick start
	Menu
	Syntax
	Options for import dbase
	Options for export dbase
	Remarks
	Stored results
	Also see

	import delimited
	Description
	Quick start
	Menu
	Syntax
	Options for import delimited
	Options for export delimited
	Remarks and examples
	Introduction
	Importing a text file
	Using other delimiters
	Specifying variable types

	Exporting to a text file
	Video example

	Stored results
	Also see

	import excel
	Description
	Quick start
	Menu
	Syntax
	Options for import excel
	Options for export excel
	Remarks and examples
	Video example

	Stored results
	References
	Also see

	import fred
	Description
	Quick start
	Menu
	Syntax
	Options
	Option for set fredkey
	Options for import fred
	Options for freddescribe
	Options for fredsearch

	Remarks and examples
	Introduction and setup
	The FRED interface
	Advanced imports using the import fred command
	Importing historical vintage data
	Searching, saving, and retrieving series information
	Describing series

	Stored results
	References
	Also see

	import haver
	Description
	Quick start
	Menu
	Syntax
	Options for import haver
	Options for import haver, describe
	Option for set haverdir
	Remarks and examples
	Installation
	Setting the path to Haver databases
	Download example Haver databases
	Determining the contents of a Haver database
	Loading a Haver database
	Loading a Haver database from a describe file
	Temporal aggregation
	Daily data
	Weekly data

	Stored results
	Acknowledgment
	Also see

	import sas
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Also see

	import sasxport5
	Description
	Quick start
	Menu
	Syntax
	Options for import sasxport5
	Options for export sasxport5
	Remarks and examples
	Saving XPORT files for transferring to SAS
	Determining the contents of XPORT files received from SAS
	Using XPORT files received from SAS

	Stored results
	Technical appendix
	A1. Overview of SAS XPORT Transport format
	A2. Implications for writing XPORT datasets from Stata
	A3. Implications for reading XPORT datasets into Stata

	Also see

	import sasxport8
	Description
	Quick start
	Menu
	Syntax
	Options for import sasxport8
	Options for export sasxport8
	Remarks and examples
	Stored results
	Also see

	import spss
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Also see

	infile (fixed format)
	Description
	Quick start
	Menu
	Syntax
	Options
	Dictionary directives

	Remarks and examples
	Introduction
	Reading free-format files
	Reading fixed-format files
	Numeric formats
	String formats
	Specifying column and line numbers
	Examples of reading fixed-format files
	Reading fixed-block files
	Reading EBCDIC files

	Also see

	infile (free format)
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Reading free-format data
	Reading comma-separated data
	Specifying variable types
	Reading string variables
	Skipping variables
	Skipping observations
	Reading time-series data

	Also see

	infix (fixed format)
	Description
	Quick start
	Menu
	Syntax
	Options
	Specifications

	Remarks and examples
	Two ways to use infix
	Reading string variables
	Reading data with multiple lines per observation
	Reading subsets of observations

	Also see

	input
	Description
	Quick start
	Syntax
	Options
	Remarks and examples
	Reference
	Also see

	insobs
	Description
	Menu
	Syntax
	Options
	Remarks and examples
	Acknowledgment
	Also see

	inspect
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Also see

	ipolate
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Methods and formulas
	Reference
	Also see

	isid
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Also see

	jdbc
	Description
	Quick start
	Syntax
	Options
	Options for jdbc connect and jdbc add
	Options for jdbc load
	Options for jdbc insert

	Remarks and examples
	JDBC drivers
	Connecting to a database
	Data source names
	Exploring a database
	Loading data from a database
	Inserting data into a database
	Executing SQL on a database

	Stored results
	References
	Also see

	joinby
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Acknowledgment
	References
	Also see

	label
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Overview
	Video examples

	Stored results
	References
	Also see

	label language
	Description
	Quick start
	Menu
	Syntax
	Option
	Remarks and examples
	Creating labels in the first language
	Creating labels in the second and subsequent languages
	Creating labels from a clean slate
	Creating labels from a previously existing language
	Switching languages
	Changing the name of a language
	Deleting a language
	Appendix: Selected ISO 639-1 two-letter codes

	Stored results
	Methods and formulas
	References
	Also see

	labelbook
	Description
	Quick start
	Menu
	Syntax
	Options
	Options for labelbook
	Options for numlabel
	Options for uselabel

	Remarks and examples
	labelbook
	Diagnosing problems
	numlabel
	uselabel

	Stored results
	Acknowledgments
	References
	Also see

	list
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	References
	Also see

	lookfor
	Description
	Quick start
	Syntax
	Remarks and examples
	Stored results
	References
	Also see

	memory
	Description
	Quick start
	Syntax
	Options
	Remarks and examples
	Examples
	Serious bug in Linux OS
	Notes for system administrators

	Stored results
	Also see

	merge
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Overview
	Basic description
	1:1 merges
	m:1 merges
	1:m merges
	m:m merges
	Sequential merges
	Treatment of overlapping variables
	Sort order
	Troubleshooting m:m merges
	Examples
	Video example

	References
	Also see

	Missing values
	Description
	Remarks and examples
	References
	Also see

	mkdir
	Description
	Quick start
	Syntax
	Option
	Remarks and examples
	Also see

	mvencode
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Overview
	Video example

	Acknowledgment
	Also see

	notes
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	How notes are numbered
	Attaching and listing notes
	Selectively listing notes
	Searching and replacing notes
	Deleting notes
	Warnings
	Video example

	Reference
	Also see

	obs
	Description
	Quick start
	Syntax
	Remarks and examples
	Also see

	odbc
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Unicode and ODBC
	Setting up the data sources
	Listing ODBC data source names
	Listing available table names from a specified data source's system catalog
	Describing a specified table
	Loading data from ODBC sources

	Reference
	Also see

	order
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Also see

	outfile
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Also see

	pctile
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	pctile
	xtile
	_pctile

	Stored results
	Methods and formulas
	Acknowledgment
	Also see

	putmata
	Description
	Quick start
	Syntax
	Options for putmata
	Options for getmata
	Remarks and examples
	Use of putmata
	Use of putmata and getmata
	Using putmata and getmata on subsets of observations
	Using views
	Constructing do-files

	Stored results
	Reference
	Also see

	range
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Also see

	recast
	Description
	Quick start
	Syntax
	Option
	Remarks and examples
	Also see

	recode
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Simple examples
	Setting up value labels with recode
	Referring to the minimum and maximum in rules
	Recoding missing values
	Recoding subsets of the data
	Otherwise rules
	Test for overlapping rules
	Video example

	Acknowledgment
	Also see

	rename
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Reference
	Also see

	rename group
	Description
	Quick start
	Menu
	Syntax
	Options for renaming variables
	Options for changing the case of groups of variable names
	Remarks and examples
	Advice
	Explanation
	* matches 0 or more characters; use ?* to match 1 or more
	* is greedy
	# is greedier

	Stored results
	Also see

	reshape
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Description of basic syntax
	Wide and long data forms
	Avoiding and correcting mistakes
	reshape long and reshape wide without arguments
	Missing variables
	Advanced issues with basic syntax: i()
	Advanced issues with basic syntax: j()
	Advanced issues with basic syntax: xij
	Advanced issues with basic syntax: String identifiers for j()
	Advanced issues with basic syntax: Second-level nesting
	Description of advanced syntax
	Video examples

	Stored results
	Acknowledgment
	References
	Also see

	rmdir
	Description
	Quick start
	Syntax
	Remarks and examples
	Also see

	sample
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	References
	Also see

	save
	Description
	Quick start
	Menu
	Syntax
	Options for save
	Options for saveold
	Remarks and examples
	Also see

	separate
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Acknowledgment
	Reference
	Also see

	shell
	Description
	Syntax
	Remarks and examples
	Stata for Windows
	Stata for Mac
	Stata for Unix(GUI)
	Stata for Unix(console)

	Reference
	Also see

	snapshot
	Description
	Quick start
	Menu
	Syntax
	Option
	Remarks and examples
	Stored results
	Also see

	sort
	Description
	Quick start
	Menu
	Syntax
	Option
	Remarks and examples
	Finding the smallest values (and the largest)
	Tracking sort order
	Sorting on multiple variables
	Descending sorts
	Sorting on string variables
	Sorting with ties

	References
	Also see

	split
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Acknowledgments
	Also see

	splitsample
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	stack
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Reference
	Also see

	statsby
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Collecting coefficients and standard errors
	Collecting stored results
	All subsets

	Acknowledgment
	References
	Also see

	sysuse
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Typical use
	A note concerning shipped datasets
	Using user-installed datasets
	How sysuse works

	Stored results
	Also see

	type
	Description
	Quick start
	Syntax
	Options
	Remarks and examples
	Also see

	unicode
	Description
	Remarks and examples
	Also see

	unicode collator
	Description
	Syntax
	Remarks and examples
	Overview of collation
	The role of locales in collation
	Further controlling collation

	Also see

	unicode convertfile
	Description
	Syntax
	Options
	Remarks and examples
	Conversion between encodings
	Invalid and unsupported characters
	Examples

	Also see

	unicode encoding
	Description
	Syntax
	Remarks and examples
	Also see

	unicode locale
	Description
	Syntax
	Remarks and examples
	Overview
	Default locale and locale fallback

	Also see

	unicode translate
	Description
	Syntax
	Options
	Remarks and examples
	What is this about?
	Do I need to translate my files?
	Overview of the process
	How to determine the extended ASCII encoding
	Use of unicode analyze
	Use of unicode translate: Overview
	Use of unicode translate: A word on backups
	Use of unicode translate: Output
	Translating binary strLs

	Also see

	use
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Also see

	varmanage
	Description
	Menu
	Syntax
	Remarks and examples
	Also see

	vl
	Description
	Remarks and examples
	Introduction
	vl set and system-defined variable lists
	Classification criteria for system-defined variable lists
	Moving variables into another classification
	vl create and user-defined variable lists
	vl list
	vl substitute and factor-variable operators
	Exploring data with vl set
	Changing the cutoffs for classification
	Moving variables from one classification to another
	Dropping variables and rebuilding variable lists
	Changing variables and updating variable lists
	Saving and using datasets with variable lists
	User-defined variable lists and factor-variable operators
	Updating variable lists created by vl substitute

	Also see

	vl create
	Description
	Quick start
	Syntax
	Remarks and examples
	vl create
	vl modify

	Using variable lists with other Stata commands
	vl substitute

	Also see

	vl drop
	Description
	Quick start
	Syntax
	Options
	Remarks and examples
	Also see

	vl list
	Description
	Quick start
	Syntax
	Options
	Remarks and examples
	Stored results
	Also see

	vl rebuild
	Description
	Quick start
	Syntax
	Remarks and examples
	Reloading datasets
	Merging datasets
	Dropping variables
	vl substitute and vl rebuild
	Characteristics

	Stored results
	Also see

	vl set
	Description
	Quick start
	Syntax
	Options
	Remarks and examples
	Stored results
	Also see

	webuse
	Description
	Quick start
	Menu
	Syntax
	Option
	Remarks and examples
	Typical use
	A note concerning example datasets
	Redirecting the source

	Also see

	xpose
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Reference
	Also see

	zipfile
	Description
	Quick start
	Syntax
	Option for zipfile
	Option for unzipfile
	Remarks and examples

	Glossary

	[DSGE] DSGE
	Contents
	Intro
	Description
	Remarks and examples
	Also see

	Intro 1
	Description
	Remarks and examples
	Introduction to DSGE models
	An example: A nonlinear DSGE model
	Writing down nonlinear DSGEs
	Data preparation
	Specifying the model to dsgenl
	Parameter estimation and interpretation of nonlinear DSGEs

	An example: A linear DSGE model
	Writing down linearized DSGEs
	Specifying the model to dsge
	Parameter estimation and interpretation of linear DSGEs

	Postestimation
	Policy and transition matrices
	Impulse responses
	Forecasts

	Structural and reduced forms of DSGE models

	References
	Also see

	Intro 2
	Description
	Remarks and examples
	Introduction
	Syntax for linear DSGE models
	Preview of dsge syntax
	Specifying the system of linear equations
	Control variables
	State variables and shocks
	Expectations of future values of control variables
	Specifying parameters using dsge's substitutable expressions

	Syntax for nonlinear DSGE models
	Preview of dsgenl syntax
	Specifying the system of nonlinear equations
	State and control variables
	Expectations in nonlinear models


	Also see

	Intro 3
	Description
	Remarks and examples
	Also see

	Intro 3a
	Description
	Remarks and examples
	The model
	Parameter estimation
	Policy and transition matrices
	One-step-ahead predictions
	Estimating an unobserved state

	Reference
	Also see

	Intro 3b
	Description
	Remarks and examples
	The model
	Solving the model
	Policy and transition matrices
	Impulse responses
	Sensitivity analysis

	Reference
	Also see

	Intro 3c
	Description
	Remarks and examples
	The model
	Parameter estimation
	Policy and transition matrices
	Impulse responses

	Also see

	Intro 3d
	Description
	Remarks and examples
	The model
	Parameter estimation
	Policy and transition matrices
	Impulse responses
	A change in constraints

	Reference
	Also see

	Intro 3e
	Description
	Remarks and examples
	The model
	Parameter estimation
	Steady state
	Model-implied covariances
	Policy and transition matrices
	Impulse responses
	Sensitivity analysis

	Reference
	Also see

	Intro 3f
	Description
	Remarks and examples
	The model
	Approximating the solution to a nonlinear DSGE model
	Specifying the model to Stata
	After solving
	The steady state
	Approximations to the policy and transition matrices
	Linear and log-linear approximations


	References
	Also see

	Intro 4
	Description
	Remarks and examples
	Introduction
	Shocks to a control equation
	Including a lag of a control variable
	Including a lag of a state variable
	Including an expectation of a control dated by more than one period ahead
	Including a second-order lag of a control variable
	Including an observed exogenous variable

	Also see

	Intro 4a
	Description
	Remarks and examples
	The model
	Parameter estimation

	Also see

	Intro 4b
	Description
	Remarks and examples
	A model with a lagged endogenous variable
	Parameter estimation

	Also see

	Intro 4c
	Description
	Remarks and examples
	A model with a lagged state variable
	Parameter estimation

	Also see

	Intro 4d
	Description
	Remarks and examples
	The model
	Parameter estimation

	Also see

	Intro 4e
	Description
	Remarks and examples
	The model
	Parameter estimation

	Also see

	Intro 4f
	Description
	Remarks and examples
	The model
	Parameter estimation

	Also see

	Intro 4g
	Description
	Remarks and examples
	The model
	Parameter estimation

	Also see

	Intro 5
	Description
	Remarks and examples
	Why we care about stability
	What if the initial values are not saddle-path stable?

	References
	Also see

	Intro 6
	Description
	Remarks and examples
	Reference
	Also see

	Intro 7
	Description
	Remarks and examples
	Also see

	Intro 8
	Description
	Remarks and examples
	Wald tests vary with nonlinear transforms
	LR tests do not vary with nonlinear transforms

	References
	Also see

	Intro 9
	Description
	Remarks and examples
	Introduction
	Principles of Bayesian DSGE estimation
	An uninformative prior
	An informative prior
	Convergence diagnostics


	Also see

	Intro 9a
	Description
	Remarks and examples
	The model
	Parameter estimation
	Posterior diagnostics and plots
	Improving sampling efficiency
	Impulse responses

	Also see

	Intro 9b
	Description
	Remarks and examples
	The model
	Parameter estimation
	Posterior diagnostics and plots
	Impulse responses

	Reference
	Also see

	dsge
	Description
	Menu
	Syntax
	Options
	Remarks
	Stored results
	Methods and formulas
	References
	Also see

	dsge postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	Remarks and examples
	Methods and formulas
	Also see

	dsgenl
	Description
	Menu
	Syntax
	Options
	Remarks
	Stored results
	Methods and formulas
	Reference
	Also see

	dsgenl postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	Remarks and examples
	Methods and formulas
	Also see

	estat covariance
	Description
	Quick start
	Menu for estat
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	estat policy
	Description
	Quick start
	Menu for estat
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	estat stable
	Description
	Menu for estat
	Syntax
	Remarks and examples
	Stored results
	Methods and formulas
	Reference
	Also see

	estat steady
	Description
	Quick start
	Menu for estat
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	estat transition
	Description
	Quick start
	Menu for estat
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	Glossary
	Reference


	[ERM] Extended Regression
	Contents
	Intro
	Description
	Remarks and examples
	Introductions
	Examples
	ERM commands
	Postestimation
	Technical details
	Glossary


	Intro 1
	Description
	Remarks and examples
	The problems ERMs solve
	The simple syntax of ERMs
	Normality assumption underlying ERMs
	Learning more about ERMs

	Reference
	Also see

	Intro 2
	Description
	Remarks and examples
	Linear regression models
	Interval regression models
	Probit regression models
	Ordered probit regression models

	Also see

	Intro 3
	Description
	Remarks and examples
	What are endogenous and exogenous covariates?
	Solving the problem of endogenous covariates
	Solving the problem of reverse causation
	You can interact endogenous covariates
	You can have continuous, binary, and ordered endogenous covariates
	You can have instruments that are themselves endogenous
	Video example

	Also see

	Intro 4
	Description
	Remarks and examples
	Is sample selection a concern in your research problem?
	The problem and solution of endogenous sample selection
	Endogenous sample selection handles missing not at random
	Endogenous sample selection can be used with other features of ERMs
	Mechanical notes
	Video example

	Also see

	Intro 5
	Description
	Remarks and examples
	What are treatment-effect models?
	Treatment-effect models and potential outcomes
	Endogenous and exogenous treatment effects
	Binary and ordinal treatment effects
	Sample versus population standard errors
	Using treatment effects with other ERMs
	Using treatment effects with other features of ERMs
	Using treat() and select() to handle lost to follow-up
	Treatment statistics reported by estat teffects
	Video example

	Also see

	Intro 6
	Description
	Remarks and examples
	Random-effects models that ERMs handle
	Random effects can be used with other features of ERMs

	Also see

	Intro 7
	Description
	Remarks and examples
	Use margins
	Endogenous covariates
	How to interpret coefficients
	How to use and interpret margins
	How to use margins in models without endogenous covariates
	How to use margins with endogenous covariates 
	margins with predict(asf)
	margins with predict(fixedasf)
	When to use which
	Using margins with nonlinear and random-effects models
	Advanced options: Using margins predict(base()) and predict(fix())

	References
	Also see

	Intro 8
	Description
	Remarks and examples
	Also see

	Intro 9
	Description
	Remarks and examples
	Introduction
	Complications
	Endogenous covariates
	Nonrandom treatment assignment
	Endogenous sample selection

	Interpreting effects
	Video examples

	References
	Also see

	eintreg
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	Introduction
	Endogenous covariates
	Continuous endogenous covariates
	Binary and ordinal endogenous covariates

	Treatment
	Endogenous sample selection
	Probit endogenous sample selection
	Tobit endogenous sample selection

	Random effects
	Combinations of features
	Confidence intervals

	References
	Also see

	eintreg postestimation
	Postestimation commands
	predict
	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Methods and formulas
	Also see

	eintreg predict
	Description
	Syntax
	Options for statistics
	Options for asfmethod
	Option for counterfactuals
	Remarks and examples
	Methods and formulas
	Also see

	eoprobit
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	intro
	Endogenous covariates
	contendog
	catendog

	Treatment
	Endogenous sample selection
	probitsel
	tobitsel

	Random effects
	Combinations of features
	ci

	References
	Also see

	eoprobit postestimation
	Postestimation commands
	predict
	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Methods and formulas
	References
	Also see

	eoprobit predict
	Description
	Syntax
	Options for statistics
	Options for asfmethod
	Option for counterfactuals
	Remarks and examples
	Using predict after eoprobit and xteoprobit
	How to think about nonlinear models

	Methods and formulas
	Also see

	eprobit
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	intro
	Endogenous covariates
	contendog
	catendog

	Treatment
	Endogenous sample selection
	probitsel
	tobitsel

	Random effects
	Combined model
	ci
	likelihood

	References
	Also see

	eprobit postestimation
	Postestimation commands
	predict
	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Methods and formulas
	asf
	predtotal

	References
	Also see

	eprobit predict
	Description
	Syntax
	Options for statistics
	Options for asfmethod
	Option for counterfactuals
	Remarks and examples
	Using predict after eprobit
	How to think about nonlinear models

	Methods and formulas
	Also see

	eregress
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	intro
	Endogenous covariates
	contendog
	catendog

	Treatment
	Endogenous sample selection
	probitsel
	tobitsel

	Random effects
	Combinations of features
	ci

	References
	Also see

	eregress postestimation
	Postestimation commands
	predict
	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Methods and formulas
	References
	Also see

	eregress predict
	Description
	Syntax
	Options for statistics
	Options for asfmethod
	Option for counterfactuals
	Remarks and examples
	How to think about the model you fit
	The default asf mean calculation for predictions
	The fixedasf calculation for predictions

	Methods and formulas
	References
	Also see

	ERM options
	Description
	Syntax
	Options
	Also see

	estat teffects
	Description
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Also see

	Example 1a
	Description
	Remarks and examples
	Video example

	Also see

	Example 1b
	Description
	Remarks and examples
	Also see

	Example 1c
	Description
	Remarks and examples
	Also see

	Example 2a
	Description
	Remarks and examples
	Also see

	Example 2b
	Description
	Remarks and examples
	Also see

	Example 2c
	Description
	Remarks and examples
	Video example

	Also see

	Example 3a
	Description
	Remarks and examples
	Also see

	Example 3b
	Description
	Remarks and examples
	Also see

	Example 4a
	Description
	Remarks and examples
	Also see

	Example 4b
	Description
	Remarks and examples
	Also see

	Example 5
	Description
	Remarks and examples
	Also see

	Example 6a
	Description
	Remarks and examples
	Also see

	Example 6b
	Description
	Remarks and examples
	Also see

	Example 7
	Description
	Remarks and examples
	Reference
	Also see

	Example 8a
	Description
	Remarks and examples
	Also see

	Example 8b
	Description
	Remarks and examples
	Also see

	Example 9
	Description
	Remarks and examples
	Also see

	predict advanced
	Description
	Syntax
	Options
	Remarks and examples
	Methods and formulas
	Also see

	predict treatment
	Description
	Syntax
	Options
	Remarks and examples
	Predicting treatment effects after eregress, eintreg, xteregress, and xteintreg
	Predicting treatment effects after eprobit and xteprobit
	Predicting treatment effects after eoprobit and xteoprobit

	Methods and formulas
	Also see

	Triangularize
	Description
	Remarks and examples
	What is a triangular system?
	Triangularizing nontriangular systems
	You can only triangularize linear equations
	Options entreat(), select(), and tobitselect() also add endogenous variables
	Workarounds involving the main equation
	Why the above is a workaround and not a fix

	Also see

	Glossary
	References


	[FMM] Finite Mixture Models
	Contents
	fmm intro
	Description
	Remarks and examples
	Introduction
	Finite mixture models
	ex1
	Beyond mixtures of distributions

	Acknowledgment
	References
	Also see

	fmm estimation
	Description
	Also see

	fmm
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	The likelihood
	The EM algorithm
	Survey data
	Predictions

	Also see

	fmm: betareg
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Methods and formulas
	Reference
	Also see

	fmm: cloglog
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	fmm: glm
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	fmm: intreg
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	fmm: ivregress
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	fmm: logit
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	fmm: mlogit
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	fmm: nbreg
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	fmm: ologit
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	fmm: oprobit
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	fmm: pointmass
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	fmm: poisson
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	fmm: probit
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	fmm: regress
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	fmm: streg
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	fmm: tobit
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	fmm: tpoisson
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	fmm: truncreg
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	fmm postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Methods and formulas
	Also see

	estat eform
	Description
	Menu for estat
	Syntax
	Options
	Remarks and examples
	Also see

	estat lcmean
	Description
	Menu for estat
	Syntax
	Options
	Remarks and examples
	Stored results
	Also see

	estat lcprob
	Description
	Menu for estat
	Syntax
	Options
	Remarks and examples
	Stored results
	Also see

	Example 1a
	Description
	Remarks and examples
	References
	Also see

	Example 1b
	Description
	Remarks and examples
	Also see

	Example 1c
	Description
	Remarks and examples
	Also see

	Example 1d
	Description
	Remarks and examples
	Also see

	Example 2
	Description
	Remarks and examples
	References
	Also see

	Example 3
	Description
	Remarks and examples
	References
	Also see

	Example 4
	Description
	Remarks and examples
	References
	Also see

	Glossary

	[FN] Functions
	Contents
	Intro
	Description
	Reference
	Also see

	Functions by category
	Contents
	Date and time functions
	Mathematical functions
	Matrix functions
	Programming functions
	Random-number functions
	Selecting time-span functions
	Statistical functions
	String functions
	Trigonometric functions
	Also see

	Functions by name
	
	Also see

	Date and time functions
	Contents
	Functions
	age()
	age_frac()
	birthday()
	bofd()
	Cdhms()
	Chms()
	Clock()
	clock()
	Clockdiff()
	clockdiff()
	Clockdiff_frac()
	clockdiff_frac()
	Clockpart()
	clockpart()
	Cmdyhms()
	Cofc()
	cofC()
	Cofd()
	cofd()
	daily()
	date()
	datediff()
	datediff_frac()
	datepart()
	day()
	daysinmonth()
	dhms()
	dofb()
	dofC()
	dofc()
	dofh()
	dofm()
	dofq()
	dofw()
	dofy()
	dow()
	doy()
	firstdayofmonth()
	halfyear()
	halfyearly()
	hh()
	hhC()
	hms()
	hofd()
	hours()
	isleapsecond()
	isleapyear()
	lastdayofmonth()
	mdy()
	mdyhms()
	minutes()
	mm()
	mmC()
	mofd()
	month()
	monthly()
	msofhours()
	msofminutes()
	msofseconds()
	nextbirthday()
	nextleapyear()
	now()
	previousbirthday()
	previousleapyear()
	qofd()
	quarter()
	quarterly()
	seconds()
	ss()
	ssC()
	tC()
	tc()
	td()
	th()
	tm()
	today()
	tq()
	tw()
	week()
	weekly()
	wofd()
	year()
	yearly()
	yh()
	ym()
	yofd()
	yq()
	yw()

	Remarks and examples
	Video example

	Methods and formulas
	References
	Also see

	Mathematical functions
	Contents
	Functions
	abs()
	ceil()
	cloglog()
	comb()
	digamma()
	exp()
	expm1()
	floor()
	int()
	invcloglog()
	invlogit()
	ln()
	ln1m()
	ln1p()
	lnfactorial()
	lngamma()
	log()
	log10()
	log1m()
	log1p()
	logit()
	max()
	min()
	mod()
	reldif()
	round()
	sign()
	sqrt()
	sum()
	trigamma()
	trunc()

	Video example
	References
	Also see

	Matrix functions
	Contents
	Functions
	Matrix functions returning a matrix
	cholesky()
	corr()
	diag()
	get()
	hadamard()
	I()
	inv()
	invsym()
	invvech()
	invvecp()
	J()
	matuniform()
	nullmat()
	sweep()
	vec()
	vecdiag()
	vech()
	vecp()
	Matrix functions returning a scalar
	coleqnumb()
	colnfreeparms()
	colnumb()
	colsof()
	det()
	diag0cnt()
	el()
	issymmetric()
	matmissing()
	mreldif()
	roweqnumb()
	rownfreeparms()
	rownumb()
	rowsof()
	trace()

	Reference
	Also see

	Programming functions
	Contents
	Functions
	autocode()
	byteorder()
	c()
	_caller()
	chop()
	clip()
	cond()
	e()
	e(sample)
	epsdouble()
	epsfloat()
	fileexists()
	fileread()
	filereaderror()
	filewrite()
	float()
	fmtwidth()
	frval()
	frvalu()
	_frval()
	_frvaliv()
	has_eprop()
	inlist()
	inrange()
	irecode()
	matrix()
	maxbyte()
	maxdouble()
	maxfloat()
	maxint()
	maxlong()
	mi()
	minbyte()
	mindouble()
	minfloat()
	minint()
	minlong()
	missing()
	r()
	recode()
	replay()
	return()
	s()
	scalar()
	smallestdouble()

	References
	Also see

	Random-number functions
	Contents
	Functions
	runiform()
	runiform(ab)
	runiformint()
	rbeta()
	rbinomial()
	rcauchy()
	rchi2()
	rexponential()
	rgamma()
	rhypergeometric()
	rigaussian()
	rlaplace()
	rlogistic()
	rlogistic(s)
	rlogistic(ms)
	rnbinomial()
	rnormal()
	rnormal(m)
	rnormal(ms)
	rpoisson()
	rt()
	rweibull()
	rweibull(ab)
	rweibull(abg)
	rweibullph()
	rweibullph(ab)
	rweibullph(abg)

	Remarks and examples
	Methods and formulas
	kiss32 generator

	Acknowledgments
	References
	Also see

	Selecting time-span functions
	Contents
	Functions
	tin()
	twithin()

	Also see

	Statistical functions
	Contents
	Functions
	Beta and noncentral beta distributions
	betaden()
	ibeta()
	ibetatail()
	invibeta()
	invibetatail()
	nbetaden()
	nibeta()
	invnibeta()
	Binomial distribution
	binomialp()
	binomial()
	binomialtail()
	invbinomial()
	invbinomialtail()
	Cauchy distribution
	cauchyden()
	cauchy()
	cauchytail()
	invcauchy()
	invcauchytail()
	lncauchyden()
	Chi-squared and noncentral chi-squared distributions
	chi2den()
	chi2()
	chi2tail()
	invchi2()
	invchi2tail()
	nchi2den()
	nchi2()
	nchi2tail()
	invnchi2()
	invnchi2tail()
	npnchi2()
	Dunnett's multiple range distribution
	dunnettprob()
	invdunnettprob()
	Exponential distribution
	exponentialden()
	exponential()
	exponentialtail()
	invexponential()
	invexponentialtail()
	F and noncentral F distributions
	Fden()
	F()
	Ftail()
	invF()
	invFtail()
	nFden()
	nF()
	nFtail()
	invnF()
	invnFtail()
	npnF()
	Gamma distribution
	gammaden()
	gammap()
	gammaptail()
	invgammap()
	invgammaptail()
	dgammapda()
	dgammapdada()
	dgammapdadx()
	dgammapdx()
	dgammapdxdx()
	lnigammaden()
	Hypergeometric distribution
	hypergeometricp()
	hypergeometric()
	Inverse Gaussian distribution
	igaussianden()
	igaussian()
	igaussiantail()
	invigaussian()
	invigaussiantail()
	lnigaussianden()
	Laplace distribution
	laplaceden()
	laplace()
	laplacetail()
	invlaplace()
	invlaplacetail()
	lnlaplaceden()
	Logistic distribution
	logisticden(x)
	logisticden(sx)
	logisticden()
	logisticden(msx)
	logistic()
	logistic(x)
	logistic(sx)
	logistic(msx)
	logistictail()
	logistictail(x)
	logistictail(sx)
	logistictail(msx)
	invlogistic()
	invlogistic(p)
	invlogistic(sp)
	invlogistic(msp)
	invlogistictail()
	invlogistictail(p)
	invlogistictail(sp)
	invlogistictail(msp)
	Negative binomial distribution
	nbinomialp()
	nbinomial()
	nbinomialtail()
	invnbinomial()
	invnbinomialtail()
	Normal (Gaussian), binormal, and multivariate normal distributions
	normalden()
	normalden(xs)
	normalden(xms)
	normal()
	invnormal()
	lnnormalden()
	lnnormalden(xs)
	lnnormalden(xms)
	lnnormal()
	binormal()
	lnmvnormalden()
	Poisson distribution
	poissonp()
	poisson()
	poissontail()
	invpoisson()
	invpoissontail()
	Student's t and noncentral Student's t distributions
	tden()
	t()
	ttail()
	invt()
	invttail()
	invnt()
	invnttail()
	ntden()
	nt()
	nttail()
	npnt()
	Tukey's Studentized range distribution
	tukeyprob()
	invtukeyprob()
	Weibull distribution
	weibullden()
	weibullden(abx)
	weibullden(abgx)
	weibull()
	weibull(abx)
	weibull(abgx)
	weibulltail()
	weibulltail(abx)
	weibulltail(abgx)
	invweibull()
	invweibull(abp)
	invweibull(abgp)
	invweibulltail()
	invweibulltail(abp)
	invweibulltail(abgp)
	Weibull (proportional hazards) distribution
	weibullphden()
	weibullphden(abx)
	weibullphden(abgx)
	weibullph()
	weibullph(abx)
	weibullph(abgx)
	weibullphtail()
	weibullphtail(abx)
	weibullphtail(abgx)
	invweibullph()
	invweibullph(abp)
	invweibullph(abgp)
	invweibullphtail()
	invweibullphtail(abp)
	invweibullphtail(abgp)
	Wishart distribution
	lnwishartden()
	lniwishartden()

	References
	Also see

	String functions
	Contents
	Functions
	abbrev()
	char()
	uchar()
	collatorlocale()
	collatorversion()
	indexnot()
	plural()
	real()
	regexm()
	regexr()
	regexs()
	ustrregexm()
	ustrregexrf()
	ustrregexra()
	ustrregexs()
	soundex()
	soundex_nara()
	strcat()
	strdup()
	string()
	string(ns)
	stritrim()
	strlen()
	ustrlen()
	udstrlen()
	strlower()
	ustrlower()
	strltrim()
	ustrltrim()
	strmatch()
	strofreal()
	strofreal(ns)
	strpos()
	ustrpos()
	strproper()
	ustrtitle()
	strreverse()
	ustrreverse()
	strrpos()
	ustrrpos()
	strrtrim()
	ustrrtrim()
	strtoname()
	ustrtoname()
	strtrim()
	ustrtrim()
	strupper()
	ustrupper()
	subinstr()
	usubinstr()
	subinword()
	substr()
	usubstr()
	udsubstr()
	tobytes()
	uisdigit()
	uisletter()
	ustrcompare()
	ustrcompareex()
	ustrfix()
	ustrfrom()
	ustrinvalidcnt()
	ustrleft()
	ustrnormalize()
	ustrright()
	ustrsortkey()
	ustrsortkeyex()
	ustrto()
	ustrtohex()
	ustrunescape()
	word()
	ustrword()
	wordbreaklocale()
	wordcount()
	ustrwordcount()

	References
	Also see

	Trigonometric functions
	Contents
	Functions
	acos()
	acosh()
	asin()
	asinh()
	atan()
	atan2()
	atanh()
	cos()
	cosh()
	sin()
	sinh()
	tan()
	tanh()

	Reference
	Also see


	[G] Graphics
	Contents
	Introduction
	Intro
	Description
	Also see

	Graph intro
	Remarks and examples
	Suggested reading order
	A quick tour
	Using the menus

	References
	Also see

	Graph Editor
	Remarks and examples
	Quick start
	Introduction
	Starting and stopping the Graph Editor
	The tools
	The Object Browser
	Right-click menus, or Contextual menus
	The Standard Toolbar
	The main Graph Editor menu
	Grid editing
	Graph Recorder
	Tips, tricks, and quick edits
	Video example

	Reference
	Also see


	Commands
	graph
	Description
	Syntax
	Remarks and examples
	Also see

	graph bar
	Description
	Quick start
	Menu
	Syntax
	Options
	group_options
	yvar_options
	lookofbar_options
	legending_options
	axis_options
	title_and_other_options
	Suboptions for use with over() and yvaroptions()

	Remarks and examples
	Introduction
	Examples of syntax
	Treatment of bars
	Treatment of data
	Obtaining frequencies
	Multiple bars (overlapping the bars)
	Controlling the text of the legend
	Multiple over()s (repeating the bars)
	Nested over()s
	Charts with many categories
	How bars are ordered
	Reordering the bars
	Putting the bars in a prespecified order
	Putting the bars in height order
	Putting the bars in a derived order
	Reordering the bars, example
	Use with by()
	Video example
	History

	References
	Also see

	graph box
	Description
	Quick start
	Menu
	Syntax
	Options
	group_options
	yvar_options
	boxlook_options
	legending_options
	axis_options
	title_and_other_options
	Suboptions for use with over() and yvaroptions()

	Remarks and examples
	Introduction
	Examples of syntax
	Treatment of multiple yvars versus treatment of over() groups
	How boxes are ordered
	Reordering the boxes
	Putting the boxes in a prespecified order
	Putting the boxes in median order
	Use with by()
	Video example
	History

	Methods and formulas
	References
	Also see

	graph close
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Also see

	graph combine
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Typical use
	Typical use with memory graphs
	Combining twoway graphs
	Advanced use
	Controlling the aspect ratio of subgraphs

	References
	Also see

	graph copy
	Description
	Quick start
	Menu
	Syntax
	Option
	Remarks and examples
	Also see

	graph describe
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Also see

	graph dir
	Description
	Quick start
	Syntax
	Options
	Remarks and examples
	Stored results
	Also see

	graph display
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Changing the size and aspect ratio
	Changing the margins and aspect ratio
	Changing the scheme

	Also see

	graph dot
	Description
	Quick start
	Menu
	Syntax
	Options
	group_options
	yvar_options
	linelook_options
	legending_options
	axis_options
	title_and_other_options
	Suboptions for use with over() and yvaroptions()

	Remarks and examples
	Relationship between dot plots and horizontal bar charts
	Examples
	Appendix: Examples of syntax

	References
	Also see

	graph drop
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Typical use
	Relationship between graph drop _all and discard
	Erasing graphs on disk

	Also see

	graph export
	Description
	Quick start
	Syntax
	Options
	Remarks and examples
	Exporting the graph displayed in a Graph window
	Exporting a graph stored on disk
	Exporting a graph stored in memory

	Reference
	Also see

	graph manipulation
	Description
	Syntax
	Remarks and examples
	Overview of graphs in memory and graphs on disk
	Summary of graph manipulation commands

	Also see

	graph matrix
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Typical use
	Marker symbols and the number of observations
	Controlling the axes labeling
	Adding grid lines
	Adding titles
	Use with by()
	History

	References
	Also see

	graph other
	Description
	Syntax
	Remarks and examples
	Also see

	graph pie
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Typical use
	Data are summed
	Data may be long rather than wide
	How slices are ordered
	Ordering slices by size
	Reordering the slices
	Use with by()
	Video example
	History

	References
	Also see

	graph play
	Description
	Syntax
	Remarks and examples
	Also see

	graph print
	Description
	Quick start
	Syntax
	Options
	Remarks and examples
	Printing the graph displayed in a Graph window
	Printing a graph stored on disk
	Printing a graph stored in memory
	Appendix: Setting up Stata for Unix to print graphs

	Also see

	graph query
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Also see

	graph rename
	Description
	Quick start
	Menu
	Syntax
	Option
	Remarks and examples
	Also see

	graph replay
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Also see

	graph save
	Description
	Quick start
	Syntax
	Options
	Remarks and examples
	Also see

	graph set
	Description
	Quick start
	Syntax
	Remarks and examples
	Overview
	Setting defaults

	Also see

	graph twoway
	Description
	Menu
	Syntax
	Remarks and examples
	Definition
	Syntax
	Multiple if and in restrictions
	twoway and plot options

	References

	graph twoway area
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Typical use
	Advanced use
	Cautions

	Also see

	graph twoway bar
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Typical use
	Advanced use: Overlaying
	Advanced use: Population pyramid
	Cautions

	Reference
	Also see

	graph twoway connected
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Also see

	graph twoway contour
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Controlling the number of contours and their values
	Controlling the colors of the contour areas
	Choose the interpolation method
	Video example

	Reference
	Also see

	graph twoway contourline
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Controlling the number of contour lines and their values
	Controlling the colors of the contour lines
	Choose the interpolation method

	Also see

	graph twoway dot
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Reference
	Also see

	graph twoway dropline
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Typical use
	Advanced use
	Cautions

	Also see

	graph twoway fpfit
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Typical use
	Cautions
	Use with by()

	Also see

	graph twoway fpfitci
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Typical use
	Advanced use
	Cautions
	Use with by()

	Also see

	graph twoway function
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Typical use
	Advanced use 1
	Advanced use 2

	Reference
	Also see

	graph twoway histogram
	Description
	Quick start
	Menu
	Syntax
	Options for use in the discrete case
	Options for use in the continuous case
	Options for use in both cases
	Remarks and examples
	Relationship between graph twoway histogram and histogram
	Typical use
	Use with by()
	History

	References
	Also see

	graph twoway kdensity
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Typical use
	Use with by()

	References
	Also see

	graph twoway lfit
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Typical use
	Cautions
	Use with by()

	Also see

	graph twoway lfitci
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Typical use
	Advanced use
	Cautions
	Use with by()

	Also see

	graph twoway line
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Oneway equivalency of line and scatter
	Typical use
	Advanced use
	Cautions

	Reference
	Also see

	graph twoway lowess
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Typical use
	Use with by()

	References
	Also see

	graph twoway lpoly
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Typical use
	Use with by()

	References
	Also see

	graph twoway lpolyci
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Typical use
	Use with by()

	Also see

	graph twoway mband
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Typical use
	Use with by()

	Also see

	graph twoway mspline
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Typical use
	Cautions
	Use with by()

	Also see

	graph twoway pcarrow
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Basic use
	Advanced use

	References
	Also see

	graph twoway pcarrowi
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Also see

	graph twoway pccapsym
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Basic use 1
	Basic use 2

	Also see

	graph twoway pci
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Also see

	graph twoway pcscatter
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Also see

	graph twoway pcspike
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Basic use
	Advanced use
	Advanced use 2

	Reference
	Also see

	graph twoway qfit
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Typical use
	Cautions
	Use with by()

	Also see

	graph twoway qfitci
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Typical use
	Advanced use
	Cautions
	Use with by()

	Also see

	graph twoway rarea
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Typical use
	Advanced use
	Cautions

	Also see

	graph twoway rbar
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Typical use
	Advanced use

	References
	Also see

	graph twoway rcap
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Typical use
	Advanced use
	Advanced use 2

	Also see

	graph twoway rcapsym
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Also see

	graph twoway rconnected
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Also see

	graph twoway rline
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Also see

	graph twoway rscatter
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Also see

	graph twoway rspike
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Typical use
	Advanced use
	Advanced use 2

	Also see

	graph twoway scatter
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Typical use
	Scatter syntax
	The overall look for the graph
	The size and aspect ratio of the graph
	Titles
	Axis titles
	Axis labels and ticking
	Grid lines
	Added lines
	Axis range
	Log scales
	Multiple axes
	Markers
	Weighted markers
	Jittered markers
	Connected lines
	Graphs by groups
	Saving graphs
	Video example
	Appendix: Styles and composite styles

	References
	Also see

	graph twoway scatteri
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Also see

	graph twoway spike
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Typical use
	Advanced use
	Cautions

	Also see

	graph twoway tsline
	Description
	Quick start
	Menu
	Syntax
	Also see

	graph use
	Description
	Quick start
	Syntax
	Options
	Remarks and examples
	Also see

	palette
	Description
	Quick start
	Syntax
	Options
	Remarks and examples
	Reference
	Also see

	set graphics
	Description
	Quick start
	Syntax
	Remarks and examples
	Also see

	set printcolor
	Description
	Quick start
	Syntax
	Option
	Remarks and examples
	What set printcolor affects
	The problem set printcolor solves
	set printcolor automatic
	set printcolor asis
	set printcolor gs1, gs2, and gs3
	The scheme matters, not the background color you set

	Also see

	set scheme
	Description
	Quick start
	Syntax
	Option
	Remarks and examples
	References
	Also see


	Options
	added_line_options
	Description
	Quick start
	Syntax
	Options
	Suboptions

	Remarks and examples
	Typical use
	Interpretation of repeated options

	Reference
	Also see

	added_text_options
	Description
	Quick start
	Syntax
	Options
	Suboptions

	Remarks and examples
	Typical use
	Advanced use
	Use of the textbox option width()

	Reference
	Also see

	addplot_option
	Description
	Syntax
	Option
	Remarks and examples
	Commands that allow the addplot() option
	Advantage of graph twoway commands
	Advantages of graphic commands implemented outside graph twoway
	Use of the addplot() option

	Reference
	Also see

	advanced_options
	Description
	Syntax
	Options
	Remarks and examples
	Use of yvarlabel() and xvarlabel()
	Use of yvarformat() and xvarformat()
	Use of recast()

	Also see

	area_options
	Description
	Syntax
	Options
	Remarks and examples
	Use with twoway
	Use with graph dot

	Also see

	aspect_option
	Description
	Quick start
	Syntax
	Option
	Suboption
	Remarks and examples
	Reference
	Also see

	axis_choice_options
	Description
	Syntax
	Options
	Remarks and examples
	Usual case: one set of axes
	Special case: multiple axes due to multiple scales
	yaxis(1) and xaxis(1) are the defaults
	Notation style is irrelevant
	yaxis() and xaxis() are plot options
	Specifying the other axes options with multiple axes
	Each plot may have at most one x scale and one y scale
	Special case: Multiple axes with a shared scale

	Reference
	Also see

	axis_label_options
	Description
	Quick start
	Syntax
	Options
	Suboptions

	Remarks and examples
	Default labeling and ticking
	Controlling the labeling and ticking
	Adding extra ticks
	Adding minor labels and ticks
	Adding grid lines
	Suppressing grid lines
	Substituting text for labels
	Contour axes---zlabel(), etc.
	Appendix: Details of syntax

	References
	Also see

	axis_options
	Description
	Options
	Remarks and examples
	Also see

	axis_scale_options
	Description
	Quick start
	Syntax
	Options
	Suboptions

	Remarks and examples
	Use of the yscale() and xscale()
	Specifying the range of a scale
	Obtaining log scales
	Obtaining reversed scales
	Suppressing the axes
	Contour axes---zscale()

	References
	Also see

	axis_title_options
	Description
	Quick start
	Syntax
	Options
	Suboptions

	Remarks and examples
	Default axis titles
	Overriding default titles
	Specifying multiline titles
	Suppressing axis titles
	Interpretation of repeated options
	Titles with multiple y axes or multiple x axes
	Contour axes---ztitle()

	Also see

	barlook_options
	Description
	Syntax
	Options
	Remarks and examples
	Also see

	blabel_option
	Description
	Quick start
	Syntax
	Option
	Suboptions

	Remarks and examples
	Increasing the information content
	Changing how bars are labeled

	Also see

	by_option
	Description
	Quick start
	Syntax
	Option
	byopts
	Remarks and examples
	Typical use
	Placement of graphs
	Treatment of titles
	by() uses subtitle() with graph
	Placement of the subtitle()
	by() uses the overall note()
	Use of legends with by()
	By-styles
	Labeling the edges
	Specifying separate scales for the separate plots
	History

	References
	Also see

	cat_axis_label_options
	Description
	Quick start
	Syntax
	Options
	Remarks and examples
	Also see

	cat_axis_line_options
	Description
	Quick start
	Syntax
	Options
	Remarks and examples
	Also see

	clegend_option
	Description
	Quick start
	Syntax
	Option
	Content and appearance suboptions for use with clegend()
	Suboptions for use with clegend(region())
	Location suboptions for use with clegend()

	Remarks and examples
	When contour legends appear
	Where contour legends appear
	Putting titles on contour legends
	Controlling the axis in contour legends
	Use of legends with by()

	Also see

	cline_options
	Description
	Syntax
	Options
	Remarks and examples
	Also see

	connect_options
	Description
	Syntax
	Options
	Remarks and examples
	Also see

	eps_options
	Description
	Syntax
	Options
	Remarks and examples
	Using the eps_options
	Setting defaults
	Note about PostScript fonts

	Also see

	fcline_options
	Description
	Syntax
	Options
	Remarks and examples

	fitarea_options
	Description
	Syntax
	Options
	Remarks and examples

	gif_options
	Description
	Syntax
	Options
	Remarks and examples
	Using gif_options
	Specifying the width or height

	Also see

	jpg_options
	Description
	Syntax
	Options
	Remarks and examples
	Using jpg_options
	Specifying the width or height
	Image quality

	Also see

	legend_options
	Description
	Quick start
	Syntax
	Options
	Content suboptions for use with legend() and plegend()
	Suboptions for use with legend(region())
	Location suboptions for use with legend()

	Remarks and examples
	When legends appear
	The contents of legends
	Where legends appear
	Putting titles on legends
	Use of legends with by()
	Problems arising with or because of legends

	Also see

	line_options
	Description
	Syntax
	Options
	Remarks and examples
	Also see

	marker_label_options
	Description
	Syntax
	Options
	Remarks and examples
	Typical use
	Eliminating overprinting and overruns
	Advanced use
	Using marker labels in place of markers

	Also see

	marker_options
	Description
	Syntax
	Options
	Remarks and examples
	Also see

	name_option
	Description
	Syntax
	Option
	Remarks and examples
	Also see

	nodraw_option
	Description
	Syntax
	Option
	Remarks and examples
	Also see

	play_option
	Description
	Syntax
	Option
	Remarks and examples
	Also see

	png_options
	Description
	Syntax
	Options
	Remarks and examples
	Using png_options
	Specifying the width or height

	Also see

	pr_options
	Description
	Syntax
	Options
	Remarks and examples
	Using the pr_options
	Setting defaults
	Note for Unix users

	Also see

	ps_options
	Description
	Syntax
	Options
	Remarks and examples
	Using the ps_options
	Setting defaults
	Note about PostScript fonts
	Note for Unix users

	Also see

	rcap_options
	Description
	Syntax
	Options
	Remarks and examples
	Also see

	region_options
	Description
	Quick start
	Syntax
	Options
	Suboptions

	Remarks and examples
	Setting the offset between the axes and the plot region
	Controlling the aspect ratio
	Suppressing the border around the plot region
	Setting background and fill colors
	How graphs are constructed

	Also see

	rspike_options
	Description
	Syntax
	Options
	Remarks and examples
	Also see

	saving_option
	Description
	Quick start
	Syntax
	Option
	Suboptions

	Remarks and examples
	Also see

	scale_option
	Description
	Quick start
	Syntax
	Option
	Remarks and examples
	Also see

	scheme_option
	Description
	Quick start
	Syntax
	Option
	Remarks and examples
	Also see

	std_options
	Description
	Syntax
	Options
	Remarks and examples
	Also see

	svg_options
	Description
	Syntax
	Options
	Remarks and examples
	Using the svg_options
	Setting defaults

	Also see

	textbox_options
	Description
	Syntax
	Options
	Remarks and examples
	Definition of a textbox
	Position
	Justification
	Position and justification combined
	Margins
	Width and height
	Appendix: Overriding default or context-specified positioning

	Also see

	tif_options
	Description
	Syntax
	Options
	Remarks and examples
	Using tif_options
	Specifying the width or height

	Also see

	title_options
	Description
	Quick start
	Syntax
	Options
	Suboptions

	Remarks and examples
	Multiple-line titles
	Interpretation of repeated options
	Positioning of titles
	Alignment of titles
	Spanning
	Using the textbox options box and bexpand

	Reference
	Also see

	twoway_options
	Description
	Syntax
	Options
	Remarks and examples
	Also see


	Styles/concepts/schemes
	addedlinestyle
	Description
	Syntax
	Remarks and examples
	What is an added line?
	What is an addedlinestyle?
	You do not need to specify an addedlinestyle

	Also see

	alignmentstyle
	Description
	Syntax
	Remarks and examples
	Also see

	anglestyle
	Description
	Syntax
	Remarks and examples
	Also see

	areastyle
	Description
	Syntax
	Remarks and examples
	Overview of areastyles
	Numbered styles
	Using numbered styles
	When to use areastyles

	Also see

	axisstyle
	Description
	Syntax
	Remarks and examples
	Also see

	bystyle
	Description
	Syntax
	Remarks and examples
	What is a by-graph?
	What is a bystyle?

	Also see

	clockposstyle
	Description
	Syntax
	Remarks and examples
	Also see

	colorstyle
	Description
	Syntax
	Remarks and examples
	Adjust opacity
	Adjust intensity
	Specify RGB values
	Specify CMYK values
	Specify HSV values
	Export custom colors
	Video example

	References
	Also see

	compassdirstyle
	Description
	Syntax
	Remarks and examples
	Also see

	Concept: gph files
	Description
	Remarks and examples
	Background
	Gph files are machine/operating system independent
	Gph files come in three forms
	Advantages of live-format files
	Advantages of as-is format files
	Retrieving data from live-format files

	Also see

	Concept: lines
	Description
	Syntax
	Remarks and examples
	linestyle
	linealignmentstyle
	linepatternstyle
	linewidthstyle
	colorstyle

	Also see

	Concept: repeated options
	Description
	Remarks and examples
	Also see

	connectstyle
	Description
	Syntax
	Remarks and examples
	Also see

	gridstyle
	Description
	Syntax
	Remarks and examples
	What is a grid?
	What is a gridstyle?
	You do not need to specify a gridstyle
	Turning off and on the grid

	Also see

	intensitystyle
	Description
	Syntax
	Remarks and examples
	Also see

	justificationstyle
	Description
	Syntax
	Remarks and examples
	Also see

	legendstyle
	Description
	Syntax
	Remarks and examples
	What is a legend?
	What is a legendstyle?
	You do not need to specify a legendstyle

	Also see

	linealignmentstyle
	Description
	Syntax
	Also see

	linepatternstyle
	Description
	Syntax
	Remarks and examples
	Also see

	linestyle
	Description
	Syntax
	Remarks and examples
	What is a line?
	What is a linestyle?
	You do not need to specify a linestyle
	Specifying a linestyle can be convenient
	What are numbered styles?
	Suppressing lines

	Reference
	Also see

	linewidthstyle
	Description
	Syntax
	Remarks and examples
	Also see

	marginstyle
	Description
	Syntax
	Remarks and examples
	Also see

	markerlabelstyle
	Description
	Syntax
	Remarks and examples
	What is a markerlabel?
	What is a markerlabelstyle?
	You do not need to specify a markerlabelstyle
	Specifying a markerlabelstyle can be convenient
	What are numbered styles?

	Also see

	markersizestyle
	Description
	Syntax
	Remarks and examples
	Also see

	markerstyle
	Description
	Syntax
	Remarks and examples
	What is a marker?
	What is a markerstyle?
	You do not have to specify a markerstyle
	Specifying a markerstyle can be convenient
	What are numbered styles?

	Also see

	orientationstyle
	Description
	Syntax
	Remarks and examples
	Also see

	plotregionstyle
	Description
	Syntax
	Remarks and examples
	Also see

	pstyle
	Description
	Syntax
	Remarks and examples
	What is a plot?
	What is a pstyle?
	The pstyle() option
	Specifying a pstyle
	What are numbered styles?

	Also see

	ringposstyle
	Description
	Syntax
	Remarks and examples
	Also see

	Schemes intro
	Description
	Syntax
	Remarks and examples
	The role of schemes
	Finding out about other schemes
	Setting your default scheme
	The scheme is applied at display time
	Background color
	Foreground color
	Obtaining new schemes
	Examples of schemes

	References
	Also see

	Scheme economist
	Description
	Syntax
	Remarks and examples
	Also see

	Scheme s1
	Description
	Syntax
	Remarks and examples
	Also see

	Scheme s2
	Description
	Syntax
	Remarks and examples
	Also see

	Scheme sj
	Description
	Syntax
	Remarks and examples
	Also see

	shadestyle
	Description
	Syntax
	Remarks and examples
	What is a shadestyle?
	What are numbered styles?

	Also see

	size
	Description
	Syntax
	Remarks and examples
	Also see

	stylelists
	Description
	Syntax
	Also see

	symbolstyle
	Description
	Syntax
	Remarks and examples
	Typical use
	Filled and hollow symbols
	Size of symbols

	Also see

	text
	Description
	Remarks and examples
	Overview
	Bold and italics
	Superscripts and subscripts
	Fonts, standard
	Fonts, advanced
	Greek letters and other symbols
	Full list of SMCL tags useful in graph text

	Also see

	textboxstyle
	Description
	Syntax
	Remarks and examples
	What is a textbox?
	What is a textboxstyle?
	You do not need to specify a textboxstyle

	Also see

	textsizestyle
	Description
	Syntax
	Also see

	textstyle
	Description
	Syntax
	Remarks and examples
	What is text?
	What is a textstyle?
	You do not need to specify a textstyle
	Relationship between textstyles and textboxstyles

	Also see

	ticksetstyle
	Description
	Syntax
	Also see

	tickstyle
	Description
	Syntax
	Remarks and examples
	What is a tick? What is a tick label?
	What is a tickstyle?
	You do not need to specify a tickstyle
	Suppressing ticks and/or tick labels

	Also see

	Glossary


	[IRT] Item Response Theory
	Contents
	irt
	Description
	Remarks and examples
	References
	Also see

	Control Panel
	Description
	Remarks and examples
	Reference
	Also see

	irt 1pl
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Overview
	Video example

	Stored results
	Methods and formulas
	References
	Also see

	irt 1pl postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	Methods and formulas
	Also see

	irt 2pl
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Overview
	Video example

	Stored results
	Methods and formulas
	References
	Also see

	irt 2pl postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	Methods and formulas
	Also see

	irt 3pl
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Overview
	Video example

	Stored results
	Methods and formulas
	References
	Also see

	irt 3pl postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	Methods and formulas
	Also see

	irt grm
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Overview
	Video example

	Stored results
	Methods and formulas
	References
	Also see

	irt grm postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	Methods and formulas
	Also see

	irt nrm
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Overview
	Video example

	Stored results
	Methods and formulas
	References
	Also see

	irt nrm postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	Methods and formulas
	Also see

	irt pcm
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	irt pcm postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	Methods and formulas
	Also see

	irt rsm
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Overview
	Video example

	Stored results
	Methods and formulas
	References
	Also see

	irt rsm postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	Methods and formulas
	Also see

	irt hybrid
	Description
	Quick start
	Menu
	Syntax
	mopts
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	The likelihood
	Groups
	Gauss--Hermite quadrature
	Adaptive quadrature

	References
	Also see

	irt hybrid postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	Methods and formulas
	Empirical Bayes
	Other predictions

	References
	Also see

	irt, group()
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Overview
	Baseline group model
	Differential item functioning

	Reference
	Also see

	irt, group() postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	Methods and formulas
	Also see

	irt constraints
	Description
	Quick start
	Syntax
	Remarks and examples
	Overview
	Constraints in 1PL, 2PL, and 3PL models
	Constraints in graded response models
	Constraints in nominal response models
	Constraints in partial credit models
	Constraints in rating scale models

	Also see

	estat report
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Also see

	estat greport
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Also see

	irtgraph icc
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	References
	Also see

	irtgraph tcc
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Reference
	Also see

	irtgraph iif
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Methods and formulas
	References
	Also see

	irtgraph tif
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Methods and formulas
	Reference
	Also see

	DIF
	Description
	Remarks and examples
	References
	Also see

	diflogistic
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	difmh
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	Glossary

	[LASSO] Lasso
	Contents
	Lasso intro
	Description
	Remarks and examples
	Summary of Stata's lasso and elastic-net features
	What is lasso?
	Lasso for prediction
	How lasso for prediction works
	Stata commands for prediction

	Lasso for model selection
	Lasso for inference
	Why do we need special lasso methods for inference?
	Methods of lasso for inference
	Stata commands for inference

	Where to learn more

	Acknowledgments
	References
	Also see

	Lasso inference intro
	Description
	Remarks and examples
	The problem
	Possible solutions
	Solutions that focus on the true model
	The double-selection solution
	The partialing-out solution
	The cross-fit partialing-out (double machine-learning) solution

	Where to learn more

	References
	Also see

	bicplot
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Also see

	coefpath
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Coefficient path plots
	An example
	Adding a legend
	lambda scale and reference line
	After fitting with sqrtlasso
	After fitting with elasticnet
	After fitting with inference commands

	Also see

	Collinear covariates
	Description
	Remarks and examples
	Summary
	Explanation
	Applies to inferential commands
	Does not apply to alwaysvars

	Also see

	cvplot
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Also see

	dslogit
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	Reference
	Also see

	dspoisson
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	Reference
	Also see

	dsregress
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	Reference
	Also see

	elasticnet
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	estimates store
	Description
	Remarks and examples
	Overview
	Postestimation commands that work only with current results
	Postestimation commands that work with current results
	lassoselect creates new estimation results

	Also see

	Inference examples
	Description
	Remarks and examples
	1 Overview
	1.1 How to read the example entries
	1.2 Detailed outline of the topics
	1.3 Review of concepts
	1.4 The primary dataset

	2 Fitting and interpreting inferential models
	2.1 Overview of inferential estimation methods
	2.2 Fitting via cross-fit partialing out (xpo) using plugin
	2.3 Fitting via cross-fit partialing out (xpo) using cross-validation
	2.4 Fitting via double selection (ds) using cross-validation
	2.5 Fitting via the other 22 methods
	2.6 Fitting models with several variables of interest
	2.7 Fitting models with factor variables of interest
	2.8 Fitting models with interactions of interest
	2.9 Fitting models with a nonlinear relationship of interest
	2.10 Controls are controls

	3 Fitting logit inferential models to binary outcomes. What is different?
	3.1 Interpreting standard odds ratios
	3.2 Interpreting models with factor variables, nonlinear relationships, and interactions

	4 Fitting inferential models to count outcomes. What is different?
	4.1 Interpreting standard incidence-rate ratios
	4.2 Interpreting models with factor variables

	5 Exploring inferential model lassos
	6 Fitting an inferential model with endogenous covariates

	References
	Also see

	Inference requirements
	Description
	Remarks and examples
	Also see

	lasso
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Lasso fitting and selection methods
	selection(cv): Cross-validation
	The CV function
	Penalized and postselection coefficients
	predict
	Selecting lambda by hand using lassoselect
	More lasso examples

	Stored results
	Methods and formulas
	Lasso and elastic-net objective functions
	Coordinate descent
	Grid of values for lambda
	How to choose the penalty parameters
	How CV is performed
	Adaptive lasso
	Plugin estimators
	BIC


	References
	Also see

	lasso postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	Remarks and examples
	References
	Also see

	lassocoef
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Also see

	lasso examples
	Description
	Remarks and examples
	Overview
	Using vl to manage variables
	Using splitsample
	Lasso linear models
	Adaptive lasso
	Cross-validation folds
	BIC
	More potential variables than observations
	Factor variables in lasso
	Lasso logit and probit models
	Lasso Poisson models

	Also see

	lasso fitting
	Description
	Remarks and examples
	Introduction
	Model selection
	The process
	Step 1. Set the grid range
	Step 2. Fit the model for next lambda in grid
	Selection method none
	Step 3. Identifying a minimum of the CV function
	Plotting the CV function
	Selecting another model

	What exactly is CV?
	Adaptive lasso
	Plugin selection

	Also see

	lassogof
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	lasso inference postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict

	Remarks and examples
	Also see

	lassoinfo
	Description
	Quick start
	Menu
	Syntax
	Option
	Remarks and examples
	Stored results
	Also see

	lassoknots
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Measures of fit
	In-sample measures versus estimates of out-of-sample measures
	BIC
	Examples

	Stored results
	Methods and formulas
	Overview
	Statistics that measure the size of the coefficient vector
	Statistics that measure fit
	CV measures of fit
	Single-sample measures of fit
	Deviance formulas
	Saturated log likelihood

	Prediction error formulas
	BIC formula

	References
	Also see

	lasso options
	Description
	Syntax
	Options
	Suboptions for lasso() and sqrtlasso()

	Remarks and examples
	Reference
	Also see

	lassoselect
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Also see

	poivregress
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	Reference
	Also see

	pologit
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	Reference
	Also see

	popoisson
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	Reference
	Also see

	poregress
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	sqrtlasso
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	Notation
	Plugin estimators

	References
	Also see

	xpoivregress
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	xpologit
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	Reference
	Also see

	xpopoisson
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	Reference
	Also see

	xporegress
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	Reference
	Also see

	Glossary

	[M] Mata
	Contents
	Introduction to the Mata manual
	Intro
	Contents
	Description
	Remarks and examples
	References
	Also see


	Introduction and advice
	Intro
	Contents
	Description
	Remarks and examples
	References
	Also see

	Ado
	Description
	Remarks and examples
	A first example
	Where to store the Mata functions
	Passing arguments to Mata functions
	Returning results to ado-code
	Advice: Use of matastrict
	Advice: Some useful Mata functions

	Also see

	First
	Description
	Remarks and examples
	Invoking Mata
	Using Mata
	Making mistakes: Interpreting error messages
	Working with real numbers, complex numbers, and strings
	Working with scalars, vectors, and matrices
	Working with functions
	Distinguishing real and complex values
	Working with matrix and scalar functions
	Performing element-by-element calculations: Colon operators
	Writing programs
	More functions
	Mata environment commands
	Exiting Mata

	Also see

	help
	Description
	Syntax
	Remarks and examples
	Also see

	How
	Description
	Remarks and examples
	What happens when you define a program
	What happens when you work interactively
	What happens when you type a mata environment command
	Working with object code I: .mo files
	Working with object code II: .mlib libraries
	The Mata environment

	Reference
	Also see

	Interactive
	Description
	Remarks and examples
	1. Start in Stata; load the data
	2. Create any time-series variables
	3. Create a constant variable
	4. Drop unnecessary variables
	5. Drop observations with missing values
	6. Put variables on roughly the same numeric scale
	7. Enter Mata
	8. Use Mata's st_view() function to access your data
	9. Perform your matrix calculations

	Review
	Reference
	Also see

	LAPACK
	Description
	Syntax
	Option for set lapack_mkl
	Remarks and examples
	LAPACK in Mata
	set lapack_mkl
	Intel MKL conditional numerical reproducibility
	set lapack_mkl_cnr

	Acknowledgments
	References
	Also see

	Limits
	Description
	Summary
	Remarks and examples
	Also see

	Naming
	Description
	Syntax
	Remarks and examples
	Interactive use
	Naming variables
	Naming functions
	What happens when functions have the same names
	How to determine if a function name has been taken

	Also see

	Permutation
	Description
	Syntax
	Remarks and examples
	Permutation matrices
	How permutation matrices arise
	Permutation vectors

	Also see

	Returned args
	Description
	Syntax
	Remarks and examples
	Also see

	Source
	Description
	Syntax
	Remarks and examples
	Also see

	Tolerance
	Description
	Syntax
	Remarks and examples
	The problem
	Absolute versus relative tolerances
	Specifying tolerances

	Also see


	Language definition
	Intro
	Contents
	Description
	Remarks and examples
	Also see

	break
	Description
	Syntax
	Remarks and examples
	Also see

	class
	Description
	Syntax
	Introduction
	Example
	Declaration of member variables
	Declaration and definition of methods (member functions)
	Default exposure in declarations

	Remarks and examples
	Notation and jargon
	Declaring and defining a class
	Saving classes in files
	Workflow recommendation
	When you need to recompile
	Obtaining instances of a class
	Constructors and destructors
	Setting member variable and member function exposure
	Making a member final
	Making a member static
	Virtual functions
	Referring to the current class using this
	Using super to access the parent's concept
	Casting back to a parent
	Accessing external functions from member functions
	Pointers to classes

	Reference
	Also see

	Comments
	Description
	Syntax
	Remarks and examples
	The /* */ enclosed comment
	The // rest-of-line comment

	Also see

	continue
	Description
	Syntax
	Remarks and examples
	Also see

	Declarations
	Description
	Syntax
	Remarks and examples
	The purpose of declarations
	Types, element types, and organizational types
	Implicit declarations
	Element types
	Organizational types
	Function declarations
	Argument declarations
	The by-address calling convention
	Variable declarations
	Linking to external globals

	Also see

	do
	Description
	Syntax
	Remarks and examples
	Also see

	Errors
	Description
	Remarks and examples
	The error codes

	Also see

	exp
	Description
	Syntax
	Remarks and examples
	What's an expression
	Assignment suppresses display, as does (void)
	The pieces of an expression
	Numeric literals
	String literals
	Variable names
	Operators
	Functions

	Reference
	Also see

	for
	Description
	Syntax
	Remarks and examples
	Also see

	ftof
	Description
	Syntax
	Remarks and examples
	Passing functions to functions
	Writing functions that receive functions, the simplified convention
	Passing built-in functions

	Also see

	goto
	Description
	Syntax
	Remarks and examples
	Reference
	Also see

	if
	Description
	Syntax
	Remarks and examples
	Also see

	op_arith
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	op_assignment
	Description
	Syntax
	Remarks and examples
	Assignment suppresses display
	The equal-assignment operator
	lvals, what appears on the left-hand side
	Row, column, and element lvals
	Pointer lvals

	Conformability
	Diagnostics
	Also see

	op_colon
	Description
	Syntax
	Remarks and examples
	C-conformability: element by element
	Usefulness of colon logical operators
	Use parentheses

	Conformability
	Diagnostics
	Also see

	op_conditional
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	op_increment
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	op_join
	Description
	Syntax
	Remarks and examples
	Comma and backslash are operators
	Comma as a separator
	Warning about the misuse of comma and backslash operators

	Conformability
	Diagnostics
	Also see

	op_kronecker
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Reference
	Also see

	op_logical
	Description
	Syntax
	Remarks and examples
	Introduction
	Use of logical operators with pointers

	Conformability
	Diagnostics
	Also see

	op_range
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	op_transpose
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	optargs
	Description
	Syntax
	Remarks and examples
	What are optional arguments?
	How to code optional arguments
	Examples revisited

	Also see

	pointers
	Description
	Syntax
	Remarks and examples
	What is a pointer?
	Pointers to variables
	Pointers to expressions
	Pointers to functions
	Pointers to pointers
	Pointer arrays
	Mixed pointer arrays
	Definition of NULL
	Use of parentheses
	Pointer arithmetic
	Listing pointers
	Declaration of pointers
	Use of pointers to collect objects
	Efficiency

	Diagnostics
	References
	Also see

	pragma
	Description
	Syntax
	Remarks and examples
	pragma unset
	pragma unused

	Also see

	reswords
	Description
	Syntax
	Remarks and examples
	Future developments
	Version control

	Also see

	return
	Description
	Syntax
	Remarks and examples
	Functions that return results
	Functions that return nothing (void functions)

	Also see

	Semicolons
	Description
	Syntax
	Remarks and examples
	Optional use of semicolons
	You cannot break a statement anywhere even if you use semicolons
	Use of semicolons to create multistatement lines
	Significant semicolons
	Do not use #delimit ;

	Also see

	struct
	Description
	Syntax
	Remarks and examples
	Introduction
	Structures and functions must have different names
	Structure variables must be explicitly declared
	Declare structure variables to be scalars whenever possible
	Vectors and matrices of structures
	Structures of structures
	Pointers to structures
	Operators and functions for use with structure members
	Operators and functions for use with entire structures
	Listing structures
	Use of transmorphics as passthrus
	Saving compiled structure definitions
	Saving structure variables

	References
	Also see

	Subscripts
	Description
	Syntax
	Remarks and examples
	List subscripts
	Range subscripts
	When to use list subscripts and when to use range subscripts
	A fine distinction

	Conformability
	Diagnostics
	Reference
	Also see

	Syntax
	Description
	Syntax
	Remarks and examples
	Treatment of semicolons
	Types and declarations
	Void matrices
	Void functions
	Operators
	Subscripts
	Implied input tokens
	Function argument-passing convention
	Passing functions to functions
	Optional arguments

	Reference
	Also see

	version
	Description
	Syntax
	Remarks and examples
	Purpose of version control
	Recommendations for do-files
	Recommendations for ado-files
	Compile-time and run-time versioning

	Also see

	void
	Description
	Syntax
	Remarks and examples
	Void matrices, vectors, row vectors, and column vectors
	How to read conformability charts

	Also see

	while
	Description
	Syntax
	Remarks and examples
	Also see


	Commands for controlling Mata
	Intro
	Contents
	Description
	Remarks and examples
	Also see

	end
	Description
	Syntax
	Remarks and examples
	Also see

	lmbuild
	Description
	Syntax
	Options
	Remarks and examples
	Background
	Version control

	Also see

	mata
	Description
	Syntax
	Remarks and examples
	Introduction
	The fine distinction between syntaxes 3 and 4
	The fine distinction between syntaxes 1 and 2

	Also see

	mata clear
	Description
	Syntax
	Remarks and examples
	Also see

	mata describe
	Description
	Syntax
	Option
	Remarks and examples
	Diagnostics
	Also see

	mata drop
	Description
	Syntax
	Remarks and examples
	Also see

	mata help
	Description
	Syntax
	Remarks and examples
	Also see

	mata matsave
	Description
	Syntax
	Option for mata matsave
	Option for mata matuse
	Remarks and examples
	Diagnostics
	Also see

	mata memory
	Description
	Syntax
	Remarks and examples
	Also see

	mata mlib
	Description
	Syntax
	Options
	Remarks and examples
	Background
	Outline of the procedure for dealing with libraries
	Creating a .mlib library
	Adding members to a .mlib library
	Listing the contents of a library
	Making it so Mata knows to search your libraries
	Advice on organizing your source code

	Also see

	mata mosave
	Description
	Syntax
	Options
	Remarks and examples
	Example of use
	Where to store .mo files
	Use of .mo files versus .mlib files

	Also see

	mata rename
	Description
	Syntax
	Also see

	mata set
	Description
	Syntax
	Option
	Remarks and examples
	Relationship between Mata's mata set and Stata's set commands
	c() values

	Also see

	mata stata
	Description
	Syntax
	Remarks and examples
	Also see

	mata which
	Description
	Syntax
	Remarks and examples
	Also see

	namelists
	Description
	Syntax
	Remarks and examples
	Also see


	Categorical guide to Mata functions
	Intro
	Contents
	Description
	Remarks and examples
	Also see

	Dates
	Contents
	Description
	Also see

	IO
	Contents
	Description
	Remarks and examples
	Reference
	Also see

	Manipulation
	Contents
	Description
	Remarks and examples
	Also see

	Mathematical
	Contents
	Description
	Remarks and examples
	Also see

	Matrix
	Contents
	Description
	Remarks and examples
	Also see

	Programming
	Contents
	Also see

	Scalar
	Contents
	Description
	Remarks and examples
	Also see

	Solvers
	Contents
	Description
	Remarks and examples
	Also see

	Standard
	Contents
	Description
	Remarks and examples
	Also see

	Stata
	Contents
	Description
	Remarks and examples
	Reference
	Also see

	Statistical
	Contents
	Description
	Remarks and examples
	Also see

	String
	Contents
	Description
	Remarks and examples
	Also see

	Utility
	Contents
	Description
	Remarks and examples
	Also see


	Alphabetical index to Mata functions
	Intro
	Contents
	Description
	Remarks and examples
	Also see

	abbrev()
	Description
	Syntax
	Conformability
	Diagnostics
	Also see

	abs()
	Description
	Syntax
	Conformability
	Diagnostics
	Also see

	adosubdir()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	all()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	args()
	Description
	Syntax
	Conformability
	Diagnostics
	Also see

	asarray()
	Description
	Syntax
	Remarks and examples
	Detailed description
	Example 1: Scalar keys and scalar contents
	Example 2: Scalar keys and matrix contents
	Example 3: Vector keys and scalar contents; sparse matrix
	Setting the efficiency parameters

	Conformability
	Diagnostics
	Also see

	AssociativeArray()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	ascii()
	Description
	Syntax
	Conformability
	Diagnostics
	Also see

	uchar()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	assert()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	base64encode()
	Description
	Syntax
	Conformability
	Diagnostics
	Also see

	blockdiag()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	bufio()
	Description
	Syntax
	Remarks and examples
	Basics
	Argument C
	Arguments B and offset
	Argument fh
	Argument bfmt
	bfmts for numeric data
	bfmts for string data
	Argument X
	Arguments r and c
	Advanced issues

	Conformability
	Diagnostics
	Also see

	byteorder()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	C()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	c()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	callersversion()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	cat()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	chdir()
	Description
	Syntax
	Conformability
	Diagnostics
	Also see

	cholesky()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Reference
	Also see

	cholinv()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	cholsolve()
	Description
	Syntax
	Remarks and examples
	Derivation
	Relationship to inversion
	Tolerance

	Conformability
	Diagnostics
	Also see

	comb()
	Description
	Syntax
	Conformability
	Diagnostics
	Also see

	cond()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	conj()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	corr()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	cross()
	Description
	Syntax
	Remarks and examples
	Comment concerning cross() and missing values

	Conformability
	Diagnostics
	Also see

	crossdev()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	cvpermute()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	date()
	Description
	Syntax
	Conformability
	Diagnostics
	Also see

	deriv()
	Description
	Syntax
	Remarks and examples
	First example
	Notation and formulas
	Type d evaluators
	Example of a type d evaluator
	Type v evaluators
	User-defined arguments
	Example of a type v evaluator
	Type t evaluators
	Example of a type t evaluator
	Functions

	Conformability
	Diagnostics
	Methods and formulas
	References
	Also see

	designmatrix()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	det()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	_diag()
	Description
	Syntax
	Conformability
	Diagnostics
	Also see

	diag()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	diag0cnt()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	diagonal()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	dir()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	direxists()
	Description
	Syntax
	Conformability
	Diagnostics
	Also see

	direxternal()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	display()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	displayas()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	displayflush()
	Description
	Syntax
	Remarks and examples
	Diagnostics
	Also see

	Dmatrix()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Reference
	Also see

	_docx*()
	Description
	Syntax
	Create and save .docx file
	Add paragraph and text
	Add image file
	Add table
	Edit table
	Query routines

	Remarks and examples
	Detailed description
	Error codes
	Functions
	Create and save .docx file
	Add paragraph and text
	Add image
	Add table
	Edit table
	Query routines

	Save document to disk file
	Current paragraph and text
	Supported image types
	Linked and embedded images
	Styles
	Performance
	Examples
	Create a .docx document in memory
	Add paragraphs and text
	Display data
	Display regression results
	Add an image
	Display nested table
	Add images to table cells
	Save the .docx document in memory to a disk file


	Diagnostics
	References
	Also see

	dsign()
	Description
	Syntax
	Conformability
	Diagnostics
	Also see

	e()
	Description
	Syntax
	Conformability
	Diagnostics
	Also see

	editmissing()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	edittoint()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	edittozero()
	Description
	Syntax
	Remarks and examples
	Background
	Treatment of complex values
	Recommendations

	Conformability
	Diagnostics
	Also see

	editvalue()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	eigensystem()
	Description
	Syntax
	Remarks and examples
	Eigenvalues and eigenvectors
	Left eigenvectors
	Symmetric eigensystems
	Normalization and order
	Eigenvalue condition
	Balancing
	eigensystem() and eigenvalues()
	lefteigensystem()
	symeigensystem() and symeigenvalues()

	Conformability
	Diagnostics
	References
	Also see

	eigensystemselect()
	Description
	Syntax
	Remarks and examples
	Introduction
	Range selection
	Index selection
	Criterion selection
	Other functions

	Conformability
	Diagnostics
	Also see

	eltype()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	epsilon()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	_equilrc()
	Description
	Syntax
	Remarks and examples
	Introduction
	Is equilibration necessary?
	The _equil*() family of functions
	The _perhapsequil*() family of functions
	rowscalefactors() and colscalefactors()

	Conformability
	Diagnostics
	Also see

	error()
	Description
	Syntax
	Remarks and examples
	Use of _error()
	Use of error()

	Conformability
	Diagnostics
	Also see

	errprintf()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	exit()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	exp()
	Description
	Syntax
	Conformability
	Diagnostics
	Also see

	factorial()
	Description
	Syntax
	Conformability
	Diagnostics
	Also see

	favorspeed()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	ferrortext()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	fft()
	Description
	Syntax
	Remarks and examples
	Definitions, notation, and conventions
	Fourier transform
	Convolution and deconvolution
	Correlation
	Utility routines
	Warnings

	Conformability
	Diagnostics
	Also see

	fileexists()
	Description
	Syntax
	Conformability
	Diagnostics
	Also see

	_fillmissing()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	findexternal()
	Description
	Syntax
	Remarks and examples
	Definition of a global
	Use of globals

	Conformability
	Diagnostics
	Also see

	findfile()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	floatround()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	fmtwidth()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	fopen()
	Description
	Syntax
	Remarks and examples
	Opening and closing files
	Reading from a file
	Writing to a file
	Reading and writing in the same file
	Reading and writing matrices
	Repositioning in a file
	Truncating a file
	Error codes

	Conformability
	Diagnostics
	Also see

	fullsvd()
	Description
	Syntax
	Remarks and examples
	Introduction
	Relationship between the full and thin SVDs
	The contents of s
	Possibility of convergence problems

	Conformability
	Diagnostics
	Also see

	geigensystem()
	Description
	Syntax
	Remarks and examples
	Generalized eigenvalues
	Generalized eigenvectors
	Criterion selection
	Range selection
	Index selection

	Conformability
	Diagnostics
	References
	Also see

	ghessenbergd()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	ghk()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	ghkfast()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	gschurd()
	Description
	Syntax
	Remarks and examples
	Generalized Schur decomposition
	Grouping the results

	Conformability
	Diagnostics
	Also see

	halton()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	References
	Also see

	hash1()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	References
	Also see

	hessenbergd()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	Hilbert()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	References
	Also see

	I()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	inbase()
	Description
	Syntax
	Remarks and examples
	Positive integers
	Negative integers
	Numbers with nonzero fractional parts
	Use of the functions

	Conformability
	Diagnostics
	Reference
	Also see

	indexnot()
	Description
	Syntax
	Conformability
	Diagnostics
	Also see

	invorder()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	invsym()
	Description
	Syntax
	Remarks and examples
	Definition of generalized inverse
	Specifying the order in which columns are omitted
	Determining the rank, or counting the number of omitted columns
	Extracting linear dependencies

	Conformability
	Diagnostics
	Also see

	invtokens()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	isascii()
	Description
	Syntax
	Conformability
	Also see

	isdiagonal()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	isfleeting()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	isreal()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	isrealvalues()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	issamefile()
	Description
	Syntax
	Remarks and examples
	Conformability
	Also see

	issymmetric()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Reference
	Also see

	isview()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	J()
	Description
	Syntax
	Remarks and examples
	First syntax: J(r, c, val), val a scalar
	Second syntax: J(r, c, mat), mat a matrix

	Conformability
	Diagnostics
	Also see

	Kmatrix()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Reference
	Also see

	lapack()
	Description
	Syntax
	Remarks and examples
	Mapping calling sequence from Fortran to Mata
	Flopping: Preparing matrices for LAPACK
	Warning on the use of rows() and cols() after _flopin()
	Warning: It is your responsibility to check info
	Example

	Reference
	Also see

	ldl()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	LinearProgram()
	Description
	Syntax
	Step 1: Initialization
	Step 2: Definition of linear programming problem
	Step 3: Perform optimization
	Step 4: Display or obtain results
	Utility function for use in all steps
	Definition of q
	Functions defining the linear programming problem
	Performing optimization
	Functions for obtaining results
	Utility function

	Remarks and examples
	Introduction
	Details about the interior-point method
	Examples

	Conformability
	Diagnostics
	References
	Also see

	liststruct()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	Lmatrix()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Reference
	Also see

	logit()
	Description
	Syntax
	Conformability
	Diagnostics
	Also see

	lowertriangle()
	Description
	Syntax
	Remarks and examples
	Optional argument d
	Nonsquare matrices

	Conformability
	Diagnostics
	Also see

	lud()
	Description
	Syntax
	Remarks and examples
	LU decomposition
	LAPACK routine

	Conformability
	Diagnostics
	Also see

	luinv()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	lusolve()
	Description
	Syntax
	Remarks and examples
	Derivation
	Relationship to inversion
	Tolerance

	Conformability
	Diagnostics
	Also see

	makesymmetric()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	matexpsym()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	matpowersym()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	mean()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	mindouble()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Reference
	Also see

	minindex()
	Description
	Syntax
	Remarks and examples
	Use of functions when v has all unique values
	Use of functions when v has repeated (tied) values
	Summary

	Conformability
	Diagnostics
	Also see

	minmax()
	Description
	Syntax
	Conformability
	Diagnostics
	Also see

	missing()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	missingof()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	mod()
	Description
	Syntax
	Conformability
	Diagnostics
	Also see

	moptimize()
	Description
	Syntax
	Step 1: Initialization
	Step 2: Definition of maximization or minimization problem
	Step 3: Perform optimization or perform a single function evaluation
	Step 4: Post, display, or obtain results
	Utility functions for use in all steps
	Definition of M
	Setting the sample
	Specifying dependent variables
	Specifying independent variables
	Specifying constraints
	Specifying weights or survey data
	Specifying clusters and panels
	Specifying optimization technique
	Specifying initial values
	Performing one evaluation of the objective function
	Performing optimization of the objective function
	Tracing optimization
	Specifying convergence criteria
	Accessing results
	Stata evaluators
	Advanced functions
	Syntax of evaluators
	Syntax of type lf evaluators
	Syntax of type d evaluators
	Syntax of type lf* evaluators
	Syntax of type gf evaluators
	Syntax of type q evaluators
	Passing extra information to evaluators
	Utility functions

	Remarks and examples
	Relationship of moptimize() to Stata's ml and to Mata's optimize()
	Mathematical statement of the moptimize() problem
	Filling in moptimize() from the mathematical statement
	The type lf evaluator
	The type d, lf*, gf, and q evaluators
	Example using type d
	Example using type lf*

	Conformability
	Diagnostics
	References
	Also see

	more()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	mvnormal()
	Description
	Syntax
	Remarks and examples
	Distribution functions
	mvnormal(U,R)
	mvnormal(L,U,R)
	mvnormalcv(L,U,M,V)

	Derivatives of multivariate normal distribution functions
	mvnormalderiv(U,R,dU,dR)
	mvnormalderiv(L,U,R,dL,dU,dR)
	mvnormalcvderiv(L,U,M,V,dL,dU,dM,dV)


	Conformability
	References
	Also see

	_negate()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	norm()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	normal()
	Description
	Syntax
	Remarks and examples
	R-conformability
	A note concerning invbinomial() and invbinomialtail()
	A note concerning ibeta()
	A note concerning gammap()

	Conformability
	Diagnostics
	Also see

	optimize()
	Description
	Syntax
	Remarks and examples
	First example
	Notation
	Type d evaluators
	Example of d0, d1, and d2
	d1debug and d2debug
	Type gf evaluators
	Example of gf0, gf1, and gf2
	Functions

	Conformability
	Diagnostics
	References
	Also see

	panelsetup()
	Description
	Syntax
	Remarks and examples
	Definition of panel data
	Definition of problem
	Preparation
	Use of panelsetup()
	Using panelstats()
	Using panelsubmatrix()
	Using panelsubview()

	Conformability
	Diagnostics
	Also see

	panelsum()
	Description
	Syntax
	Conformability
	Diagnostics
	Also see

	pathjoin()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	Pdf*()
	Description
	Syntax
	PdfDocument
	PdfParagraph
	PdfText
	PdfTable

	Remarks and examples
	PdfDocument class details
	PdfParagraph class details
	PdfText class details
	PdfTable class details
	Error codes
	Examples
	Add paragraph
	Add paragraph with customized text
	Add table (simple example)
	Add table (table with header and footer)
	Add table (table with graph)


	Also see

	pinv()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	References
	Also see

	polyeval()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	printf()
	Description
	Syntax
	Remarks and examples
	printf()
	sprintf()
	The %us and %uds formats

	Conformability
	Diagnostics
	Also see

	qrd()
	Description
	Syntax
	Remarks and examples
	QR decomposition
	Avoiding calculation of Q
	Pivoting
	Least-squares solutions with omitted columns

	Conformability
	Diagnostics
	Also see

	qrinv()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	qrsolve()
	Description
	Syntax
	Remarks and examples
	Derivation
	Relationship to inversion
	Tolerance

	Conformability
	Diagnostics
	Also see

	quadcross()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	Quadrature()
	Description
	Syntax
	Step 1: Initialization
	Step 2: Definition of integration problem
	Step 3: Perform integration
	Step 4: Display or obtain results
	Utility function for use in all steps
	Definition of q
	Functions defining the integration problem
	Performing integration
	Functions for obtaining results
	Utility function

	Remarks and examples
	Introduction
	Examples
	A basic example
	Integrals with infinite limits
	Passing arguments to the evaluator function
	Singular points and setting tolerances
	Displaying settings and results at each stage
	Vectors and matrices of integrals


	Conformability
	Diagnostics
	References
	Also see

	range()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	rank()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	Re()
	Description
	Syntax
	Conformability
	Diagnostics
	Also see

	reldif()
	Description
	Syntax
	Conformability
	Diagnostics
	Also see

	rows()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	rowshape()
	Description
	Syntax
	Remarks and examples
	Example of rowshape()
	Example of colshape()

	Conformability
	Diagnostics
	Also see

	runiform()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	References
	Also see

	runningsum()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	schurd()
	Description
	Syntax
	Remarks and examples
	Schur decomposition
	Grouping the results

	Conformability
	Diagnostics
	Reference
	Also see

	select()
	Description
	Syntax
	Remarks and examples
	Examples
	Using st_select()

	Conformability
	Diagnostics
	Also see

	setbreakintr()
	Description
	Syntax
	Remarks and examples
	Default break-key processing
	Suspending the break-key interrupt
	Break-key polling

	Conformability
	Diagnostics
	Also see

	sign()
	Description
	Syntax
	Conformability
	Diagnostics
	Also see

	sin()
	Description
	Syntax
	Conformability
	Diagnostics
	Also see

	sizeof()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	solve_tol()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	solvelower()
	Description
	Syntax
	Remarks and examples
	Derivation
	Tolerance

	Conformability
	Diagnostics
	Also see

	solvenl()
	Description
	Syntax
	Remarks and examples
	Introduction
	A fixed-point example
	A zero-finding example
	Writing a fixed-point problem as a zero-finding problem and vice versa
	Gauss{--}Seidel methods
	Newton-type methods
	Convergence criteria
	Exiting early
	Functions

	Conformability
	Diagnostics
	References
	Also see

	sort()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	soundex()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	spline3()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Reference
	Also see

	sqrt()
	Description
	Syntax
	Conformability
	Diagnostics
	Also see

	st_addobs()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	st_addvar()
	Description
	Syntax
	Remarks and examples
	Creating a new variable
	Creating new variables
	Creating new string variables
	Creating a new temporary variable
	Creating temporary variables
	Handling errors
	Using nofill

	Conformability
	Diagnostics
	Reference
	Also see

	st_data()
	Description
	Syntax
	Remarks and examples
	Description of _st_data() and _st_sdata()
	Description of st_data() and st_sdata()
	Details of observation subscripting using st_data() and st_sdata()

	Conformability
	Diagnostics
	Also see

	st_dir()
	Description
	Syntax
	Conformability
	Diagnostics
	Also see

	st_dropvar()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	st_frame*()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	st_global()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Reference
	Also see

	st_isfmt()
	Description
	Syntax
	Conformability
	Diagnostics
	Also see

	st_isname()
	Description
	Syntax
	Conformability
	Diagnostics
	Also see

	st_local()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Reference
	Also see

	st_macroexpand()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	st_matrix()
	Description
	Syntax
	Remarks and examples
	Processing Stata's row and column stripes

	Conformability
	Diagnostics
	Also see

	st_numscalar()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	st_nvar()
	Description
	Syntax
	Conformability
	Diagnostics
	Also see

	st_rclear()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	st_store()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	st_subview()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	st_tempname()
	Description
	Syntax
	Remarks and examples
	Creating temporary objects
	When temporary objects will be eliminated

	Conformability
	Diagnostics
	Also see

	st_tsrevar()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	st_updata()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	st_varformat()
	Description
	Syntax
	Conformability
	Diagnostics
	Also see

	st_varindex()
	Description
	Syntax
	Remarks and examples
	Overview
	Cautions when using variable indices: A variable index can change

	Conformability
	Diagnostics
	Also see

	st_varname()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	st_varrename()
	Description
	Syntax
	Conformability
	Diagnostics
	Also see

	st_vartype()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	st_view()
	Description
	Syntax
	Remarks and examples
	Overview
	Advantages and disadvantages of views
	When not to use views
	Cautions when using views 1: Conserving memory
	Cautions when using views 2: Assignment
	Cautions when using views 3: View connections are ephemeral
	Efficiency

	Conformability
	Diagnostics
	Reference
	Also see

	st_viewvars()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	st_vlexists()
	Description
	Syntax
	Remarks and examples
	Value-label mapping
	Value-label creation and editing
	Loading value labels

	Conformability
	Diagnostics
	Also see

	stata()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	stataversion()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	strdup()
	Description
	Syntax
	Conformability
	Diagnostics
	Also see

	strlen()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	ustrlen()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	udstrlen()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	strmatch()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	strofreal()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	strpos()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	ustrpos()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	strreverse()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	ustrreverse()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	strtoname()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	ustrtoname()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	strtoreal()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	strtrim()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	ustrtrim()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	strupper()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	ustrupper()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	subinstr()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	usubinstr()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	sublowertriangle()
	Description
	Syntax
	Remarks and examples
	Get lower triangle of a matrix
	Nonsquare matrices

	Conformability
	Diagnostics
	Also see

	_substr()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	_usubstr()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	substr()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	usubstr()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	udsubstr()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	sum()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	svd()
	Description
	Syntax
	Remarks and examples
	Introduction
	Possibility of convergence problems

	Conformability
	Diagnostics
	References
	Also see

	svsolve()
	Description
	Syntax
	Remarks and examples
	Derivation
	Relationship to inversion
	Tolerance

	Conformability
	Diagnostics
	Also see

	swap()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	Toeplitz()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Reference
	Also see

	tokenget()
	Description
	Syntax
	Remarks and examples
	Concepts
	Function overview

	Conformability
	Diagnostics
	Also see

	tokens()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	trace()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	_transpose()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	transposeonly()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	trunc()
	Description
	Syntax
	Remarks and examples
	Relationship to Stata's functions
	Examples of rounding

	Conformability
	Diagnostics
	Also see

	uniqrows()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	unitcircle()
	Description
	Syntax
	Conformability
	Diagnostics
	Also see

	unlink()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	urlencode()
	Description
	Syntax
	Conformability
	Diagnostics
	Also see

	ustrcompare()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	ustrfix()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	ustrnormalize()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	ustrsplit()
	Description
	Syntax
	Remarks and examples
	Conformability
	Also see

	ustrto()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	ustrunescape()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	ustrword()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	valofexternal()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Also see

	Vandermonde()
	Description
	Syntax
	Remarks and examples
	Conformability
	Diagnostics
	Reference
	Also see

	vec()
	Description
	Syntax
	Remarks and examples
	Example of vec()
	Example of vech() and invvech()

	Conformability
	Diagnostics
	Also see

	xl()
	Description
	Syntax
	Step 1: Initialization
	Step 2: Creating and opening an Excel workbook
	Step 3: Setting the Excel worksheet
	Step 4: Reading and writing data from and to an Excel worksheet
	Step 5: Formatting cells in an Excel worksheet
	Step 6: Formatting text in an Excel worksheet
	Step 7: Formatting cell ranges in an Excel worksheet
	Utility functions for use in all steps

	Remarks and examples
	Definition of B
	Specifying the Excel workbook
	Specifying the Excel worksheet
	Reading data from Excel
	Writing data to Excel
	Dealing with missing values
	Dealing with dates
	Formatting functions
	Numeric formatting
	Text alignment
	Cell borders
	Fonts
	Other
	Formatting examples

	Range formatting functions
	Adding format IDs
	Setting formats by ID
	Cell formatting functions
	Adding font IDs
	Setting font IDs for format IDs
	Font formatting functions
	Range formatting examples

	Utility functions
	Handling errors
	Error codes

	Appendix
	Codes for numeric formats
	Codes for border styles
	Codes for fill pattern styles
	Codes for text rotation
	Format colors

	Also see


	Mata glossary of common terms
	Glossary
	Description
	Mata glossary
	Also see



	[ME] Multilevel Mixed Effects
	Contents
	me
	Description
	Quick start
	Syntax
	Remarks and examples
	Introduction
	Using mixed-effects commands
	Mixed-effects models
	Linear mixed-effects models
	Generalized linear mixed-effects models
	Survival mixed-effects models
	Nonlinear mixed-effects models
	Alternative mixed-effects model specification
	Likelihood calculation
	Computation time and the Laplacian approximation
	Diagnosing convergence problems
	Distribution theory for likelihood-ratio test

	Examples
	Two-level models
	Covariance structures
	Three-level models
	Crossed-effects models
	Nonlinear models


	Acknowledgments
	References
	Also see

	estat df
	Description
	Menu for estat
	Syntax
	Options
	Remarks and examples
	Stored results
	Also see

	estat group
	Description
	Menu for estat
	Syntax
	Remarks and examples
	Also see

	estat icc
	Description
	Menu for estat
	Syntax
	Option
	Remarks and examples
	Stored results
	Methods and formulas
	Intraclass correlations

	Also see

	estat recovariance
	Description
	Menu for estat
	Syntax
	Options
	Remarks and examples
	Stored results
	Also see

	estat sd
	Description
	Menu for estat
	Syntax
	Options
	Remarks and examples
	Stored results
	Also see

	estat wcorrelation
	Description
	Menu for estat
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	Linear mixed-effects model
	Nonlinear mixed-effects model

	Reference
	Also see

	mecloglog
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	Reference
	Also see

	mecloglog postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Methods and formulas
	Also see

	meglm
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Two-level models for continuous responses
	Two-level models for nonlinear responses
	Three-level models for nonlinear responses
	Crossed-effects models
	Obtaining better starting values
	Survey data
	Video example

	Stored results
	Methods and formulas
	Introduction
	Gauss--Hermite quadrature
	Adaptive Gauss--Hermite quadrature
	Laplacian approximation
	Survey data

	References
	Also see

	meglm postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Methods and formulas
	References
	Also see

	meintreg
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	meintreg postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Methods and formulas
	Also see

	melogit
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Two-level models
	Other covariance structures
	Three-level models
	Crossed-effects models

	Stored results
	Methods and formulas
	References
	Also see

	melogit postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Methods and formulas
	References
	Also see

	menbreg
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	menbreg postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Methods and formulas
	Also see

	menl
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Random-effects substitutable expressions
	Substitutable expressions
	Linear combinations
	Linear forms versus linear combinations
	Random effects
	Multilevel specifications
	Time-series operators
	Summary

	Specifying initial values
	Two-level models
	Testing variance components
	Random-effects covariance structures
	Heteroskedastic within-group errors
	Restricted maximum likelihood
	Pharmacokinetic modeling
	Single-dose pharmacokinetic modeling
	Multiple-dose pharmacokinetic modeling

	Nonlinear marginal models
	Three-level models
	Obtaining initial values
	Linearization approach to finding initial values
	Graphical approach to finding initial values
	Smart regressions approach to finding initial values
	Examples of specifying initial values


	Stored results
	Methods and formulas
	Introduction
	Variance-components parameters
	Inference based on linearization
	Initial values

	References
	Also see

	menl postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Methods and formulas
	Reference
	Also see

	meologit
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	meologit postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Methods and formulas
	Also see

	meoprobit
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	meoprobit postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Methods and formulas
	Also see

	mepoisson
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Two-level models
	Higher-level models

	Stored results
	Methods and formulas
	References
	Also see

	mepoisson postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Methods and formulas
	Also see

	meprobit
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	meprobit postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Methods and formulas
	Also see

	mestreg
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Two-level models
	Three-level models

	Stored results
	Methods and formulas
	Survival models
	Survey data

	References
	Also see

	mestreg postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Methods and formulas
	Also see

	metobit
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	metobit postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Methods and formulas
	Introduction
	Conditional predictions
	Marginal predictions
	Marginal variance of the linear predictor

	Also see

	mixed
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Two-level models
	Covariance structures
	Likelihood versus restricted likelihood
	Three-level models
	Blocked-diagonal covariance structures
	Heteroskedastic random effects
	Heteroskedastic residual errors
	Other residual-error structures
	Crossed-effects models
	Diagnosing convergence problems
	Survey data
	Small-sample inference for fixed effects

	Stored results
	Methods and formulas
	Estimation using ML and REML
	Denominator degrees of freedom
	Residual DDF
	Repeated DDF
	ANOVA DDF
	Satterthwaite DDF
	Kenward{--}Roger DDF

	Fixed-effects constraints

	Acknowledgments
	References
	Also see

	mixed postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	test and testparm
	Description for test and testparm
	Menu for test and testparm
	Syntax for test and testparm
	Options for test and testparm

	lincom
	Description for lincom
	Menu for lincom
	Syntax for lincom
	Options for lincom

	contrast
	Description for contrast
	Menu for contrast
	Syntax for contrast
	Options for contrast

	pwcompare
	Description for pwcompare
	Menu for pwcompare
	Syntax for pwcompare
	Options for pwcompare

	Remarks and examples
	Stored results
	Methods and formulas
	Prediction
	Small-sample inference

	References
	Also see

	Glossary
	References


	[META] Meta-Analysis
	Contents
	Intro
	Description
	Remarks and examples
	Brief overview of meta-analysis
	Meta-analysis models
	Common-effect (``fixed-effect'') model
	Fixed-effects model
	Random-effects model
	Comparison between the models and interpretation of their results
	Meta-analysis estimation methods

	Forest plots
	Heterogeneity
	Assessing heterogeneity
	Addressing heterogeneity
	Subgroup meta-analysis
	Meta-regression

	Publication bias
	Funnel plots
	Tests for funnel-plot asymmetry
	The trim-and-fill method

	Cumulative meta-analysis
	Leave-one-out meta-analysis
	Multivariate meta-regression

	References
	Also see

	meta
	Description
	Remarks and examples
	Introduction to meta-analysis using Stata
	Example datasets
	Effects of teacher expectancy on pupil IQ ({pupiliq.dta})
	Effect of streptokinase after a myocardial infarction (strepto.dta)
	Efficacy of BCG vaccine against tuberculosis (bcg.dta)
	Effectiveness of nonsteroidal anti-inflammatory drugs (nsaids.dta)
	Treatment of moderate periodontal disease (periodontal.dta)

	Tour of meta-analysis commands
	Prepare your data for meta-analysis in Stata
	Basic meta-analysis summary
	Subgroup meta-analysis
	Cumulative meta-analysis
	Heterogeneity: Galbraith plot, meta-regression, and bubble plot
	Funnel plots for exploring small-study effects
	Testing for small-study effects
	Trim-and-fill analysis for addressing publication bias
	Multivariate meta-regression


	Acknowledgments
	References
	Also see

	meta data
	Description
	Remarks and examples
	Overview
	Declaring meta-analysis information
	Declaring effect sizes and their precision
	Declaring a meta-analysis model
	Declaring a meta-analysis estimation method
	Default meta-analysis model and method
	Declaring a confidence level for meta-analysis
	Declaring display settings for meta-analysis
	Modifying default meta settings

	Meta-analysis information
	Meta settings with meta set
	Meta settings with meta esize

	System variables
	Examples of data declaration for meta-analysis
	Declaring precomputed effect sizes using meta set
	Computing and declaring effect sizes using meta esize
	Displaying and updating meta settings


	References
	Also see

	meta esize
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Meta-analysis of binary data
	Meta-analysis of continuous data

	Stored results
	Methods and formulas
	Effect sizes for continuous outcomes
	Unstandardized mean difference
	Standardized mean difference

	Effect sizes for binary outcomes
	Odds ratio
	Risk ratio (rate ratio)
	Risk difference
	Zero-cells adjustments

	Confidence intervals for effect sizes

	References
	Also see

	meta set
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Overview
	Using meta set

	Stored results
	References
	Also see

	meta update
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Also see

	meta forestplot
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Overview
	Using meta forestplot
	Plot columns

	Examples of using meta forestplot

	Methods and formulas
	References
	Also see

	meta summarize
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Examples of using meta summarize

	Stored results
	Methods and formulas
	Fixed-effects and common-effect methods for combining study estimates
	Inverse-variance method
	Mantel--Haenszel method for binary outcomes
	Peto's method for odds ratios

	Random-effects methods for combining study estimates
	Iterative methods
	Noniterative methods
	Knapp--Hartung standard-error adjustment
	Prediction intervals

	Confidence intervals and significance test
	Heterogeneity measures
	Homogeneity test
	Subgroup meta-analysis
	Fixed-effects model
	Random-effects model

	Cumulative meta-analysis
	Leave-one-out meta-analysis

	References
	Also see

	meta galbraithplot
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	References
	Also see

	meta labbeplot
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	meta regress
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Examples of using meta regress

	Stored results
	Methods and formulas
	Fixed-effects meta-regression
	Random-effects meta-regression
	Iterative methods for computing tau-hat-squared
	Noniterative methods for computing tau-hat-squared
	Knapp--Hartung standard-error adjustment

	Residual homogeneity test
	Residual heterogeneity measures

	References
	Also see

	meta regress postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Methods and formulas
	Random-effects meta-regression
	Fixed-effects meta-regression

	Reference
	Also see

	estat bubbleplot
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Examples of using estat bubbleplot

	Methods and formulas
	References
	Also see

	meta funnelplot
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Funnel plots
	Contour-enhanced funnel plots

	Using meta funnelplot
	Examples of using meta funnelplot

	Stored results
	Methods and formulas
	References
	Also see

	meta bias
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Using meta bias
	Examples of using meta bias

	Stored results
	Methods and formulas
	Regression-based tests
	Egger's linear regression test
	Harbord's test for log odds-ratios or log risk-ratios
	Peters's test for log odds-ratios

	Begg's rank correlation test

	References
	Also see

	meta trimfill
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Using meta trimfill
	Examples of using meta trimfill

	Stored results
	Methods and formulas
	Estimating the number of missing studies
	Trim-and-fill algorithm

	References
	Also see

	meta mvregress
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Examples of using meta mvregress

	Stored results
	Methods and formulas
	Fixed-effects multivariate meta-regression
	Random-effects multivariate meta-regression
	Iterative methods for computing Sigma
	Noniterative method for computing Sigma
	Random-effects covariance structures
	Jackson--Riley standard-error adjustment

	Multivariate meta-analysis
	Residual homogeneity test

	References
	Also see

	meta mvregress postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Methods and formulas
	Random-effects multivariate meta-regression
	Fixed-effects multivariate meta-regression

	Also see

	estat heterogeneity
	Description
	Menu for estat
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	Brief overview of heterogeneity statistics
	Cochran heterogeneity statistics
	Jackson--White--Riley heterogeneity statistics
	White heterogeneity statistics

	References
	Also see

	estat recovariance
	Description
	Menu for estat
	Syntax
	Options
	Remarks and examples
	Stored results
	Also see

	estat sd
	Description
	Menu for estat
	Syntax
	Options
	Remarks and examples
	Stored results
	Also see

	Glossary
	References


	[MI] Multiple Imputation
	Contents
	Intro substantive
	Description
	Remarks and examples
	Motivating example
	What is multiple imputation?
	Theory underlying multiple imputation
	How large should M be?
	Assumptions about missing data
	Patterns of missing data
	Proper imputation methods
	Analysis of multiply imputed data
	A brief introduction to MI using Stata
	Summary

	References
	Also see

	Intro
	Description
	Remarks and examples
	A simple example
	Suggested reading order

	Acknowledgments
	Also see

	Estimation
	Description
	Also see

	mi add
	Description
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Also see

	mi append
	Description
	Menu
	Syntax
	Options
	Remarks and examples
	Adding new observations
	Adding new observations and imputations
	Adding new observations and imputations, M unequal
	Treatment of registered variables

	Stored results
	Also see

	mi convert
	Description
	Menu
	Syntax
	Options
	Remarks and examples
	Using mi convert as a convenience tool
	Converting from flongsep
	Converting to flongsep

	Also see

	mi copy
	Description
	Menu
	Syntax
	Option
	Remarks and examples
	Also see

	mi describe
	Description
	Menu
	Syntax
	Options
	Remarks and examples
	mi query
	mi describe

	Stored results
	Also see

	mi erase
	Description
	Menu
	Syntax
	Option
	Remarks and examples
	Also see

	mi estimate
	Description
	Menu
	Syntax
	Options
	Remarks and examples
	Using mi estimate
	Example 1: Completed-data logistic analysis
	Example 2: Completed-data linear regression analysis
	Example 3: Completed-data survival analysis
	Example 4: Panel data and multilevel models
	Example 5: Estimating transformations
	Example 6: Monte Carlo error estimates
	Potential problems that can arise when using mi estimate

	Stored results
	Methods and formulas
	Univariate case
	Multivariate case

	Acknowledgments
	References
	Also see

	mi estimate using
	Description
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	mi estimate postestimation
	Postestimation commands
	Remarks and examples
	Using the command-specific postestimation tools

	Also see

	mi expand
	Description
	Menu
	Syntax
	Options
	Remarks and examples
	Also see

	mi export
	Description
	Syntax
	Remarks and examples
	References
	Also see

	mi export ice
	Description
	Menu
	Syntax
	Option
	Remarks and examples
	References
	Also see

	mi export nhanes1
	Description
	Menu
	Syntax
	Options
	Remarks and examples
	Also see

	mi extract
	Description
	Menu
	Syntax
	Options
	Remarks and examples
	Also see

	mi import
	Description
	Syntax
	Remarks and examples
	When to use which mi import command
	Import data into Stata before importing into mi
	Using mi import nhanes1, ice, flong, and flongsep

	References
	Also see

	mi import flong
	Description
	Menu
	Syntax
	Options
	Remarks and examples
	Also see

	mi import flongsep
	Description
	Menu
	Syntax
	Options
	Remarks and examples
	Also see

	mi import ice
	Description
	Menu
	Syntax
	Options
	Remarks and examples
	References
	Also see

	mi import nhanes1
	Description
	Menu
	Syntax
	Options
	Remarks and examples
	Description of the nhanes1 format
	Importing nhanes1 data

	Also see

	mi import wide
	Description
	Menu
	Syntax
	Options
	Remarks and examples
	Also see

	mi impute
	Description
	Menu
	Syntax
	Options
	Remarks and examples
	Imputation methods
	Imputation modeling
	Model building
	Outcome variables
	Transformations
	Categorical variables
	The issue of perfect prediction during imputation of categorical data
	Convergence of iterative methods
	Imputation diagnostics

	Using mi impute
	Univariate imputation
	Multivariate imputation
	Imputing on subsamples
	Conditional imputation
	Imputation and estimation samples
	Imputing transformations of incomplete variables

	Stored results
	Methods and formulas
	References
	Also see

	mi impute chained
	Description
	Menu
	Syntax
	Options
	Remarks and examples
	Multivariate imputation using chained equations
	Compatibility of conditionals
	Convergence of MICE
	First use
	Using mi impute chained
	Default prediction equations
	Custom prediction equations
	Link between mi impute chained and mi impute monotone
	Examples

	Stored results
	Methods and formulas
	Acknowledgments
	References
	Also see

	mi impute intreg
	Description
	Menu
	Syntax
	Options
	Remarks and examples
	Univariate imputation using interval regression
	Using mi impute intreg
	Example

	Stored results
	Methods and formulas
	Reference
	Also see

	mi impute logit
	Description
	Menu
	Syntax
	Options
	Remarks and examples
	Univariate imputation using logistic regression
	Using mi impute logit
	Video example

	Stored results
	Methods and formulas
	References
	Also see

	mi impute mlogit
	Description
	Menu
	Syntax
	Options
	Remarks and examples
	Univariate imputation using multinomial logistic regression
	Using mi impute mlogit

	Stored results
	Methods and formulas
	References
	Also see

	mi impute monotone
	Description
	Menu
	Syntax
	Options
	Remarks and examples
	Multivariate imputation when a missing-data pattern is monotone
	First use
	Using mi impute monotone
	Default syntax of mi impute monotone
	The alternative syntax of mi impute monotone---custom prediction equations
	Examples of using default prediction equations
	Examples of using custom prediction equations

	Stored results
	Methods and formulas
	References
	Also see

	mi impute mvn
	Description
	Menu
	Syntax
	Options
	Remarks and examples
	Incomplete continuous data with arbitrary pattern of missing values
	Multivariate imputation using data augmentation
	Convergence of the MCMC method
	Using mi impute mvn
	Examples

	Stored results
	Methods and formulas
	Data augmentation
	Prior distribution
	Initial values: EM algorithm
	 Worst linear function

	References
	Also see

	mi impute nbreg
	Description
	Menu
	Syntax
	Options
	Remarks and examples
	Univariate imputation using negative binomial regression
	Using mi impute nbreg

	Stored results
	Methods and formulas
	Reference
	Also see

	mi impute ologit
	Description
	Menu
	Syntax
	Options
	Remarks and examples
	Univariate imputation using ordered logistic regression
	Using mi impute ologit

	Stored results
	Methods and formulas
	References
	Also see

	mi impute pmm
	Description
	Menu
	Syntax
	Options
	Remarks and examples
	Univariate imputation using predictive mean matching
	Using mi impute pmm
	Video example

	Stored results
	Methods and formulas
	References
	Also see

	mi impute poisson
	Description
	Menu
	Syntax
	Options
	Remarks and examples
	Univariate imputation using Poisson regression
	Using mi impute poisson

	Stored results
	Methods and formulas
	References
	Also see

	mi impute regress
	Description
	Menu
	Syntax
	Options
	Remarks and examples
	Univariate imputation using linear regression
	Using mi impute regress
	Video example

	Stored results
	Methods and formulas
	References
	Also see

	mi impute truncreg
	Description
	Menu
	Syntax
	Options
	Remarks and examples
	Univariate imputation using truncated regression
	Using mi impute truncreg

	Stored results
	Methods and formulas
	References
	Also see

	mi impute usermethod
	Description
	Syntax
	Options
	Remarks and examples
	Toy example: Naive regression imputation
	Steps for adding a new method to mi impute
	Writing an imputation parser
	Writing an initializer
	Writing an imputer
	Storing additional results
	Writing a cleanup program

	Examples
	Naive regression imputation
	Univariate regression imputation
	Multivariate monotone imputation

	Global macros

	Stored results
	Acknowledgment
	Also see

	mi merge
	Description
	Menu
	Syntax
	Options
	Remarks and examples
	Merging with non-mi data
	Merging with mi data
	Merging with mi data containing overlapping variables

	Stored results
	Also see

	mi misstable
	Description
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Also see

	mi passive
	Description
	Menu
	Syntax
	Options
	Remarks and examples
	mi passive basics
	mi passive works with the by prefix
	mi passive works fastest with the wide style
	mi passive and super-varying variables
	Renaming passive variables
	Dropping passive variables
	Update passive variables when imputed values change
	Alternatives to mi passive

	Also see

	mi predict
	Description
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Using mi predict and mi predictnl
	Example 1: Obtain MI linear predictions and other statistics
	Example 2: Obtain MI linear predictions for the estimation sample
	Example 3: Obtain MI estimates of probabilities
	Example 4: Obtain other MI predictions
	Example 5: Obtain MI predictions after multiple-equation commands

	Methods and formulas
	References
	Also see

	mi ptrace
	Description
	Syntax
	Options
	Remarks and examples
	Stored results
	Also see

	mi rename
	Description
	Menu
	Syntax
	Option
	Remarks and examples
	Specifying the noupdate option
	What to do if you accidentally use rename
	What to do if you accidentally use rename on wide data
	What to do if you accidentally use rename on mlong data
	What to do if you accidentally use rename on flong data
	What to do if you accidentally use rename on flongsep data

	Also see

	mi replace0
	Description
	Menu
	Syntax
	Option
	Remarks and examples
	Also see

	mi reset
	Description
	Menu
	Syntax
	Options
	Remarks and examples
	Using mi reset
	Technical notes and relation to mi update

	Also see

	mi reshape
	Description
	Menu
	Syntax
	Options
	Remarks and examples
	Also see

	mi select
	Description
	Syntax
	Option
	Remarks and examples
	Stored results
	Also see

	mi set
	Description
	Menu
	Syntax
	Option for mi unset
	Remarks and examples
	mi set style
	mi register and mi unregister
	mi set M and mi set m
	mi unset

	Also see

	mi stsplit
	Description
	Menu
	Syntax
	Options
	Remarks and examples
	Also see

	mi test
	Description
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Overview
	Example 1: Testing subsets of coefficients equal to zero
	Example 2: Testing linear hypotheses
	Example 3: Testing nonlinear hypotheses

	Stored results
	Methods and formulas
	References
	Also see

	mi update
	Description
	Menu
	Syntax
	Remarks and examples
	Purpose of mi update
	What mi update does
	mi update is run automatically

	Also see

	mi varying
	Description
	Menu
	Syntax
	Options
	Remarks and examples
	Detecting problems
	Fixing problems

	Stored results
	Also see

	mi xeq
	Description
	Syntax
	Remarks and examples
	Using mi xeq with reporting commands
	Using mi xeq with data-modification commands
	Using mi xeq with data-modification commands on flongsep data

	Stored results
	Also see

	mi XXXset
	Description
	Syntax
	Remarks and examples
	Also see

	noupdate option
	Description
	Syntax
	Option
	Remarks and examples
	Also see

	Styles
	Description
	Syntax
	Remarks and examples
	The four styles
	Style wide
	Style flong
	Style mlong
	Style flongsep
	How we constructed this example

	Using mi system variables
	Advice for using flongsep

	Also see

	Technical
	Description
	Remarks and examples
	Notation
	Definition of styles
	Style all
	Style wide
	Style mlong
	Style flong
	Style flongsep
	Style flongsep_sub

	Adding new commands to mi
	Outline for new commands
	Utility routines
	u_mi_assert_set
	u_mi_certify_data
	u_mi_no_sys_vars and u_mi_no_wide_vars
	u_mi_zap_chars
	u_mi_xeq_on_tmp_flongsep
	u_mi_get_flongsep_tmpname
	mata: u_mi_flongsep_erase()
	u_mi_sortback
	u_mi_save and u_mi_use
	mata: u_mi_wide_swapvars()
	u_mi_fixchars
	mata: u_mi_cpchars_get() and mata: u_mi_cpchars_put()
	mata: u_mi_get_mata_instanced_var()
	mata: u_mi_ptrace_*()

	How to write other set commands to work with mi

	Also see

	Workflow
	Description
	Remarks and examples
	Suggested workflow for original data
	Suggested workflow for data that already have imputations
	Example

	Also see

	Glossary
	Also see


	[MV] Multivariate Statistics
	Contents
	Intro
	Description
	Also see

	Multivariate
	Description
	Remarks and examples
	Cluster analysis
	Discriminant analysis
	Factor analysis and principal component analysis
	Rotation
	Multivariate analysis of variance, multivariate regression, and related techniques
	Structural equation modeling
	Multidimensional scaling and biplots
	Correspondence analysis
	Bayesian analysis
	Item response theory
	Multivariate time-series models
	Multivariate meta-regression

	Also see

	alpha
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	Acknowledgment
	References
	Also see

	biplot
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	Acknowledgment
	References
	Also see

	ca
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	A first example
	How many dimensions?
	Statistics on the points
	Normalization and interpretation of correspondence analysis
	Plotting the points
	Supplementary points
	Matrix input
	Crossed variables

	Stored results
	Methods and formulas
	References
	Also see

	ca postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	estat
	Description for estat
	Menu for estat
	Syntax for estat
	Options for estat

	Remarks and examples
	Postestimation statistics
	Predicting new variables

	Stored results
	Methods and formulas
	References
	Also see

	ca postestimation plots
	Postestimation commands
	cabiplot
	Description for cabiplot
	Menu for cabiplot
	Syntax for cabiplot
	Options for cabiplot

	caprojection
	Description for caprojection
	Menu for caprojection
	Syntax for caprojection
	Options for caprojection

	Remarks and examples
	References
	Also see

	candisc
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	canon
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	Acknowledgment
	References
	Also see

	canon postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	estat
	Description for estat
	Menu for estat
	Syntax for estat
	Option for estat

	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	cluster
	Description
	Syntax
	Remarks and examples
	Introduction to cluster analysis
	Stata's cluster-analysis system
	Data transformations and variable selection
	Similarity and dissimilarity measures
	Partition cluster-analysis methods
	Hierarchical cluster-analysis methods
	Hierarchical cluster analysis applied to a dissimilarity matrix
	Postclustering commands
	Cluster-management tools

	References
	Also see

	clustermat
	Description
	Syntax
	Remarks and examples
	References
	Also see

	cluster dendrogram
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	References
	Also see

	cluster generate
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Also see

	cluster kmeans and kmedians
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Methods and formulas
	Reference
	Also see

	cluster linkage
	Description
	Quick start
	Menu
	Syntax
	Options for cluster linkage commands
	Options for clustermat linkage commands
	Remarks and examples
	Methods and formulas
	Also see

	cluster notes
	Description
	Menu
	Syntax
	Remarks and examples
	Also see

	cluster programming subroutines
	Description
	Remarks and examples
	Adding a cluster subroutine
	Adding a cluster generate function
	Adding a cluster stopping rule
	Applying an alternate cluster dendrogram routine

	Reference
	Also see

	cluster programming utilities
	Description
	Syntax
	Options for cluster set
	Options for cluster delete
	Options for cluster measures
	Remarks and examples
	Stored results
	Also see

	cluster stop
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	cluster utility
	Description
	Menu
	Syntax
	Options for cluster list
	Options for cluster renamevar
	Remarks and examples
	Also see

	discrim
	Description
	Syntax
	Remarks and examples
	Introduction
	A simple example
	Prior probabilities, costs, and ties

	Methods and formulas
	References
	Also see

	discrim estat
	Postestimation commands
	Description for estat
	Quick start for estat
	Menu for estat
	Syntax for estat
	Options for estat
	Options for estat classtable
	Options for estat errorrate
	Options for estat grsummarize
	Options for estat list
	Options for estat summarize

	Remarks and examples
	Discriminating-variable summaries
	Discrimination listings
	Classification tables and error rates

	Stored results
	Methods and formulas
	References
	Also see

	discrim knn
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	A first example
	Mahalanobis transformation
	Binary data

	Stored results
	Methods and formulas
	References
	Also see

	discrim knn postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	Remarks and examples
	Methods and formulas
	Also see

	discrim lda
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Descriptive LDA
	Predictive LDA
	A classic example

	Stored results
	Methods and formulas
	Predictive LDA
	Descriptive LDA

	References
	Also see

	discrim lda postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	estat
	Description for estat
	Menu for estat
	Syntax for estat
	Options for estat
	Options for estat classfunctions
	Options for estat correlations
	Options for estat covariance
	Options for estat grdistances
	Options for estat grmeans
	Options for estat loadings
	Option for estat structure

	Remarks and examples
	Classification tables, error rates, and listings
	ANOVA, MANOVA, and canonical correlations
	Discriminant and classification functions
	Scree, loading, and score plots
	Means and distances
	Covariance and correlation matrices
	Predictions

	Stored results
	Methods and formulas
	References
	Also see

	discrim logistic
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	discrim logistic postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	Remarks and examples
	Reference
	Also see

	discrim qda
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	discrim qda postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	estat
	Description for estat
	Menu for estat
	Syntax for estat
	Options for estat
	Options for estat correlations
	Options for estat covariance
	Options for estat grdistances

	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	factor
	Description
	Quick start
	Menu
	Syntax
	Options for factor and factormat
	Options unique to factormat
	Remarks and examples
	Introduction
	Factor analysis
	Factor analysis from a correlation matrix

	Stored results
	Methods and formulas
	References
	Also see

	factor postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	estat
	Description for estat
	Menu for estat
	Syntax for estat
	Options for estat

	Remarks and examples
	Postestimation statistics
	Plots of eigenvalues, factor loadings, and scores
	Rotating the factor loadings
	Factor scores

	Stored results
	Methods and formulas
	estat
	rotate
	predict

	References
	Also see

	hotelling
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	manova
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	One-way MANOVA
	Reporting coefficients
	Two-way MANOVA
	N-way MANOVA
	MANCOVA
	MANOVA for Latin-square designs
	MANOVA for nested designs
	MANOVA for mixed designs
	MANOVA with repeated measures

	Stored results
	Methods and formulas
	References
	Also see

	manova postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	manovatest
	Description of manovatest
	Menu for manovatest
	Syntax for manovatest
	Options for manovatest

	test
	Description for test
	Menu for test
	Syntax for test
	Options for test

	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	matrix dissimilarity
	Description
	Syntax
	Options
	Remarks and examples
	References
	Also see

	mca
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Compare MCA on two variables and CA
	MCA on four variables
	CA of the indicator matrix
	CA of the Burt matrix
	Joint correspondence analysis

	Stored results
	Methods and formulas
	Notation
	Using ca to compute MCA
	CA of an indicator or Burt matrix
	JCA
	Supplementary variables
	predict

	References
	Also see

	mca postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	estat
	Description for estat
	Menu for estat
	Syntax for estat
	Options for estat
	Options for estat coordinates
	Options for estat summarize

	Remarks and examples
	Postestimation statistics
	Predicting new variables

	Stored results
	Methods and formulas
	References
	Also see

	mca postestimation plots
	Postestimation commands
	mcaplot
	Description for mcaplot
	Menu for mcaplot
	Syntax for mcaplot
	Options for mcaplot

	mcaprojection
	Description for mcaprojection
	Menu for mcaprojection
	Syntax for mcaprojection
	Options for mcaprojection

	Remarks and examples
	Methods and formulas
	References
	Also see

	mds
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Euclidean distances
	Non-Euclidean dissimilarity measures
	Introduction to modern MDS
	Protecting from local minimums

	Stored results
	Methods and formulas
	References
	Also see

	mds postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	estat
	Description for estat
	Menu for estat
	Syntax for estat
	Options for estat

	Remarks and examples
	Postestimation statistics
	Predictions

	Stored results
	Methods and formulas
	References
	Also see

	mds postestimation plots
	Postestimation commands
	mdsconfig
	Description for mdsconfig
	Menu for mdsconfig
	Syntax for mdsconfig
	Options for mdsconfig

	mdsshepard
	Description for mdsshepard
	Menu for mdsshepard
	Syntax for mdsshepard
	Options for mdsshepard

	Remarks and examples
	References
	Also see

	mdslong
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Proximity data in long format
	Modern nonmetric MDS

	Stored results
	Methods and formulas
	References
	Also see

	mdsmat
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Proximity data in a Stata matrix
	Modern MDS and local minimums

	Stored results
	Methods and formulas
	Classical multidimensional scaling
	Modern multidimensional scaling
	Conversion of similarities to dissimilarities

	References
	Also see

	measure_option
	Description
	Syntax
	Options
	References
	Also see

	mvreg
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	mvreg postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Also see

	mvtest
	Description
	Syntax
	References
	Also see

	mvtest correlations
	Description
	Quick start
	Menu
	Syntax
	Options for multiple-sample tests
	Options for one-sample tests
	Remarks and examples
	One-sample tests for correlation matrices
	A multiple-sample test for correlation matrices

	Stored results
	Methods and formulas
	One-sample tests for correlation matrices
	A multiple-sample test for correlation matrices

	References
	Also see

	mvtest covariances
	Description
	Quick start
	Menu
	Syntax
	Options for multiple-sample tests
	Options for one-sample tests
	Remarks and examples
	One-sample tests for covariance matrices
	A multiple-sample test for covariance matrices

	Stored results
	Methods and formulas
	One-sample tests for covariance matrices
	A multiple-sample test for covariance matrices

	References
	Also see

	mvtest means
	Description
	Quick start
	Menu
	Syntax
	Options for multiple-sample tests
	Options with one-sample tests
	Remarks and examples
	One-sample tests for mean vectors
	Multiple-sample tests for mean vectors

	Stored results
	Methods and formulas
	One-sample tests for mean vectors
	Multiple-sample tests for mean vectors

	References
	Also see

	mvtest normality
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	Mardia mSkewness and mKurtosis
	Henze--Zirkler
	Doornik--Hansen

	Acknowledgment
	References
	Also see

	pca
	Description
	Quick start
	Menu
	Syntax
	Options
	Options unique to pcamat
	Remarks and examples
	Stored results
	Methods and formulas
	Notation
	Inference on eigenvalues and eigenvectors
	More general tests for multivariate normal distributions

	References
	Also see

	pca postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	estat
	Description for estat
	Menu for estat
	Syntax for estat
	Options for estat

	Remarks and examples
	Postestimation statistics
	Plots of eigenvalues, component loadings, and scores
	Rotating the components
	How rotate interacts with pca
	Predicting the component scores

	Stored results
	Methods and formulas
	References
	Also see

	procrustes
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction to Procrustes methods
	Orthogonal Procrustes analysis
	Is an orthogonal Procrustes analysis symmetric?
	Other transformations

	Stored results
	Methods and formulas
	Introduction
	Orthogonal transformations
	Oblique transformations
	Unrestricted transformations
	Reported statistics

	References
	Also see

	procrustes postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	estat
	Description for estat
	Menu for estat
	Syntax for estat
	Options for estat

	procoverlay
	Description for procoverlay
	Menu for procoverlay
	Syntax for procoverlay
	Options for procoverlay

	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	rotate
	Description
	Quick start
	Menu
	Syntax
	Options
	Rotation criteria

	Remarks and examples
	Orthogonal rotations
	Oblique rotations
	Other types of rotation

	Stored results
	Methods and formulas
	References
	Also see

	rotatemat
	Description
	Menu
	Syntax
	Options
	Rotation criteria

	Remarks and examples
	Introduction
	Orthogonal rotations
	Oblique rotations
	Promax rotation

	Stored results
	Methods and formulas
	References
	Also see

	scoreplot
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Also see

	screeplot
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	References
	Also see

	Glossary
	References


	[P] Programming
	Contents
	Combined subject table of contents
	Intro
	Description
	References
	Also see

	Automation
	Description
	Remarks and examples
	Also see

	break
	Description
	Syntax
	Remarks and examples
	Also see

	byable
	Description
	Syntax
	Option
	Remarks and examples
	byable(recall) programs
	Using sort in byable(recall) programs
	Byable estimation commands
	byable(onecall) programs
	Using sort in byable(onecall) programs
	Combining byable(onecall) with byable(recall)
	The by-group header

	Also see

	capture
	Description
	Syntax
	Remarks and examples
	Reference
	Also see

	char
	Description
	Syntax
	Option
	Remarks and examples
	How to program with characteristics

	Also see

	class
	Description
	Remarks and examples
	1. Introduction
	2. Definitions
	3. Version control
	4. Member variables
	5. Inheritance
	6. Member programs' return values
	7. Assignment
	8. Built-ins
	9. Prefix operators
	10. Using object values
	11. Object destruction
	12. Advanced topics
	Appendix A. Finding, loading, and clearing class definitions
	Appendix B. Jargon
	Appendix C. Syntax diagrams

	Also see

	class exit
	Description
	Syntax
	Remarks and examples
	Examples

	Also see

	classutil
	Description
	Syntax
	Options for classutil describe
	Options for classutil dir
	Option for classutil which
	Remarks and examples
	classutil drop
	classutil describe
	classutil dir
	classutil cdir
	classutil which

	Stored results
	Also see

	comments
	Description
	Remarks and examples
	Also see

	confirm
	Description
	Syntax
	Option
	Remarks and examples
	confirm existence
	confirm file
	confirm format
	confirm frame
	confirm names
	confirm number
	confirm matrix
	confirm scalar
	confirm variable

	Also see

	continue
	Description
	Syntax
	Option
	Remarks and examples
	Also see

	creturn
	Description
	Menu
	Syntax
	Remarks and examples
	System values
	Directories and paths
	System limits
	Numerical and string limits
	Current dataset
	Memory settings
	Output settings
	Interface settings
	Graphics settings
	Network settings
	Update settings
	Trace (program debugging) settings
	Mata settings
	Java settings
	LAPACK settings
	putdocx settings
	Python settings
	RNG settings
	sort settings
	Unicode settings
	Other settings
	Other

	Also see

	_datasignature
	Description
	Syntax
	Options
	Remarks and examples
	Stored results
	Reference
	Also see

	#delimit
	Description
	Syntax
	Remarks and examples
	Also see

	Dialog programming
	Description
	Remarks and examples
	1. Introduction
	2. Concepts
	2.1 Organization of the .dlg file
	2.2 Positions, sizes, and the DEFINE command
	2.3 Default values
	2.4 Memory (recollection)
	2.5 I-actions and member functions
	2.6 U-actions and communication options
	2.7 The distinction between i-actions and u-actions
	2.8 Error and consistency checking

	3. Commands
	3.1 VERSION
	3.2 INCLUDE
	3.3 DEFINE
	3.4 POSITION
	3.5 LIST
	3.6 DIALOG
	3.6.1 CHECKBOX on/off input control
	3.6.2 RADIO on/off input control
	3.6.3 SPINNER numeric input control
	3.6.4 EDIT string input control
	3.6.5 VARLIST and VARNAME string input controls
	3.6.6 FILE string input control
	3.6.7 LISTBOX list input control
	3.6.8 COMBOBOX list input control
	3.6.9 BUTTON special input control
	3.6.10 TEXT static control
	3.6.11 TEXTBOX static control
	3.6.12 GROUPBOX static control
	3.6.13 FRAME static control
	3.6.14 COLOR input control
	3.6.15 EXP expression input control
	3.6.16 HLINK hyperlink input control
	3.6.17 TREEVIEW tree input control
	3.7 OK, SUBMIT, CANCEL, and COPY u-action buttons
	3.8 HELP and RESET helper buttons
	3.9 Special dialog directives

	4. SCRIPT
	5. PROGRAM
	5.1 Concepts
	5.1.1 Vnames
	5.1.2 Enames
	5.1.3 rstrings: cmdstring and optstring
	5.1.4 Adding to an rstring
	5.2 Flow-control commands
	5.2.1 if
	5.2.2 while
	5.2.3 call
	5.2.4 exit
	5.2.5 close
	5.3 Error-checking and presentation commands
	5.3.1 require
	5.3.2 stopbox
	5.4 Command-construction commands
	5.4.1 by
	5.4.2 bysort
	5.4.3 put
	5.4.4 varlist
	5.4.5 ifexp
	5.4.6 inrange
	5.4.7 weight
	5.4.8 beginoptions and endoptions
	5.4.8.1 option
	5.4.8.2 optionarg
	5.5 Command-execution commands
	5.5.1 stata
	5.5.2 clear
	5.6 Special scripts and programs

	6. Properties
	7. Child dialogs
	7.1 Referencing the parent
	8. Example
	Appendix A: Jargon
	Appendix B: Class definition of dialog boxes
	Appendix C: Interface guidelines for dialog boxes
	Frequently asked questions

	Also see

	discard
	Description
	Syntax
	Remarks and examples
	Also see

	display
	Description
	Syntax
	Remarks and examples
	Introduction
	Styles
	display used with quietly and noisily
	Columns
	display and SMCL
	Displaying variable names
	Obtaining input from the terminal

	Also see

	ereturn
	Description
	Syntax
	Options
	Remarks and examples
	Estimation-class programs
	Setting individual estimation results
	Posting estimation coefficient and variance--covariance matrices

	Stored results
	Also see

	error
	Description
	Syntax
	Remarks and examples
	Introduction
	Summary
	Other messages

	Also see

	estat programming
	Description
	Remarks and examples
	Standard subcommands
	Adding subcommands to estat
	Overriding standard behavior of a subcommand

	Also see

	_estimates
	Description
	Syntax
	Options
	Remarks and examples
	Stored results
	Also see

	Estimation command
	Description
	Remarks and examples
	References
	Also see

	exit
	Description
	Syntax
	Options
	Remarks and examples
	Also see

	file
	Description
	Syntax
	Options
	Text output specifications

	Remarks and examples
	Use of file
	Use of file with tempfiles
	Writing text files
	Reading text files
	Use of seek when writing or reading text files
	Writing and reading binary files
	Writing binary files
	Reading binary files
	Use of seek when writing or reading binary files
	Appendix A.1 $mskip 	hinmuskip $ Useful commands and functions for use with file
	Appendix A.2 $mskip 	hinmuskip $ Actions of binary output formats with out-of-range values

	Stored results
	Reference
	Also see

	File formats .dta
	Description
	Also see

	findfile
	Description
	Syntax
	Options
	Remarks and examples
	Stored results
	Also see

	foreach
	Description
	Syntax
	Remarks and examples
	Introduction
	foreach {
elax $mathsurround hbox {$Z$}@ mathinner {ldotp ldotp ldotp }mskip 	hinmuskip $} of local and foreach {
elax $mathsurround hbox {$Z$}@ mathinner {ldotp ldotp ldotp }mskip 	hinmuskip $} of global
	foreach {
elax $mathsurround hbox {$Z$}@ mathinner {ldotp ldotp ldotp }mskip 	hinmuskip $} of varlist
	foreach {
elax $mathsurround hbox {$Z$}@ mathinner {ldotp ldotp ldotp }mskip 	hinmuskip $} of newlist
	foreach {
elax $mathsurround hbox {$Z$}@ mathinner {ldotp ldotp ldotp }mskip 	hinmuskip $} of numlist
	Use of foreach with continue
	The unprocessed list elements

	References
	Also see

	forvalues
	Description
	Syntax
	Remarks and examples
	References
	Also see

	frame post
	Description
	Syntax
	Remarks and examples
	Also see

	fvexpand
	Description
	Syntax
	Remarks and examples
	Stored results
	Also see

	gettoken
	Description
	Syntax
	Options
	Remarks and examples
	Reference
	Also see

	H2O intro
	Description

	if
	Description
	Syntax
	Remarks and examples
	Introduction
	Avoid single-line if and else with ++ and -/- macro expansion

	Reference
	Also see

	include
	Description
	Syntax
	Option
	Remarks and examples
	Use with do-files
	Use with Mata
	Warning

	Also see

	Java intro
	Description
	Also see

	Java integration
	Description
	Syntax
	Calling Java from Stata
	Instance commands

	Option
	Remarks and examples
	How the environment works
	Invoking Java interactively
	Executing Java in a do-file
	Executing Java in an ado-file
	Executing Java files
	Stata Function Interface examples
	Using JAR dependencies

	Also see

	Java plugin
	Description
	Remarks and examples
	References
	Also see

	Java utilities
	Description
	Syntax
	Remarks and examples
	Also see

	javacall
	Description
	Syntax
	Options
	Remarks and examples
	Also see

	levelsof
	Description
	Syntax
	Options
	Remarks and examples
	Stored results
	Acknowledgments
	References
	Also see

	macro
	Description
	Syntax
	Remarks and examples
	Formal definition of a macro
	Global and local macro names
	Macro assignment
	Macro functions
	Macro function for extracting program properties
	Macro function for extracting program results class
	Macro functions for extracting data attributes
	Macro function for naming variables
	Macro functions for filenames and file paths
	Macro function for accessing operating-system parameters
	Macro functions for names of stored results
	Macro function for formatting results
	Macro function for manipulating lists
	Macro functions related to matrices
	Macro function related to time-series operators
	Macro function for copying a macro
	Macro functions for parsing
	Macro expansion operators and function
	The tempvar, tempname, and tempfile commands
	Manipulation of macros
	Macros as arguments

	References
	Also see

	macro lists
	Description
	Syntax
	Remarks and examples
	Treatment of adornment
	Treatment of duplicate elements in lists

	Also see

	makecns
	Description
	Syntax
	Options
	Remarks and examples
	Introduction
	Overview
	Mathematics
	Linkage of the mathematics to Stata

	Stored results
	Also see

	mark
	Description
	Syntax
	Options
	Remarks and examples
	Reference
	Also see

	matlist
	Description
	Syntax
	Style options
	General options
	Required options for the second syntax
	Remarks and examples
	All columns with the same format
	Different formats for each column
	Other output options

	Also see

	matrix
	Description
	Remarks and examples
	Overview of matrix commands
	Creating and replacing matrices
	Namespace
	Naming conventions in programs

	Reference
	Also see

	matrix accum
	Description
	Syntax
	Options
	Remarks and examples
	matrix accum
	matrix glsaccum
	matrix opaccum
	matrix vecaccum
	Treatment of user-specified weights

	Stored results
	Reference
	Also see

	matrix define
	Description
	Menu
	Syntax
	Remarks and examples
	Introduction
	Inputting matrices by hand
	Matrix operators
	Matrix functions returning matrices
	Matrix functions returning scalars
	Subscripting and element-by-element definition
	Name conflicts in expressions (namespaces)
	Macro functions

	Also see

	matrix dissimilarity
	Description
	Syntax
	Options
	Remarks and examples
	References
	Also see

	matrix eigenvalues
	Description
	Menu
	Syntax
	Remarks and examples
	Methods and formulas
	References
	Also see

	matrix get
	Description
	Syntax
	Remarks and examples
	Also see

	matrix mkmat
	Description
	Menu
	Syntax
	Options
	Remarks and examples
	mkmat
	svmat

	Acknowledgment
	References
	Also see

	matrix rowjoinbyname
	Description
	Syntax
	Options
	Remarks and examples
	Also see

	matrix rownames
	Description
	Syntax
	Remarks and examples
	Also see

	matrix score
	Description
	Syntax
	Options
	Remarks and examples
	Also see

	matrix svd
	Description
	Menu
	Syntax
	Remarks and examples
	Methods and formulas
	Reference
	Also see

	matrix symeigen
	Description
	Menu
	Syntax
	Remarks and examples
	Methods and formulas
	References
	Also see

	matrix utility
	Description
	Menu
	Syntax
	Options
	Remarks and examples
	Also see

	more
	Description
	Syntax
	Remarks and examples
	Also see

	nopreserve option
	Description
	Syntax
	Option
	Remarks and examples
	Also see

	numlist
	Description
	Syntax
	Options
	Remarks and examples
	Stored results
	Also see

	pause
	Description
	Syntax
	Remarks and examples
	Also see

	plugin
	Description
	Syntax
	Options
	Remarks and examples
	References
	Also see

	postfile
	Description
	Syntax
	Options
	Remarks and examples
	References
	Also see

	_predict
	Description
	Syntax
	Options
	Methods and formulas
	Reference
	Also see

	preserve
	Description
	Syntax
	Options
	Remarks and examples
	Also see

	program
	Description
	Syntax
	Options
	Remarks and examples
	Also see

	program properties
	Description
	Option
	Remarks and examples
	Introduction
	Writing programs for use with nestreg and stepwise
	Writing programs for use with svy
	Writing programs for use with mi
	Properties for survival-analysis commands
	Properties for exponentiating coefficients
	Putting it all together
	Checking for program properties

	Also see

	Project Manager
	Description
	Remarks and examples
	Getting started with the Project Manager
	Editing projects
	Properties
	Relative versus absolute paths
	Filtering and searching

	Also see

	PyStata intro
	Description
	Also see

	PyStata integration
	Description
	Syntax
	Options
	Remarks and examples
	Invoking Python interactively
	The distinction between python and python:
	Embedding Python code in a do-file
	Running a Python script file
	Embedding Python code in an ado-file
	Stata Function Interface (sfi) module
	Configuring Python
	Locating modules
	Error codes

	Stored results
	Acknowledgment
	References
	Also see

	PyStata module
	Description
	Also see

	quietly
	Description
	Syntax
	Remarks and examples
	quietly used interactively
	quietly used in programs
	Note for programmers

	Also see

	_return
	Description
	Syntax
	Option
	Remarks and examples
	Stored results
	Also see

	return
	Description
	Syntax
	Options
	Remarks and examples
	Introduction
	Storing results in r()
	Storing results in e()
	Storing results in s()
	Recommended names for stored results
	Using hidden and historical stored results
	Programming hidden and historical stored results

	Reference
	Also see

	_rmcoll
	Description
	Syntax
	Options
	Remarks and examples
	Stored results
	Also see

	rmsg
	Description
	Syntax
	Option
	Remarks and examples
	Also see

	_robust
	Description
	Syntax
	Options
	Remarks and examples
	Introduction
	Formulas and simple examples
	Clustered data
	Survey data
	Controlling the header display
	Maximum likelihood estimators
	Multiple-equation estimators

	Stored results
	Methods and formulas
	References
	Also see

	scalar
	Description
	Syntax
	Remarks and examples
	Naming scalars

	Reference
	Also see

	serset
	Description
	Syntax
	Options
	Options for serset create
	Options for serset create_xmedians
	Option for serset create_cspline
	Option for serset summarize
	Option for serset use

	Remarks and examples
	Introduction
	serset create
	serset create_xmedians
	serset create_cspline
	serset set
	serset sort
	serset summarize
	serset
	serset use
	serset reset_id
	serset drop
	serset clear
	serset dir
	file sersetwrite and file sersetread

	Stored results
	Also see

	set locale_functions
	Description
	Syntax
	Option
	Also see

	set locale_ui
	Description
	Syntax
	Also see

	set sortmethod
	Description
	Syntax
	Remarks and examples
	Overview and version control
	Controlling the sorter within a program
	Reproducibility

	Also see

	set sortrngstate
	Description
	Syntax
	Remarks and examples
	Holding and restoring the jumbler state
	Reproducibility

	Also see

	signestimationsample
	Description
	Syntax
	Remarks and examples
	Using signestimationsample and checkestimationsample
	Signing
	Checking
	Handling of weights
	Do not sign unnecessarily

	Stored results
	Also see

	sleep
	Description
	Syntax
	Remarks and examples

	smcl
	Description
	Remarks and examples
	Introduction
	SMCL modes
	Command summary---general syntax
	Help file preprocessor directive for substituting repeated material
	Formatting directives for use in line and paragraph modes
	Link directives for use in line and paragraph modes
	Formatting directives for use in line mode
	Formatting directives for use in paragraph mode
	Directive for entering the as-is mode
	Inserting values from constant and current-value class
	Displaying characters using ASCII and extended ASCII codes
	Advice on using display
	Advice on formatting help files

	Also see

	sortpreserve
	Description
	Syntax
	Option
	Remarks and examples
	Introduction
	sortpreserve
	The cost of sortpreserve
	How sortpreserve works
	Use of sortpreserve with preserve
	Use of sortpreserve with subroutines that use sortpreserve

	Also see

	syntax
	Description
	Syntax
	Syntax, continued
	Remarks and examples
	Introduction
	The args command
	The syntax command

	Also see

	sysdir
	Description
	Syntax
	Option
	Remarks and examples
	Introduction
	sysdir
	adopath
	set adosize

	Also see

	tabdisp
	Description
	Syntax
	Options
	Remarks and examples
	Limits
	Introduction
	Treatment of string variables
	Treatment of missing values

	Also see

	timer
	Description
	Syntax
	Remarks and examples
	Stored results
	Also see

	tokenize
	Description
	Syntax
	Option
	Remarks and examples
	Also see

	trace
	Description
	Syntax
	Options
	Remarks and examples
	Also see

	unab
	Description
	Syntax
	Options
	Remarks and examples
	Reference
	Also see

	unabcmd
	Description
	Syntax
	Remarks and examples
	Also see

	varabbrev
	Description
	Syntax
	Remarks and examples
	Also see

	version
	Description
	Syntax
	Option
	Remarks and examples
	Version
	Version a single command
	User version
	Version and random numbers

	Also see

	viewsource
	Description
	Syntax
	Remarks and examples
	Also see

	while
	Description
	Syntax
	Remarks and examples
	Also see

	window programming
	Description
	Syntax
	Also see

	window fopen
	Description
	Syntax
	Remarks and examples
	Also see

	window manage
	Description
	Syntax
	Remarks and examples
	Minimizing or restoring the main window
	Windowing preferences
	Restoring file associations (Windows only)
	Resetting the main window title
	Setting Dock icon's label (Mac only)
	Bringing windows forward
	Commands to manage Graph windows
	Commands to manage Viewer windows

	Also see

	window menu
	Description
	Syntax
	Remarks and examples
	Overview
	Clear previously defined menu additions
	Define submenus
	Define menu items
	Define separator bars
	Activate menu changes
	Add files to the Open recent menu
	Keyboard shortcuts (Windows only)
	Examples
	Advanced features: Dialogs and built-in actions
	Advanced features: Creating checked menu items
	Putting it all together

	Also see

	window push
	Description
	Syntax
	Remarks and examples
	Also see

	window stopbox
	Description
	Syntax
	Remarks and examples
	Also see

	Glossary

	[PSS] Power, Precision, and Sample Size
	Contents
	Introduction to power, precision, and sample-size analysis
	Intro
	Description
	Also see


	Power and sample-size analysis
	Intro (power)
	Description
	Remarks and examples
	Power and sample-size analysis
	Hypothesis testing
	Components of PSS analysis
	Study design
	Statistical method
	Significance level
	Power
	Clinically meaningful difference and effect size
	Sample size
	One-sided test versus two-sided test
	Another consideration: Dropout

	Survival data
	Sensitivity analysis
	An example of PSS analysis in Stata
	Video example

	References
	Also see

	GUI (power)
	Description
	Menu
	Remarks and examples
	PSS Control Panel
	Example using PSS Control Panel

	Also see

	power
	Description
	Menu
	Syntax
	Options
	Remarks and examples
	Using the power command
	Specifying multiple values of study parameters

	One-sample tests
	Two-sample tests
	Paired-sample tests
	Analysis of variance models
	Linear regression
	Contingency tables
	Survival analysis
	Cluster randomized designs
	Tables of results
	Power curves
	Add your own methods to power

	Stored results
	Methods and formulas
	References
	Also see

	power usermethod
	Description
	Syntax
	Remarks and examples
	A quick example
	Steps for adding a new method to the power command
	Convention for naming options and storing results
	Allowing multiple values in method-specific options
	Customizing default tables
	Setting supported columns
	Modifying the default table columns
	Modifying the look of the default table
	Example continued

	Customizing default graphs
	Other settings
	Handling parsing more efficiently
	More examples: Adding two-sample methods
	Initializer's s() return settings

	References
	Also see

	power, graph
	Description
	Quick start
	Menu
	Syntax
	Suboptions
	Remarks and examples
	Using power, graph
	Graph symbols
	Default graphs
	Changing default graph dimensions
	Changing the look of graphs
	Parallel plots

	Also see

	power, table
	Description
	Quick start
	Menu
	Syntax
	Suboptions
	Remarks and examples
	Using power, table
	Default tables
	Modifying default tables
	Custom tables

	Stored results
	Also see

	power onemean
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Using power onemean
	Computing sample size
	Computing power
	Computing effect size and target mean
	Performing hypothesis tests on mean
	Video examples

	Stored results
	Methods and formulas
	Known standard deviation
	Unknown standard deviation
	Finite population size

	References
	Also see

	power onemean, cluster
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Using power , table, cluster
	Computing number of clusters
	Computing cluster size
	Computing power
	Computing effect size and target mean
	Performing hypothesis tests on mean in a CRD

	Stored results
	Methods and formulas
	Equal cluster sizes
	Unequal cluster sizes

	References
	Also see

	power twomeans
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Using power twomeans
	Computing sample size
	Computing power
	Computing effect size and experimental-group mean
	Testing a hypothesis about two independent means

	Stored results
	Methods and formulas
	Known standard deviations
	Unknown standard deviations
	Unequal standard deviations
	Equal standard deviations


	References
	Also see

	power twomeans, cluster
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Using power , table, cluster
	Computing numbers of clusters
	Computing number of clusters in one group
	Computing cluster sizes
	Computing power
	Computing effect size and experimental-group mean
	Testing hypotheses about two means in a CRD

	Stored results
	Methods and formulas
	Introduction
	Equal cluster sizes
	Unequal cluster sizes

	References
	Also see

	power pairedmeans
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Using power pairedmeans
	Computing sample size
	Computing power
	Computing effect size and target mean difference
	Testing a hypothesis about two correlated means
	Video examples

	Stored results
	Methods and formulas
	References
	Also see

	power oneproportion
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Using power oneproportion
	Computing sample size
	Computing power
	Computing effect size and target proportion
	Performing hypothesis tests on proportion
	Video examples

	Stored results
	Methods and formulas
	Large-sample normal approximation
	Binomial test

	References
	Also see

	power oneproportion, cluster
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Using power , table, cluster
	Computing number of clusters
	Computing cluster size
	Computing power
	Computing effect size and target proportion
	Performing hypothesis tests on proportion in a CRD

	Stored results
	Methods and formulas
	Equal cluster sizes
	Unequal cluster sizes

	References
	Also see

	power twoproportions
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Using power twoproportions
	Alternative ways of specifying effect

	Computing sample size
	Computing power
	Computing effect size and experimental-group proportion
	Testing a hypothesis about two independent proportions
	Video examples

	Stored results
	Methods and formulas
	Effect size
	Pearsons chi2 test
	Likelihood-ratio test
	Fisher's exact conditional test

	References
	Also see

	power twoproportions, cluster
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Using power , table, cluster
	Computing numbers of clusters
	Computing number of clusters in one group
	Computing cluster sizes
	Computing power
	Computing effect size and experimental-group proportion
	Testing hypotheses about two proportions in a CRD

	Stored results
	Methods and formulas
	References
	Also see

	power pairedproportions
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Using power pairedproportions
	Alternative ways of specifying effect

	Computing sample size
	Computing power
	Computing effect size and target discordant proportions
	Testing a hypothesis about two correlated proportions

	Stored results
	Methods and formulas
	References
	Also see

	power onevariance
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Using power onevariance
	Computing sample size
	Computing power
	Computing effect size and target variance
	Performing a hypothesis test on variance

	Stored results
	Methods and formulas
	Reference
	Also see

	power twovariances
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Using power twovariances
	Computing sample size
	Computing power
	Computing effect size and experimental-group variance
	Testing a hypothesis about two independent variances

	Stored results
	Methods and formulas
	References
	Also see

	power onecorrelation
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Using power onecorrelation
	Computing sample size
	Computing power
	Computing effect size and target correlation
	Performing hypothesis tests on correlation

	Stored results
	Methods and formulas
	References
	Also see

	power twocorrelations
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Using power twocorrelations
	Computing sample size
	Computing power
	Computing effect size and experimental-group correlation
	Testing a hypothesis about two independent correlations

	Stored results
	Methods and formulas
	References
	Also see

	power oneway
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Using power oneway
	Alternative ways of specifying effect

	Computing sample size
	Computing power
	Computing effect size and between-group variance
	Testing hypotheses about multiple group means
	Video examples

	Stored results
	Methods and formulas
	References
	Also see

	power twoway
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Using power twoway
	Alternative ways of specifying effect

	Computing sample size
	Computing power
	Computing effect size and target variance explained by the tested effect
	Testing hypotheses about means from multiple populations

	Stored results
	Methods and formulas
	Main effects
	Interaction effects
	Hypothesis testing

	References
	Also see

	power repeated
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Using power repeated
	Computing sample size
	Computing power
	Computing effect size and target variance explained by the tested effect
	Testing hypotheses about means from multiple dependent populations

	Stored results
	Methods and formulas
	Hypothesis testing
	Computing power

	References
	Also see

	power oneslope
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Using power oneslope
	Computing sample size
	Computing power
	Computing effect size and target slope
	Performing hypothesis tests on the slope coefficient

	Stored results
	Methods and formulas
	References
	Also see

	power rsquared
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Using power rsquared
	Computing sample size
	Computing power
	Computing effect size and target R$^2$
	Performing hypothesis tests on the coefficients

	Stored results
	Methods and formulas
	Introduction
	Testing all coefficients
	Testing a subset of coefficients: R$^2$ of full versus reduced models
	Testing a subset of coefficients: Partial multiple correlation

	Reference
	Also see

	power pcorr
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Using power pcorr
	Computing sample size
	Computing power
	Computing effect size and target squared partial correlation
	Performing hypothesis tests on the partial correlation

	Stored results
	Methods and formulas
	Reference
	Also see

	power cmh
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Using power cmh
	Alternative ways of specifying probabilities

	Motivating example
	Computing sample size
	Computing power
	Computing effect size
	Testing hypotheses about association in 2 x 2 x K tables

	Stored results
	Methods and formulas
	References
	Also see

	power mcc
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Using power mcc
	Computing sample size
	Computing power
	Computing target odds ratio
	Testing hypotheses in matched case{--}control studies

	Stored results
	Methods and formulas
	References
	Also see

	power trend
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Using power trend
	Alternative ways of specifying probabilities

	Computing sample size
	Computing power
	Testing hypotheses about a trend in J x 2 tables

	Stored results
	Methods and formulas
	Computing power
	Computing sample size

	References
	Also see

	power cox
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Using power cox
	Computing sample size
	Computing sample size in the absence of censoring
	Computing sample size in the presence of censoring
	Link to the sample-size and power computation for the log-rank test

	Computing power
	Computing effect size
	Performing analyses using a Cox PH model

	Stored results
	Methods and formulas
	References
	Also see

	power exponential
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Using power exponential
	Alternative ways of specifying effect

	Computing sample size
	Computing sample size in the absence of censoring
	Computing sample size in the presence of censoring
	Nonuniform accrual
	Exponential losses to follow-up

	The conditional versus unconditional approaches
	Link to the sample-size and power computation for the log-rank test
	Computing power
	Testing hypotheses about two exponential survivor functions

	Stored results
	Methods and formulas
	References
	Also see

	power logrank
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Using power logrank
	Computing sample size
	Computing sample size in the absence of censoring
	Computing sample size in the presence of censoring

	Withdrawal of subjects from the study
	Including information about subject accrual
	Computing power
	Computing effect size
	Testing a hypothesis about two survivor functions using the log-rank test

	Stored results
	Methods and formulas
	References
	Also see

	power logrank, cluster
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Using power , table, cluster
	Computing numbers of clusters
	Computing cluster sizes
	Computing power
	Computing effect size
	Compare two survivor functions with clustered data

	Stored results
	Methods and formulas
	References
	Also see


	Precision and sample-size analysis
	Intro (ciwidth)
	Description
	Remarks and examples
	Precision and sample-size analysis
	Confidence intervals
	Components of PrSS analysis
	Confidence level
	CI width
	Probability of CI width
	Sample size
	One-sided versus two-sided CIs

	Sensitivity analysis
	An example of PrSS analysis in Stata

	References
	Also see

	GUI (ciwidth)
	Description
	Menu
	Remarks and examples
	PSS Control Panel
	Example using PSS Control Panel

	Also see

	ciwidth
	Description
	Menu
	Syntax
	Options
	Remarks and examples
	Using the ciwidth command
	Specifying multiple values of study parameters

	PrSS analysis for CIs for one population parameter
	PrSS analysis for CIs comparing two independent samples
	PrSS analysis for CIs comparing paired samples
	Tables of results
	Sample-size and other curves
	Add your own methods to ciwidth

	Stored results
	Methods and formulas
	Also see

	ciwidth usermethod
	Description
	Syntax
	Remarks and examples
	A quick example
	Steps for adding a new method to the ciwidth command
	Convention for naming options and storing results
	Allowing multiple values in method-specific options
	Customizing default tables
	Setting supported columns
	Modifying the default table columns
	Modifying the look of the default table
	Example continued

	Customizing default graphs
	Other settings
	Handling parsing more efficiently
	More examples: Compute probability of CI width for a one-proportion CI
	Step 1: Program to simulate the data and compute the CI width
	Step 2: Estimating probability of CI width using simulation
	Step 3: Adding probability of CI width computation to ciwidth
	Step 4: Computing exact probability of CI width

	Initializer's s() return settings

	References
	Also see

	ciwidth, graph
	Description
	Quick start
	Menu
	Syntax
	Suboptions
	Remarks and examples
	Using ciwidth, graph
	Graph symbols
	Default graphs
	Changing default graph dimensions
	Changing the look of graphs
	Parallel plots

	Also see

	ciwidth, table
	Description
	Quick start
	Menu
	Syntax
	Suboptions
	Remarks and examples
	Using ciwidth, table
	Default tables
	Modifying default tables
	Custom tables

	Stored results
	Also see

	ciwidth onemean
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Using ciwidth onemean
	Computing sample size
	Computing CI width
	Computing probability of CI width

	Stored results
	Methods and formulas
	Known standard deviation
	Unknown standard deviation
	Finite population size

	References
	Also see

	ciwidth twomeans
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Using ciwidth twomeans
	Computing sample size
	Computing CI width
	Computing probability of CI width

	Stored results
	Methods and formulas
	Known equal and unequal standard deviations
	Unknown and equal standard deviations

	References
	Also see

	ciwidth pairedmeans
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Using ciwidth pairedmeans
	Computing sample size
	Computing CI width
	Computing probability of CI width

	Stored results
	Methods and formulas
	References
	Also see

	ciwidth onevariance
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Using ciwidth onevariance
	Computing sample size
	Computing CI width
	Computing probability of CI width

	Stored results
	Methods and formulas
	References
	Also see


	Design specification
	Unbalanced designs
	Description
	Syntax
	Options
	Remarks and examples
	Two samples
	Specifying total sample size and allocation ratio
	Specifying group sample sizes
	Specifying one of the group sample sizes and allocation ratio
	Specifying total sample size and one of the group sample sizes

	Fractional sample sizes

	Also see


	Glossary of common terms
	Glossary


	[R] Base Reference
	Contents
	Introduction
	Intro
	Description
	Remarks and examples
	Arrangement of the reference manuals
	Arrangement of each entry
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	Acknowledgments
	References
	Also see


	Also see


	A
	about
	Description
	Menu
	Syntax
	Remarks and examples
	Also see

	ado update
	Description
	Quick start
	Syntax
	Options
	Remarks and examples
	Using ado update
	Notes for developers

	Stored results
	Also see

	ameans
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Video example

	Stored results
	Methods and formulas
	Acknowledgments
	References
	Also see

	anova
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	One-way ANOVA
	Two-way ANOVA
	N-way ANOVA
	Weighted data
	ANCOVA
	Nested designs
	Mixed designs
	Latin-square designs
	Repeated-measures ANOVA
	Video examples

	Stored results
	References
	Also see

	anova postestimation
	Postestimation commands
	predict
	margins
	test
	Description for test
	Menu for test
	Syntax for test
	Options for test

	Remarks and examples
	Testing effects
	Obtaining symbolic forms
	Testing coefficients and contrasts of margins
	Video example

	References
	Also see

	areg
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	areg postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	References
	Also see


	B
	betareg
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	Acknowledgments
	References
	Also see

	betareg postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Also see

	BIC note
	Description
	Remarks and examples
	Background
	The problem of determining N
	The problem of conformable likelihoods
	The first problem does not arise with AIC; the second problem does
	Calculating BIC correctly

	Methods and formulas
	References
	Also see

	binreg
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	binreg postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	References
	Also see

	biprobit
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	biprobit postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Also see

	bitest
	Description
	Quick start
	Menu
	Syntax
	Option
	Remarks and examples
	bitest
	bitesti

	Stored results
	Methods and formulas
	Reference
	Also see

	bootstrap
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Using bootstrap
	Regression coefficients
	Expressions
	Combining bootstrap datasets
	A note about macros
	Achieved significance level
	Bootstrapping a ratio
	Warning messages and e(sample)
	Bootstrapping statistics from data with a complex structure

	Stored results
	Methods and formulas
	References
	Also see

	bootstrap postestimation
	Postestimation commands
	predict
	margins
	estat
	Description for estat
	Menu for estat
	Syntax for estat
	Options for estat

	Remarks and examples
	Also see

	boxcox
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Theta model
	Lambda model
	Left-hand-side-only model
	Right-hand-side-only model

	Stored results
	Methods and formulas
	References
	Also see

	boxcox postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	Remarks and examples
	Methods and formulas
	References
	Also see

	brier
	Description
	Quick start
	Menu
	Syntax
	Option
	Remarks and examples
	Stored results
	Methods and formulas
	Acknowledgment
	References
	Also see

	bsample
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	References
	Also see

	bstat
	Description
	Menu
	Syntax
	Options
	Remarks and examples
	Bootstrap datasets
	Creating a bootstrap dataset

	Stored results
	References
	Also see


	C
	centile
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	Default case
	Normal case
	meansd case

	Acknowledgment
	References
	Also see

	churdle
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	churdle postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Methods and formulas
	Also see

	ci
	Description
	Quick start
	Menu
	Syntax
	Options
	Options for ci and cii means
	Options for ci and cii proportions
	Options for ci and cii variances

	Remarks and examples
	Confidence intervals for means
	Normal-based confidence intervals
	Poisson confidence intervals

	Confidence intervals for proportions
	Confidence intervals for variances
	Immediate form

	Stored results
	Methods and formulas
	Normal mean
	Poisson mean
	Binomial proportion
	Variance and standard deviation

	Acknowledgment
	References
	Also see

	clogit
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Matched case--control data
	Use of weights
	Fixed-effects logit

	Stored results
	Methods and formulas
	References
	Also see

	clogit postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Methods and formulas
	Reference
	Also see

	cloglog
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction to complementary log--log regression
	Robust standard errors

	Stored results
	Methods and formulas
	Acknowledgment
	References
	Also see

	cloglog postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Also see

	cls
	Description
	Syntax

	cnsreg
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	cnsreg postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Also see

	constraint
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Reference
	Also see

	contrast
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	One-way models
	Estimated cell means
	Testing equality of cell means
	Reference category contrasts
	Reverse adjacent contrasts
	Orthogonal polynomial contrasts

	Two-way models
	Estimated interaction cell means
	Simple effects
	Interaction effects
	Main effects
	Partial interaction effects

	Three-way and higher-order models
	Contrast operators
	Differences from a reference level (r.)
	Differences from the next level (a.)
	Differences from the previous level (ar.)
	Differences from the grand mean (g.)
	Differences from the mean of subsequent levels (h.)
	Differences from the mean of previous levels (j.)
	Orthogonal polynomials (p. and q.)

	User-defined contrasts
	Empty cells
	Empty cells, ANOVA style
	Nested effects
	Multiple comparisons
	Unbalanced data
	Using observed cell frequencies
	Weighted contrast operators

	Testing factor effects on slopes
	Chow tests
	Beyond linear models
	Multiple equations
	Video example

	Stored results
	Methods and formulas
	Marginal linear predictions
	Contrast operators
	Reference level contrasts
	Adjacent contrasts
	Grand mean contrasts
	Helmert contrasts
	Reverse Helmert contrasts
	Orthogonal polynomial contrasts

	Contrasts within interactions
	Multiple comparisons

	References
	Also see

	contrast postestimation
	Postestimation commands
	Remarks and examples
	Also see

	copyright
	Description
	Syntax
	Remarks and examples
	Also see

	Copyright Apache
	Description
	Also see

	Copyright autolink
	Description
	Also see

	Copyright Boost
	Description
	Also see

	Copyright flexmark
	Description
	Also see

	Copyright Hamcrest
	Description
	Also see

	Copyright H2O
	Description
	Also see

	Copyright ICD-10
	Description
	Also see

	Copyright ICU
	Description
	Also see

	Copyright JAXB
	Description
	Source code
	Also see

	Copyright JGoodies Common
	Description
	Also see

	Copyright JGoodies Forms
	Description
	Also see

	Copyright JSON
	Description
	Also see

	Copyright jsoup
	Description
	Also see

	Copyright LAPACK
	Description
	Also see

	Copyright libHaru
	Description
	Also see

	Copyright libpng
	Description
	Also see

	Copyright Mersenne Twister
	Description
	Also see

	Copyright MiG Layout
	Description
	Also see

	Copyright Parsington
	Description
	Also see

	Copyright ReadStat
	Description
	Also see

	Copyright Scintilla
	Description
	Also see

	Copyright slf4j
	Description
	Also see

	Copyright ttf2pt1
	Description
	Also see

	Copyright zlib
	Description
	Also see

	correlate
	Description
	Quick start
	Menu
	Syntax
	Options for correlate
	Options for pwcorr
	Remarks and examples
	correlate
	pwcorr
	Video example

	Stored results
	Methods and formulas
	References
	Also see

	cpoisson
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	cpoisson postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Methods and formulas
	Also see

	cumul
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Acknowledgment
	References
	Also see

	cusum
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Acknowledgment
	Reference
	Also see


	D
	db
	Description
	Syntax
	Options
	Remarks and examples
	Also see

	Diagnostic plots
	Description
	Quick start
	Menu
	Syntax
	Options for symplot, quantile, and qqplot
	Options for qnorm and pnorm
	Options for qchi and pchi
	Remarks and examples
	symplot
	quantile
	qqplot
	qnorm
	pnorm
	qchi
	pchi

	Methods and formulas
	Acknowledgments
	References
	Also see

	display
	Description
	Quick start
	Syntax
	Remarks and examples
	Also see

	do
	Description
	Quick start
	Menu
	Syntax
	Option
	Reference
	Also see

	doedit
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Also see

	dotplot
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Acknowledgments
	Reference

	dstdize
	Description
	Quick start
	Menu
	Syntax
	Options for dstdize
	Options for istdize
	Remarks and examples
	Direct standardization
	Indirect standardization

	Stored results
	Methods and formulas
	Acknowledgments
	References
	Also see

	dydx
	Description
	Quick start
	Menu
	Syntax
	Options for dydx
	Options for integ
	Remarks and examples
	Stored results
	Methods and formulas
	Acknowledgment
	References
	Also see


	E
	eform_option
	Description
	Remarks and examples
	Reference
	Also see

	eivreg
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	eivreg postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Also see

	Epitab
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Incidence-rate data
	Stratified incidence-rate data
	Standardized estimates with stratified incidence-rate data
	Cumulative incidence data
	Stratified cumulative incidence data
	Standardized estimates with stratified cumulative incidence data
	Case--control data
	Stratified case--control data
	Case--control data with multiple levels of exposure
	Case--control data with confounders and possibly multiple levels of exposure
	Standardized estimates with stratified case--control data
	Matched case--control data
	Video examples
	Glossary

	Stored results
	Methods and formulas
	Unstratified incidence-rate data (ir and iri)
	Unstratified cumulative incidence data (cs and csi)
	Unstratified case--control data (cc and cci)
	Unstratified matched case--control data (mcc and mcci)
	Stratified incidence-rate data (ir with the by() option)
	Stratified cumulative incidence data (cs with the by() option)
	Stratified case--control data (cc with by() option, mhodds, tabodds)

	Acknowledgments
	References
	Also see

	Error messages
	Description
	Also see

	esize
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Estimating effect sizes
	Immediate form
	Video example

	Stored results
	Methods and formulas
	References
	Also see

	estat
	Description
	Syntax

	estat classification
	Description
	Quick start
	Menu for estat
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	estat gof
	Description
	Quick start
	Menu for estat
	Syntax
	Options
	Remarks and examples
	Introduction
	Samples other than the estimation sample

	Stored results
	Methods and formulas
	References
	Also see

	estat ic
	Description
	Quick start
	Menu for estat
	Syntax
	Option
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	estat summarize
	Description
	Quick start
	Menu for estat
	Syntax
	Options
	Remarks and examples
	Stored results
	Also see

	estat vce
	Description
	Quick start
	Menu for estat
	Syntax
	Options
	Remarks and examples
	Stored results
	Also see

	estimates
	Description
	Syntax
	Remarks and examples
	Saving and using estimation results
	Storing and restoring estimation results
	Comparing estimation results
	Jargon

	Also see

	estimates describe
	Description
	Quick start
	Menu
	Syntax
	Option
	Remarks and examples
	Stored results
	Also see

	estimates for
	Description
	Quick start
	Syntax
	Options
	Remarks and examples
	Also see

	estimates notes
	Description
	Quick start
	Syntax
	Remarks and examples
	Also see

	estimates replay
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Also see

	estimates save
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Setting e(sample)
	Resetting e(sample)
	Determining who set e(sample)

	Stored results
	Also see

	estimates selected
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Also see

	estimates stats
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	estimates store
	Description
	Quick start
	Menu
	Syntax
	Option
	Remarks and examples
	Stored results
	References
	Also see

	estimates table
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	References
	Also see

	estimates title
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Also see

	Estimation options
	Description
	Syntax
	Options
	Also see

	etable
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	A first example
	Table comparing regression results
	Multiple-equation models

	Appendix
	Colors
	Underline patterns
	Shading patterns

	Reference
	Also see

	exit
	Description
	Syntax
	Option
	Remarks and examples
	Also see

	exlogistic
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	Sufficient statistics
	Conditional distribution and CMLE
	Median unbiased estimates and exact CI
	Conditional hypothesis tests
	Sufficient-statistic p-value

	References
	Also see

	exlogistic postestimation
	Postestimation commands
	estat
	Description for estat
	Menu for estat
	Syntax for estat
	Options for estat predict
	Option for estat se

	Remarks and examples
	Stored results
	Reference
	Also see

	expoisson
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	Conditional distribution

	References
	Also see

	expoisson postestimation
	Postestimation commands
	estat
	Description for estat
	Menu for estat
	Syntax for estat
	Option for estat

	Remarks and examples
	Also see


	F
	fp
	Description
	Quick start
	Menu
	Syntax
	Options
	Options for fp
	Options for fp generate

	Remarks and examples
	Fractional polynomial regression
	Scaling
	Centering
	Examples

	Stored results
	Methods and formulas
	Acknowledgment
	References
	Also see

	fp postestimation
	Postestimation commands
	predict
	margins
	fp plot and fp predict
	Description for fp plot and fp predict
	Menu for fp plot and fp predict
	Syntax for fp plot and fp predict
	Options for fp plot
	Options for fp predict

	Remarks and examples
	Examples

	Methods and formulas
	Acknowledgment
	Reference
	Also see

	fracreg
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	fracreg postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Obtaining predicted values
	Performing hypothesis tests

	Also see

	frontier
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	frontier postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Reference
	Also see

	fvrevar
	Description
	Quick start
	Syntax
	Options
	Remarks and examples
	Stored results
	Also see

	fvset
	Description
	Quick start
	Syntax
	Options
	Remarks and examples
	Stored results


	G
	gllamm
	Description
	Remarks and examples
	References
	Also see

	glm
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	General use
	Variance estimators
	User-defined functions

	Stored results
	Methods and formulas
	Acknowledgments
	References
	Also see

	glm postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Predictions
	Other postestimation commands

	Methods and formulas
	References
	Also see

	gmm
	Description
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Substitutable expressions
	The weight matrix and two-step estimation
	Obtaining standard errors
	Factor-variable coefficients in multiple residual functions
	Parameter interpretation using margins
	Exponential (Poisson) regression models
	Specifying derivatives
	Exponential regression models with panel data
	Rational-expectations models
	System estimators
	Dynamic panel-data models
	Details of moment-evaluator programs

	Stored results
	Methods and formulas
	Initial weight matrix
	Weight matrix
	Variance--covariance matrix
	Hansen's J statistic
	Panel-style instruments
	Marginal predictions with unconditional standard errors

	References
	Also see

	gmm postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Option for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	estat
	Description for estat
	Menu for estat
	Syntax for estat

	Remarks and examples
	Stored results
	References
	Also see

	grmeanby
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	References


	H
	hausman
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	Acknowledgment
	References
	Also see

	heckman
	Description
	Quick start
	Menu
	Syntax
	Options for Heckman selection model (ML)
	Options for Heckman selection model (two-step)
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	heckman postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Reference
	Also see

	heckoprobit
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	heckoprobit postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Methods and formulas
	Also see

	heckpoisson
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	heckpoisson postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Methods and formulas
	Also see

	heckprobit
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	heckprobit postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Also see

	help
	Description
	Menu
	Syntax
	Options
	Remarks and examples
	Video examples

	Also see

	hetoprobit
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	hetoprobit postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Methods and formulas
	Also see

	hetprobit
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Robust standard errors

	Stored results
	Methods and formulas
	References
	Also see

	hetprobit postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Also see

	hetregress
	Description
	Quick start
	Menu
	Syntax
	Options for maximum likelihood estimation
	Options for two-step GLS estimation
	Remarks and examples
	Introduction
	Maximum likelihood estimation
	Two-step GLS estimation

	Stored results
	Methods and formulas
	Maximum likelihood estimation
	Two-step GLS estimation

	References
	Also see

	hetregress postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Also see

	histogram
	Description
	Quick start
	Menu
	Syntax
	Options
	Options for use in the continuous case
	Options for use in the discrete case
	Options for use in the continuous and discrete cases

	Remarks and examples
	Histograms of continuous variables
	Overlaying normal and kernel density estimates
	Histograms of discrete variables
	Use with by()
	Video example

	References
	Also see


	I
	icc
	Description
	Quick start
	Menu
	Syntax
	Options for one-way RE model
	Options for two-way RE and ME models
	Remarks and examples
	Introduction
	One-way random effects
	Two-way random effects
	Two-way mixed effects
	Adoption study
	Relationship between ICCs
	Tests against nonzero values

	Stored results
	Methods and formulas
	Mean squares
	One-way random effects
	Two-way random effects
	Two-way mixed effects

	References
	Also see

	Inequality
	Remarks and examples
	References

	intreg
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	intreg postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Also see

	ivpoisson
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	GMM estimator for additive model
	GMM estimator for multiplicative model
	CF estimator for multiplicative model

	Stored results
	Methods and formulas
	References
	Also see

	ivpoisson postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	estat
	Description for estat
	Menu for estat
	Syntax for estat

	Remarks and examples
	Stored results
	Methods and formulas
	Reference
	Also see

	ivprobit
	Description
	Quick start
	Menu
	Syntax
	Options for ML estimator
	Options for two-step estimator
	Remarks and examples
	Model setup
	Model identification

	Stored results
	Methods and formulas
	Acknowledgments
	References
	Also see

	ivprobit postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	estat
	Description for estat
	Menu for estat
	Syntax for estat
	Options for estat

	Remarks and examples
	Marginal effects
	Obtaining predicted values

	Methods and formulas
	References
	Also see

	ivregress
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	2SLS and LIML estimators
	GMM estimator
	Video example

	Stored results
	Methods and formulas
	Notation
	2SLS and LIML estimators
	GMM estimator

	References
	Also see

	ivregress postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	estat
	Description for estat
	Menu for estat
	Syntax for estat
	Options for estat
	Options for estat endogenous
	Options for estat firststage
	Options for estat overid

	Remarks and examples
	estat endogenous
	estat firststage
	estat overid

	Stored results
	Methods and formulas
	Notation
	estat endogenous
	estat firststage
	estat overid

	References
	Also see

	ivtobit
	Description
	Quick start
	Menu
	Syntax
	Options for ML estimator
	Options for two-step estimator
	Remarks and examples
	Stored results
	Methods and formulas
	Acknowledgments
	References
	Also see

	ivtobit postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	estat
	Description for estat
	Menu for estat
	Syntax for estat
	Options for estat

	Remarks and examples
	Marginal effects
	Obtaining predicted values

	Methods and formulas
	References
	Also see


	J
	jackknife
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Using jackknife
	Jackknifed standard deviation
	Collecting multiple statistics
	Collecting coefficients

	Stored results
	Methods and formulas
	References
	Also see

	jackknife postestimation
	Postestimation commands
	predict
	margins
	Also see


	K
	kappa
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Two raters
	More than two raters

	Stored results
	Methods and formulas
	kap: m=2
	kappa: m>2, k=2
	kappa: m>2, k>2

	References

	kdensity
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	Acknowledgments
	References
	Also see

	ksmirnov
	Description
	Quick start
	Menu
	Syntax
	Options for two-sample test
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	kwallis
	Description
	Quick start
	Menu
	Syntax
	Option
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see


	L
	ladder
	Description
	Quick start
	Menu
	Syntax
	Options for ladder
	Options for gladder
	Options for qladder
	Remarks and examples
	Stored results
	Methods and formulas
	Acknowledgment
	References
	Also see

	level
	Description
	Syntax
	Option
	Remarks and examples
	Also see

	Limits
	Description
	Remarks and examples
	Maximum size limits
	Determining which edition of Stata you are running

	Also see

	lincom
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Using lincom
	Odds ratios and incidence-rate ratios
	Multiple-equation models

	Stored results
	References
	Also see

	linktest
	Description
	Quick start
	Menu
	Syntax
	Option
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	lnskew0
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	Acknowledgment
	Reference
	Also see

	log
	Description
	Quick start
	Menu
	Syntax
	Options for use with both log and cmdlog
	Options for use with log
	Option for use with set logtype
	Remarks and examples
	Stored results
	Reference
	Also see

	logistic
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	logistic and logit
	Robust estimate of variance
	Video examples

	Stored results
	Methods and formulas
	References
	Also see

	logistic postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	predict without options
	predict with the xb and stdp options
	predict with the residuals option
	predict with the number option
	predict with the deviance option
	predict with the rstandard option
	predict with the hat option
	predict with the dx2 option
	predict with the ddeviance option
	predict with the dbeta option

	Methods and formulas
	References
	Also see

	logit
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Basic usage
	Model identification

	Stored results
	Methods and formulas
	References
	Also see

	logit postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Methods and formulas
	References
	Also see

	loneway
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	The one-way ANOVA model
	R-squared
	The random-effects ANOVA model
	Intraclass correlation
	Estimated reliability of the group-averaged score

	Stored results
	Methods and formulas
	Acknowledgment
	References
	Also see

	lowess
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Methods and formulas
	Acknowledgment
	References
	Also see

	lpoly
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Local polynomial smoothing
	Choice of a bandwidth
	Confidence bands

	Stored results
	Methods and formulas
	References
	Also see

	lroc
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Samples other than the estimation sample
	Models other than the last fitted model

	Stored results
	Methods and formulas
	References
	Also see

	lrtest
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Nested models
	Composite models

	Stored results
	Methods and formulas
	References
	Also see

	lsens
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Models other than the last fitted model

	Stored results
	Methods and formulas
	Reference
	Also see

	lv
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see


	M
	margins
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Obtaining margins of responses
	Example 1: A simple case after regress
	Example 2: A simple case after logistic
	Example 3: Average response versus response at average
	Example 4: Multiple margins from one command
	Example 5: Margins with interaction terms
	Example 6: Margins with continuous variables
	Example 7: Margins of continuous variables
	Example 8: Margins of interactions
	Example 9: Decomposing margins
	Example 10: Testing margins---contrasts of margins
	Example 11: Margins of a specified prediction
	Example 12: Margins of a specified expression
	Example 13: Margins with multiple outcomes (responses)
	Example 14: Margins with multiple equations
	Example 15: Margins evaluated out of sample

	Obtaining margins of derivatives of responses (a.k.a. marginal effects)
	Use at() freely, especially with continuous variables
	Expressing derivatives as elasticities
	Derivatives versus discrete differences
	Example 16: Average marginal effect (partial effects)
	Example 17: Average marginal effect of all covariates
	Example 18: Evaluating marginal effects over the response surface

	Obtaining margins with survey data and representative samples
	Example 19: Inferences for populations, margins of response
	Example 20: Inferences for populations, marginal effects
	Example 21: Inferences for populations with svyset data

	Standardizing margins
	Obtaining margins as though the data were balanced
	Balancing using asbalanced
	Balancing by standardization
	Balancing nonlinear responses
	Treating a subset of covariates as balanced
	Using fvset design
	Balancing in the presence of empty cells

	Obtaining margins with nested designs
	Introduction to nested designs
	Margins with nested designs as though the data were balanced
	Coding of nested designs

	Special topics
	Requirements for model specification
	Estimability of margins
	Manipulability of tests
	Using margins after the estimates use command
	Syntax of at()
	Estimation commands that may be used with margins

	Video examples
	Glossary

	Stored results
	Methods and formulas
	Notation
	Marginal effects
	Fixing covariates and balancing factors
	Estimable functions
	Standard errors conditional on the covariates
	Unconditional standard errors

	References
	Also see

	margins postestimation
	Postestimation commands
	Remarks and examples
	Also see

	margins, contrast
	Description
	Quick start
	Menu
	Syntax
	Suboptions
	Remarks and examples
	Contrasts of margins
	Contrasts and the over() option
	The overjoint suboption
	The marginswithin suboption

	Contrasts and the at() option
	Estimating treatment effects with margins
	Conclusion

	Stored results
	Methods and formulas
	Reference
	Also see

	margins, pwcompare
	Description
	Quick start
	Menu
	Syntax
	Suboptions
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	marginsplot
	Description
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Dataset
	Profile plots
	Interaction plots
	Contrasts of margins---effects (discrete marginal effects)
	Three-way interactions
	Continuous covariates
	Plots at every value of a continuous covariate
	Contrasts of at() groups---discrete effects
	Controlling the graph's dimensions
	Pairwise comparisons
	Horizontal is sometimes better
	Marginal effects
	Plotting a subset of the results from margins
	Advanced usage
	Plots with multiple terms
	Plots with multiple at() options
	Adding scatterplots of the data

	Video examples

	Addendum: Advanced uses of dimlist
	Acknowledgments
	References
	Also see

	Maximize
	Description
	Syntax
	Maximization options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	mean
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Video example

	Stored results
	Methods and formulas
	The mean estimator
	Survey data
	The survey mean estimator
	The standardized mean estimator
	The poststratified mean estimator
	The standardized poststratified mean estimator
	Subpopulation estimation

	References
	Also see

	mean postestimation
	Postestimation commands
	estat sd
	Description for estat sd
	Menu for estat sd
	Syntax for estat sd
	Option for estat sd
	Stored results for estat sd

	Also see

	mfp
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Iteration report
	Estimation algorithm
	Methods of FP model selection
	Zeros and zero categories

	Stored results
	Acknowledgments
	References
	Also see

	mfp postestimation
	Postestimation commands
	fracplot and fracpred
	Description for fracplot and fracpred
	Menu for fracplot and fracpred
	Syntax for fracplot and fracpred
	Options for fracplot
	Options for fracpred

	Remarks and examples
	Methods and formulas
	Also see

	misstable
	Description
	Quick start
	Menu
	Syntax
	Options
	Options for misstable summarize
	Options for misstable patterns
	Options for misstable tree
	Option for misstable nested
	Common options

	Remarks and examples
	misstable summarize
	misstable patterns
	misstable tree
	misstable nested
	Execution time of misstable nested

	Stored results
	Also see

	mkspline
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Linear splines
	Restricted cubic splines

	Stored results
	Methods and formulas
	Linear splines
	Restricted cubic splines

	Acknowledgment
	References
	Also see

	ml
	Description
	Syntax
	Syntax of subroutines for use by evaluator programs
	Syntax of user-written evaluator

	Options
	Options for use with ml model in interactive or noninteractive mode
	Options for use with ml model in noninteractive mode
	Options for use when specifying equations
	Options for use with ml search
	Option for use with ml plot
	Options for use with ml init
	Options for use with ml maximize
	Option for use with ml graph
	Options for use with ml display
	Options for use with mleval
	Option for use with mlsum
	Option for use with mlvecsum
	Option for use with mlmatsum
	Options for use with mlmatbysum
	Options for use with ml score

	Remarks and examples
	Survey options and ml

	Stored results
	Methods and formulas
	References
	Also see

	mlexp
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Substitutable expressions
	Parameter interpretation using margins
	Parameter constraints
	Specifying derivatives

	Stored results
	Methods and formulas
	References
	Also see

	mlexp postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Also see

	mlogit
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Description of the model
	Fitting unconstrained models
	Fitting constrained models

	Stored results
	Methods and formulas
	References
	Also see

	mlogit postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Obtaining predicted values
	Calculating marginal effects
	Testing hypotheses about coefficients

	Reference
	Also see

	more
	Description
	Syntax
	Option
	Remarks and examples
	Also see

	mprobit
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	mprobit postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	References
	Also see


	N
	nbreg
	Description
	Quick start
	Menu
	Syntax
	Options for nbreg
	Options for gnbreg
	Remarks and examples
	Introduction to negative binomial regression
	nbreg
	gnbreg

	Stored results
	Methods and formulas
	Mean-dispersion model
	Constant-dispersion model

	References
	Also see

	nbreg postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Methods and formulas
	Mean-dispersion model
	Constant-dispersion model

	Reference
	Also see

	nestreg
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Estimation commands
	Wald tests
	Likelihood-ratio tests
	Programming for nestreg

	Stored results
	Acknowledgment
	References
	Also see

	net
	Description
	Syntax
	Options
	Remarks and examples
	Definition of a package
	The purpose of the net and ado commands
	Content pages
	Package-description pages
	Where packages are installed
	A summary of the net command
	A summary of the ado command
	Relationship of net and ado to the point-and-click interface
	Creating your own site
	Format of content and package-description files
	Example 1
	Example 2
	Additional package directives
	SMCL in content and package-description files
	Error-free file delivery

	Also see

	net search
	Description
	Quick start
	Syntax
	Options
	Remarks and examples
	Topic searches
	Author searches
	Command searches
	Where does net search look?
	How does net search work?

	Also see

	netio
	Description
	Syntax
	Options
	Remarks and examples
	Also see

	nl
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Substitutable expressions
	Substitutable expression programs
	Built-in functions
	Lognormal errors
	Other uses
	Weights
	Potential errors
	General comments on fitting nonlinear models
	Function evaluator programs

	Stored results
	Methods and formulas
	Acknowledgments
	References
	Also see

	nl postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Also see

	nlcom
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Basics
	Using the post option
	Reparameterizing ML estimators for univariate data
	nlcom versus eform

	Stored results
	Methods and formulas
	References
	Also see

	nlsur
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Substitutable expression programs
	Function evaluator programs

	Stored results
	Methods and formulas
	References
	Also see

	nlsur postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Also see

	npregress intro
	Description
	Remarks and examples
	Overview
	Nonparametric series regression
	Runge's phenomenon
	Splines and B-splines

	Nonparametric kernel regression
	Limitations of nonparametric methods

	References
	Also see

	npregress kernel
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Overview
	Estimation and effects
	Visualizing covariate effects

	Stored results
	Methods and formulas
	Acknowledgments
	References
	Also see

	npregress kernel postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins
	Options for margins

	npgraph
	Description for npgraph
	Syntax for npgraph
	Options for npgraph

	Remarks and examples
	Methods and formulas
	References
	Also see

	npregress series
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Overview
	Estimation and effects

	Stored results
	Methods and formulas
	Overview
	Polynomials
	Natural splines
	B-splines
	Model selection
	Cross-validation
	Generalized cross-validation
	Mallows's C$_p$
	AIC and BIC


	References
	Also see

	npregress series postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins
	Options for margins

	Remarks and examples
	Methods and formulas
	Reference
	Also see

	nptrend
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Cochran--Armitage test
	Jonckheere--Terpstra test
	Linear-by-linear trend test
	Cuzick's test

	Stored results
	Methods and formulas
	Overview
	Cochran--Armitage test for trend
	Jonckheere--Terpstra test for trend
	Linear-by-linear test for trend
	Cuzick's test with rank scores
	Exact p-values

	Acknowledgments
	References
	Also see


	O
	ologit
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	ologit postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Reference
	Also see

	oneway
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Obtaining observed means
	Multiple-comparison tests
	Weighted data
	Video example

	Stored results
	Methods and formulas
	One-way analysis of variance
	Bartlett's test
	Multiple-comparison tests

	References
	Also see

	oprobit
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	oprobit postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Also see

	orthog
	Description
	Quick start
	Menu
	Syntax
	Options for orthog
	Options for orthpoly
	Remarks and examples
	Methods and formulas
	References
	Also see


	P
	pcorr
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Methods and formulas
	Acknowledgment
	References
	Also see

	permute
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Monte Carlo permutation tests
	Two-sided p-values from permutation tests
	One-sided permutation test
	Enumeration
	Efficiency considerations for Monte Carlo permutations
	Efficiency considerations for enumeration

	Stored results
	Methods and formulas
	References
	Also see

	pk
	Description
	Remarks and examples
	References
	Also see

	pkcollapse
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Methods and formulas
	Also see

	pkcross
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Methods and formulas
	References
	Also see

	pkequiv
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	pkexamine
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	Reference
	Also see

	pkshape
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	References
	Also see

	pksumm
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Methods and formulas
	Also see

	poisson
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	poisson postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	estat
	Description for estat
	Menu for estat
	Syntax for estat

	Remarks and examples
	Stored results
	Methods and formulas
	Reference
	Also see

	postest
	Description
	Menu
	Syntax
	Remarks and examples
	Overview
	Video example

	Also see

	predict
	Description
	Quick start
	Menu for predict
	Syntax
	Options
	Remarks and examples
	Estimation-sample predictions
	Out-of-sample predictions
	Residuals
	Single-equation (SE) models
	SE model scores
	Multiple-equation (ME) models
	ME model scores

	Methods and formulas
	References
	Also see

	predictnl
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Nonlinear transformations and standard errors
	Using xb() and predict()
	Multiple-equation (ME) estimators
	Test statistics and $p$-values
	Manipulability
	Confidence intervals

	Methods and formulas
	References
	Also see

	probit
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Robust standard errors
	Model identification
	Video examples

	Stored results
	Methods and formulas
	References
	Also see

	probit postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Obtaining predicted values
	Performing hypothesis tests

	Methods and formulas
	Also see

	proportion
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	Confidence intervals

	References
	Also see

	proportion postestimation
	Postestimation commands
	Remarks and examples
	Also see

	prtest
	Description
	Quick start
	Menu
	Syntax
	Options for prtest
	Options for prtesti
	Remarks and examples
	Tests of proportions
	Adjust for clustering
	Immediate form

	Stored results
	Methods and formulas
	One-sample test
	Two-sample test

	References
	Also see

	pwcompare
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Pairwise comparisons of means
	Marginal means
	All pairwise comparisons

	Overview of multiple-comparison methods
	Fisher's protected least-significant difference (LSD)
	Bonferroni's adjustment
	{accent 20 S}id{accent 19 a}k's adjustment
	Scheff{accent 19 e}'s adjustment
	Tukey's HSD adjustment
	Student--Newman--Keuls's adjustment
	Duncan's adjustment
	Dunnett's adjustment

	Example adjustments using one-way models
	Fisher's protected LSD
	Tukey's HSD
	Dunnett's method for comparisons to a control

	Two-way models
	Pairwise comparisons of slopes
	Nonlinear models
	Multiple-equation models
	Unbalanced data
	Empty cells

	Stored results
	Methods and formulas
	Notation
	Unadjusted comparisons
	Bonferroni's method
	{accent 20 S}id{accent 19 a}k's method
	Scheff{accent 19 e}'s method
	Tukey's method
	Student--Newman--Keuls's method
	Duncan's method
	Dunnett's method

	References
	Also see

	pwcompare postestimation
	Postestimation commands
	Remarks and examples
	Also see

	pwmean
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Group means
	Pairwise differences of means
	Group output
	Adjusting for multiple comparisons
	Tukey's method
	Dunnett's method

	Multiple over() variables
	Equal variance assumption

	Stored results
	Methods and formulas
	Reference
	Also see

	pwmean postestimation
	Postestimation commands
	Remarks and examples
	Also see


	Q
	QC
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	qreg
	Description
	Quick start
	Menu
	Syntax
	Options for qreg
	Options for iqreg
	Options for sqreg
	Options for bsqreg
	Remarks and examples
	Median regression
	Quantile regression
	Estimated standard errors
	Interquantile and simultaneous-quantile regression
	What are the parameters?

	Stored results
	Methods and formulas
	Introduction
	Linear programming formulation of quantile regression
	Standard errors when residuals are i.i.d.
	Pseudo-R-squared

	References
	Also see

	qreg postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Also see

	query
	Description
	Syntax
	Remarks and examples
	Also see


	R
	ranksum
	Description
	Quick start
	Menu
	Syntax
	Options for ranksum
	Options for median
	Remarks and examples
	Stored results
	Methods and formulas
	ranksum
	median

	References
	Also see

	ratio
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	The ratio estimator
	Survey data
	The survey ratio estimator
	The standardized ratio estimator
	The poststratified ratio estimator
	The standardized poststratified ratio estimator
	Subpopulation estimation

	References
	Also see

	ratio postestimation
	Postestimation commands
	Remarks and examples
	Also see

	reg3
	Description
	Nomenclature

	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	reg3 postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Methods and formulas
	Reference
	Also see

	regress
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Ordinary least squares
	Treatment of the constant
	Robust standard errors
	Weighted regression
	Video examples

	Stored results
	Methods and formulas
	Coefficient estimation and ANOVA table
	Weighted regression
	A general notation for the robust variance calculation
	Robust calculation for regress

	Acknowledgments
	References
	Also see

	regress postestimation
	Postestimation commands
	Predictions
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict
	Remarks and examples for predict
	Terminology
	Fitted values and residuals
	Prediction standard errors
	Prediction with weighted data
	Leverage statistics
	Standardized and Studentized residuals
	DFITS, Cook's Distance, and Welsch Distance
	COVRATIO


	margins
	Description for margins
	Menu for margins
	Syntax for margins

	DFBETA influence statistics
	Description for dfbeta
	Menu for dfbeta
	Syntax for dfbeta
	Option for dfbeta
	Remarks and examples for dfbeta

	Tests for violation of assumptions
	Description for estat hettest
	Menu for estat
	Syntax for estat hettest
	Options for estat hettest
	Description for estat imtest
	Menu for estat
	Syntax for estat imtest
	Options for estat imtest
	Description for estat ovtest
	Menu for estat
	Syntax for estat ovtest
	Option for estat ovtest
	Description for estat szroeter
	Menu for estat
	Syntax for estat szroeter
	Options for estat szroeter
	Remarks and examples for estat hettest, estat imtest, estat ovtest, and estat szroeter
	Stored results for estat hettest, estat imtest, and estat ovtest

	Variance inflation factors
	Description for estat vif
	Menu for estat
	Syntax for estat vif
	Option for estat vif
	Remarks and examples for estat vif

	Measures of effect size
	Description for estat esize
	Menu for estat
	Syntax for estat esize
	Options for estat esize
	Remarks and examples for estat esize
	Stored results for estat esize

	Methods and formulas
	predict
	Special-interest postestimation commands

	Acknowledgments
	References
	Also see

	regress postestimation diagnostic plots
	Description
	rvfplot
	Description for rvfplot
	Menu for rvfplot
	Syntax for rvfplot
	Options for rvfplot
	Remarks and examples for rvfplot

	avplot
	Description for avplot
	Menu for avplot
	Syntax for avplot
	Options for avplot
	Remarks and examples for avplot

	avplots
	Description for avplots
	Menu for avplots
	Syntax for avplots
	Options for avplots
	Remarks and examples for avplots

	cprplot
	Description for cprplot
	Menu for cprplot
	Syntax for cprplot
	Options for cprplot
	Remarks and examples for cprplot

	acprplot
	Description for acprplot
	Menu for acprplot
	Syntax for acprplot
	Options for acprplot
	Remarks and examples for acprplot

	rvpplot
	Description for rvpplot
	Menu for rvpplot
	Syntax for rvpplot
	Options for rvpplot
	Remarks and examples for rvpplot

	lvr2plot
	Description for lvr2plot
	Menu for lvr2plot
	Syntax for lvr2plot
	Options for lvr2plot
	Remarks and examples for lvr2plot

	Methods and formulas
	References
	Also see

	regress postestimation time series
	Postestimation commands
	estat archlm
	Description for estat archlm
	Menu for estat
	Syntax for estat archlm
	Options for estat archlm

	estat bgodfrey
	Description for estat bgodfrey
	Menu for estat
	Syntax for estat bgodfrey
	Options for estat bgodfrey

	estat durbinalt
	Description for estat durbinalt
	Menu for estat
	Syntax for estat durbinalt
	Options for estat durbinalt

	estat dwatson
	Description for estat dwatson
	Menu for estat
	Syntax for estat dwatson

	Remarks and examples
	Stored results
	Methods and formulas
	Acknowledgment
	References
	Also see

	#review
	Description
	Syntax
	Remarks and examples

	roc
	Description
	References

	roccomp
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Comparing areas under the ROC curve
	Correlated data
	Independent data
	Comparing areas with a gold standard

	Stored results
	Methods and formulas
	References
	Also see

	rocfit
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	rocfit postestimation
	Postestimation commands
	rocplot
	Description for rocplot
	Menu for rocplot
	Syntax for rocplot
	Options for rocplot

	Remarks and examples
	Using lincom and test
	Using rocplot

	Also see

	rocreg
	Description
	Quick start
	Menu
	Syntax
	Options
	Options for nonparametric ROC estimation, using bootstrap
	Options for parametric ROC estimation, using bootstrap
	Options for parametric ROC estimation, using maximum likelihood

	Remarks and examples
	Introduction
	ROC statistics
	Covariate-adjusted ROC curves
	Parametric ROC curves: Estimating equations
	Parametric ROC curves: Maximum likelihood

	Stored results
	Methods and formulas
	ROC statistics
	Covariate-adjusted ROC curves
	Parametric ROC curves: Estimating equations
	Parametric ROC curves: Maximum likelihood

	Acknowledgments
	References
	Also see

	rocreg postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	estat
	Description for estat
	Menu for estat
	Syntax for estat nproc
	Options for estat nproc

	Remarks and examples
	Using predict after rocreg
	Using estat nproc

	Stored results
	Methods and formulas
	Parametric model: Summary parameter definition
	Maximum likelihood estimation
	Estimating equations estimation

	References
	Also see

	rocregplot
	Description
	Quick start
	Menu
	Syntax
	probit_options
	common_options
	boot_options
	Remarks and examples
	Plotting covariate-specific ROC curves
	Plotting marginal ROC curves

	Methods and formulas
	Parametric model: Summary parameter definition
	Maximum likelihood estimation
	Estimating equations estimation

	References
	Also see

	roctab
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Nonparametric ROC curves
	Lorenz-like curves

	Stored results
	Methods and formulas
	References
	Also see

	rreg
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	Acknowledgment
	References
	Also see

	rreg postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Also see

	runtest
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	Acknowledgment
	References


	S
	scobit
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Skewed logistic model
	Robust standard errors

	Stored results
	Methods and formulas
	References
	Also see

	scobit postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Also see

	sdtest
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Basic form
	Immediate form
	Robust test

	Stored results
	Methods and formulas
	References
	Also see

	search
	Description
	Quick start
	Menu
	Syntax
	Options for search
	Option for set searchdefault
	Remarks and examples
	Introduction
	Internet searches
	Author searches
	Entry ID searches
	Return codes

	Acknowledgment
	Also see

	serrbar
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Acknowledgment
	Also see

	set
	Description
	Syntax
	Remarks and examples
	Also see

	set cformat
	Description
	Syntax
	Option
	Remarks and examples
	Also see

	set_defaults
	Description
	Syntax
	Option
	Remarks and examples
	Also see

	set emptycells
	Description
	Syntax
	Option
	Remarks and examples
	Also see

	set iter
	Description
	Syntax
	Option
	Remarks and examples
	Also see

	set rng
	Description
	Syntax
	Remarks and examples
	Introduction
	Random-number generators in Stata

	Reference
	Also see

	set rngstream
	Description
	Syntax
	Remarks and examples
	References
	Also see

	set seed
	Description
	Syntax
	Remarks and examples
	Examples
	Setting the seed
	How to choose a seed
	Do not set the seed too often
	Preserving and restoring the random-number generator state

	Reference
	Also see

	set showbaselevels
	Description
	Syntax
	Option
	Remarks and examples
	Also see

	signrank
	Description
	Quick start
	Menu
	Syntax
	Option for signrank
	Remarks and examples
	Stored results
	Methods and formulas
	signrank
	signtest

	References
	Also see

	simulate
	Description
	Quick start
	Syntax
	Options
	Remarks and examples
	References
	Also see

	sj
	Description
	Remarks and examples
	Installing the Stata Journal software
	Installing the STB software

	Also see

	sktest
	Description
	Quick start
	Menu
	Syntax
	Option
	Remarks and examples
	Stored results
	Methods and formulas
	Acknowledgments
	References
	Also see

	slogit
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	One-dimensional model
	Higher-dimension models

	Stored results
	Methods and formulas
	References
	Also see

	slogit postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Methods and formulas
	Also see

	smooth
	Description
	Quick start
	Menu
	Syntax
	Option
	Remarks and examples
	Methods and formulas
	Running median smoothers of odd span
	Running median smoothers of even span
	Repeat operator
	Endpoint rule
	Splitting operator
	Hanning smoother
	Twicing

	Acknowledgments
	References
	Also see

	spearman
	Description
	Quick start
	Menu
	Syntax
	Options for spearman
	Options for ktau
	Remarks and examples
	Stored results
	Methods and formulas
	Acknowledgment
	References
	Also see

	spikeplot
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Acknowledgments
	References
	Also see

	ssc
	Description
	Command overview

	Quick start
	Syntax
	Options
	Options for use with ssc new
	Options for use with ssc hot
	Option for use with ssc describe
	Options for use with ssc install
	Option for use with ssc type
	Options for use with ssc copy

	Remarks and examples
	Acknowledgments
	References
	Also see

	stem
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	References
	Also see

	stepwise
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Search logic for a step
	Full search logic
	Examples
	Estimation sample considerations
	Messages
	Programming for stepwise

	Stored results
	Methods and formulas
	References
	Also see

	Stored results
	Description
	Syntax
	Option
	Remarks and examples
	References
	Also see

	suest
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Using suest
	Remarks on regress
	Testing the assumption of the independence of irrelevant alternatives
	Testing proportionality
	Testing cross-model hypotheses

	Stored results
	Methods and formulas
	Acknowledgment
	References
	Also see

	summarize
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Video example

	Stored results
	Methods and formulas
	References
	Also see

	sunflower
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Acknowledgments
	References

	sureg
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	sureg postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Also see

	swilk
	Description
	Quick start
	Menu
	Syntax
	Options for swilk
	Options for sfrancia
	Remarks and examples
	Stored results
	Methods and formulas
	Acknowledgment
	References
	Also see

	symmetry
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	Asymptotic tests
	Exact symmetry test

	References
	Also see


	T
	table intro
	Description
	Remarks and examples
	Overview
	Tabulations
	Tables of summary statistics
	Tables of results from other commands
	Flexible tables combining results
	Formatting, customizing, and exporting tables

	Reference
	Also see

	table oneway
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Tabulation of one variable
	Tabulation, including percentages
	Customizing results
	Advanced customization

	Stored results
	References
	Also see

	table twoway
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Tabulation of two variables
	Tabulation, including percentages
	Customizing results

	Stored results
	References
	Also see

	table multiway
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Tables with columns defined by multiple variables
	Appending tables
	Multiple tables with specified totals

	Stored results
	Reference
	Also see

	table summary
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Basic summary statistic tables
	Classic Table 1

	Stored results
	References
	Also see

	table hypothesis tests
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Creating tables from scalars
	Creating tables from matrices

	Stored results
	Reference
	Also see

	table regression
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Tables with results from a single command
	Tables with results from multiple estimation commands
	Regression results with factor variables

	Stored results
	References
	Also see

	table
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Specifying the table layout
	Advanced table customization

	Stored results
	Methods and formulas
	Also see

	tabstat
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Video example

	Acknowledgments
	Reference
	Also see

	tabulate oneway
	Description
	Quick start
	Menu
	Syntax
	Options
	Limits

	Remarks and examples
	tabulate
	tab1
	Video example

	Stored results
	References
	Also see

	tabulate twoway
	Description
	Quick start
	Menu
	Syntax
	Options
	Limits

	Remarks and examples
	tabulate
	Measures of association
	N-way tables
	Weighted data
	Tables with immediate data
	tab2
	Video examples

	Stored results
	Methods and formulas
	References
	Also see

	tabulate, summarize()
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	One-way tables
	Two-way tables

	Also see

	test
	Description
	Quick start
	Menu
	Syntax
	Options for testparm
	Options for test
	Remarks and examples
	Introductory examples
	Special syntaxes after multiple-equation estimation
	Constrained coefficients
	Multiple testing

	Stored results
	Methods and formulas
	Acknowledgment
	References
	Also see

	testnl
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Using testnl to perform linear tests
	Specifying constraints
	Dropped constraints
	Multiple constraints
	Manipulability

	Stored results
	Methods and formulas
	References
	Also see

	tetrachoric
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Association in 2-by-2 tables
	Factor analysis of dichotomous variables
	Tetrachoric correlations with simulated data

	Stored results
	Methods and formulas
	References
	Also see

	tnbreg
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	Mean-dispersion model
	Constant-dispersion model

	Acknowledgment
	References
	Also see

	tnbreg postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Methods and formulas
	Mean-dispersion model
	Constant-dispersion model

	Also see

	tobit
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	tobit postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Reference
	Also see

	total
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	The total estimator
	Survey data
	The survey total estimator
	The poststratified total estimator
	Subpopulation estimation

	References
	Also see

	total postestimation
	Postestimation commands
	Remarks and examples
	Also see

	tpoisson
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	Acknowledgment
	References
	Also see

	tpoisson postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Methods and formulas
	Also see

	translate
	Description
	Quick start
	Syntax
	Options for print
	Options for translate
	Remarks and examples
	Overview
	Printing files
	Printing files, Mac and Windows
	Printing files, Unix
	Translating files from one format to another

	Stored results
	Also see

	truncreg
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	truncreg postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Also see

	ttest
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	One-sample t test
	Two-sample t test
	Paired t test
	Two-sample t test compared with one-way ANOVA
	Immediate form
	Video examples

	Stored results
	Methods and formulas
	References
	Also see


	U
	update
	Description
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Also see


	V
	vce_option
	Description
	Syntax
	Options
	Remarks and examples
	Prefix commands
	Passing options in vce()

	Methods and formulas
	Also see

	view
	Description
	Menu
	Syntax
	Options
	Remarks and examples
	Also see

	vwls
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	vwls postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Also see


	W
	which
	Description
	Syntax
	Option
	Remarks and examples
	Also see


	X
	xi
	Description
	Menu
	Syntax
	Options
	Remarks and examples
	Background
	Indicator variables for simple effects
	Controlling the omitted dummy
	Categorical variable interactions
	Interactions with continuous variables
	Using xi: Interpreting output
	How xi names variables
	xi as a command rather than a command prefix
	Warnings

	Stored results
	Also see


	Z
	zinb
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	zinb postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Methods and formulas
	References
	Also see

	ziologit
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	ziologit postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Methods and formulas
	Reference
	Also see

	zioprobit
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	zioprobit postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Methods and formulas
	Also see

	zip
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	zip postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Methods and formulas
	References
	Also see

	ztest
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	One-sample z test
	Two-sample z test
	Paired z test
	Adjust for clustering
	Immediate form

	Stored results
	Methods and formulas
	One-sample z test
	Two-sample unpaired z test
	Paired z test

	References
	Also see



	[RPT] Reporting
	Contents
	Intro
	Description
	Remarks and examples
	Introduction
	Exporting to a Word (.docx) file
	Exporting to a PDF file
	Exporting to an Excel file
	Creating dynamic documents
	Converting file types


	docx2pdf
	Description
	Quick start
	Syntax
	Options
	Remarks and examples
	Also see

	Dynamic documents intro
	Description
	Remarks and examples
	Also see

	Dynamic tags
	Description
	Remarks
	Descriptions of dynamic tags
	Version control
	Execute and include output from a block of Stata code
	Include strings and values of scalar expressions in text
	Include values of scalar expressions and formatted text in a .docx file
	Export and include a Stata graph
	Include a text file
	Disable dynamic text processing
	Process contents based on condition
	Skip contents based on condition
	Remove contents

	Also see

	dyndoc
	Description
	Quick start
	Syntax
	Options
	Remarks and examples
	References
	Also see

	dyntext
	Description
	Quick start
	Syntax
	Options
	Remarks and examples
	References
	Also see

	html2docx
	Description
	Quick start
	Syntax
	Options
	Remarks and examples
	Also see

	markdown
	Description
	Quick start
	Syntax
	Options
	Remarks and examples
	References
	Also see

	putdocx intro
	Description
	Remarks and examples
	Introduction
	A first example
	Create a document
	Add a paragraph with text
	Add an image to a paragraph
	Add a table of estimation results

	Automating a report
	Workflow options for report building
	Create a complete document in Stata
	Create a document from Stata and Word
	Append files in Stata
	Append files in Word


	References
	Also see

	putdocx begin
	Description
	Quick start
	Syntax
	Options
	Options for putdocx begin
	Options for putdocx save
	Options for putdocx append

	Remarks and examples
	Creating and formatting a .docx file
	Including headers and footers
	Describing the document
	Saving or clearing the .docx file
	Appending .docx files

	Also see

	putdocx collect
	Description
	Quick start
	Syntax
	Options
	Remarks and examples
	Introduction
	Export a collection
	Specify the style for a collection

	Stored results
	References
	Also see

	putdocx pagebreak
	Description
	Quick start
	Syntax
	Options
	Remarks and examples
	Also see

	putdocx paragraph
	Description
	Quick start
	Syntax
	Options
	Options for putdocx paragraph
	Options for putdocx text
	Options for putdocx textblock begin
	Options for putdocx textblock append
	Options for putdocx pagenumber
	Options for putdocx textfile
	Options for putdocx image

	Remarks and examples
	Adding a paragraph
	Formatting text
	Working with blocks of text
	Adding an image to the document
	Inserting text files in the document

	Also see

	putdocx table
	Description
	Quick start
	Syntax
	Output types for tables

	Options
	table_options
	cell_options
	row_col_options
	cell_fmt_options
	exp_options
	image_options

	Remarks and examples
	Introduction
	Creating basic tables
	Exporting summary statistics
	Exporting estimation results

	Creating advanced tables
	Customizing headers and footers with tables

	Stored results
	Reference
	Also see

	Appendix for putdocx
	Description
	Border patterns
	Chapter styles
	Colors
	Page number formats
	Paragraph styles
	Shading patterns
	Underline patterns
	Unsupported estimation commands

	Also see

	putexcel
	Description
	Quick start
	Menu
	Syntax
	Output types

	Options
	Remarks and examples
	Introduction
	Writing expressions and formatting cells
	Exporting summary statistics to Excel
	Export estimation results
	Export a table from a collection
	Export graphs and other images

	Appendix
	Codes for numeric formats
	Colors
	Border styles
	Background patterns

	Stored results
	References
	Also see

	putexcel advanced
	Description
	Quick start
	Menu
	Syntax
	Output types

	Options
	Remarks and examples
	Writing expressions and formatting cells
	Using formulas
	Exporting estimation results

	References
	Also see

	putpdf intro
	Description
	Remarks and examples
	Introduction
	Create a PDF file
	Add a paragraph with text
	Add an image to a paragraph
	Add table of estimation results


	Also see

	putpdf begin
	Description
	Quick start
	Syntax
	Options
	Options for putpdf begin
	Options for putpdf save

	Remarks and examples
	Creating and formatting a PDF file
	Describing the document
	Saving or clearing the PDF file

	References
	Also see

	putpdf collect
	Description
	Quick start
	Syntax
	Options
	Remarks and examples
	Introduction
	Export a table with items from a collection

	Stored results
	References
	Also see

	putpdf pagebreak
	Description
	Quick start
	Syntax
	Options
	Remarks and examples
	Also see

	putpdf paragraph
	Description
	Quick start
	Syntax
	Options
	Options for putpdf paragraph
	Options for putpdf text
	Options for putpdf image

	Remarks and examples
	Adding a paragraph
	Adding an image to the document

	Also see

	putpdf table
	Description
	Quick start
	Syntax
	Output types for tables

	Options
	table_options
	cell_options
	row_col_options
	cell_fmt_options

	Remarks and examples
	Creating basic tables
	Exporting summary statistics
	Exporting estimation results

	Creating advanced tables

	Stored results
	Reference
	Also see

	Appendix for putpdf
	Description
	Colors
	Unsupported estimation commands

	Also see

	set docx
	Description
	Syntax
	Remarks and examples
	Reference
	Also see

	Glossary

	[SEM] Structural Equation Modeling
	Contents
	Acknowledgments
	Reference
	Also see

	Intro 1
	Description
	Remarks and examples
	Also see

	Intro 2
	Description
	Remarks and examples
	Using path diagrams to specify standard linear SEMs
	Specifying correlation
	Using the command language to specify standard linear SEMs
	Specifying generalized SEMs: Family and link
	Specifying generalized SEMs: Family and link, multinomial logistic regression
	Specifying generalized SEMs: Family and link, paths from response variables
	Specifying generalized SEMs: Multilevel mixed effects (2 levels)
	Specifying generalized SEMs: Multilevel mixed effects (3 levels)
	Specifying generalized SEMs: Multilevel mixed effects (4+ levels)
	Specifying generalized SEMs: Multilevel mixed effects with random intercepts
	Specifying generalized SEMs: Multilevel mixed effects with random slopes
	Specifying generalized SEMs: Latent class analysis (LCA)
	Specifying generalized SEMs: Latent class analysis, class predictors
	Specifying generalized SEMs: Latent class analysis, two latent variables

	Reference
	Also see

	Intro 3
	Description
	Remarks and examples
	Specifying indicator variables
	Specifying interactions with indicator variables
	Specifying categorical variables
	Specifying interactions with categorical variables
	Specifying endogenous variables

	Also see

	Intro 4
	Description
	Remarks and examples
	Differences in assumptions between sem and gsem
	sem: Choice of estimation method
	gsem: Choice of estimation method

	Treatment of missing values
	Variable types: Observed, latent, endogenous, exogenous, and error
	Constraining parameters
	Constraining path coefficients to specific values
	Constraining intercepts to specific values (suppressing the intercept)
	Constraining path coefficients or intercepts to be equal
	Constraining covariances to be equal (or to specific values)
	Constraining variances to specific values (or to be equal)

	Identification 1: Substantive issues
	Not all models are identified
	How to count parameters
	What happens when models are unidentified
	How to diagnose and fix the problem

	Identification 2: Normalization constraints (anchoring)
	Why the problem arises
	How the problem would manifest itself
	How sem (gsem) solves the problem for you
	Overriding sem's (gsem's) solution


	References
	Also see

	Intro 5
	Description
	Remarks and examples
	Single-factor measurement models
	Item response theory (IRT) models
	Multiple-factor measurement models
	Confirmatory factor analysis (CFA) models
	Structural models 1: Linear regression
	Structural models 2: Gamma regression
	Structural models 3: Binary-outcome models
	Structural models 4: Count models
	Structural models 5: Ordinal models
	Structural models 6: Multinomial logistic regression
	Structural models 7: Survival models
	Structural models 8: Dependencies between response variables
	Structural models 9: Unobserved inputs, outputs, or both
	Structural models 10: MIMIC models
	Structural models 11: Seemingly unrelated regression (SUR)
	Structural models 12: Multivariate regression
	Structural models 13: Mediation models
	Correlations
	Higher-order CFA models
	Correlated uniqueness model
	Latent growth models
	Models with reliability
	Multilevel mixed-effects models
	Latent class models
	Finite mixture models

	References
	Also see

	Intro 6
	Description
	Remarks and examples
	Comparing groups with sem
	The generic SEM model
	sem: Fitting the model for different groups of the data
	sem: Which parameters vary by default, and which do not
	sem: Specifying which parameters are allowed to vary in broad, sweeping terms
	sem: Adding constraints for path coefficients across groups
	sem: Adding constraints for means, variances, or covariances across groups
	sem: Adding constraints for some groups but not others
	sem: Adding paths for some groups but not others
	sem: Relaxing constraints

	Comparing groups with gsem
	gsem: Fitting the model for different groups of the data
	gsem: Which parameters vary by default, and which do not
	gsem: Specifying which parameters are allowed to vary in broad, sweeping terms
	gsem: Adding constraints for path coefficients across groups
	gsem: Adding constraints for means, variances, or covariances across groups
	gsem: Adding constraints for some groups but not others
	gsem: Adding paths for some groups but not others
	gsem: Relaxing constraints


	Reference
	Also see

	Intro 7
	Description
	Remarks and examples
	Replaying the model (sem and gsem)
	Displaying odds ratios, incidence-rate ratios, etc. (gsem only)
	Obtaining goodness-of-fit statistics (sem and gsem)
	Performing tests for including omitted paths and relaxing constraints (sem only)
	Performing tests of model simplification (sem and gsem)
	Displaying other results, statistics, and tests (sem and gsem)
	Obtaining predicted values (sem)
	Obtaining predicted values (gsem)
	Using contrast, pwcompare, and margins (sem and gsem)
	Accessing stored results

	Reference
	Also see

	Intro 8
	Description
	Options
	Remarks and examples
	Also see

	Intro 9
	Description
	Options
	Remarks and examples
	Reference
	Also see

	Intro 10
	Description
	Remarks and examples
	Also see

	Intro 11
	Description
	Remarks and examples
	Background
	How to use sem with SSD
	What you cannot do with SSD
	Entering SSD
	Entering SSD for multiple groups
	What happens when you do not set all the summary statistics
	Labeling SSD
	Making summary statistics from data for use by others

	Reference
	Also see

	Intro 12
	Description
	Remarks and examples
	Is your model identified?
	Convergence solutions generically described
	Temporarily eliminate option reliability()
	Use default normalization constraints
	Temporarily eliminate feedback loops
	Temporarily simplify the model
	Try other numerical integration methods (gsem only)
	Get better starting values (sem and gsem)
	Get better starting values (gsem)

	Also see

	Builder
	Description
	Remarks and examples
	Video example

	Reference

	Builder, generalized
	Description
	Remarks and examples
	Video example

	Reference

	estat eform
	Description
	Menu
	Syntax
	Options
	Remarks and examples
	Also see

	estat eqgof
	Description
	Menu
	Syntax
	Option
	Remarks and examples
	Stored results
	Reference
	Also see

	estat eqtest
	Description
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Also see

	estat framework
	Description
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Reference
	Also see

	estat ggof
	Description
	Menu
	Syntax
	Option
	Remarks and examples
	Stored results
	Also see

	estat ginvariant
	Description
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	References
	Also see

	estat gof
	Description
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	References
	Also see

	estat lcgof
	Description
	Menu
	Syntax
	Option
	Remarks and examples
	Stored results
	References
	Also see

	estat lcmean
	Description
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Also see

	estat lcprob
	Description
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Also see

	estat mindices
	Description
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	References
	Also see

	estat residuals
	Description
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	References
	Also see

	estat scoretests
	Description
	Menu
	Syntax
	Option
	Remarks and examples
	Stored results
	References
	Also see

	estat sd
	Description
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Also see

	estat stable
	Description
	Menu
	Syntax
	Option
	Remarks and examples
	Stored results
	Reference
	Also see

	estat stdize
	Description
	Menu
	Syntax
	Remarks and examples
	Stored results
	Also see

	estat summarize
	Description
	Menu
	Syntax
	Options
	Stored results
	Also see

	estat teffects
	Description
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	References
	Also see

	Example 1
	Description
	Remarks and examples
	Single-factor measurement model
	Satorra--Bentler scaled chi-squared test
	Fitting the same model with gsem
	Fitting the same model with the Builder
	The measurement-error model interpretation

	References
	Also see

	Example 2
	Description
	Remarks and examples
	Background
	Creating the SSD
	At this point, we could save the dataset and stop
	Labeling the SSD
	Listing the SSD

	Reference
	Also see

	Example 3
	Description
	Remarks and examples
	Fitting multiple-factor measurement models
	Displaying standardized results
	Fitting the model with the Builder
	Obtaining equation-level goodness of fit by using estat eqgof

	References
	Also see

	Example 4
	Description
	Remarks and examples
	Reference
	Also see

	Example 5
	Description
	Remarks and examples
	Reference
	Also see

	Example 6
	Description
	Remarks and examples
	Fitting linear regression models
	Displaying standardized results
	Fitting the model with the Builder

	Also see

	Example 7
	Description
	Remarks and examples
	Fitting the model
	Fitting the model with the Builder
	Checking stability with estat stable
	Reporting total, direct, and indirect effects with estat teffects

	References
	Also see

	Example 8
	Description
	Remarks and examples
	Using test to evaluate adding constraints
	Refitting the model with added constraints
	Using estat scoretests to test whether constraints can be relaxed

	Also see

	Example 9
	Description
	Remarks and examples
	Fitting the model
	Fitting the model with the Builder
	Evaluating omitted paths with estat mindices
	Refitting the model

	References
	Also see

	Example 10
	Description
	Remarks and examples
	Fitting the MIMIC model
	Fitting the MIMIC model with the Builder
	Evaluating the residuals with estat residuals
	Performing likelihood-ratio tests with lrtest

	Reference
	Also see

	Example 11
	Description
	Remarks and examples
	Also see

	Example 12
	Description
	Remarks and examples
	Fitting the seemingly unrelated regression model
	Fitting the model with the Builder

	Also see

	Example 13
	Description
	Remarks and examples
	Also see

	Example 14
	Description
	Remarks and examples
	Also see

	Example 15
	Description
	Remarks and examples
	Fitting the model
	Fitting the model with the Builder

	Reference
	Also see

	Example 16
	Description
	Remarks and examples
	Using sem to obtain correlation matrices
	Fitting the model with the Builder
	Testing correlations with estat stdize and test

	Also see

	Example 17
	Description
	Remarks and examples
	Fitting the model
	Fitting the model with the Builder

	Reference
	Also see

	Example 18
	Description
	Remarks and examples
	Fitting the model
	Fitting the model with the Builder

	Reference
	Also see

	Example 19
	Description
	Remarks and examples
	Reference
	Also see

	Example 20
	Description
	Remarks and examples
	Background
	Fitting the model with all the data
	Fitting the model with the group() option
	Fitting the model with the Builder

	Reference
	Also see

	Example 21
	Description
	Remarks and examples
	Also see

	Example 22
	Description
	Remarks and examples
	Also see

	Example 23
	Description
	Remarks and examples
	Background
	Fitting the constrained model

	Also see

	Example 24
	Description
	Remarks and examples
	Baseline model (reliability ignored)
	Model with reliability
	Model with two measurement variables and reliability

	Also see

	Example 25
	Description
	Remarks and examples
	Preparing data for conversion
	Converting to summary statistics form
	Publishing SSD
	Creating SSD with multiple groups

	Also see

	Example 26
	Description
	Remarks and examples
	Fitting the model with method(ml)
	Fitting the model with method(mlmv)
	Fitting the model with the Builder

	Also see

	Example 27g
	Description
	Remarks and examples
	Single-factor pass/fail measurement model
	Single-factor pass/fail + continuous measurement model
	Fitting the model with the Builder

	Also see

	Example 28g
	Description
	Remarks and examples
	1-PL IRT model with unconstrained variance
	1-PL IRT model with variance constrained to 1
	Obtaining item characteristic curves
	Fitting the model with the Builder

	References
	Also see

	Example 29g
	Description
	Remarks and examples
	Fitting the 2-PL IRT model
	Obtaining predicted difficulty and discrimination
	Using coeflegend to obtain the symbolic names of the parameters
	Graphing item characteristic curves
	Fitting the model with the Builder

	References
	Also see

	Example 30g
	Description
	Remarks and examples
	Fitting the two-level model
	Fitting the variance-components model
	Fitting the model with the Builder

	References
	Also see

	Example 31g
	Description
	Remarks and examples
	Fitting the two-factor model
	Fitting the model with the Builder

	Also see

	Example 32g
	Description
	Remarks and examples
	Structural model with measurement component
	Fitting the model with the Builder

	Also see

	Example 33g
	Description
	Remarks and examples
	Fitting the logit model
	Obtaining odds ratios
	Fitting the model with the Builder

	Reference
	Also see

	Example 34g
	Description
	Remarks and examples
	Fitting the combined model
	Obtaining odds ratios and incidence-rate ratios
	Fitting the model with the Builder

	Reference
	Also see

	Example 35g
	Description
	Remarks and examples
	Ordered probit
	Ordered logit
	Fitting the model with the Builder

	Reference
	Also see

	Example 36g
	Description
	Remarks and examples
	Fitting the MIMIC model
	Fitting the model with the Builder

	Reference
	Also see

	Example 37g
	Description
	Remarks and examples
	Simple multinomial logistic regression model
	Multinomial logistic regression model with constraints
	Fitting the simple multinomial logistic model with the Builder
	Fitting the multinomial logistic model with constraints with the Builder

	Reference
	Also see

	Example 38g
	Description
	Remarks and examples
	Random-intercept model, single-equation formulation
	Random-intercept model, within-and-between formulation
	Random-slope model, single-equation formulation
	Random-slope model, within-and-between formulation
	Fitting the random-intercept model with the Builder
	Fitting the random-slope model with the Builder

	Reference
	Also see

	Example 39g
	Description
	Remarks and examples
	Three-level negative binomial model
	Three-level Poisson model
	Testing for overdispersion
	Fitting the models with the Builder

	References
	Also see

	Example 40g
	Description
	Remarks and examples
	The crossed model
	Fitting the model with the Builder

	Reference
	Also see

	Example 41g
	Description
	Remarks and examples
	Two-level multinomial logistic model with shared random effects
	Two-level multinomial logistic model with separate but correlated random effects
	Fitting the model with the Builder

	References
	Also see

	Example 42g
	Description
	Remarks and examples
	One-level model with sem
	One-level model with gsem
	Two-level model with gsem
	Fitting the models with the Builder

	References
	Also see

	Example 43g
	Description
	Remarks and examples
	Fitting tobit regression models
	Fitting the model with the Builder

	Also see

	Example 44g
	Description
	Remarks and examples
	Fitting interval regression models
	Fitting the model with the Builder

	Also see

	Example 45g
	Description
	Remarks and examples
	The Heckman selection model as an SEM
	Fitting the Heckman selection model as an SEM
	Transforming results and obtaining rho
	Fitting the model with the Builder

	References
	Also see

	Example 46g
	Description
	Remarks and examples
	Fitting the treatment-effects model
	Fitting the model with the Builder

	References
	Also see

	Example 47g
	Description
	Remarks and examples
	Fitting the exponential model
	Obtaining hazard ratios
	Fitting the model with the Builder

	Also see

	Example 48g
	Description
	Remarks and examples
	Censoring and truncation
	Using stset to declare survival characteristics
	Fitting the loglogistic model
	Fitting the model with the Builder

	Reference
	Also see

	Example 49g
	Description
	Remarks and examples
	Fitting the multiple-group model
	Fitting the model with the Builder

	Also see

	Example 50g
	Description
	Remarks and examples
	References
	Also see

	Example 51g
	Description
	Remarks and examples
	Likelihood-ratio test
	Comparing models

	Reference
	Also see

	Example 52g
	Description
	Remarks and examples
	Fitting the two-class model
	Comparing models
	Fitting the three-class model with covariances

	References
	Also see

	Example 53g
	Description
	Remarks and examples
	References
	Also see

	Example 54g
	Description
	Remarks and examples
	References
	Also see

	gsem
	Description
	Menu
	Syntax
	Options
	Remarks and examples
	Default normalization constraints
	Default covariance assumptions
	How to solve convergence problems

	Stored results
	References
	Also see

	gsem estimation options
	Description
	Syntax
	Options
	Remarks and examples
	Also see

	gsem family-and-link options
	Description
	Syntax
	Options
	Remarks and examples
	Also see

	gsem group options
	Description
	Syntax
	Options
	Remarks and examples
	Also see

	gsem lclass options
	Description
	Syntax
	Options
	Remarks and examples
	Also see

	gsem model description options
	Description
	Syntax
	Options
	Remarks and examples
	Also see

	gsem path notation extensions
	Description
	Syntax
	Options
	Remarks and examples
	Specifying family and link
	Specifying multilevel nested latent variables
	Specifying multilevel crossed latent variables
	Specifying paths for a specific group
	Specifying paths for a specific latent class
	Specifying paths for a specific group and latent class

	Also see

	gsem postestimation
	Postestimation commands
	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Also see

	gsem reporting options
	Description
	Syntax
	Options
	Remarks and examples
	Also see

	lincom
	Description
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Also see

	lrtest
	Description
	Menu
	Syntax
	Remarks and examples
	Stored results
	Also see

	Methods and formulas for gsem
	Description
	Remarks and examples
	Introduction
	Families of distributions
	The Bernoulli family
	The beta family
	The binomial family
	The ordinal family
	The multinomial family
	The Poisson family
	The negative binomial family
	The Gaussian family
	Reliability
	Point mass

	Link functions
	The logit link
	The probit link
	The complementary log--log link
	The log link
	The identity link

	Survival distributions
	The exponential distribution
	The Weibull distribution
	The gamma distribution
	The loglogistic distribution
	The lognormal distribution

	Models with continuous latent variables
	Continuous latent variables likelihood
	Gauss--Hermite quadrature
	Adaptive quadrature
	Laplacian approximation
	Continuous latent variables survey data
	Continuous latent variables predictions

	Models with categorical latent variables
	Categorical latent variables likelihood
	The EM algorithm
	Categorical latent variables survey data
	Categorical latent variables predictions


	References
	Also see

	Methods and formulas for sem
	Description
	Remarks and examples
	Variable notation
	Model and parameterization
	Summary data
	Maximum likelihood
	Weighted least squares
	Groups
	Fitted parameters
	Satorra{--}Bentler variance estimation
	Standardized parameters
	Reliability
	Postestimation

	References
	Also see

	nlcom
	Description
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Also see

	predict after gsem
	Description
	Menu
	Syntax
	Options
	Remarks and examples
	Reference
	Also see

	predict after sem
	Description
	Menu
	Syntax
	Options
	Remarks and examples
	Reference
	Also see

	sem
	Description
	Menu
	Syntax
	Options
	Remarks and examples
	Default normalization constraints
	Default covariance assumptions
	How to solve convergence problems

	Stored results
	References
	Also see

	sem and gsem option constraints()
	Description
	Syntax
	Remarks and examples
	Use with sem
	Use with gsem

	Also see

	sem and gsem option covstructure()
	Description
	Syntax
	Option
	Remarks and examples
	Also see

	sem and gsem option from()
	Description
	Syntax
	Option
	Remarks and examples
	Syntax 1, especially useful when dealing with convergence problems
	Syntax 2, seldom used

	Also see

	sem and gsem option reliability()
	Description
	Syntax
	Option
	Remarks and examples
	Background
	Dealing with measurement error of exogenous variables
	Dealing with measurement error of endogenous variables
	What can go wrong

	Also see

	sem and gsem path notation
	Description
	Syntax
	Options
	Remarks and examples
	Also see

	sem and gsem syntax options
	Description
	Syntax
	Options
	Remarks and examples
	Also see

	sem estimation options
	Description
	Syntax
	Options
	Remarks and examples
	Also see

	sem group options
	Description
	Syntax
	Options
	Remarks and examples
	Also see

	sem model description options
	Description
	Syntax
	Options
	Remarks and examples
	Also see

	sem option method()
	Description
	Syntax
	Options
	Remarks and examples
	Also see

	sem option noxconditional
	Description
	Syntax
	Option
	Remarks and examples
	What is x conditional?
	When to specify noxconditional
	Option forcexconditional (a technical note)

	Also see

	sem option select()
	Description
	Syntax
	Option
	Remarks and examples
	Also see

	sem path notation extensions
	Description
	Syntax
	Options
	Remarks and examples
	Also see

	sem postestimation
	Postestimation commands
	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Reference
	Also see

	sem reporting options
	Description
	Syntax
	Options
	Remarks and examples
	Reference
	Also see

	sem ssd options
	Description
	Syntax
	Options
	Remarks and examples
	Also see

	ssd
	Description
	Syntax
	Options
	Remarks and examples
	Stored results
	Also see

	test
	Description
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Also see

	testnl
	Description
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Also see

	Glossary
	Reference


	[SP] Spatial Autoregressive Models
	Contents
	Intro
	Description
	Remarks and examples
	References for learning SAR models
	Technical references on the development and fitting of SAR models

	Acknowledgments
	References

	Intro 1
	Description
	Remarks and examples
	Also see

	Intro 2
	Description
	Remarks and examples
	Understanding the W matrix
	Missing values, dropped observations, and the W matrix

	Reference
	Also see

	Intro 3
	Description
	Remarks and examples
	Three types of Sp data
	Type 1: Data with shapefiles
	Type 2: Data without shapefiles but including location information
	Type 3: Data without shapefiles or location information

	Sp can be used with cross-sectional data or panel data
	ID variables for cross-sectional data
	ID variables for panel data

	Also see

	Intro 4
	Description
	Remarks and examples
	Overview
	How to find and download shapefiles on the web
	Standard-format shapefiles
	Stata-format shapefiles
	Creating Stata-format shapefiles
	Step 1: Find and download a shapefile
	Step 2: Translate the shapefile to Stata format
	Step 3: Look at the translated data
	Step 4: Create a common ID variable for use with other data
	Step 5: Optionally, tell Sp to use the common ID variable
	Step 6: Set the units of the coordinates, if necessary

	Preparing your data
	Step 7a: Merge your cross-sectional data with the Stata-format shapefiles
	Step 7b: Merge your panel data with the Stata-format shapefiles

	Rules for working with Sp data, whether cross-sectional or panel

	Also see

	Intro 5
	Description
	Remarks and examples
	Preparation of cross-sectional data
	Preparation of panel data
	There are no rules as there are with shapefiles

	Also see

	Intro 6
	Description
	Remarks and examples
	Nongeographic spatial data
	Preparation of cross-sectional data
	Preparation of panel data
	There are no rules as there are with shapefiles

	Also see

	Intro 7
	Description
	Remarks and examples
	Research plan
	Finding and preparing data
	Finding a shapefile for Texas counties
	Creating the Stata-format shapefile
	Merging our data with the Stata-format shapefile

	Analyzing texas_ue.dta
	Testing whether ordinary regression is adequate
	spregress can reproduce regress results
	Fitting models with a spatial lag of the dependent variable
	Interpreting models with a spatial lag of the dependent variable
	Fitting models with a spatial lag of independent variables
	Interpreting models with a spatial lag of the independent variables
	Fitting models with spatially autoregressive errors
	Models can have all three kinds of spatial lag terms


	Also see

	Intro 8
	Description
	Remarks and examples
	spregress, gs2sls
	spregress, ml
	spivregress
	spxtregress
	spxtregress, re
	spxtregress, fe

	Reference
	Also see

	estat moran
	Description
	Quick start
	Menu for estat
	Syntax
	Option
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	grmap
	Description
	Quick start
	Menu
	Remarks and examples
	References
	Also see

	spbalance
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Balancing by dropping spatial units

	Stored results
	Also see

	spcompress
	Description
	Quick start
	Menu
	Syntax
	Option
	Remarks and examples
	Introduction
	Using the force option

	Stored results
	Also see

	spdistance
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Are coordinates really planar and not latitude and longitude?
	Reverse engineering planar distances
	More than you want to know about coordinates
	Planar coordinates
	Latitude and longitude coordinates


	Stored results
	Methods and formulas
	Reference
	Also see

	spgenerate
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Use with Sp data
	Use with other datasets

	Also see

	spivregress
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	spivregress postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins
	Remarks for margins

	estat impact
	Description for estat impact
	Syntax for estat impact
	Options for estat impact
	Remarks for estat impact
	Stored results for estat impact

	Methods and formulas
	Predictions
	Reduced-form mean
	Direct and indirect means
	Limited-information mean
	Full-information mean
	Naive-form predictor
	Linear predictor
	Residuals
	Uncorrelated residuals

	Impacts

	References
	Also see

	spmatrix
	Description
	Reference
	Also see

	spmatrix copy
	Description
	Quick start
	Menu
	Syntax
	Also see

	spmatrix create
	Description
	Quick start
	Menu
	Syntax
	Options for spmatrix create contiguity
	Option for spmatrix create idistance
	Options for both contiguity and idistance
	Remarks and examples
	Creating contiguity matrices
	Creating inverse-distance matrices
	Creating inverse-distance contiguity matrices
	The normalize() option
	Panel data

	Also see

	spmatrix drop
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	spmatrix dir
	Save and drop matrices you are not using

	Stored results
	Also see

	spmatrix export
	Description
	Quick start
	Menu
	Syntax
	Option
	Remarks and examples
	Using spmatrix export
	The spmatrix export text-file format

	Also see

	spmatrix fromdata
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Also see

	spmatrix import
	Description
	Quick start
	Menu
	Syntax
	Option
	Remarks and examples
	Also see

	spmatrix matafromsp
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Getting W and id
	Using W without involving the data in memory
	Using W involving the data in memory

	Also see

	spmatrix normalize
	Description
	Quick start
	Menu
	Syntax
	Option
	Remarks and examples
	Using spmatrix normalize after spmatrix import
	Using spmatrix normalize after other commands
	Using spmatrix normalize to change normalization

	Also see

	spmatrix note
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Also see

	spmatrix save
	Description
	Quick start
	Menu
	Syntax
	Option
	Remarks and examples
	Also see

	spmatrix spfrommata
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	W and v
	Simple use
	Advanced use

	References
	Also see

	spmatrix summarize
	Description
	Quick start
	Menu
	Syntax
	Option
	Remarks and examples
	Stored results
	Also see

	spmatrix use
	Description
	Quick start
	Menu
	Syntax
	Option
	Remarks and examples
	Also see

	spmatrix userdefined
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Overview
	Sfcnname() versus Afcnname()
	Programming style
	Advanced programs
	Mixed approaches

	Also see

	spregress
	Description
	Quick start
	Menu
	Syntax
	Options for spregress, gs2sls
	Options for spregress, ml
	Remarks and examples
	Introduction
	Choosing weighting matrices and their normalization
	Weighting matrices
	Normalization of weighting matrices
	Direct and indirect effects and normalization

	Examples

	Stored results
	Methods and formulas
	Model
	GS2SLS estimator
	2SLS estimator of delta
	GMM estimator of rho based on 2SLS residuals
	GS2SLS estimator of delta
	Efficient GMM estimator of rhon based on GS2SLS residuals

	ML estimator
	Log-likelihood function

	Pseudo-R-squared

	References
	Also see

	spregress postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins
	Remarks for margins

	estat impact
	Description for estat impact
	Syntax for estat impact
	Options for estat impact
	Remarks for estat impact
	Stored results for estat impact

	Methods and formulas
	Predictions
	Reduced-form mean
	Direct and indirect means
	Limited-information mean
	Full-information mean
	Naive-form predictor
	Linear predictor
	Residuals
	Uncorrelated residuals

	Impacts

	References
	Also see

	spset
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Determining whether and how data are spset
	Setting data for the first time
	Setting data with a standard-format shapefile
	Setting data with a Stata-format shapefile
	Setting data without a shapefile but with coordinates
	Setting data without a shapefile

	Modifying settings
	Modifying coordinates
	Modifying how coordinates are interpreted
	Modifying the ID variable
	Modifying whether the data are linked to a shapefile

	Converting cross-sectional data to panel data and vice versa

	Stored results
	Also see

	spshape2dta
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Also see

	spxtregress
	Description
	Quick start
	Menu
	Syntax
	Options for spxtregress, fe
	Options for spxtregress, re
	Remarks and examples
	Sp panel models
	The fixed-effects model
	The random-effects model
	The random-effects model with autoregressive panel effects
	Differences among models
	Examples

	Stored results
	Methods and formulas
	Fixed-effects estimators
	Random-effects estimators

	References
	Also see

	spxtregress postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins
	Remarks for margins

	estat impact
	Description for estat impact
	Syntax for estat impact
	Option for estat impact
	Remarks for estat impact
	Stored results for estat impact

	Methods and formulas
	Predictions
	Reduced-form mean
	Direct and indirect means
	Linear predictor

	Impacts in random-effects models
	Impacts in fixed-effects models

	Reference
	Also see

	Glossary

	[ST] Survival Analysis
	Contents
	Intro
	Description
	Also see

	Survival analysis
	Description
	Remarks and examples
	Introduction
	Declaring and converting count data
	Converting snapshot data
	Declaring and summarizing survival-time data
	Manipulating survival-time data
	Obtaining summary statistics, confidence intervals, tables, etc.
	Fitting regression models
	Sample size and power determination for survival analysis
	Converting survival-time data
	Programmer's utilities

	References
	Also see

	ct
	Description
	Also see

	ctset
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Examples
	Data errors flagged by ctset

	Also see

	cttost
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Also see

	Discrete
	Description
	Acknowledgment
	References
	Also see

	ltable
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Video example

	Methods and formulas
	Acknowledgments
	References
	Also see

	snapspan
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Snapshot and time-span datasets
	Specifying varlist

	Also see

	st
	Description
	Also see

	st_is
	Description
	Syntax
	Remarks and examples
	Definitions of characteristics and st variables
	Outline of an st command
	Using the st_ct utility
	Comparison of st_ct with sttoct
	Verifying data
	Converting data

	Also see

	stbase
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	stbase without the at() option
	stbase with the at() option
	Single-failure st data where all subjects enter at time 0
	Single-failure st data where some subjects enter after time 0
	Single-failure st data with gaps and perhaps delayed entry
	Multiple-failure st data

	Also see

	stci
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Single-failure data
	Multiple-failure data

	Stored results
	Methods and formulas
	References
	Also see

	stcox
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Cox regression with uncensored data
	Cox regression with censored data
	Treatment of tied failure times
	Cox regression with discrete time-varying covariates
	Cox regression with continuous time-varying covariates
	Robust estimate of variance
	Cox regression with multiple-failure data
	Stratified estimation
	Cox regression as Poisson regression
	Cox regression with shared frailty

	Stored results
	Methods and formulas
	Acknowledgment
	References
	Also see

	stcox PH-assumption tests
	Description
	Quick start
	Menu
	Syntax
	Options
	Options for stphplot
	Options for stcoxkm
	Options for estat phtest

	Remarks and examples
	Video example

	Stored results
	Methods and formulas
	Acknowledgment
	References
	Also see

	stcox postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	estat
	Description for estat
	Menu for estat
	Syntax for estat
	Options for estat

	Remarks and examples
	Baseline functions
	Making baseline reasonable
	Residuals and diagnostic measures
	Multiple records per subject
	Predictions after stcox with the tvc() option
	Predictions after stcox with the shared() option
	estat concordance

	Stored results
	Methods and formulas
	estat concordance

	References
	Also see

	stcrreg
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	The case for competing-risks regression
	Using stcrreg
	Multiple competing-event types
	stcrreg as an alternative to stcox
	Multiple records per subject
	Option tvc() and testing the proportional-subhazards assumption

	Stored results
	Methods and formulas
	Acknowledgment
	References
	Also see

	stcrreg postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Baseline functions
	Null models
	Measures of influence

	Methods and formulas
	References
	Also see

	stcurve
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	stcurve after stcox
	stcurve after streg
	stcurve after stcrreg
	stcurve after stintreg and stintcox
	Using at() with stcurve

	References
	Also see

	stdescribe
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Video example

	Stored results
	Reference
	Also see

	stfill
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Also see

	stgen
	Description
	Quick start
	Menu
	Syntax
	Functions
	Remarks and examples
	Also see

	stintcox
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Case II interval-censored data
	Standard-error estimation with interval-censored data
	Current status or case I interval-censored data

	Stored results
	Methods and formulas
	Data and model
	EM algorithm for computing parameter estimates
	Variance estimation using profile log-likelihood function
	Stratified estimation

	Acknowledgments
	References
	Also see

	stintcox PH-assumption plots
	Description
	Quick start
	Menu
	Syntax
	Options
	Options for stintphplot
	Options for stintcoxnp

	Remarks and examples
	Methods and formulas
	References
	Also see

	stintcox postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Baseline functions
	Residuals and diagnostic measures

	Methods and formulas
	Reference
	Also see

	stintreg
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Types of interval-censoring
	Case II interval-censored data
	Case I interval-censored data

	Parameterization of ancillary parameters
	Stratified estimation

	Stored results
	Methods and formulas
	Introduction
	Distributions and parameterizations
	Parameter estimation using interval-censored data

	References
	Also see

	stintreg postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	estat gofplot
	Description for estat gofplot
	Menu for estat
	Syntax for estat gofplot
	Options for estat gofplot

	Remarks and examples
	Predicted values
	Residuals and diagnostic measures

	Methods and formulas
	References
	Also see

	stir
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Video example

	Stored results
	Methods and formulas
	Reference
	Also see

	stptime
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Video example

	Stored results
	References
	Also see

	strate
	Description
	Quick start
	Menu
	Syntax
	Options for strate
	Options for stmh and stmc
	Remarks and examples
	Tabulation of rates by using strate
	Stratified rate ratios using stmh
	Log-linear trend test for metric explanatory variables using stmh
	Controlling for age with fine strata by using stmc

	Stored results
	Acknowledgments
	References
	Also see

	streg
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Distributions
	Examples
	Parameterization of ancillary parameters
	Stratified estimation
	(Unshared-) frailty models
	Shared-frailty models

	Stored results
	Methods and formulas
	Parameter estimation

	References
	Also see

	streg postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Methods and formulas
	References
	Also see

	sts
	Description
	Syntax
	Remarks and examples
	Listing, graphing, and generating variables
	Comparing survivor or cumulative hazard functions
	Testing equality of survivor functions
	Covariate-adjusted estimates
	Counting the number lost to censoring
	Video examples

	Stored results
	Methods and formulas
	References
	Also see

	sts generate
	Description
	Quick start
	Menu
	Syntax
	Functions
	Options
	Remarks and examples
	Methods and formulas
	References
	Also see

	sts graph
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Including the number lost on the graph
	Graphing the Nelson{--}Aalen cumulative hazard function
	Graphing the hazard function
	Adding an at-risk table
	On boundary bias for smoothed hazards
	Video example

	Methods and formulas
	Smoothed hazard estimate

	References
	Also see

	sts list
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Video example

	Methods and formulas
	References
	Also see

	sts test
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	The log-rank test
	The Wilcoxon (Breslow--Gehan) test
	The Tarone--Ware test
	The Peto--Peto--Prentice test
	The generalized Fleming--Harrington tests
	The ``Cox'' test
	The trend test
	Video example

	Stored results
	Methods and formulas
	References
	Also see

	stset
	Description
	Quick start
	Menu
	Syntax
	Options
	Options for use with stset and streset
	Options unique to streset
	Options for st

	Remarks and examples
	What are survival-time data?
	Key concepts
	Survival-time datasets
	Using stset
	Two concepts of time
	The substantive meaning of analysis time
	Setting the failure event
	Setting multiple failures
	First entry times
	Final exit times
	Intermediate exit and reentry times (gaps)
	if() versus if exp
	Past and future records
	Using streset
	Performance and multiple-record-per-subject datasets
	Sequencing of events within t
	Weights
	Data warnings and errors flagged by stset
	Using survival-time data in Stata
	Video example

	References
	Also see

	stsplit
	Description
	Quick start
	Menu
	Syntax
	Options for stsplit
	Option for stjoin
	Remarks and examples
	What stsplit does and why
	Using stsplit to split at designated times
	Time versus analysis time
	Splitting data on recorded ages
	Using stsplit to split at failure times

	Acknowledgments
	References
	Also see

	stsum
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Single-failure data
	Multiple-failure data
	Video example

	Stored results
	Methods and formulas
	Also see

	sttocc
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Acknowledgments
	References
	Also see

	sttoct
	Description
	Quick start
	Syntax
	Options
	Remarks and examples
	Case 1: entvar not specified
	Case 2: entvar specified

	Also see

	stvary
	Description
	Quick start
	Menu
	Syntax
	Option
	Remarks and examples
	Video example

	Stored results
	Reference
	Also see

	adjustfor_option
	Description
	Quick start
	Syntax
	Options
	Remarks and examples
	Using adjustfor() with sts, stphplot, and stintphplot
	Syntax of at()

	Also see

	Glossary

	[SVY] Survey Data
	Contents
	Intro
	Description
	Also see

	Survey
	Description
	Remarks and examples
	Introduction
	Survey design tools
	Survey data analysis tools
	Survey data concepts
	Tools for programmers of new survey commands
	Video examples

	Acknowledgments
	References
	Also see

	bootstrap_options
	Description
	Syntax
	Options
	Also see

	brr_options
	Description
	Syntax
	Options
	Also see

	Calibration
	Description
	Remarks and examples
	Methods and formulas
	References
	Also see

	Direct standardization
	Description
	Remarks and examples
	Methods and formulas
	References
	Also see

	estat
	Description
	Quick start
	Menu
	Syntax
	Options
	Options for estat effects
	Options for estat lceffects
	Options for estat size
	Options for estat sd
	Options for estat cv
	Options for estat gof
	Options for estat vce

	Remarks and examples
	Stored results
	Methods and formulas
	Design effects
	Linear combinations
	Misspecification effects
	Population and subpopulation standard deviations
	Coefficient of variation
	Goodness of fit for binary response models

	References
	Also see

	jackknife_options
	Description
	Syntax
	Options
	Also see

	ml for svy
	Remarks and examples
	Reference
	Also see

	Poststratification
	Description
	Remarks and examples
	Methods and formulas
	References
	Also see

	sdr_options
	Description
	Syntax
	Options
	Also see

	Subpopulation estimation
	Description
	Remarks and examples
	Methods and formulas
	Subpopulation totals
	Subpopulation estimates other than the total
	Subpopulation with replication methods

	References
	Also see

	svy
	Description
	Quick start
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	svy bootstrap
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	svy brr
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	svy estimation
	Description
	Menu
	Remarks and examples
	Overview of survey analysis in Stata
	Descriptive statistics
	Regression models
	Health surveys

	References
	Also see

	svy jackknife
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	svy postestimation
	Postestimation commands
	predict
	margins
	Remarks and examples
	References
	Also see

	svy sdr
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	Reference
	Also see

	svy: tabulate oneway
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	Reference
	Also see

	svy: tabulate twoway
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	The Rao and Scott correction
	Wald statistics
	Properties of the statistics

	Stored results
	Methods and formulas
	The table items
	Confidence intervals
	The test statistics

	References
	Also see

	svydescribe
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Methods and formulas
	References
	Also see

	svymarkout
	Description
	Syntax
	Remarks and examples
	Stored results
	Also see

	svyset
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction to survey design characteristics
	Finite population correction (FPC)
	Multiple-stage designs and with-replacement sampling
	Replication-weight variables
	Combining datasets from multiple surveys
	Video example

	Stored results
	References
	Also see

	Variance estimation
	Description
	Remarks and examples
	Variance of the total
	Variance for census data
	Certainty sampling units
	Strata with one sampling unit
	Ratios and other functions of survey data
	Linearized/robust variance estimation
	The bootstrap
	BRR
	The jackknife
	Successive difference replication
	Confidence intervals

	References
	Also see

	Glossary

	[TABLES] Customizable Tables
	Contents
	Intro
	Description
	Remarks and examples
	What is in this manual?
	What are collections?
	Do you need collections?
	The table command
	The etable command

	Acknowledgments

	Intro 1
	Description
	Remarks and examples
	Also see

	Intro 2
	Description
	Remarks and examples
	Tags, dimensions, and levels
	Introducing collect:
	Introducing collect layout
	Introducing collect recode

	Using collect layout
	Selecting specific levels of a dimension

	What is in my collection?
	Introducing collect levelsof
	Introducing collect label list
	Where do result labels come from?
	Introducing collect label levels
	Introducing collect label save
	Introducing collect label use

	Interactions in collect layout
	Introducing collect style cell
	Introducing collect preview
	Reordering columns
	More layout
	Introducing collect style autolevels

	What is in my collection, regression edition
	The result levels _r_b, _r_se, 
elax $mathsurround hbox {$Z$}@ mathinner {ldotp ldotp ldotp }mskip 	hinmuskip $
	The colname dimension
	Labels on levels of dimension colname
	collect layout with regression results
	Introducing collect style showbase
	Tables of model statistics

	What is in my collection, multiple-equation models (dimension coleq)
	What is in my collection, collecting results from multiple commands (dimension cmdset)
	Seeing what is my collection
	Introducing collect dims
	Factor variables in regressions and other commands

	Special dimensions created by table
	Dimension variables
	Variables from statistic() option---dimension var
	Dimension colname and matching to regressions
	Index of command() options---dimension command
	Index of command() and statistic() options---dimension statcmd
	Other dimensions

	Let's talk styles
	Overview
	Basic targeting
	Advanced targeting
	Saving and using

	Exporting
	Saving collections
	Managing collections

	Also see

	Intro 3
	Description
	Remarks and examples
	Outline of basic steps and key commands

	Reference
	Also see

	Intro 4
	Description
	Remarks and examples
	Introduction
	Prepare to collect results
	Collect results
	Combine collections
	Explore the collection
	Modify the collection
	Lay out rows and columns of the table
	Preview the table
	Modify labels in row and column headers
	Control display of zero coefficients in regression results
	Change styles{---}formats, bolding, colors, and more
	Query collection style properties
	Export the table
	Save styles and labels
	Save the collection
	Manage collections

	Also see

	Intro 5
	Description
	Remarks and examples
	Also see

	Tables Builder
	Description
	Menu
	Remarks and examples
	Overview
	Laying out a table
	Laying out a multiway table
	Modifying the layout
	Laying out stacked dimensions
	Placing multiple results in a cell
	Multiple tables
	Changing row and column headers
	Changing cell/results appearance
	Adding significance stars
	Adding a custom table title
	Changing table title appearance
	Adding table notes
	Changing table note appearance
	Exporting a table
	Advanced tools


	collect get
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Support for other prefix commands
	Fully supported
	Partially supported
	Not supported

	Collecting results from margins, contrast, and pwcompare
	Results not collected by default

	Also see

	collect addtags
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Reference
	Also see

	collect clear
	Description
	Syntax
	Remarks and examples
	Also see

	collect combine
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Also see

	collect composite
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Example 1: Table of means and standard deviations
	Example 2: Table of means, medians, standard deviations, and confidence intervals
	Example 3: Table of regression results

	Reference
	Also see

	collect copy
	Description
	Quick start
	Menu
	Syntax
	Option
	Remarks and examples
	Stored results
	Also see

	collect create
	Description
	Menu
	Syntax
	Option
	Remarks and examples
	Stored results
	Also see

	collect dims
	Description
	Syntax
	Option
	Remarks and examples
	Stored results
	Reference
	Also see

	collect dir
	Description
	Syntax
	Remarks and examples
	Also see

	collect drop
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Also see

	collect label
	Description
	Quick start
	Menu
	Syntax
	Options
	Options for collect label dim
	Options for collect label levels
	Options for collect label save
	Options for collect label use
	Option for collect label drop
	Options for collect label list

	Remarks and examples
	Stored results
	References
	Also see

	collect levelsof
	Description
	Quick start
	Syntax
	Option
	Remarks and examples
	Stored results
	Reference
	Also see

	collect notes
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Adding notes to a table
	Removing notes

	Stored results
	Reference
	Also see

	collect query
	Description
	Quick start
	Syntax
	Option
	Remarks and examples
	Stored results
	Also see

	collect recode
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	References
	Also see

	collect remap
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Reference
	Also see

	collect rename
	Description
	Quick start
	Menu
	Syntax
	Option
	Remarks and examples
	Stored results
	Also see

	collect save
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Also see

	collect set
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Also see

	collect stars
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Also see

	collect title
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Reference
	Also see

	collect use
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Reference
	Also see

	collect layout
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	References
	Also see

	collect preview
	Description
	Syntax
	Options
	Remarks and examples
	Stored results
	Also see

	collect export
	Description
	Quick start
	Menu
	Syntax
	Options
	export_options
	docx_options
	html_options
	pdf_options
	excel_options
	tex_options
	smcl_option
	txt_option
	md_option

	Remarks and examples
	Introduction
	Styles for different documents
	Creating more extensive documents

	Stored results
	Also see

	collect style autolevels
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Also see

	collect style cell
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	References
	Also see

	collect style clear
	Description
	Syntax
	Remarks and examples
	Stored results
	Also see

	collect style column
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Reference
	Also see

	collect style _cons
	Description
	Menu
	Syntax
	Option
	Remarks and examples
	Stored results
	Reference
	Also see

	collect style header
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Also see

	collect style html
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Also see

	collect style notes
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Reference
	Also see

	collect style putdocx
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Reference
	Also see

	collect style putpdf
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Reference
	Also see

	collect style row
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	References
	Also see

	collect style save
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Also see

	collect style showbase
	Description
	Menu
	Syntax
	Option
	Remarks and examples
	Stored results
	References
	Also see

	collect style showempty
	Description
	Menu
	Syntax
	Option
	Remarks and examples
	Stored results
	Reference
	Also see

	collect style showomit
	Description
	Menu
	Syntax
	Option
	Remarks and examples
	Stored results
	Also see

	collect style table
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Reference
	Also see

	collect style tex
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Also see

	collect style title
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Reference
	Also see

	collect style use
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Reference
	Also see

	Appendix
	Description
	Border patterns
	Diagonal border patterns
	Colors
	Shading patterns
	Underline patterns

	Also see

	Collection principles
	Description
	Remarks and examples
	Basic concepts
	Basics in practice
	How collect layout processes tag specifications
	The process in practice

	Also see

	Predefined styles
	Description
	Remarks and examples
	Creating a new style
	Styles provided by Stata
	default
	etable
	table
	coef-table
	coef-table_halign
	coef-table_headers
	default_borders
	default_cidelimiter
	default_halign
	default_headers
	default_margins
	default_nformats
	default_smcl
	default_tex
	etable_borders
	etable_etable
	etable_font
	etable_halign
	etable_headers
	etable_nformats
	etable_showitem
	etable_stars
	table-1
	table-reg1
	table-reg1-fv1
	table-reg2
	table-reg2-fv1
	table-reg3
	table-reg3-fv1
	table-right
	table-tab2
	table_cidelimiter
	table_headers
	table_nformats

	Modifying the default style

	Also see

	set collect_double
	Description
	Syntax
	Option
	Remarks and examples
	Also see

	set collect_label
	Description
	Syntax
	Option
	Remarks and examples
	Overview
	Labels for e-class results
	Labels for r-class results
	Labels for other results

	Also see

	set collect_style
	Description
	Syntax
	Option
	Remarks and examples
	Also see

	set collect_warn
	Description
	Syntax
	Option
	Remarks and examples

	set etable_style
	Description
	Syntax
	Option
	Remarks and examples
	Also see

	set table_style
	Description
	Syntax
	Option
	Remarks and examples
	Also see

	Example 1
	Description
	Remarks and examples
	Table of correlations
	Table of correlations, means, and standard deviations

	Reference
	Also see

	Example 2
	Description
	Remarks and examples
	Computing and collecting statistics
	Customizing the table

	Reference
	Also see

	Example 3
	Description
	Remarks and examples
	Computing statistics with the table command
	Customizing the table

	Reference
	Also see

	Example 4
	Description
	Remarks and examples
	Collecting statistics
	Customizing the table

	Reference
	Also see

	Example 5
	Description
	Remarks and examples
	Collecting regression results and creating a table
	Customizing the table

	Reference
	Also see

	Example 6
	Description
	Remarks and examples
	Collecting regression results and creating a table
	Customizing the table

	Reference
	Also see

	Example 7
	Description
	Remarks and examples
	Introduction
	Table of regression results with complex survey data

	Reference
	Also see

	Glossary

	[TE] Treatment Effects
	Contents
	Intro
	Description
	Reference
	Also see

	Treatment effects
	Description
	Also see

	DID intro
	Description
	Remarks and examples
	Introduction
	Intuition for estimating effects
	Standard error considerations
	Different types of data and specification
	Specifying groups and time as binary indicators
	Excluding group and time effects

	Conclusion

	References
	Also see

	didregress
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	DID estimation
	Graphical diagnostics and tests
	Specifying a 2-by-2 DID
	Standard-error considerations
	Default cluster{--}robust standard errors

	Stored results
	Methods and formulas
	DID with repeated cross-sectional data
	DDD model

	DID and DDD models with longitudinal data
	Aggregation estimators
	Wild bootstrap confidence intervals and p-values
	Bias-corrected clustered standard error

	Acknowledgment
	References
	Also see

	didregress postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	estat
	Description for estat
	Menu for estat
	Syntax for estat
	Options for estat trendplots
	Options for estat grangerplot
	Stored results for estat

	Methods and formulas
	Also see

	eteffects
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	Acknowledgment
	References
	Also see

	eteffects postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	estat
	Description for estat
	Menu for estat
	Syntax for estat

	Remarks and examples
	Also see

	etpoisson
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Overview
	Basic example
	Average treatment effect (ATE)
	Average treatment effect on the treated (ATET)

	Stored results
	Methods and formulas
	References
	Also see

	etpoisson postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Methods and formulas
	Also see

	etregress
	Description
	Quick start
	Menu
	Syntax
	Options for maximum likelihood estimates
	Options for two-step consistent estimates
	Options for control-function estimates
	Remarks and examples
	Overview
	Basic examples
	Average treatment effect (ATE)
	Average treatment effect on the treated (ATET)

	Stored results
	Methods and formulas
	Constrained model
	General potential-outcome model
	Average treatment effect
	Average treatment effect on the treated

	References
	Also see

	etregress postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Also see

	stteffects
	Description
	Syntax
	Also see

	stteffects intro
	Description
	Remarks and examples
	Introduction
	A quick tour of the estimators
	Regression adjustment
	Inverse-probability weighting
	Combinations of RA and IPW
	Weighted regression adjustment

	Average treatment effect on the treated
	Comparison of treatment-effects estimators
	Assumptions and trade-offs
	The conditional independence assumption
	The sufficient overlap assumption
	The correct adjustment for censoring assumption
	Assumptions for the ATET

	Specification diagnostics and tests
	Multivalued treatments

	Acknowledgments
	References
	Also see

	stteffects ipw
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	stteffects ipwra
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	Introduction
	Regression-adjusted estimators
	Weighted-adjusted-censoring assumptions
	Weighted regression-adjusted estimators
	Inverse-probability-weighted estimators
	Uncensored data

	Inverse-probability-weighted regression-adjustment estimators
	Weighted-adjusted-censoring IPWRA
	Likelihood-adjusted-censoring IPWRA

	Functional-form details

	References
	Also see

	stteffects postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntaxes for predict
	Syntax for predict after stteffects ipw
	Syntax for predict after stteffects ipwra
	Syntax for predict after stteffects ra
	Syntax for predict after stteffects wra

	Options for predict
	Options for predict after stteffects ipw
	Options for predict after stteffects ipwra
	Options for predict after stteffects ra
	Options for predict after stteffects wra


	Remarks and examples
	References
	Also see

	stteffects ra
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	stteffects wra
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	tebalance
	Description
	Syntax
	Remarks and examples
	Methods and formulas
	Introduction
	Matched samples
	IPW samples
	Testing the propensity-score model specification

	References
	Also see

	tebalance box
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Reference
	Also see

	tebalance density
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Reference
	Also see

	tebalance overid
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	References
	Also see

	tebalance summarize
	Description
	Quick start
	Menu
	Syntax
	Option
	Remarks and examples
	Stored results
	Reference
	Also see

	teffects
	Description
	Syntax
	Also see

	teffects intro
	Description
	Remarks and examples
	Introduction
	Defining treatment effects
	Estimating treatment effects
	Regression adjustment
	Inverse-probability weighting
	Doubly robust combinations of RA and IPW
	Matching

	Caveats and assumptions
	A quick tour of the estimators
	RA
	IPW
	IPWRA
	AIPW
	Nearest-neighbor matching
	Propensity-score matching

	Video examples

	References
	Also see

	teffects intro advanced
	Description
	Remarks and examples
	Introduction
	Defining treatment effects
	The potential-outcome model
	Assumptions needed for estimation
	The CI assumption
	The overlap assumption
	The i.i.d. assumption

	Comparing the ATE and ATET
	Overview of treatment-effect estimators
	RA estimators
	IPW estimators
	AIPW estimators
	IPWRA estimators
	Nearest-neighbor matching estimators
	Propensity-score matching estimators
	Choosing among estimators
	Model choice

	Acknowledgments
	References
	Also see

	teffects aipw
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Overview
	Video example

	Stored results
	Methods and formulas
	Parameters and notation
	Overview of EE estimators
	VCE for EE estimators
	TM and OM estimating functions
	TM estimating functions
	OM estimating functions

	Effect estimating functions
	RA estimators
	IPW estimators
	AIPW estimators
	IPWRA estimators


	References
	Also see

	teffects ipw
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Overview
	Video example

	Stored results
	Methods and formulas
	References
	Also see

	teffects ipwra
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Overview
	Video example

	Stored results
	Methods and formulas
	References
	Also see

	teffects multivalued
	Description
	Remarks and examples
	Introduction
	Parameters and notation
	Illustrating multivalued treatments
	Examples

	References
	Also see

	teffects nnmatch
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Video example

	Stored results
	Methods and formulas
	Nearest-neighbor matching estimator
	Bias-corrected matching estimator

	Propensity-score matching estimator
	PSM, ATE, and ATET variance adjustment


	References
	Also see

	teffects postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntaxes for predict
	Syntax for predict after aipw and ipwra
	Syntax for predict after ipw
	Syntax for predict after nnmatch and psmatch
	Syntax for predict after ra

	Options for predict
	Options for predict after aipw and ipwra
	Options for predict after ipw
	Options for predict after nnmatch and psmatch
	Options for predict after ra


	Remarks and examples
	Also see

	teffects psmatch
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Video example

	Stored results
	Methods and formulas
	References
	Also see

	teffects ra
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Overview
	Video example

	Stored results
	Methods and formulas
	References
	Also see

	telasso
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Overview
	Estimating the ATE with lassos for covariate selection
	Choosing the tuning parameter
	Estimating the ATET
	High-dimensional semiparametric models

	Stored results
	Methods and formulas
	The model
	Neyman orthogonal moments
	Double machine learning
	Resampling the partitions


	References
	Also see

	telasso postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	Remarks and examples
	Also see

	teoverlap
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	References
	Also see

	Glossary

	[TS] Time Series
	Contents
	Intro
	Description
	Also see

	Time series
	Description
	Remarks and examples
	Data management tools and time-series operators
	Univariate time series: Estimators
	Univariate time series: Time-series smoothers and filters
	Univariate time series: Diagnostic tools
	Multivariate time series: Estimators
	Multivariate time series: Diagnostic tools
	Forecasting models
	Additional resources

	References
	Also see

	arch
	Description
	Quick start
	Menu
	Syntax
	Details of syntax
	Common models
	Reading arch output

	Options
	Remarks and examples
	Stored results
	Methods and formulas
	Priming values
	Likelihood from prediction error decomposition
	Missing data

	References
	Also see

	arch postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Also see

	arfima
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	Introduction
	The likelihood function
	The autocovariance function
	The profile likelihood
	The MPL

	References
	Also see

	arfima postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Forecasting after ARFIMA
	IRF results for ARFIMA

	Methods and formulas
	References
	Also see

	arima
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	ARIMA models
	Multiplicative seasonal ARIMA models
	ARMAX models
	Dynamic forecasting
	Video example

	Stored results
	Methods and formulas
	ARIMA model
	Kalman filter equations
	Kalman filter or state-space representation of the ARIMA model
	Kalman filter recursions
	Kalman filter initial conditions
	Likelihood from prediction error decomposition
	Missing data

	References
	Also see

	arima postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Forecasting after ARIMA
	IRF results for ARIMA

	Reference
	Also see

	corrgram
	Description
	Quick start
	Menu
	Syntax
	Options for corrgram
	Options for ac and pac
	Remarks and examples
	Basic examples
	Video example

	Stored results
	Methods and formulas
	Acknowledgment
	References
	Also see

	cumsp
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Methods and formulas
	Reference
	Also see

	dfactor
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	An introduction to dynamic-factor models
	Some examples

	Stored results
	Methods and formulas
	References
	Also see

	dfactor postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	Remarks and examples
	Methods and formulas
	Also see

	dfgls
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	Acknowledgments
	References
	Also see

	dfuller
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	estat acplot
	Description
	Quick start
	Menu for estat
	Syntax
	Options
	Remarks and examples
	Methods and formulas
	References
	Also see

	estat aroots
	Description
	Quick start
	Menu for estat
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	Reference
	Also see

	estat sbcusum
	Description
	Quick start
	Menu for estat
	Syntax
	Options
	Remarks and examples
	Introduction
	Cusum of recursive residuals
	Cusum of OLS residuals

	Stored results
	Methods and formulas
	References
	Also see

	estat sbknown
	Description
	Quick start
	Menu for estat
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	estat sbsingle
	Description
	Quick start
	Menu for estat
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	fcast compute
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Methods and formulas
	Predictions after var and svar
	Dynamic forecasts after vec

	References
	Also see

	fcast graph
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Also see

	forecast
	Description
	Quick start
	Syntax
	Remarks and examples
	Video example

	References
	Also see

	forecast adjust
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Reference
	Also see

	forecast clear
	Description
	Menu
	Syntax
	Remarks and examples
	Also see

	forecast coefvector
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Simulations with coefficient vectors

	Methods and formulas
	Also see

	forecast create
	Description
	Quick start
	Menu
	Syntax
	Option
	Remarks and examples
	Also see

	forecast describe
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Reference
	Also see

	forecast drop
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Also see

	forecast estimates
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	The advise option
	Using saved estimation results
	The predict option
	Forecasting with ARIMA models

	References
	Also see

	forecast exogenous
	Description
	Menu
	Syntax
	Remarks and examples
	Also see

	forecast identity
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Also see

	forecast list
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Reference
	Also see

	forecast query
	Description
	Menu
	Syntax
	Remarks and examples
	Stored results
	Also see

	forecast solve
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Performing conditional forecasts
	Using simulations to measure forecast accuracy

	Stored results
	Methods and formulas
	References
	Also see

	irf
	Description
	Quick start
	Syntax
	Remarks and examples
	References
	Also see

	irf add
	Description
	Quick start
	Menu
	Syntax
	Option
	Remarks and examples
	Also see

	irf cgraph
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Also see

	irf create
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introductory examples
	Technical aspects of IRF files
	IRFs and FEVDs
	IRF results for VARs
	IRF results for VECMs
	IRF results for ARIMA and ARFIMA

	Methods and formulas
	Impulse--response function formulas for VARs
	Dynamic-multiplier function formulas for VARs
	Forecast-error variance decomposition formulas for VARs
	Impulse{--}response function formulas for VECMs
	Algorithms for bootstrapping the VAR IRF and FEVD standard errors 
	Impulse--response function formulas for ARIMA and ARFIMA

	References
	Also see

	irf ctable
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Also see

	irf describe
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Also see

	irf drop
	Description
	Quick start
	Menu
	Syntax
	Option
	Remarks and examples
	Also see

	irf graph
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Also see

	irf ograph
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Also see

	irf rename
	Description
	Quick start
	Menu
	Syntax
	Option
	Remarks and examples
	Stored results
	Also see

	irf set
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Also see

	irf table
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Also see

	mgarch
	Description
	Syntax
	Remarks and examples
	An introduction to MGARCH models
	Diagonal vech MGARCH models
	Conditional correlation MGARCH models
	Constant conditional correlation MGARCH model
	Dynamic conditional correlation MGARCH model
	Varying conditional correlation MGARCH model

	Error distributions and quasimaximum likelihood
	Treatment of missing data

	References
	Also see

	mgarch ccc
	Description
	Quick start
	Menu
	Syntax
	Options
	Eqoptions

	Remarks and examples
	Some examples

	Stored results
	Methods and formulas
	References
	Also see

	mgarch ccc postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Methods and formulas
	Also see

	mgarch dcc
	Description
	Quick start
	Menu
	Syntax
	Options
	Eqoptions

	Remarks and examples
	Some examples

	Stored results
	Methods and formulas
	References
	Also see

	mgarch dcc postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Methods and formulas
	Also see

	mgarch dvech
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Some examples

	Stored results
	Methods and formulas
	References
	Also see

	mgarch dvech postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Methods and formulas
	Also see

	mgarch vcc
	Description
	Quick start
	Menu
	Syntax
	Options
	Eqoptions

	Remarks and examples
	Some examples

	Stored results
	Methods and formulas
	References
	Also see

	mgarch vcc postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Methods and formulas
	Also see

	mswitch
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Markov-switching dynamic regression
	Markov-switching AR
	Video example

	Stored results
	Methods and formulas
	Markov-switching regression models
	Markov chains
	Specification of Markov-switching models
	Markov-switching dynamic regression
	Markov-switching AR

	Likelihood function with latent states
	Smoothed probabilities
	Unconditional probabilities

	References
	Also see

	mswitch postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	estat
	Description for estat
	Menu for estat
	Syntax for estat
	Option for estat

	Remarks and examples
	One-step predictions
	Dynamic predictions
	Model fit and state predictions

	Stored results
	Methods and formulas
	References
	Also see

	newey
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	newey postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Also see

	pergram
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Methods and formulas
	References
	Also see

	pperron
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	prais
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	Acknowledgment
	References
	Also see

	prais postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Also see

	psdensity
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	The frequency-domain approach to time series
	Some ARMA examples

	Methods and formulas
	Introduction
	Spectral density after arima or arfima
	Spectral density after ucm

	References
	Also see

	rolling
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Acknowledgment
	References
	Also see

	sspace
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	An introduction to state-space models
	Some stationary state-space models
	Some nonstationary state-space models

	Stored results
	Methods and formulas
	References
	Also see

	sspace postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	Remarks and examples
	Methods and formulas
	References
	Also see

	threshold
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	Introduction
	Model with more than two regions

	References
	Also see

	threshold postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	Remarks and examples
	Also see

	tsappend
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Using tsappend with time-series data
	Using tsappend with panel data

	Stored results
	Also see

	tsfill
	Description
	Quick start
	Menu
	Syntax
	Option
	Remarks and examples
	Introduction
	Using tsfill with time-series data
	Using tsfill with panel data
	Video example

	Also see

	tsfilter
	Description
	Syntax
	Remarks and examples
	An example dataset
	A baseline method: Symmetric moving-average (SMA) filters
	An overview of filtering in the frequency domain
	SMA revisited: The Baxter--King filter
	Filtering a random walk: The Christiano--Fitzgerald filter
	A one-parameter high-pass filter: The Hodrick--Prescott filter
	A two-parameter high-pass filter: The Butterworth filter

	Methods and formulas
	Acknowledgments
	References
	Also see

	tsfilter bk
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	tsfilter bw
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	tsfilter cf
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	tsfilter hp
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	tsline
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Basic examples
	Advanced example
	Video example

	References
	Also see

	tsreport
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Basic examples
	Video example

	Stored results
	Also see

	tsrevar
	Description
	Quick start
	Syntax
	Options
	Remarks and examples
	Stored results
	Also see

	tsset
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Overview
	Panel data
	Video example

	Stored results
	References
	Also see

	tssmooth
	Description
	Syntax
	Remarks and examples
	References
	Also see

	tssmooth dexponential
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	tssmooth exponential
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Examples
	Treatment of missing values

	Stored results
	Methods and formulas
	References
	Also see

	tssmooth hwinters
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	Acknowledgment
	References
	Also see

	tssmooth ma
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Overview
	Video example

	Stored results
	Methods and formulas
	Reference
	Also see

	tssmooth nl
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	Also see

	tssmooth shwinters
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Holt{--}Winters seasonal multiplicative method
	Holt{--}Winters seasonal additive method

	Stored results
	Methods and formulas
	Acknowledgment
	References
	Also see

	ucm
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	An introduction to UCMs
	A random-walk model example
	Frequency-domain concepts used in the stochastic-cycle model
	Another random-walk model example
	Comparing UCM and ARIMA
	A local-level model example
	Comparing UCM and ARIMA, revisited
	Models for the trend and idiosyncratic components
	Seasonal component

	Stored results
	Methods and formulas
	Introduction
	State-space formulation
	Cyclical component extensions

	References
	Also see

	ucm postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	estat
	Description for estat
	Menu for estat
	Syntax for estat
	Options for estat period

	Remarks and examples
	Methods and formulas
	Also see

	var intro
	Description
	Remarks and examples
	Introduction to VARs
	Introduction to SVARs
	Short-run SVAR models
	Long-run restrictions
	IRFs and FEVDs

	References
	Also see

	var
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Fitting models with some lags excluded
	Fitting models with exogenous variables
	Fitting models with constraints on the coefficients

	Stored results
	Methods and formulas
	Acknowledgment
	References
	Also see

	var postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Model selection and inference
	Forecasting

	Methods and formulas
	Also see

	var svar
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Short-run SVAR models
	Long-run SVAR models

	Stored results
	Methods and formulas
	Acknowledgment
	References
	Also see

	var svar postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	Remarks and examples
	Model selection and inference
	Forecasting

	Also see

	varbasic
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	varbasic postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Also see

	vargranger
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	varlmar
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	varnorm
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	varsoc
	Description
	Quick start
	Menu
	Syntax
	Preestimation options
	Postestimation option
	Remarks and examples
	Stored results
	Methods and formulas
	Likelihood-ratio statistic
	Model-order statistics
	Lutstats

	References
	Also see

	varstable
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	varwle
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	vec intro
	Description
	Remarks and examples
	Introduction to cointegrating VECMs
	VECM estimation in Stata

	References
	Also see

	vec
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Specification of constants and trends
	Collinearity

	Stored results
	Methods and formulas
	General specification of the VECM
	The log-likelihood function
	Estimation with Johansen identification
	Estimation with constraints: beta identified
	Estimation with constraints: beta not identified
	Formulas for the information criteria
	Formulas for predict

	References
	Also see

	vec postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Model selection and inference
	Forecasting

	Also see

	veclmar
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	Reference
	Also see

	vecnorm
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	vecrank
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	The trace statistic
	The maximum-eigenvalue statistic
	Minimizing an information criterion

	Stored results
	Methods and formulas
	References
	Also see

	vecstable
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	wntestb
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	Acknowledgment
	References
	Also see

	wntestq
	Description
	Quick start
	Menu
	Syntax
	Option
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	xcorr
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Methods and formulas
	References
	Also see

	Glossary
	References


	[XT] Longitudinal Data/Panel Data
	Contents
	Intro
	Description
	Also see

	xt
	Description
	Remarks and examples
	References
	Also see

	quadchk
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	What makes a good random-effects model fit?
	How do I know whether I have a good quadrature approximation?
	What can I do to improve my results?


	vce_options
	Description
	Syntax
	Options
	Remarks and examples
	Methods and formulas
	Reference
	Also see

	xtabond
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	xtabond postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	estat
	Description for estat
	Menu for estat
	Syntax for estat
	Option for estat abond

	Remarks and examples
	estat abond
	estat sargan

	Methods and formulas
	Reference
	Also see

	xtcloglog
	Description
	Quick start
	Menu
	Syntax
	Options for RE model
	Options for PA model
	Remarks and examples
	Stored results
	Methods and formulas
	xtcloglog, re and the robust VCE estimator

	References
	Also see

	xtcloglog postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Also see

	xtcointtest
	Description
	Quick start
	Menu
	Syntax
	Options
	Options for xtcointtest kao
	Options for xtcointtest pedroni
	Options for xtcointtest westerlund

	Remarks and examples
	Overview
	Test details
	Kao tests
	Pedroni tests
	Westerlund tests

	Stored results
	Methods and formulas
	Overview
	Kao tests
	Pedroni tests
	Westerlund tests
	Long-run variance

	References
	Also see

	xtdata
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Methods and formulas
	Also see

	xtdescribe
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Reference
	Also see

	xtdidregress
	Description
	Quick start
	Menu
	Syntax
	Reference

	xtdpd
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	Acknowledgment
	References
	Also see

	xtdpd postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	estat
	Description for estat
	Menu for estat
	Syntax for estat
	Option for estat abond

	Remarks and examples
	estat abond
	estat sargan

	Methods and formulas
	Reference
	Also see

	xtdpdsys
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	Acknowledgment
	References
	Also see

	xtdpdsys postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	estat
	Description for estat
	Menu for estat
	Syntax for estat
	Option for estat abond

	Remarks and examples
	estat abond
	estat sargan

	Methods and formulas
	Reference
	Also see

	xteintreg
	Description
	Quick start
	Menu
	Syntax

	xteoprobit
	Description
	Quick start
	Menu
	Syntax

	xteprobit
	Description
	Quick start
	Menu
	Syntax

	xteregress
	Description
	Quick start
	Menu
	Syntax

	xtfrontier
	Description
	Quick start
	Menu
	Syntax
	Options for time-invariant model
	Options for time-varying decay model
	Remarks and examples
	Introduction
	Time-invariant model
	Time-varying decay model

	Stored results
	Methods and formulas
	References
	Also see

	xtfrontier postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Methods and formulas
	Also see

	xtgee
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	Introduction
	Calculating GEE for GLM
	Correlation structures
	Nonstationary and unstructured

	References
	Also see

	xtgee postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	estat
	Description for estat
	Menu for estat
	Syntax for estat
	Options for estat

	Remarks and examples
	Also see

	xtgls
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	Heteroskedasticity across panels
	Correlation across panels (cross-sectional correlation)
	Autocorrelation within panels

	Stored results
	Methods and formulas
	References
	Also see

	xtgls postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Also see

	xtheckman
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	xtheckman postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Also see

	xthtaylor
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	xthtaylor postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	References
	Also see

	xtintreg
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	xtintreg postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Methods and formulas
	Also see

	xtivreg
	Description
	Quick start
	Menu
	Syntax
	Options for RE model
	Options for BE model
	Options for FE model
	Options for FD model
	Remarks and examples
	Stored results
	Methods and formulas
	xtivreg, fd
	xtivreg, fe
	xtivreg, be
	xtivreg, re

	Acknowledgment
	References
	Also see

	xtivreg postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Also see

	xtline
	Description
	Quick start
	Menu
	Syntax
	Options for graph by panel
	Options for overlaid panels
	Remarks and examples
	References
	Also see

	xtlogit
	Description
	Quick start
	Menu
	Syntax
	Options for RE model
	Options for FE model
	Options for PA model
	Remarks and examples
	Stored results
	Methods and formulas
	xtlogit, re and the robust VCE estimator

	References
	Also see

	xtlogit postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Also see

	xtmlogit
	Description
	Quick start
	Menu
	Syntax
	Options for RE model
	Options for FE model
	Remarks and examples
	Introduction
	The random-effects estimator
	The conditional fixed-effects estimator
	Curse of dimensionality

	Examples

	Stored results
	Methods and formulas
	References
	Also see

	xtmlogit postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Also see

	xtnbreg
	Description
	Quick start
	Menu
	Syntax
	Options for RE/FE models
	Options for PA model
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	xtnbreg postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Methods and formulas
	Also see

	xtologit
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Overview
	Video example

	Stored results
	Methods and formulas
	xtologit and the robust VCE estimator

	References
	Also see

	xtologit postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Also see

	xtoprobit
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Overview
	Video example

	Stored results
	Methods and formulas
	xtoprobit and the robust VCE estimator

	References
	Also see

	xtoprobit postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Also see

	xtpcse
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	Acknowledgments
	References
	Also see

	xtpcse postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Also see

	xtpoisson
	Description
	Quick start
	Menu
	Syntax
	Options for RE model
	Options for FE model
	Options for PA model
	Remarks and examples
	Stored results
	Methods and formulas
	xtpoisson, re and the robust VCE estimator

	References
	Also see

	xtpoisson postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Methods and formulas
	Also see

	xtprobit
	Description
	Quick start
	Menu
	Syntax
	Options for RE model
	Options for PA model
	Remarks and examples
	Stored results
	Methods and formulas
	xtprobit, re and the robust VCE estimator

	References
	Also see

	xtprobit postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Also see

	xtrc
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	xtrc postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Also see

	xtreg
	Description
	Quick start
	Menu
	Syntax
	Options for RE model
	Options for BE model
	Options for FE model
	Options for MLE model
	Options for PA model
	Remarks and examples
	Assessing goodness of fit
	xtreg and associated commands

	Stored results
	Methods and formulas
	xtreg, fe
	xtreg, be
	xtreg, re
	xtreg, mle
	xtreg, pa

	Acknowledgments
	References
	Also see

	xtreg postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	xttest0
	Description for xttest0
	Menu for xttest0
	Syntax for xttest0

	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	xtregar
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Introduction
	The fixed-effects model
	The random-effects model

	Stored results
	Methods and formulas
	Estimating rho
	Transforming the data to remove the AR(1) component
	The within estimator of the fixed-effects model
	The Baltagi--Wu GLS estimator
	The test statistics

	Acknowledgment
	References
	Also see

	xtregar postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Also see

	xtset
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Also see

	xtstreg
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	Survival models
	xtstreg and the robust VCE estimator

	References
	Also see

	xtstreg postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Methods and formulas
	Also see

	xtsum
	Description
	Quick start
	Menu
	Syntax
	Remarks and examples
	Stored results
	Also see

	xttab
	Description
	Quick start
	Menu
	Syntax
	Option
	Remarks and examples
	Stored results
	Also see

	xttobit
	Description
	Quick start
	Menu
	Syntax
	Options
	Remarks and examples
	Stored results
	Methods and formulas
	References
	Also see

	xttobit postestimation
	Postestimation commands
	predict
	Description for predict
	Menu for predict
	Syntax for predict
	Options for predict

	margins
	Description for margins
	Menu for margins
	Syntax for margins

	Remarks and examples
	Methods and formulas
	Also see

	xtunitroot
	Description
	Quick start
	Menu
	Syntax
	Options
	LLC_options
	HT_options
	Breitung_options
	IPS_options
	Fisher_options
	Hadri_options

	Remarks and examples
	Overview
	Levin--Lin--Chu test
	Harris--Tsavalis test
	Breitung test
	Im--Pesaran--Shin test
	Fisher-type tests
	Hadri LM test

	Stored results
	Methods and formulas
	Levin--Lin--Chu test
	Harris--Tsavalis test
	Breitung test
	Im--Pesaran--Shin test
	Fisher-type tests
	Hadri LM test

	Acknowledgments
	References
	Also see

	Glossary

	[I] Index
	Contents
	Combined subject table of contents
	Acronym glossary
	Vignette index
	Author index
	A
	B
	C
	D
	E
	F
	G
	H
	I
	J
	K
	L
	M
	N
	O
	P
	Q
	R
	S
	T
	U
	V
	W
	X
	Y
	Z

	Subject index
	Symbols
	A
	B
	C
	D
	E
	F
	G
	H
	I
	J
	K
	L
	M
	N
	O
	P
	Q
	R
	S
	T
	U
	V
	W
	X
	Y
	Z



